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Capitolo 1. In generale
Introduzione

GnuCash è un pacchetto software di gestione delle finanze personali. È sufficientemente versatile per
tenere traccia di tutte le transazioni finanziarie, dalle più semplici a quelle più complesse; è uno dei
pochi software finanziari che supporta tutte le valute del mondo ed è l’unico a codice aperto. Se questo
non bastasse, è anche molto semplice imparare a usarlo.

GnuCash permette di tenere traccia delle transazioni finanziare con il livello di dettaglio che si prefe-
risce. Se si è all’inizio, è possibile utilizzare GnuCash per tenere traccia dei propri assegni. In seguito
si potrà decidere di considerare anche le spese sostenute con la carta di credito per meglio conosce-
re dove il denaro viene speso. Quando si inizierà a investire, sarà possibile utilizzare GnuCash per
monitorare le proprie azioni. Si sta per comprare un’auto o una casa? GnuCash aiuterà a pianificare
l’investimento e a registrare le rate dell’eventuale mutuo. Se le transazioni finanziarie che si eseguono
sono a livello globale, GnuCash offre tutto ciò che serve per gestire le valute di ogni parte del mondo.

Questa immagine mostra le finestre dei conti e dei resoconti di GnuCash con valute multiple e inve-
stimenti.

Anche se GnuCash si presta alla gestione delle finanze personali, è anche sufficientemente potente
per un utilizzo professionale. GnuCash presenta infatti diverse caratteristiche dedicate all’impresa:
dall’integrazione del sistema dei conti per debiti e crediti correnti, alla costruzione di tabelle per le
tasse. Queste e molte altre funzioni dedicate all’attività professionale risulteranno sorprendentemente
potenti e facili da usare.

Caratteristiche

Facile da usare
In pochi minuti si potranno inserire le proprie informazioni finanziarie personali e creare dei grafici
colorati che rappresentino la propria situazione finanziaria. Se si è in grado di utilizzare il registro
presente sul libretto degli assegni allora si è anche in grado di usare GnuCash! Scrivere direttamente
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sul registro, scorrere tra i campi di inserimento e usare la funzione di completamento veloce per com-
pletare le transazioni. L’interfaccia del programma è personalizzabile direttamente dal menu dedicato.

• Menu facili da usare: i menu di GnuCash sono conformi alle disposizioni dell’interfaccia Human
di GNOME; questo significa che sono semplici e appaiono simili a tante altre applicazioni dell’am-
biente GNOME;

• documentazione: GnuCash vanta una sezione di aiuto incorporata nel software e una estesa guida
dell’utente;

• metodi di importazione: GnuCash supporta diversi modi per creare delle transazioni oltre a quello
manuale. Se si possiede l’accesso al conto bancario via internet, risulterà molto utile dato che la
maggior parte delle banche e delle compagnie di carte di credito supportano uno dei seguenti metodi
di importazione. Si risparmierà, in questo modo, tempo all’immissione dati per dedicarlo all’analisi
dei risultati;

• importazione di file Quicken (QIF): GnuCash permette di importare i file Quicken in formato
QIF, utilizzato da programmi a pagamento per la gestione delle finanze personali;

• Open Financial Exchange (OFX): GnuCash è il primo programma libero a fornire supporto al
protocollo Open Financial Exchange. Molte istituzione finanziarie si stanno attrezzando per que-
sto formato;

• Home Banking Computer Interface (HBCI): GnuCash è il primo software libero a supportare il
protocollo Tedesco Home Banking Computer Interface. Questo protocollo permette lo scarica-
mento di estratti conto, l’avvio di trasferimenti bancari e rende possibile l’addebito diretto;

• resoconti: GnuCash è fornito con oltre 30 resoconti che includono un sommario del conto, entrate,
uscite, resoconto della transazione, bilancio patrimoniale, profitti e perdite, valutazione del portafo-
glio e tanti altri. I resoconti permettono anche la visualizzazione grafica dei dati tramite istogrammi,
dispersioni e grafici a torta. I resoconti possono essere esportati in file di formato HTML e sono
facilmente personalizzabili;

• transazioni pianificate: GnuCash è ora in grado di creare e inserire automaticamente delle transa-
zioni o ricordare all’utente quando queste stanno per scadere permettendo di scegliere se inserirle,
posticiparle o rimuoverle;

• assistente per il rimborso di ipoteche e mutui: utile per impostare il pagamento di un prestito varia-
bile tramite delle transazioni pianificate;

• facile riconciliazione dei conti: la riconciliazione è integrata in GnuCash in modo che riconciliare
i propri conti di GnuCash con gli estratti conto risulti semplice ed efficace;

• Multi-platform Compatibility: GnuCash is supported on a variety of platforms and operating sy-
stems. The list of fully supported operating systems (and platforms) for GnuCash 2.6.14 is: GNU/Li-
nux (x86, x86_64, Sparc, PPC), FreeBSD (x86, x86_64), OpenBSD (x86, x86_64), Solaris (Sparc),
and MacOS X (Intel, PPC). Previous versions of GnuCash have been known to work with, SGI
IRIX (MIPS), IBM AIX 4.1.5 (RS/6000), Unixware 7 (Intel), and SCO OpenServer 5.0.4 (Intel),
but their current status is unknown.

Registrare gli investimenti
GnuCash includes a number of investment features that allow you to track all your investments. With
GnuCash you can track stocks individually (one per account) or in a portfolio of accounts (a group
of accounts that can be displayed together).

GnuCash supports online stock and mutual fund quotes. This means you no longer need to look up
stock prices one at a time. The process can be automated, and you can see the latest value of your
stocks.
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Supporto internazionale
GnuCash è un’applicazione dedicata veramente agli utenti di tutto il mondo; presenta infatti diverse
funzioni per facilitare l’interazione con il mondo internazionalizzato in cui oggi viviamo.

• Native Languages: GnuCash has been fully translated into 12 languages: Chinese, Czech, Dutch,
English, French, German, Italian, Portuguese, Russian, Slovak, Spanish and Swedish. More than
25 other languages are partially supported.

• International Format Handling: GnuCash understands that different countries display the date and
numbers differently. You are able to work with the date and number formats you are accustomed to.

• Multiple Currencies and Currency Trading: Multiple currencies are supported and can be bought
and sold (traded). Currency movements between accounts remain fully balanced if "Trading Ac-
counts" is enabled.

• Tassi di cambio online: con GnuCash, non sarà più necessario controllare ogni volta tutti i tassi di
cambio; il processo può essere automatizzato in modo che il programma fornisca in ogni momento
i valori del conto convertiti nella valuta che si preferisce usando i più recenti tassi di cambio.

Supporto all’impresa
GnuCash presenta molte caratteristiche che possono risultare utili a tutti coloro che devono tenere la
contabilità della propria attività.

• Conti per debiti e crediti correnti: GnuCash fornisce un sistema integrato di conti per debiti e crediti
correnti. È possibile registrare clienti, venditori, fatturazione e pagamento delle ricevute oltre a poter
utilizzare diversi termini per la tassazione e per le ricevute in una piccola impresa.

• Deprezzamento: GnuCash è in grado di tenere traccia del deprezzamento del patrimonio.

• Resoconti: GnuCash offre un’ampio ventaglio di resoconti pronti all’uso.

Caratteristiche di contabilità
Per coloro che si intendono di contabilità, di seguito è riportata una lista di caratteristiche supportate
da GnuCash.

• Partita doppia: ogni transazione deve addebitare un conto e accreditarne un altro di uno stesso
importo. Questo principio assicura «l’equilibrio dei libri» cioè che la differenza tra entrate e uscite
sia esattamente uguale alla somma di tutti i depositi bancari, liquidi, azioni e altri patrimoni.

• Suddivisione delle transazioni: una singola transazione può essere suddivisa in diverse parti al fine
di registrare tasse, parcelle e altre voci composte.

• Strutture dei conti: un conto principale può contenere una struttura di conti di dettaglio. Questo
permette di raggruppare in unico conto come, per esempio, quello delle «Attività» conti simili tra
loro quali liquidi, banca o azioni.

• Libro mastro generale: una finestra di registro permette di visualizzare più conti contemporanea-
mente; questa peculiarità permette di ridurre i problemi derivanti da errori di battitura e di compila-
zione. La finestra fornisce anche un utile modo di visualizzare un portafoglio di azioni, mostrando
tutte le transazioni presenti nel portafoglio stesso.

• Tipi di conti (categorie) per entrate e uscite: classificano i flussi di denaro e, quando usati corret-
tamente con la partita doppia, forniscono un accurato resoconto di profitti e perdite.

Informazioni su questo documento
Lo scopo di questo manuale è di far risparmiare tempo introducendo l’utente all’utilizzo di GnuCash
il più velocemente possibile.
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Ogni capitolo segue uno schema molto semplice. Inizia con la discussione dei «concetti» che intro-
ducono l’argomento e la terminologia adottata nel capitolo stesso. In seguito c’è una sezione «come
fare per...» che descrive la procedura da adottare nel programma per mettere in atto i concetti riportati
nella sezione precedente; infine una sezione «in pratica» conclude il capitolo e fornisce dettagliati
esempi di applicazione.

I neofiti troveranno le sezioni sui «concetti» molto utili dato che forniscono una guida su come tenere
correttamente traccia delle proprie finanze e introducono ai concetti di contabilità e alla terminologia
finanziaria. Gli utenti più esperti potranno invece saltare direttamente alle sezioni sul «come fare per...»
per imparare subito le procedure descritte passo passo. Le sezioni «in pratica» forniscono delle lezioni
sull’utilizzo del programma presentando degli esempi pratici. Iniziando con la creazione di un progetto
nel Capitolo 2, Le basi, ogni capitolo successivo prosegue il lavoro realizzato in quello precedente.

Questo manuale è diviso in 3 parti:

• Come Iniziare

• Managing Personal Finances

• Managing Business Finances

Getting Started provides you with the most basic information needed to begin using GnuCash. The
chapters in this section explain concepts that are fundamental to using GnuCash. New users of Gnu-
Cash should familiarize themselves with the information in these chapters to get you up and running:

• Capitolo 1, In generale - (this chapter) gives a general overview of GnuCash

• Capitolo 2, Le basi - gives users a very brief introduction to accounting principles, and then provides
information about how GnuCash structures its data. There is also information on basic interface
elements in GnuCash. Finally, this chapter explains how GnuCash stores and manages your data.

• Capitolo 3, Conti - gives further information about accounts and how to organize them.

• Capitolo 4, Transazioni - gives basic information about transactions and how to enter them.

Managing Personal Finances addresses common applications and features of GnuCash in greater
detail. You will see more specific cases, based on frequently asked questions about applying GnuCash
to everyday situations. Here are the applications and features covered in this part:

• Capitolo 5, Libretto degli assegni

• Capitolo 7, Carte di credito

• Capitolo 8, Prestiti

• Capitolo 9, Investimenti

• Capitolo 11, Guadagni in conto capitale

• Capitolo 12, Valute multiple

Managing Business Finances discusses the use of GnuCash in business accounting:

• Capitolo 13, Business Features

• Capitolo 14, Bilanci

• Capitolo 15, Altre attività

• Capitolo 16, Deprezzamento

• Capitolo 17, Python Bindings
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• Capitolo 18, Importare i dati dell’impresa

This manual also includes several appendices, which contains extra information you might want to
know:

• GnuCash Glossary - Glossary of terms used in GnuCash

• Appendice A, Guida alla migrazione - Guida per gli ex utenti di Quicken®, MS Money o altri
utilizzatori di file QIF

• Appendice B, Domande poste frequentemente (FAQ)

• Appendice C, Contributed Account Trees

• Appendice D, Formati di file ausiliari

• Appendice E, Documentazione sulla licenza libera GNU (in inglese)

In ultimo un glossario e l’indice permettono di trovare facilmente gli argomenti che si stanno cercando.

Getting More Help

Online Help
The online help is the counterpart to this guide. It provides the detailed instructions for using GnuCash's

menus, windows, and controls. To open online help, select Help → Contents.

GnuCash Wiki
An immense amount of less-formal documenation, both of GnuCash itself and its maintenance and de-
velopment may be found in the GnuCash Wiki [https://wiki.gnucash.org/wiki]; the Frequently Asked
Questions [https://wiki.gnucash.org/wiki/FAQ] page should be a first stop whenever you encounter
difficulty using GnuCash.

GnuCash On-line Assistance

Mailing List

The primary source of user support is the user mailing list [mailto:gnucash-user@gnucash.org]. If
you prefer a web forum-like presentation, you can use it via Nabble [http://gnucash.1415818.n4.nab-
ble.com/GnuCash-User-f1415819.html]. One must subscribe [https://lists.gnucash.org/mailman/li-
stinfo/gnucash-user] before posting, even if using Nabble.

IRC

Several of the developers monitor the #gnucash channel at irc.gnome.org. They're usually doing so-
mething else, too, and of course aren't always at their computers. Log in, ask your question, and stay
logged in; it may be several hours before your question is noticed and responded to. To see if you
missed anything check the IRC logs [https://code.gnucash.org/logs].

The GnuCash web site  [http://www.gnucash.org] has more details on these channels. You will also
find pointers there to additional useful resources such as the GnuCash wiki and bug tracking system.

Installazione
Installation of GnuCash is usually simple.
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The GnuCash download page [http://www.gnucash.org/download.phtml] contains detailed instruc-
tions on how to install GnuCash for each operating system supported.
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Capitolo 2. Le basi
Questo capitolo introduce all’utilizzo di base di GnuCash e se ne consiglia la lettura per intero prima
di iniziare qualsiasi progetto reale con GnuCash. Il capitolo successivo a questo mostrerà degli esempi
pratici di utilizzo.

Concetti di contabilità
GnuCash è abbastanza semplice da utilizzare e comprendere anche in assenza di una approfondita
conoscenza dei principi della contabilità. Comunque, nulla toglie che la conoscenza di alcuni concetti
base risulta indispensabile dato che GnuCash è stato creato sulla base di questi principi. Si consiglia
caldamente di comprendere a fondo questa sezione prima di procedere nella lettura dei capitoli suc-
cessivi.

I 5 conti di base
Le leggi della contabilità raggruppano tutti gli strumenti finanziari in 5 tipi fondamentali di «conti». In
pratica tutto quello con cui i contabili hanno a che fare può essere inserito in uno dei seguenti 5 gruppi:

Tipi di conto

Attività Tutto ciò che si possiede.

Passività I debiti.

Capitali Valore totale netto.

Entrate Aumentano il valore del conto.

Uscite Diminuiscono il valore del conto.

È ora più chiaro come sia possibile catalogare il mondo finanziario in questi 5 gruppi. Per esempio il
denaro sul proprio conto bancario fa parte dei beni, il mutuo è un debito, il salario/stipendio è un’entrata
mentre il costo della cena di ieri sera è un’uscita.

L’Equazione fondamentale della contabilità
Definiti i 5 conti fondamentali, resta da spiegare come siano in relazione tra loro. In che modo un tipo
di conto ne influenza un altro? Prima di tutto il capitale netto è definito a partire dalle attività e dalle
passività. Matematicamente parlando, il capitale netto è la differenza tra il valore delle proprie attività
e quello delle proprie passività:

attività - passività = capitale netto

In aggiunta, è possibile aumentare il capitale attraverso le entrate e diminuirlo con le uscite. Questo è
intuitivo dato che quando si riceve un assegno si diventa più «ricchi» e quando si offre una cena si di-
venta più «poveri». Matematicamente questo concetto è espresso dall’EQUAZIONE DELLA CON-
TABILITÀ:

attività - passività = capitale + (entrate - uscite)

L’equazione deve sempre essere rispettata; questo è vero se i movimenti di denaro avvengono sempre
da un conto verso un altro. Per esempio, se si riceve del denaro come entrata, deve esserci un corri-
spondente aumento del capitale. Come altro esempio si può avere un aumento del proprio patrimonio
se a esso corrisponde un aumento delle passività.
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Figura 2.1. La relazione fondamentale della contabilità

Visualizzazione grafica della relazione che intercorre tra i 5 tipi fondamentali di conti. Il capitale netto si accresce
grazie alle entrate e diminuisce a causa delle uscite. Le freccie rappresentano la direzione del valore.

Partita doppia
L’equazione di bilancio appena descritta costituisce il cuore di un sistema di registrazione a partita
doppia. A ogni cambio di valore di un termine dell’equazione deve corrispondere la variazione di un
altro termine per rispettare l’uguaglianza. Questo concetto è noto con il nome di principio del bilancio
ed è di fondamentale importanza per capire come funziona GnuCash ma anche gli altri programmi che
usano uno schema a partita doppia. Quando si lavora con GnuCash, si dovranno sempre considerare
almeno due conti al fine di mantenere equilibrata l’equazione fondamentale della contabilità

Si ricordano ancora i termini debito e credito discussi nella la sezione chiamata «Concetti di contabi-
lità»? Contrariamente a quanto si possa credere e alle definizioni sui dizionari, debiti e crediti non
significano «diminuzione» o «aumento». L’unica definizione costante di debiti e crediti è che i debiti
sono inseriti nella colonna di sinistra (chiamata anche dare) mentre i crediti in quella di destra (chia-
mata anche avere). Infatti entrambi possono far aumentare certi tipi di conti e farne diminuire altri.
Nei conti delle attività e delle uscite, i debiti ne aumentano il saldo mentre i crediti lo diminuiscono.
Nei conti delle passività, del capitale e delle entrate, i crediti ne aumentano il saldo mentre i debiti
lo diminuiscono.

In traditional double-entry accounting, the left column in the register is used for debits, while the right
column is used for credits. Accountants record increases in asset and expense accounts on the debit
(left) side, and they record increases in liability, revenue, and equity accounts on the credit (right) side.
GnuCash follows this convention in the register.

Nota

This accounting terminology can be confusing to new users, which is why GnuCash allows
you to use the common terms Deposit and Withdrawal. If you prefer the formal accounting
terms, you can change the account register column headings to use them in the Accounts
tab under Preferences (see the GnuCash Help Manual for more information on setting pre-
ferences).

Avvertimento

Common use of the words debit and credit does not match how accountants use these words.
In common use, credit generally has positive associations; in accounting, credit means affec-
ting the right column of the ledger sheet of an account. This is associated with a decrease in
asset and expense, but an increase of income, liability and equity accounts.

For more details see http://en.wikipedia.org/wiki/Debits_and_credits.

Concetti sull’immissione dei dati
Quando si inseriscono dei dati in GnuCash, occorre avere ben presente i 3 livelli in cui GnuCash li
organizza: file, conti e transazioni. Questi livelli sono in ordine di complessità; un file contiene diversi
conti e un conto contiene più transazioni. Questa suddivisione è di fondamentale importanza per capire
come utilizzare

File
GnuCash immagazzina le informazioni al livello più alto nei file. Un file può essere conservato sul
proprio computer o come un singolo file XML (in tutte le versioni di GnuCash) o in un database SQL
(in GnuCash versione 2.4 o superiore).
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Nota

SQL si pronuncia «sequel», quindi nel linguaggio parlato e scritto si dice «un database SQL».

Con il formato XML, GnuCash immagazzina i propri dati finanziari in un file di estensione .xml,
generalmnete in formato compresso (aqnche se questa impostazione può essere cambiata nella scheda
Generali delle Preferenze di GnuCash).

Con l’immagazzinamento SQL, GnuCash conserva i propri dati finanziari in un database SQL nell’ap-
plicazione per i database selezionata (SQLite3, MySQL o PostgreSQL).

È necessario avere un file o database principale per ogni gruppo di conti che si vuole mantenere. Per
sapere come creare e gestire i file di GnuCash, consultare la sezione chiamata «Conservare i propri
dati finanziari».

Nota

Se fosse necessario più di un gruppo di conti, si consiglia di rivolgersi a un contabile pro-
fessionista prima di procedere. La maggior parte degli utenti avranno bisogno di un singolo
file dei dati.

GnuCash genera automaticamente dei file di backup e di log quando necessario. Questi tipi di file
sono discussi in la sezione chiamata «Creare copie di sicurezza e recuperare i dati».

Conti

Un conto tiene traccia di ciò che si ha, di ciò che si deve, di quello che si spende o riceve. Ogni file
di GnuCash contiene un numero qualsiasi di conti, e ognuno può contenere diversi sottoconti per un
numero qualsiasi di livelli. Questa semplice funzionalità fornisce a GnuCash la maggior parte della
sua abilità nella gestione delle finanze, come verrà mostrato nei capitoli successivi.

Esempi di conti sono: il conto corrente, il conto dei risparmi, il conto della carta di credito, i mutui
e i prestiti. Ogni conto di GnuCash tiene traccia dell’attività relativa al conto «reale» e fornisce infor-
mazioni sul suo stato.

Inoltre i conti sono utili per categorizzare il denaro ricevuto o speso. Per esempio, è possibile creare
dei conti delle uscite per tracciare il denaro che si spende per i servizi o per i generi alimentari. Anche
se per questi conti non si riceve un estratto conto, permettono comunque di determinare quanto denaro
vieno speso in ogni area.

I conti verranno discussi in dettaglio in Capitolo 3, Conti.

Transazioni

Una transazione consiste nel movimento di denaro tra conti. Spendere, ricevere o trasferire denaro tra
conti, rappresentano tutte delle transazioni.

Esempi di transazioni sono: pagare la bolletta del telefono, trasferire denaro dal conto bancario al pro-
prio portafoglio, prelevare denaro, depositare un assegno. L’inserimento delle transazioni è discusso
in Capitolo 4, Transazioni

In double entry accounting, transactions always involve at least two accounts–a source account and a
destination account. GnuCash manages this by inserting a line into the transaction for every account
that is affected, and recording the amounts involved in each line. A line within a transaction that
records the account and amount of money involved is called a split. A transaction can contain an
arbitrary number of splits.
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Nota

Le suddivisioni per le transazioni verranno descritte in la sezione chiamata «Split Transaction
Example»

Interfaccia
All’apertura di GnuCash per la prima volta, verrà mostrata la finestra di Benvenuto in GnuCash!. Da
qui, GnuCash propone altri strumenti di aiuto per trovare facilmente ciò che si sta cercando. Di seguito
sono riportate le schermate e le finestre che si possono incontrare più frequentemente in

Suggerimento del giorno

GnuCash è dotato di una finestra del Suggerimento del giorno che fornisce consigli utili per l’utilizzo
del programma:

Questa immagine mostra il suggerimento del giorno.

Questi suggerimenti forniscono utili informazioni in particolar modo agli utenti inesperti. Per vedere
altri consigli premere il tasto Avanti. Se si desidera che questa finestra non venga mostrata all’avvio
del programma, togliere la spunta all’opzione Mostra i suggerimenti all’avvio. Terminata la lettura
dei suggerimenti, premere il tasto Chiudi per chiudere la finestra dei suggerimenti.

Finestra della struttura ad albero del conto

Ora dovrebbe essere visibile la finestra dei conti che si presenta come mostrato più sotto. La confor-
mazione dell’albero dei conti dipende dalla scelta effettuata nella terza finestra dell’assistente per la
creazione della struttura dei conti. In questo esempio è mostrata la struttura associata alla scelta Conti
comuni.
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Questa immagine mostra la schermata dei Conti

The Account Tree window (also known as a Chart of Accounts, or CoA) provides an overview of the
data contained in the current file. It contains a list of account names and their current balances.

From this window, you can open the register of any account either by double-clicking the account
name, right clicking the account name and selecting Open Account from the menu, or by using the
Open button on the toolbar. GnuCash allows you to have as many account registers open as you
wish. For more information on using account registers, see la sezione chiamata «Finestra del registro
contabile».

Suggerimento

Clicking the small triangle to the left of an account that has children will expand the tree
view showing child accounts.

At the top of this window is the Titlebar, which displays the file name for this set of accounts (once you
have saved the file.) Below that is the Menubar. You can access the menu options by either clicking
on these menu headings or by using shortcuts and access keys (see la sezione chiamata «Scorciatoie
per i menu»). Next is the Toolbar, which contains buttons for the most common functions.

L’albero dei conti è posto al si sotto della barra degli strumenti. Una volta creati dei conti, i nomi
a essi assegnati verranno inseriti in questa finestra. È possibile scegliere quali intestazioni delle co-
lonne visualizzare utilizzando la freccia-giù all’estrema destra posizionata immediatamente sopra alla
struttura ad albero.

Nella parte inferiore si trova la barra di stato che fornisce informazioni su cosa si possiede (attività
nette) e quanto denaro è stato guadagnato (profitto).

Finestra del registro contabile

Account Register windows are used to enter and edit your account data. As the name suggests, they
look similar to a checkbook register.
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Questa immagine mostra il registro del conto corrente in cui sono presenti alcune transazioni.

In Capitolo 4, Transazioni sono fornite ulteriori informazioni sulle finestre del registro e su come
immettere i dati in esse. Per ora, si noti che le parti che compongono una finestra del registro di un conto
sono simili a quelle di cui è composta la finestra della struttura dei conti descritta precedentemente.
La barra del titolo in alto contiene il nome del conto; sotto di questa, la barra del menu contiene delle
opzioni relative al registro del conto. La barra degli strumenti semplifica l’esecuzione delle operazioni
più comuni. La barra di stato nella parte bassa della finestra, mostra alcuni saldi del conto descritti
in Capitolo 4, Transazioni. In basso nella finestra del registro del conto, vengono visualizzate delle
informazioni sulla posizione occupata in quel momento dal cursore.

Nota

In the register windows, you can resize the various columns that GnuCash displays, but keep
in mind that the Description and Balance columns behave differently from other columns.

The Description column is designed to expand automatically to fill all unused horizontal
screen space. Therefore you should set the widths of all your other columns before setting
the Description column width.

The Balance column must be resized by double-clicking on the column heading.

Pulsanti della barra degli strumenti
Sia la finestra con la struttura dei conti che quella del registro, contengono dei pulsanti sulla barra
degli strumenti. Questi pulsanti forniscono un rapido accesso alle funzioni più comunemente usate
quali Salva e Apri, nella finestra della struttura ad albero dei conti, e Registra e Cancella nella finestra
del registro. Se non si è sicuri sulla funzione di un pulsante, è sufficiente spostare il puntatore del
mouse su di esso per far apparire la descrizione della funzione.

Di seguito si riporta una lista dei pulsanti presenti nella finestra della struttura ad albero dei conti.

Pulsanti della finestra della struttura dei conti

Salva Salva sul disco il file corrente

Chiudi Chiude la scheda attiva.
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Apri, Modifica, Nuovo e Cancella Si tratta di funzioni relative ai conti e so-
no discusse in Capitolo 3, Conti.

Register-specific buttons are discussed in Capitolo 4, Transazioni.

Tab Bar
GnuCash uses a tabbed model that allows you to open multiple account registers and reports simulta-
neously. Each open window (which can include account registers, reports, or Scheduled Transactions
windows) is given a tab on this bar that you can click to view that window. Tabs can be configured in
Preferences to appear along any side of the GnuCash window.

To see the full name for a tab, hover the mouse pointer over an account window tab.

If more screens are open than can be displayed across the screen, some tabs will not display. You can
move through all tabs by clicking the arrows on either end of the tab bar. A complete list of tabs can
be viewed by right-clicking the Tab Bar and any tab can be selected by clicking it.

Voci del menu
La finestra della struttura ad albero dei conti e la finestra del registro contengono entrambe le inte-
stazioni dei menu in una barra del menu. Facendo clic su una intestazione si aprirà una tendina che
mostra le voci associate a quella del menu aperto.

È possibile fare clic sulle intestazioni della barra del menu nella finestra della struttura conti e poi
spostare il puntatore del mouse su ogni voce per vedere cosa fa. Al muoversi del puntatore su di una
voce del menu, viene fornita una descrizione della funzione nell’angolo in basso a sinistra della finestra
(nella barra di stato). Per selezionare una voce di menu, fare clic semplicemente su di essa.

È anche possibile accedere alle voci di menu più comunemente utilizzate premendo il tasto destro del
mouse in un punto qualsiasi della finestra. Nella finestra della struttura conti, si aprirà una tendina
contenente funzioni relative ai conti mentre, nella finestra del registro, appariranno funzioni per la
gestione delle transazioni.

Altri modi per accedere alle voci del menu consistono nell’utilizzo delle scorciatoie da tastiera e nelle
chiavi di accesso, descritte di seguito.

Scorciatoie per i menu
Tutte le voci del menu hanno associata una lettera per l’accesso veloce identificata da una sottolinea-
tura. Premendo simultaneamente Alt e la lettera sottolineata associata alla voce desiderata del menu
principale, comparirà un sotto-menu con altre voci che hanno un carattere sottolineato. Ora è suffi-
ciente premere la lettera sottolineata associata al comando che si vuole eseguire per completare l’ope-
razione. Per esempio premendo Alt+F nella finestra principale, si apre il menu File, e poi premendo S
è possibile salvare il file. Queste lettere, che fungono da scorciatoia, sono fisse, nel senso che l’utente
non può modificarle a proprio piacimento.

Alcune delle funzioni più comunemente usate sono associate a dei tasti scorciatoia che eseguono di-
rettamente il comando desiderato senza dover attraversare la struttura del menu. Queste scorciatoie
utilizzano tipicamente il tasto Ctrl, sebbene sia possibile utilizzare qualsiasi combinazione. Le scor-
ciatoie per i comandi del menu sono indicate alla fine del nome del comando stesso nel menu.

Ricevere aiuto
GnuCash offre aiuto in diversi modi. È già stato trattato il Suggerimento del giorno che fornisce in-
formazioni utili all’avvio della sessione di GnuCash. GnuCash offre però anche un esteso manuale
di aiuto.

16



Le basi

Manuale di aiuto
Once you have opened GnuCash, you will see the Account Tree window Help menu heading, which
opens the Help manual. The Help manual is organized by topic, and you can expand each topic into
its subtopics.

Gli argomenti sono visualizzati nel lato destro. Selezionando un argomento od un sotto argomento,
si aprirà sul lato sinistro il testo descrittivo. Utilizzare i pulsanti Indietro ed Avanti per navigare fra
gli argomenti.

Accesso Web
La finestra dell’Aiuto di GnuCash può funzionare anche come un semplice browser web in modo
da permettere l’apertura di un sito internet per ottenere ulteriori informazioni. È possibile aprire un
sito internet in questa finestra selezionando il pulsante Apri dalla barra degli strumenti e inserendo
l’indirizzo. Utilizzare i pulsanti Indietro, Avanti, Aggiorna, Stop e Stampa come se si stesse utilizzando
un normalissimo browser web.

Il sito internet di GnuCash [http://www.gnucash.org] contiene informazioni utili sul programma e su
ogni suo aggiornamento. Fornisce anche i collegamenti alle liste di discussione di GnuCash per svi-
luppatori e utenti dove è possibile effettuare ricerche negli archivi delle liste di discussione di Gnu-
Cash [https://lists.gnucash.org/cgi-bin/namazu.cgi] per trovare le discussioni relative a un particolare
argomento. Se non si ottiene la risposta che si sta cercando, è comunque possibile inviare la propria
domanda alla lista dell’utente di GnuCash [https://lists.gnucash.org/mailman/listinfo/gnucash-user],
e sicuramente qualcuno tenterà di rispondere.

L’ultima versione della FAQ di GnuCash è anche reperibile qui: GnuCash FAQ website [http://wi-
ki.gnucash.org/wiki/FAQ]; questa pagina fornisce le risposte alle domande più frequenti su GnuCash.

Ricercare un argomento
Il manuale online fornisce anche una funzione di ricerca. Per cercare un argomento particolare, fare
clic sulla sheda Cerca in basso nella finestra di aiuto e inserire l’argomento da ricercare. Fare clic sul
pulsante Cerca per completare la ricerca. Una lista di scelta apparirà al di sotto. Facendo clic su di una
scelta verrà aperto il testo relativo nella finestra di destra.

Conservare i propri dati finanziari
GnuCash è in grado di conservare i propri dati finanziari in file o in database SQL in modo che possano
essere aperti e modificati in tempi successivi. Prima di tutto è però necessario creare un «contenitore»
per i propri dati.

Creare un file
Per creare un nuovo file di GnuCash procedere nel seguente modo:

1. Dalla barra del menu di GnuCash, selezionare File → Nuovo File. L’assistente per la Creazione
di una nuova struttura dei conti verrà avviato.

Nota

If you are running GnuCash for the first time, you will be presented with the Welcome to
GnuCash! screen. This screen is described in detail in the GnuCash manual.

2. Impostare le proprie preferenze nell’assistente spostandosi tra le schermate con i pulsanti Avanti,
Annulla e Indietro.

17

http://www.gnucash.org
http://www.gnucash.org
https://lists.gnucash.org/cgi-bin/namazu.cgi
https://lists.gnucash.org/cgi-bin/namazu.cgi
https://lists.gnucash.org/cgi-bin/namazu.cgi
https://lists.gnucash.org/mailman/listinfo/gnucash-user
https://lists.gnucash.org/mailman/listinfo/gnucash-user
http://wiki.gnucash.org/wiki/FAQ
http://wiki.gnucash.org/wiki/FAQ
http://wiki.gnucash.org/wiki/FAQ


Le basi

Salvare i dati
Seguire i passi seguenti per salvare il file con un nome preferito:

1. Selezionare File → Salva come... dalla barra del menu oppure premere il pulsante Salva sulla barra
degli strumenti. GnuCash presenterà la finestra di salvataggio.

2. Selezionare il Formato dati del file che si sta per salvare dalla lista a comparsa. La selezione prede-
finita è il formato XML ma se è stato impostato un backend per un database è possibile selezionare
quest’ultimo formato

A seconda del Formato dati selezionato, la finestra può cambiare come descritto nel seguito.

3.
• Se è stato selezionato XML o sqlite3 verrà mostrata una finestra questa come questa:

Figura 2.2. Schermata di salvataggio quando è stato selezionato il formato
XML o sqlite3

Questa immagine mostra la schermata di salvataggio quando il Formato dati selezionato è XML
o sqlite3.

Digitare nel campo del Nome il nome da assegnare al file. Non è necessario specificare un’e-
stensione quando si scrive il nome del file; GnuCash aggiungerà automaticamente l’estensione
.gnucash al file.

Nota

L’estensione .gnucash è stata introdotta a partire dalla serie 2.3 di GnuCash. per i
file già esistenti, l’estensione non verrà cambiata. Quindi se viene aperto un file esi-
stente denominato ilmiovecchiofile, questo nome non cambierà se il file viene
salvato. Usare il comando Salva come... e dare al file un nuovo nome per salvarlo con
l’estensione .gnucash.

Selezionare il percorso in cui salvare il file sfogliando la struttura delle cartelle nel riquadro
inferiore.

18



Le basi

Suggerimento

Premere il pulsante Crea Cartellai per caricare una nuova cartella con un nome perso-
nalizzato nel percorso selezionato

• Se è stato selezionato il Formato dati mysql o postgres. verrà mostrata una schermata come
questa:

Figura 2.3. Schermata di salvataggio quando è selezionao mysql o postgres.

Questa immagine mostra la schermata di salvataggio quando il Formato dati selezionato è mysql
o postgres.

Inserire in questa finestra le informazioni di Connessione al database: Host, Database, Nome
utente e Password.

Avvertimento

Salvare in formato mysql o postgres richiede i relativi permessi nel database; cioè oc-
corre avere i permessi per creare un nuovo database con il nome fornito, oppure si deve
avere il permesso di accesso in scrittura a un database esistente con il nome fornito.

4. Fare clic sul pulsante Salva per salvare il file.

Se si sta tenendo traccia delle finanze di una singola famiglia, sarà sufficiente un unico file. Se, invece,
si sta tenendo traccia anche della propria attività o se si desidera tenere dei dati separati per qualsiasi
ragione, allora sarà necessario creare più file.

Prima di terminare ogni sessione di GnuCash, assicurarsi di aver salvato le modifiche effettuate uti-

lizzando la voce del menu File → Salva o il pulsante Salva sulla barra degli strumenti.

Nota

Salvare frequentemente i propri dati finanziari è molto importante per evitare di perderli per
una qualsiasi ragione e per questo GnuCash è in grado di salvare automaticamente il file
aperto a intervalli regolari di tempo. L’ampiezza di questo intervallo può essere impostata
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nella scheda Generali raggiungibile tramite il menu Modifica → Preferenze (GnuCash →
Preferenze su Mac OS X). Questa opzione ha rilevanza esclusivamente se si salva nel formato
XML. Se si sta lavorando con un database, il pulsante Salva e la voce di menu Salva saranno
disabilitati dato che le modifiche vengono immediatamente applicate al database.

Aprire i dati

Per aprire un file o un database esistenti, selezionare File → Apri dal menu. Nella finestra che si aprirà,
selezionare il Formato dati. Se è stata selezionata l’opzione File, scegliere il file da aprire sfogliando
le cartelle nel riquadro inferiore. Diversamente, inserire le informazioni di Connessione al database
richieste.

Suggerimento

GnuCash conserva un elenco dei file aperti di ricente. Aprire il menu File per vedere l’elenco
dei file aperti recentemente. Fare clic sul nome del file che si vuole aprire per caricarlo in
GnuCash.

Duplicare una struttura dei conti
In some cases, it might be useful to duplicate the structure of an existing data file in a new file. For
example, you might want to try out new accounting techniques without corrupting your actual accoun-
ting data, or you might need to follow accounting guidelines that require you to close your books at
the end of the year and begin each year with a fresh set of books.

GnuCash allows you to create an empty copy of your Chart of Accounts simply by selecting File →
Export → Export Accounts. When you select this command, you are asked to provide the name for
the new empty file, and GnuCash creates a new data file that contains only your account hierarchy
(that is, there is no transaction data). Once saved, the new file can be opened like any other GnuCash
data file as described above.

Creare copie di sicurezza e recuperare i dati
GnuCash crea diversi tipi di file per assicurarsi che i dati non vadano persi. Controllando nella cartella
in cui è stato salvato il proprio file, saranno probabilmente presenti altri file generati automaticamente
da GnuCash con le seguenti estensioni: .gnucash, .log, .LCK, .LNK. La descrizione delle carat-
teristiche fornite da ogni formato è riportata di seguito.

Nota

Le seguenti sezioni hanno rilevanza solamente se si stanno salvando i propri dati finanziari
nel formato XML.

      $ ls
      myfile.gnucash
      myfile.gnucash.20100414185747.gnucash
      myfile.gnucash.20100414223248.log
      myfile.gnucash.20100415114340.gnucash
      myfile.gnucash.20100415154508.log
      myfile.gnucash.20100415173322.gnucash
      myfile.gnucash.20100415194251.log
      myfile.gnucash.7f0982.12093.LNK
      myfile.gnucash.LCK
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File di backup (.gnucash)
Ogni volta che si salva un file dei dati, viene creata anche una copia di sicurezza con estendione
.YYYYMMDDHHMMSS.gnucash. Questo file è una copia completa del file dei dati precedente e il
suo nome fa riferimento al nome del file dei dati, all’anno, al mese, al giorno e all’ora del backup.
Per esempio, il file di nome ilmiofile.gnucash.20100414185747.gnucash indica che si
tratta di una copia di sicurezza del file miofile salvata nell’anno 2010, il 14 Aprile alle 18:57:47.

Per recuperare un vecchio file di backup, basta aprire il file .YYYYMMDDHHMMSS.gnucash con la
data che si desidera ripristinare. Assicurarsi di salvare il file con un nome differente una volta aperto.

Nota

.YYYYMMDDHHMMSS.xac instead of the actual extension .YYYYMMDDHHMMSS.gnu-
cash. So if you upgrade from the 2.2 series to the 2.4 series, you may end up with both
.YYYYMMDDHHMMSS.xac and .YYYYMMDDHHMMSS.gnucash backup files in your di-
rectory.

File di log (.log)
Ogni volta che viene aperto un file in GnuCash, GnuCash crea un file di log che contiene le modifiche
effettuate sul file dei dati. Il file di log utilizza un nome simile a quello dei file di backup: .YYYYM-
MDDHHMMSS.log. I file di log non sono dei file di backup completi: registrano semplicemente i
cambiamenti fatti al file dei dati nella sessione corrente di GnuCash.

Nel caso GnuCash terminasse inaspettatamente, per esempio a causa di un blackout elettrico o di un
blocco del sistema, sarà possibile recuperare la maggior parte del lavoro svolto dall’ultima volta che
il file di GnuCash è stato salvato, utilizzando il file di log. Questa è la procedura da seguire:

1. Aprire l’ultimo salvataggio del file GnuCash.

2. Andare in File → Importa → Ripeti file .log di GnuCash e selezionare un file di estensione .log
con la stessa data del file salvato aperto precedentemente. Assicurarsi di aver selezionato il file di
log esatto per scongiurare il verificarsi di gravi problemi nella struttura e nei valori dei conti.

La ripetizione del file di log permette di recuperare ogni transazione che ha variato il saldo immesso
dall’ultimo salvataggio, incluse quelle create dalle transazioni pianificate e dalle funzioni per l’impresa
(fatture, ricevute, ecc...).

Avvertimento

Attenzione: le modifiche alle transazioni pianificate, alle fatture o alle ricevute NON verran-
no recuperate, e le loro transazioni che sono state recuperate potrebbero non essere corret-
tamente associate con esse; andrebbero quindi ricontrollate. In particolar modo per le tran-
sazioni di impresa, potrebbe essere necessario cancellarne alcune e ricrearne di altre. Senza
questa operazione, anche se il saldo sarà esatto, alcuni resoconti potrebbero non esserlo.

File di blocco (.LNK e .LCK)
Occasionalmente possono comparire dei file .LNK e .LCK. Questi non contengono alcun dato, ma
sono creati solamente per impedire che due o più utenti possano aprire lo stesso file contemporanea-
mente. Questi file sono creati automaticamente all’apertura di un file per bloccarlo in modo che nessun
altro possa accedervi. Quando si chiude GnuCash o si apre un altro file, GnuCash sblocca il primo file
dei dati cancellando i file .LNK e .LCK.

Se GnuCash si arresta improvvisamente quando è aperto un file di dati, i file .LCK e .LNK non
vengono cancellati. La prossima volta che che GnuCash verrà aperto, sarà presentato un avviso in cui
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si dice che il file è bloccato. Questo messaggio appare poiché i file .LNK e .LCK sono ancora nella
cartella. Si può premere tranquillamente il pulsante Sì per aprire il file, ma si dovrebbero cancellare i
file .LNK e .LCK (usando il terminale o il gestore dei file). Una volta cancellati questi file, non verrà
più presentato alcun avviso a meno che GnuCash non venga interrotto di nuovo in modo improvviso.

Gestire i file
Quali file è bene quindi conservare? quelli principali dei dati, naturalmente. È anche buona consuetu-
dine conservare i file di backup .YYYYMMDDHHMMSS.gnucash più recenti mentre si possono tran-
quillamente rimuovere i file .log dato che non rappresentano delle copie complete dei propri dati.

Nota

Se GnuCash è stato aggiornato da una versione precedente alla 2.4, potrebbero essere presenti
dei file di backup nel vecchio formato .xac. Per questi file è possibile applicare gli stes-
si principi descritti in precedenza per i file di backup del tipo .YYYYMMDDHHMMSS.gnu-
cash.

Anche i file .LCK e .LNK che rimangono nella cartella dopo la chiusura di GnuCash possono essere
rimossi. Se si decide di effettuare una copia di sicurezza manualmente su un altro disco, è sufficiente
copiare i file dei dati principali; non i file di backup del tipo .YYYYMMDDHHMMSS.gnucash

Nota

GnuCash cancella automaticamente qualsiasi file di backup .log e .YYYYMMDDHHM-
MSS.gnucash più vecchio di 30 giorni. Questo comportamento può essere modificato dalle

preferenze di GnuCash nella scheda Generali raggiungibile dal menu Modifica → Preferenze

(GnuCash → Preferenze su Mac OS X).

Migrare i dati di GnuCash
A volte si può avere la necessità di spostare i propri dati finanziari e le impostazioni di GnuCash su
un’altra macchina; casi tipici di questa situazione si verificano quando si acquista un nuovo computer
o quando si vogliono utilizzare le stesse impostazioni su due sistemi operativi diversi in dual boot.

Migrare i dati finanziari
La migrazione dei dati di GnuCash si esaurisce con la semplice copia dei file con estensione .gnu-
cash utilizzando un gestore di file se si conosce la posizione in cui i file risiedono. Se questa non è
nota, ma il file viene aperto in GnuCash, è sufficiente salvare questo file in un percorso conosciuto.

I restanti file nella cartella consistono in file per copie di sicurezza (file di backup) o registrazione di
eventi (file di log). Fondamentalmente non fa alcuna differenza copiare o non copiare anche questi.

Migrare le preferenze
Preferences are stored in three different locations: one for GnuCash preferences, one for reports, and
one for online banking settings. Preferences are managed by gsettings, reports are managed by Gnu-
Cash itself, and online banking is managed by aqbanking. If you do not use online banking, then you
will not have this folder on your machine.

Where the GnuCash preferences are stored varies depending on your operating system (see Tabella 2.1,
«Posizione delle impostazioni dell’applicazione», Tabella 2.2, «Posizione dei resoconti salvati», and
Tabella 2.3, «Posizione delle impostazioni per l’Online Banking»). To back up and transfer your entire
installation, you must copy these preferences as well.
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Tabella 2.1. Posizione delle impostazioni dell’applicazione

Sistema operativo cartella

Unix GnuCash preferences are stored in dconf. You
can use the commands dconf dump /org/
gnucash/ on the old machine and dconf
load /org/gnucash/ on the new machine
to migrate your preferences.

Mac OSX ~/Library/Preferences/gnu-
cash.plist

Finestre The preferences are stored in the Windows
registryHKEY_CURRENT_USER/soft-
ware/GSettings

Tabella 2.2. Posizione dei resoconti salvati

Sistema operativo cartella

Unix ~/.gnucash

Mac OSX ~/Library/Application Sup-
port/gnucash

Finestre Documents and Settings/Nomeu-
tente/.gnucash or Users/Userna-
me/.gnucash

Tabella 2.3. Posizione delle impostazioni per l’Online Banking

Sistema operativo cartella

Unix ~/.aqbanking

Mac OSX ~/.aqbanking

Finestre Documents and Settings/Nomeuten-
te/.aqbanking

Nota

Nei sistemi Unix e Mac OSX, queste cartelle non sono generalmente visualizzate nel gestore
dei file. Per poterle vedere il gestore dei file deve essere impostato in modo da visualizzare
i file e le cartelle nascoste.

Suggerimento

Nei sistemi Unix e Mac OSX, il simbolo ~ rappresenta un’abbreviazione della cartella home

In pratica
Nota

In questa sezione si inizia un esempio che procederà attraverso tutto questo documento. Alla
fine di ogni capitolo, è presente una sezione denominata in pratica che riporta degli esempi
che illustrano i concetti discussi in questa sezione. Ogni sezione in pratica è basata sulla
precedente, per questo è importante assicurarsi di aver salvato il file per potervi accedere
facilmente e continuare il lavoro.

Si parte!
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1. Prima di tutto si deve creare un file per conservare i propri dati finanziari. Aprire GnuCash e sel-

zionare File → Nuove file dalla barra del menu. Verrà avviato l’assistente per l’Impostazione di
una nuova struttura dei conti che permette di creare più conti in una sola volta.

Nota

Se si sta eseguendo GnuCash per la prima volta, verrà visualizzata la finestra denominata
Impossibile trovare i valori predefiniti descritta nel dettaglio nel manuale di GnuCash.

Questa immagine mostra la prima schermata dell’assistente per l’Impostazione di una nuova strut-
tura dei conti.

La prima schermata dell’assistente fornisce una descrizione dell’assistente stesso. Premere il pul-
sante Avanti per procedere alla schermata successiva.

2. Nella seconda schermata, selezionare dalla lista a comparsa la valuta da utilizzare per i nuovi conti.
Premere poi il pulsante Avanti.

Nota

La valuta selezionata in questa fase, verrà assegnata a tutti i conti creati con questo assi-
stente.
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Questa immagine mostra la seconda schermata dell’assistente per l’Impostazione di una nuova
struttura dei conti dove è possibile selezionare la valuta.

3. In the third screen, set the New Book Options, then press the Forward button. You can also update

these options later using File  → Properties. For details of these options, see the GnuCash Help
manual, chapter Customizing GnuCash, Book Options.

This image shows the third screen of the New Account Hierarchy Setup assistant where you select
the book options.

4. In the fourth screen select the Common Accounts group in the Categories pane. Then press the
Forward button to proceed.

Nota

Selezionare uno o più gruppi predefiniti di conti. Per avere maggiori informazioni sui tipi
di conti, consultare la sezione chiamata «Conti di GnuCash».
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This image shows the fourth screen of the New Account Hierarchy Setup assistant where you
choose the various accounts.

5. In the fifth screen you will be able to set an Opening Balance on each of the accounts, as well as
indicate if the account should be a Placeholder. As these features will be described in next chapters,
leave all as configured by GnuCash and click Forward to open the last screen of the assistant.

This image shows the fifth screen of the New Account Hierarchy Setup assistant where you can
set Opening Balance.

6. Nell’ultima schermata dell’assistente, premere Applica per creare tutti i conti e uscire dall’assi-
stente.
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Questa immagine mostra l’ultima schermata dell’assistente per l’Impostazione di una nuova strut-
tura dei conti.

7. Dopo aver premuto il pulsante Applica nella finestra precedente, verrà visualizzata la finestra di
salvataggio. Selezionare il Formato dati XML, inserire il Nome gcashdata_1 per il file, sele-
zionare la cartella dove salvarlo (è importante ricordarla perché questo file dei dati verrà utilizzato
negli altri esempi all’interno di questa guida) e infine premere il pulsante Salva come.

La finestra principale dovrebbe ora assomigliare a questa:
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Capitolo 3. Conti
Questo capitolo analizza alcuni concetti fondamentali riguardanti l’organizzazione dei conti; dato che
GnuCash non impone alcun tipo di struttura dei conti, si è liberi di creare la struttura che si desidera.
Esistono comunque dei concetti fondamentali che sarebbe bene seguire per ottimizzarne la fruibilità.

Concetti basilari di contabilità
As we saw in the previous chapter, accounting is based on 5 basic account types: Assets, Liabilities,
Equity, Income and Expenses. We will now expand on our understanding of these account types, and
show how they are represented in GnuCash. But first, let’s divide them into 2 groups, the balance
sheet accounts and the income and expense accounts. As the name says the balance sheet accounts can
be summarized in the balance of what you own and owe at a point in the time, while the income and
expense accounts can be summarized in the Profit & Loss report, which shows the change of values
in a period of time like the economic year

Prima di procedere con l’approfondimento, si ricorda l’equazione della contabilità introdotta al capi-
tolo precedente (attività - passività = capitale + (entrate - uscite)):

Visualizzazione grafica della relazione che intercorre tra i 5 tipi fondamentali di conti. Il capitale netto
si accresce grazie alle entrate e diminuisce a causa delle uscite. Le freccie rappresentano la direzione
del valore.

Conti di bilancio
The three so-called Balance Sheet Accounts are Assets, Liabilities, and Equity. Balance Sheet Ac-
counts are used to track the things you own or owe.

Attività è l’insieme dei beni che si posseggono. Le attività possono includere l’auto, i contanti, la casa,
le azioni o qualsiasi altro bene che ha un valore commerciale.

Passività è l’insieme dei debiti. Questo conto può comprendere le rate dell’auto o della scuola, un
mutuo, il margine di investimento e comunque qualsiasi altro bene o servizio che prima o poi si deve
ripagare.

Capitale ha lo stesso significato del valore netto. Rappresenta ciò che rimane sottraendo al valore delle
attività l’ammontare delle passività. Si può anche pensare come la porzione del patrimonio sul quale
non grava alcun debito e che quindi realmente si possiede.

Conti per entrate e uscite
I conti entrate e uscite vengono utilizzati per aumentare o diminuire il valore del capitale. Mentre
i conti di bilancio rappresentano semplicemente il valore di ciò che si possiede e dei propri debiti,
entrate e uscite permettono di variare il valore di quei conti.

Entrate rappresentano il compenso che si riceve per il proprio tempo, per i servizi che si forniscono,
o per l’utilizzo del proprio denaro. Quando si riceve lo stipendio, per esempio, viene pagato il lavoro
fornito al proprio datore di lavoro. Altri esempi di entrate possono essere le mance, i dividendi pro-
venienti da azioni e gli interessi sul denaro depositato in banca. Le entrate contribuiscono sempre ad
aumentare il valore delle attività e di conseguenza quello del capitale.

Expense refers to money you spend to purchase goods or services provided by someone else for early
consumption. Examples of expenses are a meal at a restaurant, rent, groceries, gas for your car, or
tickets to see a play. Expenses will always decrease your Equity. If you pay for the expense immedia-
tely, you will decrease your Assets, whereas if you pay for the expense on credit you increase your
Liabilities.
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Conti di GnuCash
Questa sezione ha l’intento di mostrare come le definizioni di conti che GnuCash propone, rientrino
nei 5 tipi fondamentali.

But first, let’s begin with a definition of an account in GnuCash. A GnuCash account is an entity
which contains other sub-accounts, or that contains transactions. Since an account can contain other
accounts, you often see account trees in GnuCash, in which logically associated accounts are grouped
together within a common parent account.

Un conto in GnuCash deve avere un nome unico (che è possibile assegnare) e una tipologie a scelta
fra quelle che il programma prevede. Sono presenti, in totale, 12 tipi di conti in GnuCash basati sui 5
tipi fondamentali descritti in precedenza. La ragione per cui esistono in

Questi conti di GnuCash sono descritti in dettaglio nel seguito.

Conti di bilancio
Il primo conto a essere esaminato è quello dello attività che, come ricordato nelle sezioni precedenti
si riferisce a ciò che si possiede.

Per aiutare l’utente a organizzare il proprio patrimonio e per semplificare l’inserimento delle transa-
zioni, GnuCash supporta diversi tipi di conti per le attività:

1. liquidi: usare questo conto per registrare il denaro contante che si ha, per esempio, nel portafoglio,
nel salvadanaio, sotto al materasso o dovunque si decida di tenerlo. Questo denaro è quello che
viene utilizzato più facilmente;

2. banca: questo conto serve a tenere traccia del denaro depositato presso delle istituzioni quali le
banche, le unioni di credito, le società di risparmio o di mediazione: dovunque qualcun altro si
occupa del denaro. Questo conto è secondo solamente ai liquidi come facilità di utilizzo del denaro
perché può essere facilmente convertito in contanti;

3. azioni: registrare le azioni e le obbligazioni utilizzando questo tipo di conto. Il registro per le azioni
fornisce delle colonne aggiuntive per immettere le quote e il prezzo degli investimenti. Questo tipo
di beni non si presta a essere facilmente convertito in liquidi dato che prima è necessario trovare
un acquirente e inoltre non viene garantito il riottenimento per intero del capitale investito;

4. fondi comuni: questo tipo di conto è simile al precedente, tranne per il fatto che deve essere uti-
lizzato per registrare i fondi. Il registro di immissione dati prevede due colonne per l’inserimento
delle quote e dei prezzi. I fondi rappresentano delle proprietà comuni di investimenti e, come le
azioni, non garantiscono un valore minimo del capitale;

GnuCash treats account types Stock and Mutual Fund the same.

5. crediti correnti: questo conto è dedicato tipicamente alla gestione dell’impresa e in esso vengono
registrati i crediti. È considerato come un capitale dato che si dovrebbe poter contare sull’arrivo
di questo denaro.

Transactions involving an Accounts Receivable account should not be added, changed or deleted
in any way other than by using

• post/unpost bill/invoice/voucher or

• process payment

6. Asset No matter how diverse they are, GnuCash handles many other situations easily. The account
type «Asset», covers all assets not listed above.

GnuCash treats account types Cash, Bank and Asset the same.
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I conti sono contenitori di informazioni utilizzati per tracciare e registrare tutte le azioni correlate
al motivo per cui il conto è stato creato.

Per le imprese, le attività da tracciare e di cui effettuare i resoconti, sono spesso suddivise con
maggiore dettaglio rispetto a quanto considerato finora. Per una discussione più approfondita delle
possibilità, riferirsi alle nozioni descritte nella Capitolo 15, Altre attività di questa guida.

For personal finances a person can follow the business groupings or not, as they seem useful to the
activities the person is tracking and to the kind of reporting that person needs to have to manage
their financial assets. For additional information, consult Capitolo 15, Altre attività of this Guide.

Il secondo tipo di conto di bilancio è quello delle passività che, come si ricorderà, si riferisce a ciò che
si deve, al denaro che si è preso in prestito e si è obbligati a restituire prima o poi dato che colui che ha
prestato il denaro ha il diritto di essere ripagato. Tenere traccia del bilancio delle passività permette di
conoscere in qualsiasi momento quale sia l’ammontare del proprio debito.

GnuCash permette di scegliere fra tre conti per le passività:

1. carta di credito: utilizzare questo conto per registrare le ricevute e per riconciliare l’estratto conto
della carta di credito. Le carte di credito rappresentano un prestito di breve durata che si è obbligati a
pagare alla compagnia a cui appartiene la carta di credito. Questo conto può anche essere utilizzato
per altri prestiti a breve durata;

2. debiti correnti: questo è un conto utilizzato tipicamente per la gestione dell’impresa dove vengono
registrati i debiti che devono ancora esser saldati;

Transactions involving an Accounts Payable account should not be added, changed or deleted in
any way other than by using

• post/unpost bill/invoice/voucher or

• process payment

3. passività: utilizzare questo conto per tutti gli altri prestiti, generalmente di entità maggiore e di
durata superiore come un mutuo o le rate dell’auto. Questo conto aiuta anche a conoscere quanto
denaro si deve ancora e quanto è stato già restituito.

GnuCash treats account types Credit Card and Liability the same.

Suggerimento

Le passività in contabilità agiscono in modo opposto alle attività (o patrimonio netto): gli
accrediti (avere) (valori immessi nella colonna di destra) aumentano il saldo del conto mentre
gli addebiti (dare) (valori immessi nella colonna di sinistra) lo diminuiscono (consultare la
nota più avanti in questo capitolo).

Il conto finale del bilancio patrimoniale è quello del capitale, che è sinonimo di valore netto o capitale
netto. Rappresenta ciò che rimane dopo aver sottratto le passività dalle attività, ed è quindi la porzione
di patrimonio che si possiede e sulla quale non grava alcun debito. In GnuCash si consiglia di utilizzare
questa tipologia di conto come fonte per i bilanci di apertura dei conti bancari, dato che questo saldo
rappresenta il valore netto iniziale.

There is usually only a single GnuCash equity account, called naturally enough, Equity. For compa-
nies, cooperatives etc. you can create a subaccount for each partner.

Suggerimento

Nel capitale netto, gli accrediti aumentano il saldo del conto e i debiti lo diminuiscono (con-
sultare la nota più avanti in questo capitolo).
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Nota

L’equazione della contabilità che lega i conti di bilancio è attività = passività + capitale o
anche attività - passività = capitale. Di conseguenza, semplicemente parlando, ciò che si
possiede meno ciò che si deve è uguale al valore netto.

Conti per entrate e uscite

Entrate: è il denaro che si riceve per l’impiego del proprio tempo, per i servizi che si forniscono o per
l’uso del proprio denaro. In GnuCash un conto di tipo entrate è utilizzato per registrare questi guadagni.

Suggerimento

Gli accrediti aumentano il saldo del conto entrate mentre i debiti lo diminuiscono. Come
descritto nella la sezione chiamata «Concetti di contabilità», gli accrediti rappresentano un
trasferimento di denaro da un conto; così in questi conti speciali per le entrate, quando si
trasferisce denaro dal conto entrate a un altro conto (accredito o avere), il saldo del conto
entrate aumenta. Per esempio, quando si deposita un assegno e si registra la transazione come
un trasferimento di denaro dal conto entrate al conto bancario, il saldo di entrambi aumenta.

Uscite: si riferisce al denaro che viene utilizzato per acquistare beni o servizi forniti da terzi. In Gnu-
Cash si utilizza un conto uscite per registrare le proprie uscite.

Suggerimento

Gli addebiti aumentano il valore delle passività mentre gli accrediti lo diminuiscono. (con-
sulta la nota più avanti in questo capitolo).

Nota

Quando si sottraggono alle entrate totali le uscite totali in un certo periodo di tempo, si otten-
gono le entrate nette. Questa grandezza viene indicata nello stato patrimoniale con la dicitura
utili non distribuiti, che è un tipo di conto del capitale.

Qui sotto vengono mostrati i conti standard per le entrate e per le uscite così come vengono creati
scegliendo l’opzione conti comuni nell’assistente per l’impostazione di una nuova struttura dei conti

(Operazioni → Nuova struttura conti...).
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Questa immagine mostra i conti predefiniti delle Entrate

Questa immagine mostra alcuni conti predefiniti per le Uscite

Other Account Types
There are some special other account types.

Trading Multiple currency transactions have splits in «Trading» accounts to make the transaction ba-
lance in each currency as well as in total value. See Capitolo 12, Valute multiple for more information.

Money Market and Credit Line are used only in the OFX importer, apparently for completeness with
the specification.
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In pratica
Si procederà ora a descrivere il processo di creazione di una struttura dei conti per la gestione delle
finanze personali utilizzando le informazioni apprese in questo capitolo. Una struttura dei conti è
semplicemente un nuovo file di GnuCash in cui i propri conti vengono raggruppati per tenere traccia
delle proprie finanze. Per realizzare la struttura, il primo passo consiste nel dividere le voci che si
vogliono controllare nei 5 conti base della contabilità.

Esempio semplice

Si assuma di avere acceso presso la banca un conto corrente e un conto di risparmio, e di essere assunti
in un’azienda ricevendo quindi uno stipendio. Si ipotizzi inoltre di possedere una carta di credito
(Visa) e di pagare, con cadenza mensile, dei servizi quali affitto, telefono ed elettricità. È inoltre
indispensabile fare acquisti almeno di alimentari. Per ora non è necessario sapere quanto denaro si
ha in banca, quanto si deve pagare per la carta di credito ecc... Si vuole, per ora, solo realizzare la
struttura che contiene tutti questi conti.

Le attività saranno costituite dal conto corrente e dai risparmi in banca. Le passività saranno invece
imputabili alla carta di credito. Il capitale sarà invece la somma tra i conti bancari e la carta di credito
(non si hanno ancora a disposizione gli importi per essi, ma si sa che esistono). Si ha anche una entrata
sotto forma di stipendio, e delle uscite identificabili come spese varie in negozi, affitto, elettricità,
telefono e tasse (statali, assistenza sanitaria ecc...) che gravano sullo stipendio.

I conti base di livello principale

Occorre ora decidere come raggruppare i conti. Probabilmente si vorranno raggruppare i conti delle
attività in uno unico, così come anche quelli delle passività, del capitale, delle entrate e delle uscite.
Questo rappresenta il metodo più ovvio per creare una struttura dei conti in GnuCash e si raccomanda
di ragionare comunque sempre in questi termini.

Si parta da un un nuovo file vuoto di GnuCash selezionando File → Nuovo file dal menu. Verrà avviato
l’assistente per l’Impostazione di una nuova struttura dei conti. Premere il pulsante Annulla dato che
non si intende utilizzare una delle strutture predefinite; verr selezionare VisualizzaNuova pagina dei
conti dal menu: verrConti. Selezionare quindi OperazioniNuovo conto... dal menu.

Si è ora pronti per costruire questa semplice struttura dei conti

1. Nome conto Attività (tipo di conto Attività, conto padre nuovo conto di livello principale)
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Questa immagine mostra la finestra di creazione di un conto delle attività

2. Nome conto Passività (tipo di conto Passività, conto padre nuovo conto di livello principale)

3. Nome conto Capitali (tipo di conto Capitali, conto padre nuovo conto di livello principale)

4. Nome conto Entrate (tipo di conto Entrata, conto padre nuovo conto di livello principale)

5. Nome conto Uscite (tipo di conto Uscita, conto padre nuovo conto di livello principale)

Quando tutti i conti di livello principale sono stati creati, la pagina principale dei conti in GnuCash
dovrebbe essere simile a questa:
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Questa immagine mostra i conti base di livello principale.

Creare i sottoconti
A questo punto si può creare la struttura ad albero dei conti partendo dai conti di livello principale e
aggiungendo dei sottoconti in grado di contenere delle transazioni. Si noti come i conti per le tasse
siano tutti inseriti in un sottoconto denominato Tasse. I conti e i sottoconti possono infatti a loro volta
contenere altri sottoconti: questo è utile quando si considera un gruppo di conti appartenenti a una
stessa categoria (come i conti per le tasse in questo esempio).

Suggerimento

In vece di selezionare Operazioni → Nuovo conto... dal menu, è anche possibile creare un
nuovo sottoconto di un conto facendo un clic con il tasto destro del mouse sul nome del
conto principale e selezionando la voce Nuovo conto... nel menu che comparirà. Verrà così
aperta una finestra simile a quella rappresentata in la sezione chiamata «I conti base di livello
principale» e in cui il nuovo conto sarà già impostato come sottoconto del conto principale.

1. Account name Cash (account type Cash, parent account Assets)

2. Nome conto Conto corrente (tipo di conto Banca, conto padre Attività)

3. Nome conto Conto risparmio (tipo di conto Banca, conto padre Attività)

4. Nome conto Visa (tipo di conto Carta di credito, conto padre Passività)

5. Nome conto Stipendio (tipo di conto Entrata, conto padre Entrate)

6. Nome conto Telefono (tipo di conto Uscita, conto padre Uscite)

7. Nome conto Elettricità (tipo di conto Uscita, conto padre Uscite)

8. Nome conto Affitto (tipo di conto Uscita, conto padre Uscite)

9. Nome conto Alimentari (tipo di conto Uscita, conto padre Uscite)

10.Nome conto Imposte (tipo di conto Uscita, conto padre Uscite)

11.Nome conto Statali (tipo di conto Uscita, conto padre Uscite:Imposte)

12.Nome conto Previdenza sociale (tipo di conto Uscita, conto padre Uscite:Imposte)

13.Nome conto Assistenza sanitaria (tipo di conto Uscita, conto padre Uscite:Imposte)
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14.Nome conto Bilancio di apertura (tipo di conto Capitale, conto padre Capitali)

Dopo la creazione dei sottoconti aggiuntivi, il risultato finale dovrebbe assomigliare a quello riportato
di seguito:

Questa immagine mostra una semplice struttura dei conti.

Salvare ora la struttura dei conti creata con il nome gcashdata_3, e anche come gcashda-
ta_3emptyAccts, dato che si continuerà a utilizzare questi file nei capitoli successivi.

È stata appena creata una struttura di conti per tenere traccia delle spese familiari. Con questa ossatura
in posizione, si può procedere a popolare i conti con delle transazioni; il prossimo capitolo si occuperà
approfonditamente di questo argomento.
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Capitolo 4. Transazioni
Questo capitolo fornisce le conoscenze necessarie per poter utilizzare le transazioni in GnuCash. Men-
tre i conti rappresentano l’ossatura e la struttura di un diagramma dei conti, le transazioni costituiscono
i dati che completano ogni conto.

Concetti base
A transaction in a double entry accounting system such as GnuCash is an exchange between at least 2
accounts. Thus, a single transaction must always consist of at least two parts, a from and a to account.
The from account is transferring value to the to account. Accountants call these parts of a transaction
Ledger Entries. In GnuCash, they are called Splits.

A split identifies the account to which it refers, the amount of money specifically moved to or from
that account, and can contain a few other specific pieces of information if needed. GnuCash supports
multiple splits in a single transaction, and the splits can move money into or out of the involved
accounts arbitrarily.

Per esempio, si consideri lo stipendio che si riceve e che viene depositato nel proprio conto di risparmio
in banca. La transazione avviene poiché il conto di risparmio (appartenete alle attività) riceve il denaro
dal conto delle entrate. Due conti sono interessati dall’operazione e, in questo caso, si verifica anche
un aumento del capitale.

Le operazioni con le transazioni in GnuCash avvengono in quello che viene denominato registro con-
tabile; a ogni nuovo conto che viene creato è automaticamente associato un registro contabile. Il re-
gistro apparirà familiare dato che è molto simile al registro per tenere traccia degli assegni.

The account register is explained in the upcoming section, la sezione chiamata «Il registro contabile».

Il registro contabile
The account register is the GnuCash window, which allows you to view or edit preexisting transac-
tions, or add new transactions for a particular account. To open an account register from the Account
Tree, double-click the account name, right click the account name and select Open Account from the
menu, or use the Open button on the toolbar. GnuCash will display the account register window.

Caratteristiche del registro del conto
The Titlebar of the account register displays the account name. Below the Titlebar, the Menubar
displays the menu items available within the account register, and the Toolbar contains handy buttons
that help you work with the account register.

In basso a sinistra nella finestra del registro, GnuCash visualizza degli utili messaggi mentre ci si
muove nel registro. A destra, invece, è possibile leggere il saldo attuale del conto e il totale delle
suddivisioni liquidate.

Scegliere uno stile per il registro
GnuCash offers several options for viewing your registers. The default style is Basic Ledger mode,
which displays only the summary of splits affecting the current account. This is the style that most
closely resembles other popular personal financial packages. You can choose a different register style
from the View menu. There are two other view modes:

• View → Auto-Split Ledger style expands the current transaction automatically. As you highlight a
new transaction in the register, the transaction automatically expands to show all splits.
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• View → Transaction Journal style shows all splits for all transactions in the register, which is more
like an accounting journal.

All styles permit you to view your data in either single-line or double-line format. Select View →
Double Line, and you will see your transaction line expand to two register lines. Double-line mode
will also display the transaction-level Notes field.

Below are screenshots that demonstrate how the Basic Ledger and Transaction Journal views differ.

For this example, let’s assume that you have purchased 3 pair of Jeans for $1,000, and have recorded
the purchase as a split transaction with each pair entered on a separate split.

The below screenshots illustrate the different view modes.

First let’s view the Jeans transaction from your checking account:

Questa immagine mostra la transazione suddivisa per l’acquisto di 3 Jeans

Now, let's open the Expenses:Clothes account, and look at it in Basic view.

Questa immagine mostra il conto Uscite:Abbigliamento nella modalità a libro mastro basilare.

Three entries appear here, but there was only the single split entry in the checking account. Further
examination shows that each row has a different amount, $200, $300, and $500. This demonstrates
that each row in this view reflects a single split from the original transaction.

Changing to Transaction Journal mode will display only the original split transaction.
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Questa immagine mostra il conto Uscite:Abbigliamento nella modalità giornale della transazione.

Utilizzare le scorciatoie per l’immissione dei dati
GnuCash provides several time-saving shortcuts for entering your data. When you type the first few
characters of a description that you have used before, the QuickFill feature automatically fills in the
rest of the transaction as you last entered it. When you type in the first characters of an account name
in either the Transfer field of the transaction line or the Account field of the split line, QuickFill will
automatically complete the name from your account list. It also helps you with entering sub-accounts
in these fields: simply type the first characters of the parent account name followed by a : (colon) and
the first characters of the sub-account name. For example, to enter Assets:Checking, you might type
A:C and let GnuCash fill in the rest.

Avvertimento

Because : is the account separator symbol, you can not use it in your account names.

Suggerimento

If you really need the colon in your account names, you can select another symbol by Edit

→ Preferences → Accounts+Character.

Anche le scorciatoie da tastiera per il registro permettono di risparmiare tempo e GnuCash ne fornisce
diverse. Nel campo della data si può premere:

• + o = per aumentare la data e - o _ per diminuire la data

• ] o } per aumentare il mese e [ o { per diminuire il mese

• M o m per inserire la prima data del mese

• H o h per inserire l’ultima data del mese

• Y o y per inserire la prima data dell’anno

• R o r per inserire l’ultima data dell’anno

• T o t per inserire la data odierna

Suggerimento

These date shortcuts not only work in the account register but everywhere you can enter a
date.
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Suggerimento

Specifically for dates there's another way you can save time: you can enter partial dates. For
example if you only enter one number, GnuCash will interpret it as the day in the current
month of the current year. If you only enter a day and month, GnuCash will automatically
append the year. By default this is the current year. You can however also configure GnuCash
to take such a date in a sliding window starting a number of months before the current month.

This can be done via Edit → Preferences → Date/Time+Date Completion.

Nel campo Nr. nella linea di una transazione, è possibile premere + per incrementare il numero della
transazione, mentre premendo - verrà diminuito il numero. Questo funzionerà anche nel campo Ope-
razione nella linea della suddivisione, se si sceglie di immettere i numeri della suddivisione qui. Il
campo Operazione supporta anche Quickfill: se si digitano i primi caratteri di una operazione comune
(come Deposito), GnuCash completerà il resto.

Il campo Trasferimento supporta il Quickfill dei nomi dei conti. Iniziando a digitare il nome di un
conto, GnuCash completerà la parte restante del nome con quello di un conto esistente. Digitando
il carattere separatore in qualsiasi momento, verrà completato il livello corrente del nome del conto,
lasciando il cursore posizionato all’inizio del successivo livello di nomi di conti. Digitando, per esem-
pio, A:C con il gruppo standard di conti, verrà selezionato il conto Attività:Conto corrente. Si possono
anche selezionare i tasti Menu o Ctrl+Giù in questo campo per visualizzare la lista a comparsa dei
nomi dei conti.

In ognuno dei campi per l’importo, si può usare una calcolatrice incorporata. Digitare semplicemente
il primo valore, seguito da un +, -, * o /, poi inserire il secondo valore. GnuCash eseguirà i calcoli e
restituirà il valore risultante nel campo dell’importo alla pressione del tasto Tab.

Per tutte le voci del menu sono definite delle chiavi di accesso che sono indicate da caratteri sottoli-
neati nei nome del menu. Premere Alt + [carattere sottolineato] per aprire il menu desiderato e sele-
zionare poi una voce digitando il carattere sottolineato corrispondente. Per esempio, premere Alt+T
per far comparire il menu Operazioni, poi premere S per suddividere la transazione. Alcune delle voci
del menu hanno anch’esse delle scorciatoie che immediatamente invocano il comando (normalmente
utilizzando il tasto Ctrl). Queste scorciatoie sono riportate a fianco della voce.

Per muoversi nel registro, utilizzare questi tasti per risparmiare tempo:

• Tab per spostarsi al prossimo campo, Maiusc+Tab per spostarsi nel campo precedente

• Home per spostarsi all’inizio del campo, Fine per spostarsi alla fine del campo

• Invio o ↓ per spostarsi alla transazione successiva, ↑ per spostarsi alla transazione precedente

• Pag Sù per muoversi verso l’alto di una schermata, Pg giù per muoversi verso il basso di una
schermata

• Maiusc+Pag Sù per raggiungere la prima transazione, Maiusc+Pag Giù per raggiungere l’ultima
transazione

Nella finestra Riconcilia possono essere usate le seguenti scorciatoie da tastiera:

• Tab sposta al riquadro successivo e Maiusc+Tab sposta al riquadro precedente

• La barra spaziatrice alterna lo stato tra riconciliata e non riconciliata

• ↑ e ↓ permettono di spostarsi tra gli elementi nel riquadro selezionato

Simple vs. Split Transactions
Every transaction in GnuCash has at least two splits, but a transaction can have more than two splits. A
transaction with only two splits is called a simple transaction, since it only involves the current account
and a single remote account. A transaction with three or more accounts is called a split transaction.
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When the register is in Basic view, you will see a summary of the splits affecting the current account.
For a simple transaction, the Transfer column will display the other account from which money is
transferred. For a split transaction, the Transfer column will display -- Split Transaction --. You can
see the individual splits of each transaction by clicking the Split button in the Toolbar while selecting
the appropriate transaction.

Per le transazioni suddivise, la prima linea rappresenta la linea della transazione; essa contiene una
Data, un Nr. opzionale (ad esempio il numero dell’assegno), la Descrizione della transazione, l’im-
porto totale che interessa il conto selezionato (Deposito Tot in questo caso) e il Saldo aggiornato do-
po la transazione corrente. Si noti che nella vista espansa, l’intestazione della colonna Trasferimento
scompare, e non viene visualizzato nessun nome di conto in questo campo. Questa riga mostra sola-
mente un sommario degli effetti della transazione sul conto selezionato. Per avere informazioni più
dettagliate, occorre visualizzare le suddivisioni che compongono la transazione.

Nota

Note: An account register displays a transaction when that transaction has a split assigned
to the account. If a given transaction has more than one split assigned to a single account,
then in Basic and Auto-Split view modes that transaction will appear in the register one time
for each split assigned to that account. In Transaction Journal mode, such a transaction will
only appear once in the register.

Le righe parziali sotto a quella della transazione, sono le righe delle suddivisioni e sono separate da
linee grigie. Quando si seleziona una delle linee di suddivisione, l’intestazione della colonna cambia,
visualizzando le voci relative ai campi della suddivisione:

Questa immagine mostra come le intestazioni cambino per una suddivisione.

Ogni suddivisione contiene un campo Operazione opzionale o del tipo di suddivisione, che può essere
immesso digitandolo oppure scegliendolo da una lista a comparsa. La suddivisione presenta anche un
campo per il Promemoria per descrivere la suddivisione stessa. Ogni suddivisione coinvolge un Conto,
che può essere selezionato da una lista a comparsa che comprende tutti i propri conti. Il campo R indica
se la suddivisione è stata riconciliata. Le ultime due colonne riportano l’importo della suddivisione e
se il denaro è in entrata o in uscita dal conto.

Come discusso nella la sezione chiamata «Concetti di contabilità», gli addebiti totali (o dare, inseriti
nella colonna di sinistra) devono eguagliare gli accrediti totali (o avere, inseriti nella colonna di destra)
per ogni transazione. Nell’esempio mostrato sopra, gli addebiti totali sono pari agli accrediti totali
e la transazione è quindi bilanciata. Si noti che la riga della transazione contiene lo stesso importo
in addebito presente nella riga della suddivisione Conto corrente. Perché viene mostrata due volte?
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perché la riga della transazione è semplicemente un sommario degli effetti della transazione sul conto a
cui appartiene. La stessa transazione in un conto diverso, avrebbe una linea della transazione differente
che mostra gli effetti su quel particolare conto. Questo si può vedere selezionando un’altra riga di
suddivisione e premendo il pulsante Salta sulla barra degli strumenti.

In questo esempio, se si salta al conto Entrate:Stipendio, GnuCash mostra la stessa transazione nel
registro del conto Entrate:Stipendio:

Questa immagine mostra un salto al conto Entrate:Stipendio.

Si noti che il totale nella riga della transazione, somma gli effetti sul conto Entrate:Stipendio invece
che sul Conto corrente, perché si sta guardando il registro del conto Entrate:Stipendio. Le suddivisioni
sono esattamente le stesse, ma la riga della transazione rispecchia ora l’accredito al conto Entrate:S-
tipendio.

Simple Transaction Example

Starting with the chart of accounts we created in the previous chapter gcashdata_3, double click
on the Checking asset account. Let’s add a simple transaction to the checking account. When you first
create your accounts in GnuCash, it is common to start them off with an initial balance.

Nella prima riga delle transazioni, inserire una data (es: 1 Marzo 2006), una descrizione (es: «Bilancio
di apertura»), selezionare il menu a tendina del trasferimento e selezionare Capitali:Bilanci d’aper-
tura, aggiungere un deposito del valore di €1.000, e premere Invio. Il registro contabile dovrebbe
apparire simile a quello in figura:
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Questa immagine mostra il registro del conto Attività:Conto corrente dopo aver inserito una transa-
zione per il valore iniziale.

Impostare il bilancio di apertura di un conto è un esempio di una semplice transazione che coinvolge
due conti: in questo caso i conti Attività:Conto corrente e Capitali:Bilanci d’apertura.

Per fare un altro esempio di semplice transazione a due conti, se ne aggiunga un’altra per registrare
l’acquisto di 45.21€ di alimentari. Dal conto Attività:Conto corrente, devono essere trasferiti a Usci-
te:Alimentari. Ora il registro contabile dovrebbe apparire così:

Questa immagine mostra il registro del conto Attività:Conto corrente dopo aver inserito una transa-
zione per l’acquisto di alimentari.

Split Transaction Example
Il bisogno di una transazione che coinvolge 3 o più conti sorge quando è necessario suddividere o il
conto «da» o il conto «a» in una transazione in più conti. L’esempio classico di questa situazione si
verifica quando si riceve lo stipendio. Il compenso che si riceve è sicuramente inferiore allo stipendio
lordo a causa delle imposte, del fondo pensione e altre voci. Perciò la singola transazione relativa alla
ricezione dello stipendio coinvolge altri conti oltre a quelli di Attività:Conto corrente e Entrate:Sti-
pendio.
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To add the paycheck split transaction from the Assets:Checking account register window, click on
a new transaction line and click Split. Note that if you have set your register view to Auto-Split or
Transaction Journal, the splits will be opened for you. Enter the description of this transaction on the
first line(e.g. “Employers R Us”). In the split lines below this, enter the various splits that make up this
transaction, one by one. To enter the splits, first choose the account, then enter the amount by which
to change the account. Keep in mind that when in an asset account register, amounts entered in the left
column increase the account balance, while amounts entered in the right column decrease the balance
(for more about this, see la sezione chiamata «Transazioni»). Tab or click the next split line and repeat
the process. Note that if you are using the keyboard to navigate the transaction, use Tab to move from
field to field, as using Enter will commit the transaction and create splits to an Imbalance account.

Nota

When creating a transaction in GnuCash, splits can be entered in any order. However, when
the transaction is closed (either when leaving the transaction, or when pressing the Enter
key), all debit splits will jump ahead of all credit splits.

Per questo esempio, selezionare il conto di deposito (Attività:Conto corrente) e inserire l’importo
da depositare (per esempio €670). Inserire poi l’importo delle varie tasse: Uscite:Tasse:Statali €180,
Uscite:Tasse:Servizio sanitario €90 e Uscite:Tasse:Previdenza sociale €60. Infine, inserire il totale
lordo del proprio stipendio (€1000 in questo esempio) come un trasferimento dal conto Entrate:Sti-
pendio.

La suddivisione finale dovrebbe assomnigliare a quella riportata in Figura 4.1, «Inserire una transa-
zione suddivisa». È importante ricordare di premere Invio al termine dell’immissione. È anche im-
portante notare che premendo Invio, le suddivisioni verranno chiuse in una semplice vista della tran-
sazione. Le suddivisioni sono ancora presenti; basta premere il pulsante Suddivisione sulla barra degli
strumenti per farle ricomparire. Per maggiori dettagli consultare la sezione chiamata «Caratteristiche
del registro del conto».

Figura 4.1. Inserire una transazione suddivisa

Riconciliazione
Once transactions have been entered into GnuCash, it is important to verify that they agree with the
records of your financial institution. This verification process is known as reconciliation, and it is key
to determine whether your records are accurate. Most commonly, you will check transactions against
bank statements, although you can use this process to verify any transaction.
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GnuCash keeps track of the reconciliation status of each transaction. The reconciliation status of a
transaction is shown by the reconciliation R field in a register: y indicates that a transaction has been
reconciled, n indicates that it has not, and c indicates that it has been cleared, but not reconciled. A split
marked cleared signifies that you got some kind of confirmation that the institution accepted the order
(e.g. you have the restaurant's receipt for your credit card purchase). You can toggle the reconciliation
status between n and c by clicking in the R field; you can set it to y by using la sezione chiamata
«Finestre di riconciliazione».

At the bottom of the account window, there are (among others) two running balances (the cleared
and reconciled balance), and the total balance. The former balances should correspond to how much
money the bank thinks you have in your account, while the latter includes outstanding transactions.

For example, when you write a check for something, you should enter the transaction into GnuCash.
The reconciliation R field of the transaction will initially contain n (new). Your new entry will con-
tribute to the total balance, but not to the cleared and reconciled balance. Later, if you got some con-
firmation that the check has been cashed, you might click on the transaction’s R field to change it
to c (cleared). When you do this, the cleared balance will change to include this amount. When the
bank statement arrives, you can then compare it to what you’ve recorded in GnuCash by opening the
reconciliation window. There, you will be able to change the R field to y (reconciled).

Nota

You cannot reconcile directly in a register window by clicking in the R field. You must use
the reconciliation window. Once a transaction has been marked reconciled, it can no longer
be easily changed without breaking the Starting Balance of the next reconciliation.

Avvertimento

It is important to understand that reconciliation is done for a given date, and when you re-
concile an account based on a statement from a given date, you are reconciling all transac-
tions prior to that date. Therefore, if you add or modify transactions that predate your last
reconciliation, your reconciled balances will be thrown off.

Finestre di riconciliazione

Le finestre di riconciliazione sono utilizzate per riconciliare un conto di GnuCash con l’estratto conto
che la banca o un’altra istituzione ha inviato. La riconciliazione è utile non solo per controllare le pro-
prie registrazioni nei confronti di quelle della banca, ma anche per avere un controllo sulle transazioni
in sospeso come, per esempio, gli assegni non incassati.

Per aprire le finestre di riconciliazione, selezionare un conto dalla struttura dei conti e dirigersi in

Operazioni → Riconcilia. Apparirà una finestra in cui sarà possibile immettere le informazioni di
riconciliazione.
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La finestra iniziale di riconciliazione.

Nella finestra iniziale di riconciliazione, devono essere inserite alcune informazioni di riconciliazione

Data dell’estratto conto La la data di emissione dell’estratto conto
con cui verrà riconciliato il conto.

Suggerimento

Fare clic sulla freccia alla destra
di questo campo per aprire un
calendario

Saldo iniziale Questa voce non è modificabile e visua-
lizza il saldo della precedente riconcilia-
zione. Dovrebbe corrispondere al saldo
iniziale presente sull’estratto conto.

Avvertimento

Potrebbe capitare che il saldo
iniziale in GnuCash non equi-
valga a quello presente sull’e-
stratto conto. Ciò può accade-
re quando si riconcilia un conto
per la prima volta o quando una
transazione riconciliata in pre-
cedenza sia eliminata o la sua ri-
conciliazione venga annullata.

Nota

Quando si riconcilia un conto
per la prima volta, il saldo ini-
ziale sarò pari a 0.00, e quin-
di probabilmente diverso dal bi-
lancio di apertura del proprio
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conto. Quando il conto verrà ri-
conciliato, il bilancio di apertu-
ra del conto verrà incluso nel-
la riconciliazione, e il risultato
finale dovrebbe essere in bilan-
cio.

Suggerimento

Nel caso in cui venga de-recon-
ciliata una transazione riconci-
liata in precedenza, è possibi-
le riconciliarla con le transazio-
ni presenti nell’ultimo estratto
conto. Il risultato dovrebbe es-
sere in bilancio.

Nel caso in cui una transazio-
ne già riconciliata venga elimi-
nata, è più complesso; se non è
possibile risalire alla transazio-
ne eliminata e ripristinarla nel
registro, sarà necessario creare
una transazione fittizia di pari
importo per completare la ricon-
ciliazione.

Attenzione

While the latter case does not
matter for your private accoun-
ting, you should have a really
good explanation for your audi-
tors, if you are the accountant of
a club or a company.

Saldo finale In questo campo dovrebbe essere inseri-
to il saldo di chiusura così come appare
nell’estratto conto.

Nota

GnuCash completa automatica-
mente questo campo con il saldo
Attuale così come mostrato nel-
la parte inferiore del registro del
conto.

Includi i sottoconti Check this option if you want to include
in the reconciliation the transactions that
belongs to the sub-accounts of the curren-
tly selected account. Note that all sub-ac-
counts must be in the same commodity as
the parent for the option to be enabled.

Immissione pagamento interessi Premendo questo pulsante verrà aperta
una finestra che permette di inserire una
transazione per gli interessi nel conto che
sta per essere riconciliato.
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Suggerimento

The Interest Payment window
might be opened automatically
when you start a reconciliation
for an account of the type Bank,
Credit, Mutual, Asset, Receiva-
ble, Payable, and Liability. If
you want to disable this beha-
vior for any of the previous ac-
counts, go to the Register tab
of the GnuCash Preferences and
uncheck the Automatic intere-
st transfer option. Alternatively,
to disable this behavior only for
the selected account, press the
No Auto Interest Payments for
this Account button in the Inte-
rest Payment window.

Premere poi il pulsante Ok e verrà visualizzata la lista delle transazioni nella finestra di riconciliazione:

La lista delle transazioni nella finestra di riconciliazione.

I due riquadri chiamati Fondi in ingresso e Fondi in uscita elencano tutte le transazioni non riconciliate.
La colonna R mostra se le transazioni sono state riconciliate.

Si esamini ora ogni voce dell’estratto conto e si ricerchi l’elemento corrispondente nella finestra di
riconciliazione.

Se non si è in grado di trovarne una, è probabile che ci si sia dimenticati di immetterla oppure non si
era al corrente della transazione. È possibile utilizzare il pulsante Nuovo sulla barra degli strumenti,
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o la voce di menu Transazione → Nuovo, per aprire la finestra del registro e inserire la transazione
mancante. La nuova transazione apparirà nella finestra di riconciliazione alla pressione del pulsante
Inserisci dopo aver immesso la transazione.

Quando si trova la voce corrispondente nella finestra di riconciliazione, confrontarne l’importo con
quello che compare sull’estratto conto. Nel caso fossero diversi, potrebbe essere stato commesso un
errore nell’immissione della transazione in GnuCash. È possibile utilizzare il pulsante Modifica nella

barra degli strumenti o la voce del menu Transazione → Modifica, per aprire la finestra del registro
e correggere la transazione.

Se gli importi corrispondono, fare clic sull’elemento nella finestra di Riconciliazione. Apparirà un
segno di spunta nella colonna R a fianco della transazione selezionata. GnuCash aggiornerà automa-
ticamente gli importi nel riquadro di ripilogo in basso a destra.

Suggerimento

È possibile utilizzare i tasti delle freccie su/giù per scorrere gli elementi, la barra spaziatrice
per marcare l’elemento come riconciliato e il tasto Tab per cambiare riquadro.

Ripetere quindi queste operazioni per ogni voce presente nell’estratto conto della banca, verificando
che l’importo corrisponda con quello in GnuCash e marcando le transazioni in GnuCash quando sono
riconciliate.

Suggerimento

You can check or uncheck the reconcile status of all transactions in either pane by clicking on
a transaction in the required pane then clicking Ctrl-A followed by space. This will toggle
the reconcile status of all transactions in the pane to either checked or unchecked state. This
procedure can be repeated to achieve the desired status for the transactions in the pane.

In basso nella finestra di riconciliazione viene riportata la Differenza, che dovrebbe visualizzare €0,00
quando la riconciliazione è terminata. Se riporta qualche altro valore, o si è dimenticata una o più
transazioni oppure alcuni importi potrebbero essere errati in GnuCash (o, più difficilmente, la banca
ha fatto un errore).

Nota

Under some circumstances, it may be difficult or impossible to determine why an account
will not reconcile. If you are unable to correct the discrepancy between your books and a
statement, GnuCash includes a Balance button on the Toolbar that will automatically create
a balancing entry for you in the amount that cannot be reconciled.

To use this, carry out the full reconciliation (marking all transactions that you can identify)
and then click this button. GnuCash will create a balancing entry for the remaining discre-
pancy that uses the Special Accounts:Orphan-XXX account (where "XXX" represents your
currency). The Reconcile window will close; re-opening it will allow you to check the new-
ly-created balancing entry and finish the process.

When you have marked off all the items on the bank statement and the difference is 0.00, press the

Finish button on the Toolbar or select Reconcile → Finish from the menu. The Reconcile window will
close. In the register window, the R field of the reconciled transactions will change to y.

In questo caso, non sono state ancora ricevute tutte le informazioni, così è stato premuto il pulsante
Posticipa, in modo da poter proseguire in un secondo momento. Si osservi che la colonna R indica
che sono state liquidate (l) due transazioni. Non sono state ancora riconciliate, ma si è verificata la
loro riscossione e quindi sono state marcate come liquidate. Osservando la barra di stato in fondo al
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registro del conto, si noterà un sommario di ciò che è stato riconciliato e di ciò che è stato liquidato
(Liquidato:€ 954.79; Riconciliato:€ 0.00)

Il conto corrente dopo aver posticipato la riconciliazione.

Transazioni pianificate
Le transazioni pianificate sono utili per assistere nell’immissione di operazioni ripetitive con il denaro
quali sottoscrizioni, assicurazioni e tasse. Utilizzando le transazioni pianificate, basta inserire la tran-
sazione in oggetto una sola volta, impostare alcuni parametri come la data di inizio, la frequenza e una
breve descrizione, e poi GnuCash avvertirà ogniqualvolta sarà pronto a creare una nuova transazione
oppure la creerà automaticamente.

In questa guida pratica, si considererà una sottoscrizione mensile al servizio internet di 20 Euro che
viene pagata il 28 di ogni mese.

In GnuCash, si possono creare delle transazioni pianificate in due modi: dal libro mastro o dall’Editor
transazioni pianificate.

Creazione dal libro mastro
Inserire nel registro la prima occorrenza della propria transazione da pianificare. Nel campo Trasferi-
mento per questa transazione, digitare Uscite:Internet come mostrato nell’immagine seguente.

Passo 1: creazione della transazione pianificata dal libro mastro
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Nota

Dato che non è ancora stato creato il conto Uscite:Internet, GnuCash ne richiederà la crea-
zione.

Fare clic poi con il tasto destro sulla transazione e selezionare Pianifica...

Passo 2: creazione della transazione pianificata dal libro mastro

Verrà visualizzata una finestra come questa:

Passo 3: creazione della transazione pianificata dal libro mastro

Si compilino i valori richiesti; la sottoscrizione è prelevata il 28 di ogni mese e la successiva sarà per
il mese prossimo (dato che quella per questo mese è stata inserita manualmente):
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Inserimento dei dati nella transazione pianificata

Premere il pulsante OK e la transazione verrà pianificata. GnuCash ha ora memorizzato la transazione
pianificata e, il 28 del mese prossimo, presenterà una finestra in cui verrà richiesto se la transazione
deve essere creata (un’immagine di questa finestra è riportata qui sotto).

Creazione dalla finestra dell’Editor transazioni pianifi-
cate

Un altro modo per inserire una transazione pianificata è dalla finestra dell’Editor transazioni pianifi-
cate; questo metodo può essere più veloce se si devono creare più transazioni in una sola volta.

Dalla finestra principale dei conti selezionare Operazioni → Transazioni pianificate → Editor transa-
zioni pianificate sulla barra del menu. Verrà così aperta una nuova scheda denominata Transazioni
pianificate come quella riportata di seguito:
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Scheda Transazioni pianificate vuota

Questa scheda contiene un elenco, per ora vuoto, di tutte le transazioni pianificate. Crearne una nuova
premendo il pulsante Nuovo sulla barra degli strumenti; si aprirà una nuova finestra come questa:
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Edit Scheduled Transaction window, Overview tab

Inserire dapprima un nome per la nuova transazione pianificata nell’apposito campo nella parte supe-
riore della finestra.

Nota

Il nome identifica la transazione solamente nell’Editor transazioni pianificate, non apparirà
mai nel registro.

Nel riquadro Opzioni della scheda Generali sono disponibili quattro opzioni:

Attiva Imposta lo stato della transazione pianificata.

Crea automaticamente Se abilitata, la transazione verrà inserita nel li-
bro mastro senza che venga richiesta alcuna
conferma (vedere nel seguito). Se necessario,
è possibile essere avvisati al momento dell’in-
serimento della transazione abilitando l’opzio-
ne Notifica quando creata.

Crea in anticipo di Imposta il tempo in anticipio con cui la tran-
sazione pianificata verrà creata.

Ricorda in anticipo di Imposta l’anticipo con cui notificare la sca-
denza della transazione. È utile, per esempio,
quando si deve pagare con un assegno; Gnu-
Cash può ricordare l’incombenza una settima-
na prima così da poter inviare l’assegno prima
della scadenza.

Il riquadro Scadenze permette di dire a GnuCash che questa transazione non durerà per sempre; per
esempio se si sta ripagando un prestito, si può selezionare la data di termine del prestito o il numero
di rate rimanenti.

Selezionare poi la scheda della Frequenza nell’Editor transazioni pianificate. Qui è possibile impostare
le opzioni relative al tempo per la transazione.
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Edit Scheduled Transaction window, Frequency tab

Frequenza Imposta la frequenza di base della transa-
zione; selezionare un valore tra una vol-
ta,quotidiana,settimanale,quindicinale e
mensile. In questo esempio verrà impo-
stata a mensile

Nota

È possibile impostare delle sca-
denze a intervalli diversi da
quelli elencati nell’elenco delle
Frequenze, modificando le im-
postazioni della voce Ogni (ve-
dere nel seguito).

Data d’inizio Imposta l’inizio della transazione.
Nell’esempio, questa sarà l’inizio del me-
se prossimo.

Ogni Questa opzione permette di pianificare
letransazioni in periodi multipli del valo-
re impostato come Frequenza. Per esem-
pio, per creare una transazione pianificata
ogni 3 settimane, impostare la Frequenza
a settimanale e il campo Ogni a 3.

Poi il e a eccezione dei fine settimana Imposta il giorno del mese in cui è pia-
nificata la transazione e controlla il com-
portamento di GnuCash quando la sca-
denza coincide con un giorno del fine set-
timana.

Nota

La sottoscrizione è prelevata il 28 di ogni mese, quindi la Data d’inizio sarà il 1° Novembre
2003 (assumendo che Novembre sia il mese prossimo) e la Frequenza sarà mensile; verrà
quindi prelevata il 28 di ogni mese. Dato che nell’esempio l’abbonamento internet viene
prelevato automaticamente dal conto, non sarà necessario né creare la transazione in anticipo
né impostare una data finale.

Quando le voci di questa scheda sono state completate, GnuCash evidenzierà le scadenze future nel
calendario sulla parte inferiore della finestra.

Infine, selezionare la scheda del Modello di transazione e inserire la transazione nella parte bassa come
si farebbe nel libro mastro, con la sola differenza che non è richiesta una data.

Ora, si dovrebbe avere una finestra come questa:
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Edit Scheduled Transaction window, Template Transaction tab

Si ricordi di premere il pulsante Inserisci, per convalidare e immettere la transazione.

Premendo Ok, si tornerà alla scheda delle Transazioni pianificate, ora con un elemento nella lista delle
Transazioni:
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Transazione pianificata inserita

Suggerimento

Facendo clic nel calendario in corrispondenza del primo giorno del mese, una piccola finestra,
che seguirà il mouse, mostrerà ciò che è pianificato in quel giorno. Per far scomparire la
finestra è sufficiente fare clic su di essa una volta.

Ora è possibile chiudere la scheda Transazioni pianificate e salvare il proprio lavoro.

Nota

Quello mostrato di seguito è solo a titolo esemplificativo e non deve essere immesso nel file
di GnuCash in questa fase. Avendo questo esempio come base, la finestra più sotto apparirà
quando la transazione pianificata è impostata per essere inserita.

D’ora in poi, quando si avvia GnuCash e se è in scadenza o se deve essere inserita una transazione
pianificata, potrebbe essere visualizzata la finestra Dall’ultimo avvio che riassume le operazioni pen-
denti relative alle transazioni pianificate (Promemoria, Da creare ecc... una descrizione di ogni opzioni
è fornita nel manuale di GnuCash):
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Finestra di promemoria per la transazione pianificata

È possibile fare clic nella colonna Stato per modificare lo stato della transazione pianificata, se neces-
sario. Fare poi clic sul pulsante Ok per chiudere la finestra Dall’ultimo avvio... e applicare le eventuali
modifiche. Selezionare Annulla per scartare le operazioni impostate.

Se il campo Stato era già (o è stato impostato) a Da creare, se si controlla nel registro del conto bancario,
si noterà che la transazione è stata creata:

Suggerimento

Abilitando l’opzione Controlla le transazioni create nella parte inferiore destra della finestra
Dall’ultimo avvio..., GnuCash aprirà, dopo aver premuto il pulsante Ok, la scheda del registro
di ogni conto in cui sono state inserite automaticamente le transazioni pianificate.

Nota

Se la transazione per il 28 Aprile è stata inserita in questa fase, ritornare all’ultimo file salvato

di GnuCash. Andare in File → Apri e selezionare gcashdata_3

In pratica
Nelle sezioni precedenti di questo capitolo sono stati discussi i concetti e la meccanica di lavoro con le
transazioni di GnuCash. Questa sezione si svilupperà a partire dalla struttura dei conti creata nel pre-
cedente capitolo aggiungendo dei bilanci di apertura, delle transazioni e delle transazioni pianificate.

Aprire un file di GnuCash

Si inizi aprendo il file dei dati salvato in precedenza, gcashdata_3emptyAccts, e lo salvare
come gcashdata_4 da subito. La finestra principale dovrebbe assomigliare a questa:
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Questa immagine mostra il punto di partenza per questa sezione.

Bilanci d’apertura

Come mostrato per il conto Attività:Conto corrente, i bilanci di apertura di un conto sono tipicamente
assegnati a un conto speciale denominato Capitali:Bilanci d’apertura. Per cominciare a popolare la
struttura dei conti, si impostino i bilanci di apertura dei conti. Si assuma anche che ci siano €1.000 nei
risparmi e €500 di addebito per la carta di credito.

1. Aprire il registro del conto Attività:Conto risparmio. Selezionare Visualizza dal menu e controllare
di aver impostato lo stile del registro a libro mastro basilare. Si vedranno le transazioni nelle altre
due modalità in seguito; per ora è sufficiente creare una semplice transazione utilizzando lo stile
predefinito di base.

2. Dalla finestra del registro del conto Attività:Conto risparmio, inserire una semplice transazione
tra 2 conti per impostare il bilancio di apertura a €1.000, trasferito da Capitali:Bilanci d’apertura.
Si ricorda che una transazione semplice trasferisce denaro da un conto sorgente ad un conto di
destinazione. Registrare la transazione (premere invio o fare clic sul pulsante Inserisci).

3. Dalla finestra del registro del conto Attività:Conto corrente, inserire una transazione tra 2 conti al
fine di impostare il bilancio di apertura a €1.000, trasferiti da Capitali:Bilanci d’apertura.

4. Dalla finestra del registro del conto Passività:Visa, inserire una transazione tra due conti per im-
postare il bilancio di apertura a €500, trasferiti dal conto Capitali:Bilanci d’apertura. Questo si
ottiene inserendo €500 come addebito nel conto Visa (o diminuzione nel conto dei bilanci di aper-
tura), dato che si tratta di denaro chiesto in prestito. Registrare infine la transazione (premere Invio
o fare clic sul pulsante Inserisci).

Si dovrebbero ora avere 3 conti con i relativi bilanci di apertura impostati: Attività:Conto corrente,
Attività:Conto risparmio e Passività:Visa.
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Questa immagine mostra i bilanci di apertura .

Esempi di altre transazioni

Si aggiungano ora altre transazioni per simulare delle spese mensili. Durante il mese, €78 sono spesi
per l’elettricità, €45 per il telefono ed €350 per l’affitto; si supponga che venga tutto pagato con il
conto corrente. Si spendano inoltre €45,21 in generi alimentari, si riceva uno stipendio di €670 e si
paghi una tariffa per il servizio internet. Si spostino poi €100 dal conto dei risparmi al conto corrente.

1. Aprire il registro del conto Uscite:Elettricità e inserire una transazione per pagare €78 per la bolletta
elettrica alla fine del mese corrente (esempio: 28 Marzo 2006). Inserire una descrizione (esempio:
Società elettrica) e il numero dell’assegno (esempio: 102). Il conto di trasferimento dovrebbe essere
Attività:Conto corrente.

2. Aprire il registro del conto Attività:Conto corrente e inserire una transazione per pagare €45 di
bolletta telefonica alla fine del mese corrente (esempio: 28 Marzo 2006). Inserire una descrizione
(esempio: il nome della compagnia telefonica) e il numero dell’assegno (esempio: 103). Il conto
di Trasferimento dovrebbe essere Uscite:Telefono. Si noti che è possibile inserire le transazioni sia
dal lato dell’accredito (conto delle uscite) che dal lato dell’addebito (il conto delle attività).

3. Aprire il registro del conto Uscite:Affitto e inserire una transazione per pagare €350 di affitto alla
fine del mese corrente (esempio: 28 Marzo 2006). Inserire una descrizione (esempio: affitto Aprile)
e il numero dell’assegno (esempio: 104). Il conto di Trasferimento dovrebbe essere Attività:Conto
corrente.

4. Si duplichi ora questa transazione utilizzando il pulsante Duplica sulla barra degli strumenti. Ini-
ziare facendo clic nella transazione selezionata per l’affitto e premendo poi il pulsante Duplica. In-
serire la data della transazione un mese più avanti (esempio: 28 Aprile 2006). Si noterà la comparsa
di una linea separatrice di colore blu che GnuCash utilizza per separare le transazioni correnti da
quelle future. In questo modo è possibile inserire delle transazioni prima che avvengano.

È anche possibile impostare una transazione pianificata per pagare l’affitto dato che l’importo della
rata è probabilmente costante nel futuro prossimo.

• Si inizi selezionando la transazione per l’affitto (28 Aprile) e si prema l’icona Pianifica.

• Modificare in Mensile, cambiare la descrizione se necessario e premere OK
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5. Per trasferire denaro dal conto dei risparmi al conto corrente, aprire il conto Attività:Conto rispar-
mio e aggiungere una nuova transazione impostando il trasferimento a Attività:Conto corrente di
un importo pari a €100 (datato 6 Marzo 2006).

6. Come ulteriore esempio di semplice transazione a due conti, si aggiunga una nuova transazione per
registrare un acquisto di generi alimentari per €45,21 effettuato il 5 Marzo. Dal conto Attività:Conto
corrente impostare un Trasferimento a Uscite:Alimentari. Il registro del conto dovrebbe apparire
così:

7. Per aggiungere una transazione per la busta paga dalla finestra del registro del conto Attività:Con-
to corrente, selezionare una nuova riga per la transazione e fare clic sul pulsante Suddivisione.
Nella prima riga inserire la descrizione della transazione (per esempio: «Employers R Us») e la
data (14 Marzo). Al di sotto di questa, nella riga della «suddivisione», inserire l’importo del de-
posito nel conto Attività:Conto corrente (per esempio: €670). In seguito inserire i depositi per le
imposte (Attività:Conto corrente (per esempio: €670), Uscite:Imposte:Statali (per esempio: €180),
Uscite:Imposte:Assistenza sanitaria (per esempio: €90), Uscite:Imposte:Previdenza sociale (per
esempio: €60) e, in ultimo, il totale lordo dello stipendio (per esempio: €1000) come prelievo dal
conto Entrate:Stipendio.

8. Si deve anche pagare la sottoscrizione internet di 20 Euro il giorno 28.

Questa immagine mostra il saldo finale dopo il Capitolo 4, Transazioni.

Salvare il file

Prima di procedere alla sezione sui resoconti, salvare il file di GnuCash (nome gcashdata_4).
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Resoconti

Avere a disposizione i dati solo tramite lo schermo del computer non è sempre sufficiente. Per questo
GnuCash mette a disposizione dell’utente un grande numero di resoconti ampiamente personalizzabili.

Si analizzeranno ora i resoconti per il Flusso di liquidi e il Resoconto delle transazioni.

1. Per primo verrà analizzato il resoconto del Flusso di liquidi per il mese di Marzo.

Selezionare il resoconto dei flussi di liquidi da Resoconti → Entrate e uscite → Flusso di liquidi.

Questa immagine mostra il resoconto dei flussi di liquidi dopo il Capitolo 4, Transazioni.

Per ottenere questo resoconto personalizzato, fare clic con il tasto destro del mouse nel resoconto e
scegliere Opzioni resoconto. Impostare poi il periodo e specificare quali conti si vogliono includere
nel resoconto.

2. Controllare ora il resoconto delle transazioni per il conto corrente.

Selezionare il resoconto delle transazioni dal menu Resoconti → Resoconto delle transazioni.
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Questa immagine mostra il resoconto delle transazioni per il conto corrente nel mese di Marzo.

3. Cambiare ora il resoconto delle transazioni in modo da mostrare solamente i vari conti delle uscite.

Questa immagine mostra il resoconto delle transazioni per i vari conti delle uscite nel mese di
Marzo.
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Capitolo 5. Libretto degli assegni
Questo capitolo fornisce tutte le informazioni necessarie per gestire con GnuCash il proprio libretto
degli assegni. Gestire il proprio libretto degli assegni costituisce il primo passo per tenere traccia delle
proprie finanze e GnuCash lo rende più facile di quanto sia mantenere un registro cartaceo.

Tanto per cominciare, come discusso nel Capitolo 4, Transazioni, l’immissione di transazioni comuni
è praticamente fatta da GnuCash, grazie alla funzione di auto-completamento. GnuCash mantiene
un saldo corrente per ogni conto rendendone la riconciliazione più semplice. Il metodo della partita
doppia aiuta a contabilizzare le proprie spese richiedendo un conto di trasferimento per i prelievi in
modo da conoscere facilmente quanto denaro è stato speso in differenti settori.

Una volta acquistata confidenza con l’utilizzo di GnuCash per il conto corrente e gli altri conti bancari,
si potrebbero voler tracciare altri conti finanziari. I capitoli dal 6 al 9 esaminano i metodi per gestire
gli altri conti.

Configurare i conti
Il primo passo per gestire il proprio libretto degli assegni consiste nell’impostare i conti necessari, o
utilizzando quelli predefiniti di GnuCash o creandone dei nuovi. Per maggiori dettagli su come creare
un nuovo conto, consultare la sezione chiamata «I conti base di livello principale». Per informazioni
su come importare i conti da un altro programma, assegni consultare il manuale di GnuCash.

Per partire si avrà bisogno di diversi conti. Un conto del tipo Banca per ogni conto bancario reale di
cui si desidera tenere traccia. Se si sta utilizzando una struttura dei conti personalizzata oppure quella
predefinita di GnuCash, occorre assicurarsi di avere una transazione per il bilancio di apertura associata
a ogni conto bancario che si possiede. Il metodo migliore per impostare questo valore, è di utilizzare
come bilancio di apertura il saldo dell’ultimo estratto conto fornito dalla propria banca. È possibile
inserirlo direttamente nella finestra delle informazioni del conto dell’assistente per l’Impostazione di
una nuova struttura conti oppure si può inserire manualmente una transazione direttamente nel conto.
In quest’ultimo caso è sufficiente creare una transazione dal conto Bilanci di apertura (della categoria
capitale) al conto bancario.

I più frequenti conti bancari da includere nelle registrazioni sono:

• Conto corrente - qualsiasi conto istituzionale che fornisce la facoltà di emettere assegni.

• Conto risparmi - un conto istituzionale che matura interessi utilizzato normalmente per mantenere
il denaro per tempi più lunghi rispetto al conto corrente.

Le transazioni comuni che interessano questa tipologia di conti sono i pagamenti e i depositi. I paga-
menti sono trasferimenti di denaro dal conto bancario, generalmente verso un conto delle uscite. I de-
positi sono trasferimenti di denaro verso il conto bancario, generalmente proveniente da un conto delle
entrate. È necessario impostare i conti di entrate e uscite per tracciare la provenienza e la destinazione
del denaro. Si ricordi che una transazione bilanciata richiede il trasferimento di una uguale somma di
denaro da almeno un conto verso almeno un conto. Così, se si deposita del denaro sul conto corrente,
si deve anche indicare da quale conto il denaro proviene. Se si paga una spesa prelevando dal conto
corrente, è necessario specificare il conto verso cui il denaro è stato speso.

Immettere i depositi
La maggiorana delle transazioni di deposito avvengono sotto forma di trasferimento da un conto delle
entrate a un conto bancario. Le entrate possono derivare da varie fonti ed è buona norma impostare
un conto di tipo entrate per ogni diversa fonte. Per esempio, le entrate possono provenire per la mag-
gior parte dalla busta paga, ma possono anche essere dovute alla maturazione di interessi sui propri
risparmi. In questo caso, si dovrebbero creare due conti per le entrate: uno per lo stipendio ed un uno
per gli interessi maturati.
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Suggerimento

È importante assicurarsi di aver selezionato l’opzione relativo alle tasse nella finestra delle

Informazioni sulle imposte sulle entrate (Modifica → Opzioni del resoconto delle imposte),
quando vengono impostati dei conti tassabili. Alcuni tipi di entrate, come per esempio i regali,
possono non essere considerati tassabili ed è quindi necessario controllare le regole sulla
tassabilità per determinare cosa è tassabile. Per la descrizione delle modalità di tracciamento
delle entrate dovute ai guadagni di capitale, fare riferimento a Capitolo 11, Guadagni in conto
capitale.

Prima di iniziare a inserire i depositi dello stipendio, è bene decidere con quale livello di dettaglio si
intende registrarli. Il livello base consiste nell’inserire lo stipendio netto proprio come si farebbe su
un registro cartaceo. Questo è il metodo più semplice, ma si possono ottenere maggiori dettagli se si
inserisce in GnuCash lo stipendio lordo e le sue detrazioni. Questo metodo richiede più impegno ma
inserendo tutte le informazioni sulle trattenute durante tutto l’arco dell’anno, consente di ottenere degli
utili resoconti sulle tasse in in qualsiasi momento. Questi resoconti possono aiutare a determinare se
si stanno trattenendo tasse a sufficienza e permettono di stimare le tasse da pagare in futuro. Se non
si è sicuri sul livello di dettaglio, conviene iniziare inserendo semplicemente lo stipendio netto. Sarà
sempre possibile tornare indietro e modificare le transazioni in un secondo momento se si decidesse
di optare per un dettaglio maggiore.

Immettere i prelievi
Quando si preleva per una qualsiasi ragione una somma dal conto bancario, si sta trasferendo del de-
naro dal conto bancario verso un’altra destinazione. In GnuCash, quest’altra destinazione è registrata
come un conto. Più conti di dettaglio si creano e utilizzano per le uscite, maggiori saranno le informa-
zioni disponibili sulla destinazione del proprio denaro.

I prelievi possono assumere diverse forme. I prelievi da ATM rappresentano le transazioni più diffuse.
Scrivere assegni è un altro modo per prelevare denaro al fine di pagare le bollette, per fare acquisti o
per fare beneficenza. In funzione della banca, si possono avere anche costi di servizio in cui la banca
preleva denaro dai conti. I trasferimenti di denaro verso un altro conto rappresentano anch’essi dei
prelievi. Di seguito si tratterà ogni tipo di prelievo e se ne descriverà la procedura di inserimento in
GnuCash.

ATM: prelievo di contanti
I prelievi di contanti sono trattati come trasferimenti da un conto bancario a un conto dei liquidi.
GnuCash fornisce conti speciali per i Liquidi in grado di tenere traccia dei prelievi di contanti, così
è necessario impostare un conto per i contanti allo scopo di registrare i propri prelievi sia con ATM
che con altre modalità.

I conti per i liquidi possono essere utilizzati con diversi livelli di dettaglio. Al livello più semplice,
si trasferisce semplicemente il contante dal conto corrente. Questo però indica solamente la quantità
di denaro prelevata dal conto corrente in un determinato giorno, ma non fornisce informazioni sulla
destinazione del denaro. Con poco impegno in più, è possibile utilizzare il conto per i liquidi per
registrare anche gli acquisti in contanti in modo da poter conoscere la destinazione precisa del denaro.
Questi acquisti verranno registrati come trasferimenti di denaro dal conto dei liquidi al conto delle
uscite.

Alcune persone registrano ogni acquisto in contanti, ma questo richiede molto lavoro. Un metodo più
semplice consiste nel registrare gli acquisti per i quali si ha una ricevuta, aggiustando poi il saldo del
conto in base a quanto rimane nel portafoglio.

Si consiglia di impostare almeno un conto dei liquidi per registrare i propri prelievi. Se poi si decidesse
di registrare anche la destinazione del proprio denaro, è sempre possibile inserire delle transazioni per
il denaro speso. L’utente è libero di scegliere il dettaglio di livello che preferisce.
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Riconciliare i conti
GnuCash rende molto semplice la riconciliazione del proprio conto bancario con l’estratto conto men-
sile. In la sezione chiamata «Riconciliazione» vengono fornite le istruzioni necessarie a riconciliare
le proprie transazioni con l’estratto conto mensile inviato dalla propria banca. Questa rappresenta la
principale operazione di riconciliazione che dovrebbe essere eseguita ogni mese.

Ma allora cosa fare di tutti i conti che sono stati creati? Dovrebbero essere riconciliati anche loro? Se
si riceve un estratto conto per un determinato conto, allora sarebbe bene riconciliarlo. Degli esempi
possono essere l’estratto conto del conto corrente, dei risparmi e della carta di credito. Le transazioni
e l’estratto conto per la carta di credito sono descritti in Capitolo 7, Carte di credito, quindi, se si è
interessati a tracciare le carte di credito con GnuCash, leggere le istruzioni contenute in quel capitolo.

I conti per le entrate e per le uscite non vengono normalmente riconciliati dato che non esiste nessun
documento che permette di controllarne il saldo. Per la stessa ragione è impossibile anche riconciliare i
conti del denaro liquido. Con un conto per i liquidi, però, è possibile correggere il saldo di tanto tanto, in
modo che il denaro contante a disposizione corrisponda al saldo nel conto dei liquidi. L’aggiustamento
del saldo è trattato nella sezione successiva.

In pratica
Nel Capitolo 4, Transazioni, sono state inserite alcune transazioni nel conto corrente. In questo capi-
tolo, verranno aggiunte altre transazioni e poi si procederà alla loro riconciliazione.

Bilanci d’apertura
Si cominci aprendo il file salvato nell’ultimo capitolo (gcashdata_4). La struttura dei conti do-
vrebbe assomigliare a questa:

Questa immagine mostra la struttura dei conti.

Aggiungere alcune transazioni
1. Aprire ora il conto corrente dalla finestra principale. Nel precedente capitolo, sono state inserite

alcune transazioni per lo stipendio come depositi nel conto corrente. Ora si immetterà un altro tipo
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di deposito: un trasferimento di denaro dai risparmi al conto corrente. In una riga vuota, immettere
una transazione per trasferire €500 da l conto dei risparmi al conto corrente (in questo caso, la data
dell’ultima transazione era il 28 Marzo, ma questa transazione di trasferimento è avvenuta il 24). Il
conto di trasferimento sarà quello dei risparmi dato che ci si trova nel conto corrente. Quest’ultimo
dovrebbe ora assomigliare a questo:

Questa immagine mostra il registro del conto corrente.

2. Si proceda quindi all’inserimento di alcuni assegni in questo conto. Dapprima inserire un assegno
a favore di HomeTown alimentari per €75 (5 di Marzo). Il conto di trasferimento è Alimentari, dato
che tutto il denaro è stato impiegato per acquistare dei generi alimentari. Poi inserire un assegno
di €100 per ABC Hardware (6 di Marzo) e suddividere questo importo in due uscite: €50 per Ca-
salinghi e €50 per Attrezzi. Sarà necessario creare un conto di tipo Uscite per ognuna di esse e in
seguito inserire la suddivisione. Il conto corrente dovrebbe ora assomigliare a questo:

Questa immagine mostra il registro del conto corrente dopo l’inserimento di altri assegni.

3. Si supponga ora di dover prelevare del denaro. Nella struttura dei conti, non è ancora presente
un conto per i liquidi, così sarà necessario crearne uno. Creare quindi il conto come Liquidi nella
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categoria di livello principale Attività. Dal registro del conto corrente, inserire un prelievo da ATM
per trasferire €100 dal Conto corrente al conto Liquidi in data 25 Marzo.

Questa immagine mostra il registro del conto corrente con un prelievo da ATM.

Bilanci d’apertura

A questo punto è possibile procedere alla riconciliazione del conto corrente, utilizzando questo sem-
plice estratto conto:

Questa immagine mostra un semplice estratto conto.

1. Selezionare Operazioni → Riconcilia dal menu e inserire il bilancio di chiusura di €1.451,79. Pre-
mere OK per iniziare la riconciliazione del conto. Marcare le voci come appaiono nell’estratto
conto. Quando tutte le voci sono state marcate, la finestra di riconciliazione dovrebbe assomigliare
a questa:
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Questa immagine mostra la finestra di riconciliazione con una differenza di €5,00.

Si noti che il saldo riconciliato differisce dal saldo finale di €5,00. Se si osserva l’estratto conto
della banca, si noterà la presenza di un costo di servizio di €5,00 che non è stato aggiunto nel conto
corrente.

2. Si deve quindi inserire nel registro del conto corrente un costo di servizio di €5,00. In una riga vuota
del registro del conto corrente, inserire una transazione che trasferisca €5,00 dal conto corrente a
un conto per i costi di servizio (sarà necessario creare questo conto nella categoria delle Uscite).
Utilizzare la data di emissione dell’estratto conto come data per la transazione. Il conto corrente
dovrebbe ora assomigliare a questo:

Questa immagine mostra il registro del conto corrente con l’aggiunta del costo di servizio.

3. Tornando alla finestra di riconciliazione, dovrebbe ora essere visualizzata la tassa di servizio sotto
la voce Fondi in uscita. Fare clic su di essa per marcarla come riconciliata; si noti come l’importo
della differenza sia ora pari a 0,00. Premere il pulsante Termina nella barra degli strumenti per
completare la riconciliazione. La colonna di riconciliazione R nel registro del Conto corrente, do-

73



Libretto degli assegni

vrebbe ora mostrare una s per ogni transazione appena riconciliata. Si osservi anche che la riga
delle informazioni nel basso della finestra riporta Riconciliato: EUR 1.451,79.

Questa immagine mostra il registro del conto corrente riconciliato.

Salvare il file

Tornare ora alla finestra principale del programma e salvare il file con il nuovo nome gcashdata_5.
La struttura dei conti sta costantemente crescendo e dovrebbe essere simile a questa:

74



Libretto degli assegni

Questa immagine mostra la struttura dei conti.

Resoconti

Come è stato fatto nel precedente capitolo, si dia uno sguardo ai resoconti Flusso di liquidi e Resoconto
delle transazioni.

1. Per primo verrà analizzato il resoconto del Flusso di liquidi per il mese di Marzo.

Selezionare il resoconto dei flussi di liquidi da Resoconti → Entrate e uscite → Flusso di liquidi.
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Questa immagine mostra il resoconto del flusso di liquidi dopo il Capitolo 5, Libretto degli assegni.

2. Si controlli ora il corrispondente resoconto delle transazioni per i conti del patrimonio.

Selezionare il resoconto delle transazioni dal menu Resoconti → Resoconto delle transazioni.

76



Libretto degli assegni

Questa immagine mostra il resoconto delle transazioni per i conti del patrimonio nel mese di Marzo.

3. Cambiare poi il resoconto delle transazioni in modo da mostrare solamente i vari conti delle Uscite.
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Questa immagine mostra il resoconto delle transazioni per i vari conti delle uscite nel mese di
Marzo.

Un solo conto, presente nella struttura dei conti realizzata finora, non è ancora stato utilizzato: quello
della Carta di credito. Ora che si è in grado di tenere traccia del conto bancario e dei contanti in
GnuCash, si potrebbe voler iniziare a tenere traccia anche della propria carta di credito. GnuCash
fornisce un particolare tipo di conto per le carte di credito che sarà discusso nel prossimo capitolo.
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Capitolo 6. Expense Accounts
If managing your checkbook is the first step in tracking your finances, then using expense accounts
to see where you are expending money is a close second step. This chapter will give you an under-
standing of how GnuCash uses expense accounts to help you keep track of many different categories
of transactions.

Concetti
An expense type account is used to allow you to track how much you spend on specific expenses.
Technically, expense accounts are not a part of traditional accounting, but have become common with
the increased capabilities of computer-based accounting systems. Many people's first experience with
tracking expenses comes from Quicken(tm), where transactions can be assigned to one or more cate-
gories. In GnuCash, these categories are set up as separate accounts, which are designated as Expense
type accounts. This allows GnuCash to apply the rules of double-entry accounting consistently. Ex-
pense accounts can be as detailed or as general as you need. Some users need only a few accounts for
personal expense tracking. Others use GnuCash expense accounts to manage their expenses in great
detail. The level of detail you choose is up to you. Keep in mind that with GnuCash, you can change
accounts for transactions, so if your needs change later on, it is possible to move transactions around.

Impostare i conti

Simple Expense Account Setup

For many users, the easiest way to set up expense accounts is to check the "Common Accounts"
when you create a new Account Hierarchy. This will establish many of the most common expense
accounts that users need. See "New Account Hierarchy Setup" in Chapter 3 of the Help guide for
more information.

Complex Expense Account Setup

If you have different expense accounting needs, you can refer to Capitolo 4, Transazioni, or Chapter
5.4 in the Help manual for instructions on how to create accounts.

Typical reasons for adding new or different expense accounts include: to track expenses for particular
business purposes (e.g., specific types of supply expenses), to track expenses for particular tax purpo-
ses (e.g., tax expenses that must be reported to others), or simply to track expenses that are meaningful
to you (e.g., payments made to a particular charity).

Entering Expense Transactions
While it is possible to enter transactions directly into expense accounts, it is not normally how these are
entered. For most people, transactions for an expense account are added when the user is entering data
into the other account in the transaction. In other words, if you have an expense account for Charitable
Donations (e.g., Expenses:Charity), you will typically add a transaction to the expense account by
assigning a check in your checking account register to the Charity account.

If you open an expense account, you will see a register similar to most others you find in GnuCash.
The informal column headings for the transaction amounts are slightly different, however. The left
(debit) column will read Tot Expense, while the right (credit) column will read Tot Rebate.
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Other Considerations for Expense Accounts
Because expense accounts are generated entirely by you, there are no statements against which you
would reconcile your data. Therefore, there is technically nothing to reconcile. You can, of course use
the reconcile process for expense accounts, which will lock the transactions for future editing.

One point to consider is that as your use of GnuCash continues, the balances in these accounts will
grow, since there are usually very few credit transactions that reduce the balances. There is nothing
wrong with this situation, but some users may wish to clear the balances in their expense accounts
periodically. Zeroing transactions can be entered that transfer the balance of the account to an Equity
account. GnuCash includes a Closing Books procedure that includes zeroing out expense accounts.
Keep in mind that this is not necessary, and that if you need to gather information on a given expense
account, you can use various reports to extract that data without zeroing the account out.
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Capitolo 7. Carte di credito
Questo capitolo mostra come gestire una carta di credito con GnuCash.

Concetti
Dato che probabilmente è capitato di scrivere un assegno o effettuare un pagamento elettronico alla
compagnia della carta di credito ogni mese, si potrebbe pensare che la carta di credito rappresenti una
uscita; in realtà non la è. Perché? Un conto per la carta di credito è un prestito a breve termine: si
possono fare degli acquisti da questo conto e poi si deve restituire il denaro speso, con gli interessi
(il carico finanziario a proprio conto). Gli acquisti che si effettuano con la carta di credito sono le
vere uscite.

È possibile percorrere due diverse strade quando si vuole immettere una transazione avvenuta con la
carta di credito: la scelta dipende dal livello di dettaglio che si desidera ottenere. Il metodo più semplice
consiste nel registrare solamente i pagamenti mensili alla compagnia della carta di credito. Dal proprio
conto bancario, immettere un trasferimento di denaro ogni mese al conto delle uscite della carta di
credito. Questo permetterà di visualizzare l’importo che si paga ogni mese alla compagnia della carta
di credito, ma non fornirà alcuna informazione sul saldo della carta di credito o sugli acquisti effettuati
con la carta di credito.

Un metodo più completo per tracciare la carta di credito in GnuCash consiste nell’inserire ogni acqui-
sto e ogni pagamento come una transazione separata. Utilizzando il registro del conto della carta di
credito, è possibile inserire le ricevute per tutto il mese. Quando si riceve l’estratto conto della carta
di credito, è possibile riconciliarlo con il conto della carta di credito e i pagamenti sono inseriti come
un trasferimento di denaro dal conto corrente al conto della carta di credito. Questo metodo fornisce
maggiori informazioni sul saldo durante il mese e fa emergere ogni discrepanza durante la riconcilia-
zione, ma è necessario inserire una maggior quantità di dati.

Impostare i conti
Per iniziare a gestire la propria carta di credito con GnuCash, si deve impostare un conto delle Passività
di livello principale e al suo interno creare tanti conti figli del tipo carta di credito quante sono le carte
che si vogliono tracciare. Per registrare solamente i pagamenti effettuati alla compagnia della carta
di credito, tutto quello di cui si ha bisogno è un conto per la banca e uno per la carta di credito dove
immettere le transazioni.

Le spese effettuate con la carta di credito sono delle uscite ed è quindi necessario impostare questi conti
come figli di un conto di livello principale denominato Uscite. Se si decide di utilizzare un maggiore
livello di dettaglio degli acquisti, sarà necessario creare un conto uscite per ogni tipo di acquisto che si
effettua. Dato che sarà anche necessario riconciliare il saldo con l’estratto conto della carta, sarà utile
impostare un bilancio di apertura per ogni conto di carta di credito. Il metodo più semplice per farlo
consiste nell’utilizzare come bilancio di apertura, il saldo dell’ultimo estratto conto.

Schema semplice
Se non si desidera registrare ogni spesa sostenuta con la carta di credito, è sufficiente creare una
semplice struttura dei conti come questa:

-Attività
   -Banca
-Passività
   -Carta di credito
-Uscite
   -Carta di credito
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In questo esempio, si immette l’importo totale addebitato ogni mese come una transazione tra il conto
Passività:Carta di credito e il conto Uscite:Carta di credito. Quando si effettua un pagamento si deve
inserire una transazione tra Attività:Banca e Passività:Carta di credito.

La limitazione ovvia di questo semplice schema per la carta di credito, risiede nel fatto che non è
possibile vedere dove il denaro viene impiegato. Tutte le spese effettuate con la carta di credito sono
inserite nel conto delle uscite per la carta di credito. Comunque, questo sistema è facilmente configu-
rabile e aggiornabile.

Schema completo
Se si desidera registrare le spese in modo più completo, occorre impostare più conti per le uscite
denominati a seconda dei vari tipi di acquisti che si possono effettuare. Ogni addebito sulla carta di
credito è immesso come una transazione separata tra il conto delle passività della carta di credito e il
conto specifico per l’uscita. Di seguito si riporta un esempio di struttura dei conti per questo caso:

-Attività
    -Banca
-Passività
    -Carta di credito
-Uscite
    -Cibo
    -Auto
    -Vestiti
    -Intrattenimento
    -Interessi
    -Servizi
   

Chiaramente, è necessario inserire delle uscite specifiche a seconda delle proprie abitudini di acquisto.
L’unica differenza tra questo schema e quello semplice, riguarda le uscite che ora sono suddivise in
gruppi. Si noti anche la presenza di una uscita denominata «Interessi»; questa è utilizzata quando la
carta di credito richiede il pagamento degli interessi sul denaro che mensilmente non è ancora stato
restituito. Il conto delle uscite denominato «Servizi» permette di tenere traccia delle spese di servizio
associate all’utilizzo della carta di credito, quali il costo fisso annuo di utilizzo se esiste. Con questo
schema, si sarà in grado di controllare dove il denaro viene speso ogni mese e raggrupparlo in funzione
dei conti delle uscite.

Il resto di questo capitolo assumerà che si stia utilizzando lo schema completo.

Immettere le spese
Inserire le proprie spese, fornisce un quadro più dettagliato delle proprie abitudini di acquisto. Le spese
effettuate con la carta di credito sono registrate come transazioni tra il conto passività della carta di
credito e l’appropriato conto delle uscite.

When you pay for goods or services with your credit card, you are telling the credit card company to
pay the merchant for you. This transaction will increase the amount of money you owe the credit card
company, and the credit card balance will increase. The other side of these transactions will in most
cases be an expense account. For example, if you buy clothing from a store with your credit card for
$50, you would be transferring that money from the credit account into Expenses:Clothing.

Entering these transactions into GnuCash allows you to track how much you owe the credit card
company, as well as provides you a better picture of your overall accounts. It also allows you to monitor
your account and ensure that fraud is avoided.

82



Carte di credito

Adding transactions to a credit card account is similar to entering transactions in other accounts. You
can enter them manually, or import them from your credit card company using a compatible import
format.

For assistance with entering transactions, see Chapter 6 of the Help manual and Capitolo 4, Transa-
zioni.

Immettere gli addebiti
La maggior parte dei pagamenti in favore della carta di credito sono immessi come transazioni da un
conto bancario (attività) al conto della carta di credito (passività). Quando si paga la ricevuta mensile,
si sta prelevando denaro da un conto bancario per far diminuire il saldo della carta di credito. Questa
transazione contribuisce alla diminuzione sia del saldo del conto bancario, sia dell’importo dei debiti
che si hanno verso la carta di credito.

Quando si restituisce un acquisto, si riceve un rimborso sulla carta di credito. Questa rappresenta un
altro tipo di pagamento nel senso che fa diminuire l’importo dei debiti che si hanno verso la compagnia
della carta di credito. Se l’acquisto originale è stato registrato con un trasferimento dal conto della
carta a quello delle uscite, si può semplicemente invertire la transazione: ritrasferire indietro il denaro
dal conto delle uscite a quello della carta di credito. Questa transazione provoca la diminuzione del
saldo sia del conto delle uscite, sia del conto della carta di credito. Per esempio, se è stato registrato
un acquisto di vestiario avvenuto con la carta di credito, la transazione associata consiste in un trasfe-
rimento dal conto della carta di credito al conto delle uscite per il vestiario. Se poi si restituisce questa
merce per un rimborso, è sufficiente trasferire il denaro indietro dal conto delle uscite per il vestiario
al conto della carta di credito.

Nota

Un errore comune è quello di inserire il rimborso come una entrata. Non è infatti un’entrata
ma una «uscita negativa». Questo è il motivo per cui si deve trasferire il denaro dal conto
delle uscite a quello della carta di credito quando si riceve un rimborso.

Per rendere più chiaro il concetto, si procede all’illustrazione di un esempio. Si acquistano dei Jeans
con la carta di credito per un importo di €74.99; il giorno dopo ci si accorge che sono troppo larghi e
si decide di restituirli. Fortunatamente il negoziante accetta e viene rimborsata la carta di credito.

1. Si inizi aprendo il file salvato in precedenza (gcashdata_5), e lo salvare da subito con il nome
gcashdata_6.

2. Aprire il registro del conto Passività:Visa e inserire una transazione a due conti per pagare l’acqui-
sto di Jeans per €74.99. Il conto di Trasferimento sarà Uscite:Abbigliamento e verrà addebitato il
proprio conto Visa con €74.99.

Nota

Dato che il conto Uscite:Abbigliamento non è stato creato in precedenza, GnuCash ne
richiederà la creazione. Si ricordi solo di crearlo come conto della categoria Uscite

3. Inserire poi il rimborso in uno dei seguenti modi.

• Inserire la stessa transazione utilizzata per l’acquisto, ma invece di un importo in Addebito,
inserire un importo in Pagamento nel registro del conto della carta di credito.

• Selezionare la transazione di acquisto che si vuole rimborsare (cioè la transazione per i Jeans nel

caso analizzato) e selezionare Transazione → Aggiungi transazione di inversione. Modificare
la data come necessario.

Dopo aver invertito la transazione, il conto della carta di credito dovrebbe assomigliare a questo:
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Questa immagine mostra il registro del conto Passività:Carta di credito dopo l’inversione della
transazione per l’acquisto.

E il registro del conto Uscite:Abbigliamento dovrebbe assomigliare a questo

Questa immagine mostra il registro del conto Uscite:Abbigliamento dopo l’inversione della tran-
sazione di acquisto.

4. Salvare il file dei dati di GnuCash.

In pratica
Ora che sono stati affrontati i concetti di base che stanno dietro le varie transazioni che si devono
effettuare per tracciare correttamente la propria carta di credito in GnuCash, si procederà alla illustra-
zione di un esempio: si effettueranno degli acquisti con la carta di credito, si rimborseranno due di
essi, si pagheranno gli interessi sull’importo non pagato, si riconcilierà il conto della carta e, infine,
si effettuerà un pagamento parziale della carta di credito.

Aprire un file di GnuCash

Si inizi aprendo il file dei dati salvato in precedenza, gcashdata_5 e lo salvare come gcashda-
ta_6 da subito. La finestra principale dovrebbe assomigliare a questa:
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Struttura dei conti iniziale per il tracciamento di una carta di credito nell’esempio pratico.

Acquisti

Si supponga di effettuare degli acquisti con la carta Visa. Si inizi acquistando €25 di cibo dal Greasy
Spoon Cafe, €100 di capi di vestiario da Faux Pas Fashions, €25 di carburante da Premium Gasoline,
€125 di generi alimentari e casalinghi da Groceries R Us (suddivisi in €85 di alimentari ed €40 in
oggetti per la casa) e infine, €60 di articoli per la casa da CheapMart.

Si ripeta anche l’esercizio del capitolo precedente, acquistando un paio di Jeans per €74.99 il 3 Aprile,
e si restituiscano due giorni dopo.

La finestra del registro per le passività della carta di credito dovrebbe assomigliare a questa:
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Acquisti iniziali con la carta di credito.

Rimborso

Si supponga ora che il 15 Aprile siano stati restituiti i vestiti acquistati l’11 Aprile da Faux Pas Fashions
e che sia stato rimborsato il costo sulla carta di credito. Inserire una transazione per il rimborso della
carta di credito per l’intero importo di €100. È necessario utilizzare lo stesso conto di trasferimento
utilizzato per l’acquisto, e inserire l’importo nella colonna del pagamento. GnuCash automaticamente
completerà il nome e il conto di trasferimento, ma immetterà anche automaticamente i €100 nella co-
lonna dell’addebito. Sarà necessario reinserire l’importo nella colonna dei pagamenti. La transazione
sarà come questa:

Restituzione dei vestiti a Faux Pas Fashions, rimborso sulla carta di credito.

Interessi

Dopo il mese di acquisti, sfortunatamente, arriva per posta la ricevuta della carta di credito oppure si
accede a essa tramite internet. Si scopre che sono stati addebitati €20 di interessi nell’ultimo giorno
di Aprile a causa del saldo del mese precedente. Questo viene immesso come una spesa nel conto
della carta di credito.
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Interessi.

Riconciliazione

All’arrivo della ricevuta della carta di credito, si dovrebbe riconciliare il conto della carta di credito
con questo documento. Questo può essere fatto utilizzando l’applicazione di riconciliazione fornita da

GnuCash. Evidenziare il conto della carta di credito e selezionare Operazioni → Riconcilia.... Questa
procedura di riconciliazione è descritta dettagliatamnete in la sezione chiamata «Riconciliazione», ma
comunque ne verrà descritto il processo anche qui. Per questo esempio, si assuma che l’estratto conto
della carta di credito sia datato 1 Maggio, con un saldo finale di €455. Inserire questi valori nella
finestra iniziale di riconciliazione come mostrato qui.

Finestra iniziale di riconciliazione del conto.

Durante il processo di riconciliazione, si devono marcare tutte le transazioni nel conto quando si è certi
che esse compaiono sia nel conto di GnuCash, sia nell’estratto conto della carta. In questo esempio,
come mostrato nella figura più sotto, c’è una differenza di €300 tra i conti di GnuCash e il documento
della carta di credito.
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Finetsra principale di riconciliazione del conto, dove è visualizzata una differenza di €300.

Dopo alcune analisi, si scopre di aver dimenticato di registrare un pagamento effettuato il 5 Marzo in
favore della compagnia della carta di credito per un importo di €300; questo pagamento deve essere
inserito con una transazione dal conto corrente bancario al conto della carta di credito. A questo punto
il documento della carta di credito e il conto di GnuCash possono essere riconciliati, con un saldo
di €455.

Pagamento

Nell’ipotesi che sia stata completata la riconciliazione del conto della carta di credito, è necessario
effettuare un pagamento alla compagnia della carta di credito. In questo esempio, si è in debito di €455
ma si restituiranno solamente €300 ancora per questo mese. Per fare questo, inserire una transazione dal
proprio conto bancario al conto della carta di credito, per una somma di €300, che dovrebbe diminuire
il saldo della carta di credito portandolo a €155. Il registro del conto della carta di credito dovrebbe
ora assomigliare a questo:
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Registro del conto dopo la riconciliazione e il pagamento.

Tornare alla finestra principale e salvare il file (gcashdata_6). La struttura dei conti sta continua-
mente crescendo e dovrebbe assomigliare a questa:
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Struttura dei conti di GnuCash dopo la riconciliazione e il pagamento.

Salvare il file

In ultimo, salvare il file dei dati di GnuCash (gcashdata_6).

Resoconti

Come è stato fatto nel precedente capitolo, si darà uno sguardo ai resoconti per il Flusso di liquidi e
per le Transazioni.

1. Dapprima si analizzi il resoconto del Flusso di liquidi per il conto Visa delle passività per il mese
di Marzo.

Selezionare il resoconto dei flussi di liquidi da Resoconti → Entrate e uscite → Flusso di liquidi.

Questa immagine mostra il resoconto del flusso di liquidi dopo il Capitolo 7, Carte di credito.

2. Controllare ora il corrispondente resoconto delle transazioni per il conto Visa.

Selezionare il resoconto delle transazioni dal menu Resoconti → Resoconto delle transazioni.
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Questa immagine mostra il resoconto delle transazioni per il conto Visa nei mesi di Marzo e Aprile.

3. Cambiare ora il resoconto delle transazioni in modo da mostrare solamente i vari conti delle uscite.
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Questa immagine mostra il resoconto delle transazioni per i vari conti delle uscite nel mese di
Aprile.
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Capitolo 8. Prestiti
Questo capitolo spiega come gestire un mutuo con GnuCash.

Concetti base
Un prestito è definito come una transazione finanziaria in cui una parte paga per l’utilizzo del denaro
fornito da un’altra parte. Esistono molti esempi comuni di prestiti: le carte di credito, le rate dell’auto,
i mutui per la casa o un prestito per l’impresa.

Terminologia
Prima di discutere specificatamente come vengono trattati i prestiti inGnuCash, è utile presentare un
glossario sulla terminologia. I termini riportati più sotto, costituiscono alcuni dei concetti base riguar-
danti i prestiti. Si raccomanda di prendere familiarità con questi termini o, almeno, fare riferimento a
questa lista se si incontrassero dei termini non conosciuti nelle sezioni successive.

• Piano di ammortamento - il progetto di ripagamento per assicurare che il prestito verrà interamente
restituito, tipicamente utilizzando delle rate mensili costanti. Questi pagamenti sono normalmente
suddivisi in una parte per ripagare il principale e in una parte relativa agli interessi; l’importo del
principale aumenta con l’avanzare delle rate mentre gli interessi diminuiscono.

• Debitore - l’individuo o la società che riceve in prestito il denaro.

• Insolvenza - quando il debitore non è in grado di pagare il prestito nei termini stabiliti con il creditore.

• Rinvio - un ritardo temporaneo nel rimborso di un prestito.

• Mora - è il termine che si riferisce ai pagamenti ritardati.

• Montante - importo del prestito pagato al debitore. Alcuni prestiti prevedono pagamenti multipli,
nel senso che il debitore non riceve l’importo totale del prestito in una volta sola.

• Interesse - il prezzo praticato dal creditore al debitore per l’uso del denaro prestato. Generalmente
si esprime in percentuale annua sul capitale prestato, denominato tasso annuo nominale o TAN.

• Creditore - la società o la persona che presta il denaro al debitore.

• Tassa per il prestito - un tassa per le operazioni prelevata dal capitale nel momento in cui il debitore
riceve il prestito.

• Somma capitale o principale - l’importo originale del prestito, o l’importo del prestito originale
ancora da pagare. Quando si paga una rata del prestito, una parte del denaro è per pagare gli interessi
e una parte è per pagare il capitale.

• Pagherò - il contratto legale tra debitore e creditore relativo al prestito.

Impostare i conti
Quando un debitore ottiene un prestito, normalmente ha l’intenzione di acquistare un oggetto di un
certo valore. Infatti, alcuni prestiti richiedono che il contraente acquisti un determinato bene, come
una casa. Questo bene rappresenta un’assicurazione per il creditore nei riguardi dell’insolvenza del
debitore. Esistono tuttavia esempi di prestiti che non hanno necessariamente associato un bene di
grande valore: per esempio i prestiti per gli studi.

Per la struttura dei conti presentata nel seguito, si assumerà che il prestito sia utilizzato per acquistare
un bene di valore.
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Il prestito è una passività, l’interesse risultante dal prestito è un’uscita in corso mentre ogni tassa
amministrativa che sia necessario pagare rappresenta un’altra uscita; infine, l’oggetto acquistato con
il denaro prestato, è un patrimonio. Con questi parametri, si può costruire una struttura di base dei
conti per un prestito:

Struttura di conti elementare per un prestito

-Attività
    -Beni mobili
        -conto risparmio
    -Beni immobili
        -beni acquistati
-Passività
   -Prestiti
       -Mutuo
-Uscite
   -Interessi
       -Interessi sul mutuo
   -Tasse amm. del mutuo
  

GnuCash possiede un certo numero di strutture di conti per prestiti predefinite, quali i prestiti per l’auto

e il mutuo per la casa. Per accedere a queste strutture predefinite selezionare File → Nuova struttura
conti e selezionare il tipo di prestito a cui si è interessati.

Calcoli
Determinare i piani di ammortamento per un prestito, gli importi delle rate, il valore totale o i tassi
di interesse può risultare a volte complesso. Per assistere l’utente in questo tipo di calcoli, GnuCash

incorpora un calcolatore di prestiti. Per accedervi, selezionare la voce Strumenti → Calcolatore di
prestiti.

Il calcolatore di prestiti di GnuCash.

Il calcolatore di prestiti può essere utilizzato per calcolare ognuno di questi parametri: Numero di rate,
Tasso di interesse, Valore attuale, Rata , o Valore futuro, ammesso che gli altri quattro siano stati
definiti. Sarà inoltre necessario specificare l’interesse composto e il metodo di pagamento.
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• Numero di rate - il numero di rate in cui è suddiviso il prestito.

• Tasso di interesse - il tasso di interesse nominale del prestito, per esempio il tasso annuo di interesse.

• Valore attuale - il valore a oggi del prestito, per esempio l’importo ancora da versare per estinguere
il prestito.

• Rata - l’importo da pagare come rata.

• Valore futuro - il valore futuro del prestito, per esempio l’importo ancora da versare alla scadenza
del prestito.

• Interesse composto - esistono due metodi per calcolare l’interesse composto, discreto o continuo.
Per l’interesse composto discreto, selezionare la frequenza dal menu a tendina con un intervallo
variabile da annuale a quotidiano.

• Rata - il menu a tendina permette la scelta della frequenza di pagamento con un intervallo che
va dall’anno al giorno. Si può anche scegliere se il pagamento avviene all’inizio od alla fine del
periodo. Ai pagamenti all’inizio del periodo viene applicato il tasso di interesse can also select
whether your payments occur at the beginning or end of the period. Payments made at the beginning
of the payment period have interest applied to the payment as well as any previous money paid or
money still owed.

Esempio: rate mensili
Quale sarebbe la rata mensile per un prestito di €100.000 da restituire in 30 anni a un tasso costante
del 4% composto mensilmente?

Questa situazione è mostrata nell’immagine d’esempio più in alto. Per eseguire questo calcolo, si de-
ve impostare il numero di rate a 360 (12 mesi per 30 anni), il tasso di interesse a 4, il valore attuale
a 100.000, lasciare vuoto il capo della rata e impostare il valore futuro a 0 (si desidera estinguere
completamente il prestito e non avere altro da pagare alla fine del mutuo). L’interesse composto va
impostato a mensilmente, le rate sono anch’esse mensili assumendo il pagamento alla fine del perio-
do e l’interesse composto discreto. Premere quindi il pulsante Calcola. Il risultato dovrebbe essere
€-477.42.

Risposta: la rata mensile ammonterebbe a €477.42.

Esempio: durata del prestito
Per quanto tempo si dovrebbe pagare un prestito di €20.000 al tasso fisso del 10% composto mensil-
mente e pagando una rata mensile di €500?

Per eseguire questo calcolo, lasciare vuoto il campo del numero di rate, impostare il tasso di interesse
a 10, il valore attuale a 20.000, l’importo della rata a -500 e il valore futuro a 0 (si desidera estinguere
completamente il prestito e non avere altro da pagare alla fine dello stesso). L’interesse composto va
impostato a mensilmente, le rate sono anch’esse mensili assumendo il pagamento alla fine del periodo
e l’interesse composto discreto. Premere quindi il pulsante Calcola. Il risultato dovrebbe essere 49.

Risposta: si dovrà pagare il prestito per 4 anni e 1 mese (49 mesi).

Avanzato: dettagli sui calcoli
Per poter discutere le formule matematiche utilizzate dal calcolatore di prestiti, è necessario definire
prima di tutto alcune variabili.
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 n  == numero di rate
 %i  == tasso di interesse nominale applicato TAN
 PV  == valore attuale
 PMT == rata
 FV  == valore futuro
 CF == frequenza di composizione per anno
 PF == frequenza di pagamento per anno

Valori comuni per CF e PF sono:
   1   == annuale
   2   == semestrale
   3   == quadrimestrale
   4   == trimestrale
   6   == bimestrale
   12  == mensile
   24  == quindicinale
   26  == bisettimanale
   52  == settimanale
   360 == giornaliero
   365 == giornaliero

Conversione fra tasso di interesse nominale e effettivo

Quando si ha bisogno della soluzione per n, PV, PMT o FV, Il tasso di interesse nominale «i» deve
prima essere convertito in quello effettivo «ieff». Quest’ultimo è poi utilizzato per calcolare la variabile
selezionata. Quando si vuole invece conoscere il valore di «i», il calcolo fornisce il tasso di interesse
efficace «ieff». Quindi, occorre conoscere la relazione che lega i valori di «i» e di «ieff».

Per calcolare «i» noto «ieff», vengono utilizzate le seguenti espressioni:
Interesse discreto:     ieff = (1 + i/CF)^(CF/PF) - 1
Interesse continuo: ieff = e^(i/PF) - 1 = exp(i/PF) - 1

Per calcolare «ieff» noto «i», vengono utilizzate le seguenti espressioni:
Interesse discreto:      i = CF*[(1+ieff)^(PF/CF) - 1]
Interesse continuo: i = ln[(1+ieff)^PF]

Nota

NOTA: nelle equazioni seguenti per le transazioni finanziarie, tutti i tassi di interesse indicati
sono effettivi cioè «ieff». Per maggiore brevità si utilizzerà comunque il simbolo «i» come
abbreviazione di «ieff».

L’equazione fondamentale della finanza

Una sola equazione lega tutte e 5 le variabili. Questa formula è nota come l’equazione fondamentale
della finanza:

PV*(1 + i)^n + PMT*(1 + iX)*[(1+i)^n - 1]/i + FV = 0

  Dove: X = 0 per i pagamenti alla fine del periodo, e
        X = 1 per i pagamenti all’inizio del periodo

Partendo da questa equazione, possono essere ricavate le relazioni che esplicitano ogni variabile. Per
una spiegazione più dettagliata su come vengono ricavate queste equazioni, consultare il file src/
calculation/fin.c nel codice sorgente di
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A = (1 + i)^n - 1
B = (1 + iX)/i
C = PMT*B

n = ln[(C - FV)/(C + PV)]/ln((1 + i)
PV = -[FV + A*C]/(A + 1)
PMT = -[FV + PV*(A + 1)]/[A*B]
FV = -[PV + A*(PV + C)]

The solution for interest is broken into two cases.
The simple case for when  PMT == 0 gives the solution:
i = [FV/PV]^(1/n) - 1

Il caso in cui PMT != 0 è piuttosto complesso e non verrà discusso in questa sede. Invece di prevedere
una funzione esplicita, la determinazione del tasso di interesse quando PMT !=0, prevede un metodo
iterativo. Consultare il file sorgente src/calculation/fin.c per una spiegazione dettagliata.

Esempio: rate mensili

Ricalcolare la sezione chiamata «Esempio: rate mensili», usando però le formule matematiche anziché
il calcolatore di prestiti. Quale sarebbe la rata mensile per un prestito di €100.000 da restituire in 30
anni a un tasso costante del 4% composto mensilmente?

Si definiscano per prime le variabili: n = (30*12) = 360, PV = 100000, PMT = incognita, FV = 0, i =
4%=4/100=0.04, CF = PV = 12, X = 0 (pagamento alla fine del periodo).

Il secondo passo consiste nel convertire il tasso di interesse nominale «i» in quello effettivo «ieff».
Dato che l’interesse è composto mensilmente ed è discreto si utilizza la formula: ieff = (1 + i/CF)^(CF/
PF) - 1, che fornisce ieff = (1 + 0.04/12)^(12/12) - 1, quindi ieff = 1/300 = 0.0033333.

È ora possibile calcolare A e B. A = (1 + i)^n - 1 = (1 + 1/300)^360 - 1 = 2.313498. B = (1 + iX)/
i = (1 + (1/300)*0)/(1/300) = 300.

Noti A e B, si può calcolare PMT. PMT = -[FV + PV*(A + 1)]/[A*B] = -[0 + 100000*(2.313498 +
1)] / [2.313498 * 300] = -331349.8 / 694.0494 = -477.415296 = -477.42.

Risposta: la rata mensile ammonterebbe a €477.42.

Mutuo per la casa (come fare)
Un mutuo per la casa può essere impostato usando la struttura del conto descritta nella la sezione
chiamata «Impostare i conti».

Come esempio, si assuma di avere €60.000 nel proprio conto bancario e si supponga di acquistare
una casa di valore pari a €150.000. Il mutuo applica un APR del 6% e ha dei costi amministrativi (ad
esempio costi di chiusura ecc...) del 3%. Si decida di versare €50.000 e di chiedere in prestito i restanti
€103.000, che rimarranno €100.000 dopo il pagamento dei costi di chiusura (3% di €100.000).

I conti prima di chiedere in prestito il denaro:
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I conti prima di ricevere il prestito

L’acquisto della casa è registrato con una transazione suddivisa nel conto Attività:Casa, con €50.000
provenienti dalla banca (ad esempio: l’anticipo) e €100.000 provenienti dal mutuo. Si possono inserire
anche i 3.000€ di costi di chiusura nella stessa suddivisione aumentando così l’importo del prestito
a €103.000.

Tabella 8.1. Transazione suddivisa per l’acquisto di una casa

Conto Aumento Diminuzione

Attività:Beni immobili:Casa €150.000

Attività:Attività correnti:Banca €50.000

Passività:Prestiti:mutuo €103.000

Uscite:Imposte amministrative
per il mutuo

€3.000

La suddivisione assomiglierà a questa nel conto Attività:Beni immobili:Casa:
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Transazione suddivisa per il mutuo

Mentre la struttura dei conti sarà come questa:

Conti per il mutuo

Prestito personale a un amico (come fare)
Il denaro non si chiede in prestito esclusivamente alla banca; a volte si può richiedere anche a dei
famigliari o amici; addirittura può essere un amico a chiedere in prestito del denaro. In questo capitolo
verrà descritto come comportarsi nel caso si voglia prestare del denaro.

L’esempio descritto sarà basato sulla seguente struttura dei conti.

-Asset
   -Bank
        -Bank Account
   -Money owed to you
        -Person
-Income
   -Interest Income
        -Person
  

Questo esempio mostrerà come gestire un prestito personale di 2.000 EUR (valuta predefinita) al
proprio amico di nome Mario

Caratteristiche del prestito
Mario desidera avere in prestito €2.000 e prevede di poter ripagare il prestito mensilmente nei 18
mesi seguenti. Dato che è un amico, (ma non così tanto) si decide di applicare un tasso di interesse
annuale del 5%.
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In conclusione si hanno i dati seguenti:

• Importo del principale - €2.000

• Termini - 18 mesi con 12 pagamenti per ogni anno

• Tasso di interesse annuale: 5%

• Importo del pagamento mensile: ??

Come calcolare il pagamento mensile (cioè la rata) che Mario deve versare?

Sono disponibili diverse opzioni quali carta e penna, la calcolatrice di Linux, Il modulo Calc di Open
Office, ma il metodo più semplice consiste nell’utilizzare il calcolatore di prestiti incorporato in Gnu-
Cash. Esso fornisce un valore della rata pari a 115,56 €.

Per tenere una contabilità rigorosa è necessario conoscere la frazione che compete al principale e la
frazione che compete agli interessi. A questo scopo occorre uno strumento più potente come il modulo
Calc di OpenOffice e in particolare la funzione PMT.

Vista dettagliata del prestito personale in favore di Mario

Conti per il prestito
Si inizi con i conti seguenti (tutti i conti hanno la stessa valuta, in questo caso EUR)

Attività:Banca:EUR
Attività:Denaro prestato:Mario
Entrate:Interessi in entrata:Mario
Capitale:Bilanci di apertura:EUR
  

Prestare il denaro
When you have lent money to your friend, you have in fact moved money from an Asset account (like
Bank, Checking or similar) to your Asset account Money owed to you. To record this you enter the
following transaction into the Assets:Money owed to you:Friend account.

Tabella 8.2. Prestito personale a un amico

Conto Aumento Diminuzione
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Attività:Denaro prestato:Amico €2.000

Attività:Banca:EUR €2.000

Struttura dei conti dopo aver dato in prestito il denaro

Ricevere il primo pagamento
Alla ricezione del primo pagamento (€115,56), sarà necessario determinare la quota che compete al
principale e quella di competenza degli interessi.

• Importo del prestito da restituire per il mese corrente = €2,000

• Pagamento mensile = €115,56

• Scomposizione del pagamento

• 5%/12 x €2.000 = €8,33 Interesse

• €115,56 - €8,33 = €107,23 Principale

In GnuCash questi dati sono inseriti come nel seguito

Vista dettagliata del primo pagamento

Il saldo del prestito di Mario è ora €2.000 - €107,23 = €1.892,77
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Ricevere il secondo pagamento
Al ricevimento del secondo pagamento (€115,56), sarà di nuovo necessario determinare le quote che
competono al principale e agli interessi.

• Importo del prestito da restituire per il mese corrente = €1.892,77

• Pagamento mensile = €115,56

• Scomposizione del pagamento

• 5%/12 x €1.892,77 = €7,89 Interesse

• €115,56 - €7,89 = €107,67 Principale

In GnuCash questi dati sono inseriti come nel seguito

Vista dettagliata del secondo pagamento

Il saldo del prestito a Mario è ora di €1.892,77 - €107,67 = €1.785,10

La struttura dei conti è ora come questa

La struttura dei conti dopo la seconda rata
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Come si nota, l’importo degli interessi e del principale cambiano ogni mese; così per ogni pagamen-
to che si riceve è necessario calcolare gli importi corretti per le varie suddivisioni da inserire nella
transazione.

L’importo dell’interesse diminuirà per ogni pagamento che si riceve (essendo calcolato su un valore
del prestito sempre più piccolo), fino all’ultima rata in cui l’importo degli interessi sarà prossimo allo
zero. Si esamini la figura dell vista dettagliata del prestito personale a Mario per maggiori dettagli.

Prestito per l’auto (come fare)
Il prestito per l’acquisto di un’auto è trattato più o meno allo stesso modo del mutuo per la casa; le
uniche differenze risiedono in una nomenclatura diversa dei conti e in un differente tasso di interesse.

Semplice struttura dei conti per un prestito per l’acquisto di un’auto

-Attività
    -Attività correnti
        -Conto risparmio
    -Beni immobili
        -Auto
-Passività
   -Prestiti
       -Prestito per l’auto
-Uscite
   -Interessi
       -Interessi sul prestito per l’auto
   -Imposte amm. sul prestito per l’auto

Per maggiori informazioni, consultare la la sezione chiamata «Mutuo per la casa (come fare)»

Riconciliazione con il resoconto del prestito
(come fare)

La riconciliazione con il resoconto del prestito avviene allo stesso modo della riconciliazione di un
conto bancario con l’estratto conto.

Durante tutto il periodo dovrebbero essere state registrate tutte le transazioni relative al prestito per
l’auto e ognuna di esse dovrebbe aver interessato il conto Passività:Prestiti:Prestito. In pratica,
il pagamento di una rata del prestito, diminuisce il saldo del conto bancario e aumenta il saldo del
conto del prestito, del conto degli interessi del prestito ed eventualmente del conto delle imposte
amministrative sul prestito.

Avendo sott’occhio il resoconto cartaceo del prestito, aprire il conto del prestito, avviare la procedura
di riconciliazione e spuntare tutte le transazioni registrate. Al termine di questa operazione, la diffe-
renza di riconciliazione deve essere pari a 0 e, se non lo è, controllare che tutte le transazioni presenti
nel resoconto cartaceo siano riportate anche in GnuCash ed eventualmente individuare le differenze.
Quando finalmente la differenza è nulla, il conto è riconciliato ed è possibile terminare la riconcilia-
zione.

Per avere maggiori informazioni sul processo di riconciliazione, consultare la la sezione chiamata
«Riconciliazione»

Vendere una casa o un’auto (come fare)
Per registrare in GnuCash l’acquisto della propria casa, si hanno diverse possibilità. Nel seguito ne
verranno analizzate due: una in cui è stato registrato solamente l’importo dell’acquisto e ora l’importo
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di vendita, l’altra in cui è stato seguito l’andamento del mercato immobiliare e sono stati registrati i
vari guadagni non realizzati con il passare del tempo.

Transazione semplice
In questo modo si registrerà solamente il prezzo di vendita.

Nel seguito verranno presentati due esempi di vendita di una casa; uno con profitto e uno in perdita.
Per vendere invece un’auto, basta sostituire i conti per la casa con quelli per l’auto.

-Attività
  -Beni immobili
    -Casa
  -Attività correnti
    -Conto risparmi
-Entrate
  -Guadagni in capitale (lungo)
    -Casa
    

• Si supponga di aver acquistato tempo fa una casa per €300.000, e che ora si riesca venderla per
€600.000. Come registrarlo in GnuCash?

È necessario aumentare il saldo del conto bancario di €600.000 e diminuire il saldo di un altro conto
di €600.000. Il conto per la casa contiene solamente €300.000 cioè il prezzo di acquisto, così que-
sto importo deve essere spostato nel conto bancario. Mancano ancora però €300.000; questi devo-
no essere prelevati dal conto Entrate:Guadagni in capitale (lungo):Casa. La transazione suddivisa
inserita nel proprio conto della banca (Attività:Beni immobili:Conto risparmio) dovrebbe assomi-
gliare a questa.

Tabella 8.3. Vendere un bene (casa) con un profitto

Conto Aumento Diminuzione

Attività:Attività correnti:Conto
risparmio

€600.000

Attività:Beni immobili:Casa €300.000

Entrate:Guadagni in capitale
(lungo):Casa

€300.000

• Si supponga di aver acquistato tempo fa una casa per €300.000 ma, a causa della costruzione di un
aeroporto nelle vicinanze, sia ora possibile venderla per soli €230.000. Come registralo in GnuCash?

Per poterlo registrare il conto bancario deve aumentare di €230.000 e un altro conto deve diminuire
della stessa cifra. Il conto per la casa contiene €300.000 che è un valore superiore a quello di vendita;
spostare solamente €230.000 da questo conto verso quello bancario. Rimangono ancora €70.000
sul conto della casa che devono essere rimossi spostandoli nel conto Entrate:Guadagni in capitale
(lungo):Casa come perdita. La transazione suddivisa da inserire nel conto della casa (Attività:Beni
Immobili:Casa) dovrebbe essere come questa.

Tabella 8.4. Vendere un bene (casa) in perdita

Conto Aumento Diminuzione

Attività:Beni immobili:Casa €300.000

Attività:Attività correnti:Conto
risparmio

€230.000
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Entrate:Guadagni in capitale
(lungo):Casa

€70.000

Una transazione più complessa
In questo esempio verranno illustrati alcuni concetti di contabilità più complessi. Per maggiori dettagli
sul questo argomento, consultare Capitolo 11, Guadagni in conto capitale

Nel seguito si ipotizzerà che che sia stato accuratamente stimato il valore della propria casa. Negli
altri casi (sovra e sottostima), si consulti il Capitolo 11, Guadagni in conto capitale.

-Attività
    -Beni immobili
        -Casa
            -Costo
            -Guadagni non realizzati
    -Attività correnti
        -Conto risparmi
-Entrate
    -Guadagni realizzati
        -Casa
    -Guadagni non realizzati
        -Casa
    

Si supponga di aver acquistato in passato una casa per €300.000 e che sia stato tenuto sotto controllo
il mercato immobiliare registrando il valore della casa a una certa data. Al momento di venderla, è
stato determinato un valore di mercato pari a €600.000.

La differenza tra €600.000 (valore di mercato stimato) e €300.000 (costo di acquisto) è l’attuale valore
del guadagno non realizzato. Quindi si ha un valore totale di €300.000 nel proprio conto Attività:Beni
immobili:Casa:Guadagni non realizzati.

Come registrare questa transazione di vendita?

Per registrala si dovrà aumentare il saldo del conto bancario di €600.000 e diminuire il saldo di un
altro conto di €600.000. Prima di tutto occorre cambiare il conto delle entrate da guadagni non realiz-
zati a guadagni realizzati. Infine è sufficiente trasferire l’intero importo dal sottoconto Attività:Beni
immobili:Casa.

La transazione inserita nel conto Entrate:Guadagni realizzati:Casa dovrebbe assomigliare a questa.

Tabella 8.5. Vendere un bene (casa) con un profitto

Conto Aumento Diminuzione

Entrate:Guadagni realizzati:Ca-
sa

€300.000

Entrate:Guadagni non realizza-
ti:Casa

€300.000

La transazione inserita nel conto Attività:Attività correnti:Conto risparmio dovrebbe assomigliare a
questa.

Tabella 8.6. Vendere un bene (casa) con un profitto 2

Conto Aumento Diminuzione
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Attività:Attività correnti:Conto
risparmio

€600.000

Attività:Beni immobili:Ca-
sa:Costo

€300.000

Attività:Beni immobili:Ca-
sa:Guadagni non realizzati

€300.000

Dopo la registrazione della transazione, si noterà che il conto della Casa ha un valore nullo, il Conto
risparmi è aumentato di €600.000 e, in ultimo, il conto Entrate:Guadagni realizzati è aumentato di
€300.000.
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Capitolo 9. Investimenti
Questo capitolo spiega come gestire i propri investimenti con GnuCash. La maggior parte delle persone
ha un piano di investimento, sia che si tratti di certificati di deposito o di un piano sponsorizzato dalla
società in cui si lavora, sia che si tratti di acquistare e vendere azioni e bond attraverso una società
di mediazione. GnuCash fornisce degli strumenti utili per gestire questi investimenti quali l’Editor
prezzi che permette di registrare le variazioni dei prezzi delle azioni che si posseggono.

Concetti base
Un investimento è qualsiasi bene che viene acquistato nella speranza che generi un’entrata, o che si
desidera vendere in futuro a un prezzo maggiore di quello con cui è stato acquistato. Partendo da questa
semplice definizione, molte cose possono essere considerate degli investimenti: la casa in cui si abita,
un quadro di valore, le azioni di una società vendute pubblicamente, il conto dei risparmi in banca o
un certificato di deposito. Queste tipologie di investimento verranno discusse in questo capitolo per
quanto riguarda la loro registrazione in GnuCash.

Terminologia
Prima di discutere specificatamente degli investimenti, è utile avere presente un glossario sulla termi-
nologia relativa agli investimenti. I termini presentati più sotto, rappresentano alcuni dei concetti di
base e specifici degli investimenti. Si consiglia di acquisire familiarità con essi o, almeno, rifarsi a
questa sezione se si incontrassero dei termini dubbi nelle sezioni successive.

Capital gains The difference between the purchase and
selling prices of an investment. If the sel-
ling price is lower than the purchase pri-
ce, this is called a capital loss. Also kno-
wn as realized gain/loss.

Commissionie The fee you pay to a broker to buy or sell
securities.

Azione ordinaria A security that represents a certain frac-
tional ownership of a company. This is
what you buy when you «buy stock» in a
company on the open market. This is also
sometimes known as capital stock.

Interesse composto The concept that the reinvested interest
can later earn interest of its own (intere-
st on interest). This is often referred to as
compound interest.

Dividendi Sono dei pagamenti in contanti che una
società versa ai propri azionisti. L’impor-
to di questi pagamenti è generalmente de-
terminato come una frazione dei profitti
della società. Si noti che non tutte le azio-
ni ordinarie forniscono i dividendi.

Capitali Sono investimenti in cui l’investitore di-
viene parte o unico possessore della pro-
prietà di un bene. Sono comprese le azio-
ni di una società or real estate.

Interesse What a borrower pays a lender for the use
of their money. Normally, this is expres-
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sed in terms of a percentage of the prin-
cipal per year. For example, a savings ac-
count with 1% interest (you are the len-
der, the bank is the borrower) will pay
you $1 for every $100 you keep there per
year.

Liquidità A measure of how easily convertible an
investment is to cash. Money in a savings
account is very liquid, while money inve-
sted in a house has low liquidity because
it takes time to sell a house.

Somma capitale The original amount of money invested
or borrowed.

Guadagni e perdite realizzati o non realizzati Le perdite e i guadagni non realizzati si
hanno quando si verifica una variazione
del prezzo di un bene. La perdita o il gua-
dagno si realizzano nel momento in cui
il bene viene venduto. Consultare anche
guadagno e perdita in conto capitale.

Profitto The total income plus capital gains or los-
ses of an investment. See also Yield.

Rischio The probability that the return on invest-
ment is different from what was expec-
ted. Investments are often grouped on a
scale from low risk (savings account, go-
vernment bonds) to high risk (common
stock, junk bonds). As a general rule of
thumb, the higher the risk the higher the
possible return.

Azionista A shareholder is a person who holds com-
mon stock in a company.

Frazionamento azionario Occurs when a company offers to issue
some additional multiple of shares for
each existing stock. For example, a «2 for
1» stock split means that if you own 100
shares of a stock, you will receive an ad-
ditional 100 at no cost to you. The unit
price of the shares will be adjusted so the-
re is no net change in the value, so in this
example the price per share will be hal-
ved.

Valuation The process of determining the market
value or the price the investment would
sell at in a «reasonable time frame».

Rendimento A measure of the amount of money you
earn from an investment (IE: how much
income you receive from the investment).
Typically this is reported as a percenta-
ge of the principal amount. Yield does
not include capital gains or loses (see Re-
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turn). Eg: A stock sells for $100 and gi-
ves $2 in dividends per year has a yield
of 2%.

Tipologie di investimento
Di seguito vengono proposti alcuni dei tipi più diffusi di investimenti e, per ognuno di essi, degli
esempi.

• Conti o documenti che fruttano interessi

Questo tipo di investimenti permette generalmente di accedere immediatamente al denaro; tipica-
mente vengono pagati degli interessi mensili sulla base del denaro depositato. Esempi sono il conto
bancario per i risparmi (e alcuni conti correnti che fruttano anche degli interessi) e i conti liquidi
presso la società di intermediazione. Essi rappresentano degli investimenti a rischio molto basso:
negli Stati Uniti questi conti sono assicurati contro le perdite fino a un limite determinato.

A volte, gli investimenti che producono interessi, sono bloccati temporalmente. Questo tipo di in-
vestimenti richiede che il denaro venga investito per un certo periodo di tempo nel quale si rice-
ve un tasso di guadagno predefinito. Generalmente, maggiore è la durata e maggiore è il tasso di
interesse. Se si preleva del denaro prima della data di maturazione, occorre pagare una penale. Si
tratta di investimenti a rischio relativamente basso. Esempi sono i certificati di deposito o alcuni
bond governativi. Altri tipi di bond possono avere un rendimento più elevato sulla base del maggior
rischio dovuto alla qualità del «tasso di credito» dell’ente che li ha emessi.

• Azioni e fondi comuni

Questo tipo di investimenti avviene in favore di una società di cui si diviene proprietari di una quota.
Generalmente non sussistono limiti di tempo per le azioni scambiate pubblicamente, ma potrebbero
esserci delle variazioni sulle tasse da pagare per i guadagni in conto capitale a seconda del tempo in
cui si è rimasti proprietari dell’azione. Quindi le azioni, sono tipicamente abbastanza liquide dato
che è possibile riavere il possesso del proprio denaro piuttosto velocemente. Questi investimenti
comportano un alto rischio perché non viene garantito il prezzo futuro dell’azione.

Un fondo comune rappresenta un meccanismo di investimento a gruppo in cui è possibile acquistare
diverse azioni contemporaneamente. Per esempio, un «S&P 500 index fund» è un fondo che acquista
tutte le 500 azioni elencate nell’indice «Standard and Poor’s». Quando si acquista una quota di
questo fondo, si acquista di fatto un piccolo importo di ognuna di queste azioni contenute nel fondo. I
fondi comuni sono trattati esattamente come una singola azione sia per quanto riguarda la tassazione
che per quanto concerne la contabilità.

• Beni immobili

I beni che aumentano il loro valore nel tempo rappresentano un’altra forma di investimento. Ne
sono degli esempi la casa, un appezzamento di terreno o un quadro di valore. Il valore di questo tipo
di investimenti è difficile da quantificare fino al momento della vendita. Il carico di tasse derivante
dalla vendita varia in funzione del bene. Per esempio, si può usufruire di detrazioni d’imposta nella
vendita di una casa se questa è la residenza principale, ma questo tipo di agevolazione potrebbe non
essere applicata alla vendita di un quadro.

Gli investimenti in beni immobili sono discussi in Capitolo 11, Guadagni in conto capitale e Capi-
tolo 16, Deprezzamento. Generalmente non c’è molto da fare per la contabilità degli investimenti
in beni immobili tranne registrarne le transazioni di acquisto e di vendita.

Impostare i conti
Per impostare i conti per gli investimenti in GnuCash, si possono utilizzare le strutture predefinite
o creare la propria struttura personalizzata. Il minimo da fare per tracciare gli investimenti consiste
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nell’impostare un conto per ogni investimento. Comunque, come già visto nei precedenti capitoli, è
generalmente più logico creare un diagramma dei conti strutturato in modo da raggruppare gli inve-
stimenti tra loro correlati. Per esempio, si potrebbero voler raggruppare tutte le proprie azioni scam-
biate pubblicamente sotto un unico conto padre con il nome della società di mediazione utilizzata per
l’acquisto delle azioni stesse.

Nota

Indipendentemente da come è stata impostata la struttura dei conti, è sempre possibile spo-
stare i conti in seguito (senza perdere il lavoro svolto fino a quel punto); la struttura dei conti
non deve quindi essere perfetta da subito.

Uso dei conti predefiniti per gli investimenti
The Investment Accounts option of the New Account Hierarchy Setup assistant will automatically
create a basic investment account hierarchy for you. To access the predefined investment accounts
hierarchy, you must make sure your GnuCash file is open, switch to the Accounts tab, and choose

Actions → New Account Hierarchy. This will run the New Account Hierarchy Setup assistant and
allow you to select additional accounts to add to your account hierarchy. Choose the Investment Ac-
counts option (along with any others you are interested in). Assuming only investment accounts were
selected, this will create an account hierarchy as shown below.

Suggerimento

É anche possibile eseguire l’assistente per l’Impostazione di una nuova struttura dei conti
creando un nuovo file di GnuCash.

Questa immagine mostra la schermata della scheda Conti dopo la creazione di un nuovo file e la scelta
dei soli conti investimenti predefiniti.

Probabilmente sarà necessario aggiungere almeno un conto di tipo Banca alla famiglia Attività e an-
che un conto Capitali:Bilanci d’apertura, come è già stato spiegato nei capitoli precedenti. Non si
dimentichi di salvare il nuovo file creato con un nome adatto.
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Creazione manuale dei conti per gli investimenti
If you want to set up your own investment accounts hierarchy, you may of course do so. Investments
usually have a number of associated accounts that need to be created: an asset account to track the
investment itself; an income account to track dividend transactions; and expense accounts to track
investment fees and commissions.

In a typical account structure, security accounts are sub accounts of an asset account representing an
account at a brokerage firm. The brokerage account would be denominated in your local currency and
it would include sub accounts for each security that you trade there.

Related purchases, sales, income and expense accounts should also be in the same currency as the
brokerage account.

The security sub accounts would each be configured to contain units of a single security selected from
the master (user defined) security list and they are expected to use the same currency as the brokerage
account.

Security prices are kept in a separate area of GnuCash (the Price Database - Tools  → Price Editor).
This contains prices for individual securities (not security accounts). All prices for an individual se-
curity are in a single currency. If a security is traded in multiple currencies, then a separate security
and separate accounts should be set up of each currency.

Esempio di conti personalizzati
È anche possibile impostare la propria struttura dei conti personalizzata. Quella riportata di seguito,
rappresenta un esempio un po’ più complicato di impostazioni di GnuCash per tenere traccia dei propri
investimenti; questa impostazione presenta il vantaggio di raggruppare ogni investimento a seconda
della società di mediazione che si occupa dell’investimento. In questo modo risulterà più facile con-
frontare i documenti che si ricevono dalla società di mediazione con i conti che si hanno in GnuCash
e individuare subito le eventuali discrepanze.

 Attività
    Investimenti
       Conto brokeraggio
          I*Trade
             Azioni
                ACME Corp
             Fondi del mercato monetario
                I*Trade Municipal Fund
             Cash
          Brocker
             Fondi del mercato monetario
                Active Assets Fund
             Titoli governativi
                Treas Bond xxx
                Treas Note yyy
             Fondi Comuni
                Fondo A
                Fondo B
             Liquidi
 Entrate
    Investimenti
       Conto brokeraggio
          Guadagni in capitale
             I*Trade

111



Investimenti

             Brocker
          Dividendi
             I*Trade
                Tassabile
                Non-tassabile
             Brocker
                Tassabile
                Non-tassabile
          Interest Income
             I*Trade
                Tassabile
                Non-tassabile
             Brocker
                Tassabile
                Non-tassabile
 Uscite
    Spese dell’investimento
       Commissioni
          I*Trade
          Brocker
       Costi di gestione
          I*Trade
          Brocker
 

Suggerimento

Non esiste una soluzione unica per l’impostazione della struttura dei conti per gli investi-
menti. Occorre provare disposizioni differenti fino a quando non si trova la soluzione che
suddivide i conti degli investimenti nel modo che si ritiene personalmente più logico.

Conti che maturano interessi
Gli investimenti che presentano un tasso di interesse fisso o variabile, rappresentano una delle più
semplici e diffuse forme di investimenti disponibili. Gli investimenti che fruttano interessi compren-
dono il conto in banca, i certificati di deposito o qualsiasi altra forma di investimento in cui si riceve
un interesse sulla somma capitale. Questa sezione descriverà come trattare questi tipi di investimenti
in GnuCash.

Impostare i conti

Quando si acquista un investimento fruttifero, è necessario creare un conto delle attività per registrare
l’acquisto dell’investimento stesso, un conto delle entrate per registrare il guadagno derivante dall’in-
teresse e un conto delle uscite per immettere le spese bancarie. Più sotto è riportato un esempio di
struttura in cui si ha un conto di risparmio che matura interessi e un certificato di deposito (CD) in
banca.

Attività
   Banca ABC
      CD
      Risparmio
Uscite
   Banca ABC
      Spese
Entrate
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    Interessi
      CD
      Risparmio
       

Come prima, questa struttura dei conti rappresenta solo un esempio; ognuno dovrebbe creare i conti
nella forma che rispecchia al meglio la propria situazione attuale.

Esempio

Con questo esempio si intende utilizzare dei numeri per rendere più reale quello descritto finora. Si
assuma di partire con €10.000 sul proprio conto bancario che fornisce l’1% di interessi; si acquisti poi
un certificato di deposito di €5.000 con una durata di 6 mesi e un rendimento del 2%. Naturalmente
è molto meglio investire il proprio denaro nel certificato di deposito che non nel conto di risparmio.
Dopo l’acquisto iniziale, i conti dovrebbero assomigliare a questi:

Questa immagine mostra il registro del conto dopo la creazione e l’investimento di denaro in un cer-
tificato di deposito.

Durante i sei mesi successivi, si riceverà un estratto conto della banca che descriverà l’attività sul
conto. Nell’esempio considerato, non viene eseguita nessuna operazione in questa banca e quindi le
uniche attività saranno le entrate dovute agli interessi e le spese bancarie; queste ultime ammontano a
€2. Trascorsi i 6 mesi, le finestre del registro per il certificato di deposito (CD) e del conto risparmio
dovrebbero presentarsi così:
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Questa immagine mostra il registro del conto per il certificato di deposito, trascorsi i 6 mesi.

Questa immagine mostra il registro del conto di risparmio, trascorsi i 6 mesi.

E questa è la finestra principale dei conti di GnuCash:

Questa immagine mostra i conti dopo 6 mesi.

Nell’immagine della finestra principale di GnuCash, è presente un interessante sommario di ciò che
è successo agli investimenti nell’arco dei sei mesi. Mentre il rendimento del certificato di deposito
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è doppio rispetto a quello del conto dei risparmi, il guadagno con il certificato di deposito è stato di
€50,21 contro i €13,03 del conto dei risparmi: in pratica il quadruplo. Questo è dovuto alla fastidiosa
commissione bancaria di €2 che interessa il conto di risparmio (in 6 mesi la commissione ammonta
a €12).

Dopo il periodo di 6 mesi, il certificato di deposito è maturato; questo significa che è possibile venderlo
senza dover pagare alcuna penale. per farlo, è sufficiente trasferire i €5.050,21 dal conto del certificato
al conto dei risparmi.

Impostare il portafoglio dell’investimento
Now that you have built an account hierarchy in the previous section, this section will show you
how to create and populate the accounts with your investment portfolio. After this initial setup of
your portfolio, you may have shares of stock purchased from before you started using GnuCash. For
these stocks, follow the instructions in the Entering Preexisting Shares section below. If you have just
purchased your stocks, then use the Buying New Shares  section.

Impostare i conti per le azioni e per i fondi comuni
Questa sezione mostrerà come aggiungere dei conti per le azioni e per i fondi comuni in GnuCash.
In questa sezione, si ipotizzerà di utilizzare la struttura dei conti di base introdotta nella sezione pre-
cedente, ma i principi qui descritti potranno essere applicati a qualsiasi struttura dei conti.

Si dovrebbe avere, all’interno del conto di livello principale Attività, un conto denominato Azioni.
Espandere la struttura ad albero dei conti facendo clic sull’«indicatore a triangolo che punta verso
destra» a fianco del nome del conto fino a raggiungere la profondità della struttura desiderata. A
questo punto occorre creare un sottoconto (di tipo azioni) del conto delle azioni per ogni azione che si
possiede: ogni azione ha un conto separato. La denominazione di questi conti è generalmente assegnata
utilizzando l’abbreviazione ticker dell’azione, anche se il nome assegnato può anche essere qualsiasi
parola che sia chiara per gli utilizzatori. Per esempio, è possibile nominare i conti come AMZN, IBM
e NST per le proprie azioni Amazon, IBM e NSTAR rispettivamente. Sotto è riportato un esempio
schematico di disposizione (che mostra solamente i sottoconti del conto delle attività).

 Attività
    Investimenti
       Conto brokeraggio
          Bond
          Fondi comuni
          Indice di mercato
          Azioni
             AMZN
             IBM
             NST
 

Nota

Se si desidera registrare le entrate (dividendi, interessi, guadagni in conto capitale) per singola
azione e per ogni fondo comune, sarà necessario creare i conti Entrate:Dividendi:SIMBOLO
AZIONE, Entrate:Guadagni in capitale (Lungo):SIMBOLO AZIONE, Entrate:Guadagni in
capitale (breve):SIMBOLO AZIONE e Entrate:Interessi:SIMBOLO AZIONE per ogni azione
che si possiede e che fornisce interessi e dividendi.

Esempio di conto per le azioni
Come esempio, si assuma di possedere attualmente 100 azioni di Amazon. Creare quindi il conto
AMZN evidenziando il conto Azioni e selezionando la voce del menu File+Nuovo conto. Verrà mo-
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strata la finestra per l’impostazione del nuovo conto; seguire la procedura descritta di seguito per im-
postare il nuovo conto delle azioni.

Finestra per il nuovo conto

1. Nome del conto - normalmente, utilizzare l’abbreviazione del simbolo ticker, per esempio:
«AMZN»

2. Codice del conto - è un campo opzionale; utilizzare il codice CUSIP, il simbolo riportato sui gior-
nali, l’ID della famiglia dei fondi comuni o un codice di propria scelta.

3. Descrizione - campo opzionale che può contenere una descrizione dettagliata della commodity o
dell’azione. Si noti che questo campo è mostrato di default nella finestra della struttura dei conti.

4. Tipo di conto - selezionare la tipologia di conto che sta per essere creato dalla lista in basso a sinistra.

5. Conto padre - selezionare il conto padre per il nuovo conto dalla lista in basso a destra. È possibile
espandere la lista se necessario.
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6. Creazione del nuovo titolo - per utilizzare una nuova azione, è necessario creare l’azione come una
nuova commodity

Nota

Be sure to first select Account Type Stock  or Mutual Fund so that the Select... button
brings up the list of securites rather than currencies.

• Selezionare Titolo/valuta - premere il pulsante Seleziona ... alla fine della riga del campo Tito-
lo/valuta. Occorre cambiare il titolo dal valore predefinito (la valuta predefinita) a quello dell’a-
zione. Verrà quindi aperta la finestra di Selezione del titolo.

• Type - Select the exchange where the security/commodity is traded (in this example NASDAQ).

Premere il pulsante Nuovo per aprire la finestra del Nuovo titolo.

Finestra di scelta del titolo

• Creare il titolo - premere il pulsante Nuovo... e inserire le informazioni appropriate per l’azione
nel modulo Nuovo titolo.

• Il Nome completo: è «Amazon.com».

• Il Simbolo/abbreviazione: è «AMZN». Il simbolo è l’identificativo utilizzato dalla fonte delle
quotazioni impostate alcune righe più sotto nel modulo. Si noti che diverse fonti possono
utilizzare simboli differenti; un esempio è Ericsson: nella borsa di Stoccolma è identificato
dal simbolo ERIC-B mentre su Yahoo è ERRICB.ST

• The Type: should already be NASDAQ, because this is what was selected in the security
selector, but you can change it here, including adding more categories. More information about
this can be found in the Help Manual in section 7.7, «Security Editor».

• Il Codice ISIN, CUSIP o altro consente di inserire un altro codice numerico o del testo (lasciare
vuoto in questo esempio).

• La Frazione scambiata: dovrebbe essere impostata alla frazione minima del titolo che può
essere scambiata, generalmente 1/100 o 1/10000.

• L’opzione «Ricevi quotazioni online» e i campi della fonte delle quotazioni e del fuso orario
devono essere selezionati per definire la fonte per l’aggiornamento online dei prezzi. Consul-
tare anche la sezione «Impostare automaticamente il prezzo delle azioni».

Nota

Se il pulsante Ricevi quotazioni online non è selezionabile, allora il pacchetto Finan-
ce::Quote non è installato. Consultare la «Installare Finance::Quote».
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Più sotto è riportata un’immagine di come dovrebbe apparire la finestra quando il processo
è terminato:

Finestra del nuovo titolo

• Salvataggio del titolo - premere il pulsante OK per salvare il nuovo titolo; verrà chiusa la
finestra del Nuovo titolo e si ritornerà alla finestra del Nuovo conto.

7. Selezione del titolo - si dovrebbe ora vedere il nuovo titolo creato come voce della lista a comparsa
di Titolo/valuta. Selezionarlo (probabilmente lo è già) e premere OK.

8. Frazione minima - specificare la minima frazione scambiata dell’azione o della commodity.

9. Note - inserire qui qualsiasi messaggio o nota relativo a questo titolo o commodity.

10.Relativo alle tasse - andare in Modifica → Opzioni Reseconto Tasse per abilitare questa opzione
se le transazioni in questo conto sono tassabili come entrate.

11.Segnaposto - abilitare l’opzione se questo conto è un «Segnaposto», cioè se non potrà contenere
delle transazioni.
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12.Fine - ora si dovrebbe essere automaticamente tornati alla finestra del nuovo conto, con la riga sim-
bolo/abbreviazione: impostata a «AMZN (Amazon.com)». Premere OK per salvare questo nuovo
conto delle azioni.

È stato creato il conto per le azioni Amazon e la finestra dei conti dovrebbe assomigliare a questa (si
noti che sono presenti anche altri conti: un conto bancario e un conto per i capitali):

Questa immagine è successiva alla creazione del primo conto per le azioni (AMZN)

Aprire la finestra del registro per il conto AMZN (doppio clic su di esso). Qui è mostrata la vista
del Portafoglio. Essa fornisce una panoramica del portafoglio delle azioni incluso il numero di unità
(quote per un’azione o un fondo comune) acquistate e vendute, il prezzo unitario per unità e l’importo
totale. Ovviamente, non sono ancora state acquistate o vendute delle azioni, e quindi il portafoglio
non contiene alcuna transazione.

Acquistare le quote

Immettere delle quote preesistenti

Per registrare le iniziali 100 quote dell’azione acquistate precedentemente, inserire, nella prima riga
della transazione, la data di acquisto (es: 1° Gennaio 2001), una descrizione (es: Acquisto iniziale), il
trasferimento da Capitali:Bilanci d’apertura, le quote (es: 100), e il prezzo (es: €20). Non è necessario
compilare la colonna Compra, dato che verrà completata automaticamente. In questo esempio si è
ipotizzato, per semplificare la procedura, che non ci siano delle commissioni da pagare. Il portafoglio
per l’azione AMZN dovrebbe essere simile a questo:
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Questa immagine mostra il registro delle transazioni per il conto AMZN dopo il primo «acquisto»
delle quote.

Si noti che il Saldo è espresso con l’unità della commodity (quote AMZN) e non con quella della
valuta. Quindi, il saldo ammonta a 100 (unità AMZN) invece di €2000. È così che dovrebbe essere.

Acquistare nuove quote
L’unica differenza tra l’impostazione dei conti per un nuovo acquisto di azioni e la configurazione per
un acquisto preesistente descritto nella sezione precedente, consiste nel fatto che invece di trasferire
il denaro dal conto Capitali:Bilanci d’apertura, si utilizza il proprio conto Attività:Banca ABC.

Si acquisteranno ora €5000 di azioni IBM, con una commissione di €100. Il primo passo consiste nella
creazione del conto delle azioni IBM. Verrà anche utilizzato il conto già esistente Uscite:Commissioni.
Se si desidera tracciare le commissioni separatamente per ogni azione, occorrerà creare un sottoconto
aggiuntivo.

Per la transazione, nella prima riga della transazione, inserire la data di acquisto (es: 3 Gennaio 2005),
una descrizione (es: Acquisto iniziale IBM), saltare il campo delle quote (che verrà calcolato) e infine
inserire il prezzo (es: €96,60) e l’acquisto (€5,000). Non è necessario compilare il campo delle Quote,
dato che verrà calcolato automaticamente. La riga seguente nella transazione suddivisa, sarà per il
conto Uscite:Commissioni in cui si inserirà nel campo compra il valore €100. La terza linea sarà per
il trasferimento dal conto Attività:Banca ABC:Risparmi di €5,100 per bilanciare la transazione. Il
portafoglio IBM dovrebbe apparire simile a questo:

Questa immagine mostra il registro delle transazioni per il conto IBM dopo il primo «acquisto» con
commissione.

Impostare il prezzo delle quote
Il valore di una commodity, come quello di un’azione, deve essere impostato. I conti per le azioni
tengono traccia della quantità di azioni in proprio possesso, ma il valore dell’azione è impostato nella
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finestra dell’Editor prezzi. I valori impostati nell’editor prezzi possono essere aggiornati manualmente
o automaticamente.

Impostare per la prima volta l’editor dei prezzi
To use the Price Editor to track a stock value, you must initially insert the stock. To do so, open the

Price Editor (Tools → Price Editor) and click on Add button. The first time a Commodity/Stock is
entered this window will be blank except for the control buttons on the bottom. Select the appropriate
Commodity you want to insert into the Price Editor. At this point, you can input the price of the
commodity manually. There are 6 fields in the New Commodity window:

Nome Il mercato in cui il titolo/commodity è scambiato (NASDAQ in questo esempio).

Titolo Il nome della commodity, deve essere scelto dall’elenco che compare premendo il pul-
sante Seleziona....

Valuta La valuta con cui è espresso il prezzo.

Data Data di validità del prezzo.

Tipo One of: Bid (the market buying price), Ask (the market selling price), Last (the last
transaction price), Net Asset Value (mutual fund price per share), or Unknown. Stocks
and currencies will usually give their quotes as one of bid, ask or last. Mutual funds are
often given as net asset value. For other commodities, simply choose Unknown. This
option is for informational purposes only, it is not used by GnuCash.

Prezzo Il prezzo di una unità di questa commodity.

Esempio di come aggiungere la commodity AMZN dall’Editor prezzi, con un valore iniziale di €40,50
per azione.

Aggiunta della commodity AMZN all’editor prezzi, impostando un valore iniziale di €40,50 per azio-
ne.

Premere OK al termine. Una volta eseguita l’impostazione iniziale della commodity nell’editor prezzi,
non sarà necessario effettuarlo di nuovo, anche nell’eventualità che si utilizzi questa commodity in
un altro conto.

Nota

If you have online retrieval of quotes activated (see la sezione chiamata «Configurazione per
la ricezione automatica delle quotazioni»), you can initialize a commodity without manually
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making an entry. When you initially add the security in the Security Editor, check Get Online
Quotes and save the security. Then, in the Price Editor, click Get Quotes, and the new security
will be inserted into the price list with the retrieved price.

Impostazione manuale del prezzo delle azioni
Se il prezzo della commodity (azione) cambia, è possibile aggiustarne il valore dall’Editor prezzi,
selezionando poi la commodity, premendo il pulsante Modifica e inserendo il nuovo prezzo.

La finestra principale dell’editor prezzi, che mostra la lista di tutte le commodity inserite.

Configurazione per la ricezione automatica delle quo-
tazioni

Se si hanno più di un paio di titoli o azioni ci sis tancherà presto di aggiornarne il prezzo costantemente.
GnuCash è in grado di recuperare automaticamente il prezzo più recente per le proprie commodity
utilizzando una connessione a internet. Questo è reso possibile dal modulo Finance::Quote di Perl, che
deve essere installato per poter abilitare questa funzionalità.

Per determinare se il modulo di Perl Finance::Quote è già installato sul proprio sistema, scrivere nel
terminale perldoc Finance::Quote e controllare se è disponibile la documentazione. Se questa è pre-
sente, allora il modulo è installato, contrariamente no.

Installare Finance::Quote

Microsoft Windows:

• Chiude GnuCash.

• Eseguire Installa la funzione di ricerca delle quotazioni online nella cartella GnuCash del menu
«Start».

Mac OS X: è necessario avere installato XCode. XCode è un elemento opzionale del DVD di instal-
lazione della distribuzione di OSX. Eseguire l’applicazione Aggiorna Finance Quote nel dmg di
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GnuCash. È possibile eseguirla dal dmg o copiarla nella stessa cartella in cui è stato copiato GnuCash.
Verrà aperta una finestra del terminale ed eseguito uno script che porrà diverse domande. Accettare
le risposte predefinite a meno che non si conoscano gli effetti di ogni risposta.

Linux:

• Chiudere qualsiasi istanza di GnuCash in esecuzione.

• Trovare il percorso in cui è installato GnuCash ricercando il termine gnc-fq-update.

• Spostarsi in quella cartella e aprire una shell di root.

• Eseguire il comando gnc-fq-update

Verrà lanciata una sessione di aggiornamento Perl CPAN che si collegherà a internet e installerà il
modulo Finance::Quote sul proprio sistema. Il programma gnc-fq-update è interattivo, comunque,
nella maggior parte dei sistemi, si dovrebbe essere in grado di rispondere «no» alla prima domanda
«Are you ready for manual configuration? [yes]». L’aggiornamento continuerà da questo punto in
modo automatico.

Quando l’installazione è terminata, eseguire il programma di test «gnc-fq-dump», nella stessa cartella,
distribuito con GnuCash per verificare se Finance::Quote è installato e funziona correttamente.

Nota

Se non ci si sente sicuri nell’esecuzione di questi passaggi, è possibile contattare la lista di
discussione degli utenti di GnuCash (<gnucash-user@gnucash.org>) per chiedere
aiuto o andare nell canale IRC di GnuCash su irc.gnome.org. È anche possibile saltare questi
passaggi e aggiornare manualmente i prezzi delle proprie azioni.

Impostare i titoli per le quotazioni online

Con il modulo Finance::Quote installato e correttamente funzionante, si devono impostare i propri
titoli in GnuCash al fine di utilizzare questa funzione per ottenere automaticamente le informazioni
aggiornate sui prezzi. Ogni qualvolta si intende creare dei nuovi titoli o modificarne di già esistenti,

utilizzare la funzione Strumenti → Editor titoli, per modificare il titolo e abilitare l’opzione Ricevi
quotazioni. Sarà quindi possibile modificare l’impostazione per il Tipo di fonte, aprendo il menu a
comparsa per indicare le fonti specifiche e selezionare il Fuso orario per le quotazioni. Al termine
delle modifiche, premere Chiudi per chiudere la finestra dell’editor titoli e tornare all’editro prezzi;
premere poi il pulsante Ricevi quotazioni per aggiornare i prezzi delle azioni tramite internet.

Il comando gnucash --add-price-quotes $HOME/gnucash-filename può essere utilizzato per pre-
levare il prezzo corrente delle proprie azioni. Il file specificato $HOME/gnucash-filename di-
pende dal nome e della posizione del proprio file dei dati. Questo può essere determinato dal nome
visualizzato nella cornice in alto della finestra di GnuCash, prima del simbolo «-». Il nome del file
può anche essere rintracciato nel menu File: il primo elemento della lista, a cui è associato il numero
1, è il nome del file attualmente aperto.

Questa procedura può essere automatizzata creando un comando di crontab. Per esempio, per aggior-
nare il proprio file il venerdì sera (alle 16:00) dopo la chiusura della borsa (l’orario può essere diverso
a seconda del fuso), è possibile aggiungere il comando seguente alla propria lista di crontab:

0 16 * * 5 gnucash --add-price-quotes $HOME/nome-del-file-di-gnucash > /dev/null 2>&1

È importante ricordare che i «prezzi» dei fondi comuni rappresentano dei «valori di capitale netto»
(NAV) e richiedono diverse ore dopo la chiusura dei mercati per essere disponibili. Se i NAV vengono
scaricati prima del giorno in cui vengono determinati, si riceveranno i valori del giorno precedente.
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Mostrare i valori delle quotazioni

La finestra principale del conto, di default, mostra esclusivamente la quantità di ogni commodity che
si possiede, nella colonna con l’intestazione Totale. Nel caso delle azioni, questa commodity è rappre-
sentata dal numero di quote. Spesso, comunque, si desidera visualizzare il valore delle proprie azio-
ni in termini di valuta. Questo è possibile selezionando la scheda denominata conti, facendo clic sul
pulsante Opzioni nella barra del titolo (la piccola freccia verso il basso nel lato destro della finestra
principale) e selezionando l’opzione di visualizzazione del campo «Totale (EUR)». Verrà inserita una
nuova colonna, nella finestra principale, intitolata Totale (EUR) che esprimerà il valore di tutte le
commodity nella valuta del resoconto.

Visualizzazione del valore di un’azione nella finestra principale utilizzando il Totale nelle opzioni
della valuta del resoconto.

Selezionare la «fonte del prezzo» nei resoconti del va-
lore delle azioni

La maggior parte dei resoconti per le attività forniti da GnuCash, presentano diverse opzioni che pre-
mettono di configurare e modificare un certo numero di parametri. La finestra delle opzioni viene
visualizzata selezionando la scheda del resoconto e selezionando il pulsante Opzioni sulla barra degli

strumenti o selezionando il menu Modifica → Opzioni resoconto. La scheda Generale nella finestra
che verrà aperta, contiene vari parametri relativi al resoconto; uno di questi è la Fonte del prezzo che
permette di scegliere fra tre metodi alternativi per determinare il prezzo delle azioni riportato nel re-
soconto:

Nota

Nell’esempio seguente, il resoconto è una personalizzazione del resoconto di Bilancio medio
presente nel sottomenu di Attività e passività.
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Determinazione del valore di un’azione in un resoconto impostando l’opzione della fonte del prezzo.

• Media pesata - fornisce un grafico del prezzo pesato su tutte le transazioni. NON verrà considerato
il prezzo definito nell’ editor prezzi.

• Più recente - visualizza il valore delle azioni nel tempo basandosi unicamente sul prezzo più recente
disponibile dall’editor dei prezzi. Il prezzo che figura nelle transazioni NON è considerato.

• Più vicino temporalmente - il grafico è basato esclusivamente sui prezzi disponibili nell’editor prez-
zi. Il valore delle proprie azioni a ogni passo temporale è calcolato in base al valore più vicino
temporalmente disponibile nell’editor dei prezzi.
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Prevedere quale valore avrebbero avuto le proprie azioni sui mercati azionari.

Vendere le azioni
Entering an investment you are selling is done in the same way as buying one (see la sezione chiamata
«Acquistare nuove quote») except the total cost of the transaction is entered in the Sell column and the
Shares column is entered as a negative amount. The net proceeds from the sale should be transferred
from the stock account to your bank or brokerage account.

La registrazione corretta della vendita delle azioni DEVE avvenire utilizzando una transazione sud-
divisa. In essa occorre contabilizzare il profitto (o la perdita) come entrata derivante da un conto En-
trate:Guadagni in capitale (o Uscite:Perdita in capitale). Per bilanciare questa entrata, è necessario
inserire nella suddivisione, per due volte, l’attività derivante dalle azioni: una per registrare la vendita
(utilizzando il numero corretto di azioni e del prezzo unitario) e una volta per bilanciare il profitto
ottenuto (impostando il numero di azioni a 0 e il prezzo unitario anch’esso a 0).

Nota

In order to get GnuCash to commit this zero-share, zero-price split to the transaction, you
*must* Tab out of the split. If you use the Enter key, GnuCash will convert the split into
shares of the commodity.

Nello schema con transazione suddivisa presentato di seguito, il simbolo NUM_AZIONI rappresen-
ta il numero di azioni che si desidera vendere, PREZZO_VENDITA è il prezzo con il quale vengo-
no vendute le azioni, VENDITA_LORDA è il totale ottenuto dalla vendita delle azioni ed è pari a
NUM_AZIONI x PREZZO_VENDITA; UTILE è l’importo di denaro ricavato dalla vendita; COM-
MISSIONI sono le spese di mediazione sostenute e infine VENDITA_NETTA è l’importo netto di
denaro guadagnato con la vendita e pari a VENDITA_LORDA - COMMISSIONI.
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Tabella 9.1. Vendere azioni utilizzando lo schema della transazione suddivisa

Conto Numero di quo-
te

Prezzo quota Acquisto totale Vendita totale

Attività:Banca ABC VENDI-
TA_NETTA

Attività:Azioni:SIMBOLO 0 0 UTILE (Perdita)

Uscite:Commissioni COMMISSIO-
NI

Attività:Azioni:SIMBOLO -
NUM_AZIO-
NI

PREZ-
ZO_VENDI-
TA

VENDI-
TA_LORDA

Entrate:Guadagni in capitale (Perdita) UTILE

Se la vendita delle azioni verrà registrata come un guadagno in conto capitale, consultare Capitolo 11,
Guadagni in conto capitale e Capitolo 16, Deprezzamento per ricevere ulteriori informazioni sull’ar-
gomento.

Esempio - Vendita delle azioni in guadagno

As an example we will use the AMZN account created in the previous section. So you bought 100
shares of AMZN for $20 per share, then later sell them all for $36 per share with a commission of $75.
In the split transaction scheme above, PRICEBUY is $20 (the original buying price), NUM_SHARES
is 100, TOTALBUY is $2000 (the original buying cost), GROSS_SALE is $3600, and finally PROFIT
is $1525 (GROSS_SALE-TOTALBUY-COMMISSION).

Tabella 9.2. Schema a transazione suddivisa per la vendita delle azioni

Conto Quote Prezzo Com-
pra

Vendi

Attività:Banca ABC 3525,00

Attività:Conto di brokeraggio:A-
zioni:AMZN

0 0 1600,00

Uscite:Commissioni 75,00

Attività:Conto di brokeraggio:A-
zioni:AMZN

-100 36,00 3600,00

Entrate:Guadagni in capitale (lun-
go):AMZN

1600,00
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Un esempio di vendita delle azioni in guadagno. Sono state acquistate 100 azioni di AMZN per €20
ad azione e vendute a €36.

Immagine della struttura dei conti dopo l’esempio di vendita dell’azione per il guadagno.

Esempio - Vendere le azioni in perdita

As an example we will use the IBM account created in the previous section. You then have bought
51.7598 shares of IBM for $96.6001 per share, then later sell them all for $90 per share. In the
split transaction scheme below, PRICEBUY is $96.6001 (the original buying price), NUM_SHA-
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RES is 51.7598, TOTAL_BUY is $5,000 (the original buying price), (Loss) is $341.62, and finally
GROSS_SALE is $4658.38. Assume the commission was $100.00.

Tabella 9.3. Vendita delle azioni in perdita utilizzando lo schema a transazione
suddivisa

Conto Quote Prezzo Com-
pra

Vendi

Attività:Banca ABC 4558,38

Attività:Conto di brokeraggio:A-
zioni:IBM

0 0 341,62

Uscite:Commissioni 100

Attività:Conto di brokeraggio:A-
zioni:IBM

-51,759890,00 4658,38

Entrate:Guadagni in capitale (lun-
go):IBM

341,62 0

Nota

É possibile anche inserire la perdita come un numero positivo nella colonna «Compra» o co-
me un numero negativo nella colonna «Vendi»; GnuCash sposterà automaticamente il «pro-
fitto negativo» nell’altra colonna.

Sopra è riportata un’immagine dell’esempio di vendita della azioni. Sono stati acquistati €5000 in
azioni IBM a €96,6001 cadauna e vendute per €90.
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Un’immagine della struttura dei conti derivata dall’esempio di vendita delle azioni in perdita.

Automatic Calculation of Capital Gain or Loss Using
Lots

Introduzione

Wikipedia [https://en.wikipedia.org/wiki/Lot] includes the following definition of a lot

«a set of goods for sale together in an auction; or a quantity of a financial instrument».

GnuCash has a built-in lot management facility that can be used to keep track of capital gains or losses
resulting from security sales. Buy and sell transactions are put into lots for the purpose of calculating
the cost of the sale. More specifically, a lot is used to link particular buy and sell transaction splits.
Lots can be automatically or manually created and linked. Capital gain or loss can be automatically
calculated and transaction(s) created for the difference between the sale value and the cost of the
securities sold. GnuCash refers to this process as scrubbing.

The term scrub is used because security accounts need to be cleaned after sales to ensure the difference
between the cost paid for securities, and value received from selling them, is accounted for as capital

gain or loss. If the capital gain/loss is not correct, the Trial Balance (Reports → Income & Expense

→ Trial Balance) bottom line total debits will not balance to total credits.

Nota

If you make an error, you can delete the capital gain/loss transaction(s) and lot(s) and retry.
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If you are not familiar with FIFO, LIFO or Average costing, please see Wikipedia  FIFO and LI-
FO accounting [https://en.wikipedia.org/wiki/FIFO_and_LIFO_accounting] and  Average cost me-
thod [https://en.wikipedia.org/wiki/Average_cost_method].

If you are not familiar with the difference between GnuCash transactions and splits, please see la
sezione chiamata «Simple vs. Split Transactions».

The GnuCash lot management facility can be a useful feature, reducing manual calculation, especial-
ly if dividends have been reinvested over years and there are many different costs involved. It can
automatically link buy transactions to sell transactions using FIFO cost method and one can manually
link specific buy transactions to sell transactions in order to use LIFO. Advanced Portfolio Report
basis costs and gains/losses will agree with the costs and gain/loss transactions created by scrubbing
if either the FIFO or LIFO cost methods are used.

Lots in Account Window

The Lots in Account SSSS window, where SSSS is a security account, is used to manually or auto-
matically link security transaction splits to lots and create capital gain/loss transactions to account for
the difference between the costs of buying a security and the value received by selling it.

To open the Lots in Account window, open the security account register, then select Actions → View
Lots.

Figura 9.1. Selling Shares - Capital Gains - Lots in Account window

An image of the Lots in Account  window.

Refer to the Help Manual, Chapter 8 Tools & Assistants,  Lots in Account  [https://www.gnu-
cash.org/docs/v2.6/C/gnucash-help/tool-lots.html] for details of the Lots in Account screen elements.

Procedure Summary

Using the lot management facility for the automatic calculation of capital gain or loss typically follows
these steps:

1. la sezione chiamata «Manual Lot Creation and Linking» (Optional depending on cost method)

2. la sezione chiamata «Automatic Creation of Capital Gain Or Loss Transactions»

3. la sezione chiamata «Change Orphaned Gains-CCC to Gain/Loss Account»

4. la sezione chiamata «Run a Trial Balance» report to ensure total debits balance to total credits

Manual Lot Creation and Linking

Before using this feature, ensure you have read la sezione chiamata «Considerations».

This functionality allows the manual linking of specfic buy and sell transactions. It may be used in
the case where a user wishes to use a different cost method than the automatic linking method (FIFO).
Effectively, if one wishes the cost basis and capital gains in the Advanced Portfolio Report to be
consistent with the capital gains transactions created by scrubbing, manual lot creation only needs
to be used when using LIFO or «sale of designated lots» (the same thing for securities as far as US
personal tax law is concerned). This is because the scrub function can automatically do FIFO linking
so there is no need to do it manually and scrubbing cannot be used for average costing.

See la sezione chiamata «Example of Manual Lot Creation and Linking».
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Automatic Creation of Capital Gain Or Loss Transactions

Nota

Do NOT do this unless you are using FIFO or LIFO to cost sales. See la sezione chiamata
«Considerations»

GnuCash can automatically calculate and create security sale capital gain/loss transactions. Lots are
used to link buy transaction splits with sell transaction splits so the correct cost of the securities sold
can be determined. GnuCash will use any existing lots, and create new lots for any buy transaction
splits not already linked to a lot. Buy and sell transaction splits are linked to lots using FIFO method.

See:

la sezione chiamata «Example 1 of Automatic Creation of Capital Gain Or Loss Transactions»

la sezione chiamata «Example 2 of Automatic Creation of Capital Gain Or Loss Transactions - 2 Sales
at Once»

la sezione chiamata «Example 3 of Automatic Creation of Capital Gain Or Loss Transactions - After
a Simple Stock Split»

Change Orphaned Gains-CCC to Gain/Loss Account

The capital gain/loss transaction(s) created by scrubbing uses an automatically created generic Orpha-
ned Gains-CCC account (where CCC is the security currency) because GnuCash doesn't know which
capital gain or loss account should be used. After scrubbing, the user should edit the  Orphaned Gains-
CCC transaction split to re-assign the income account to a more meaningful income (or expense) gain
or loss account (e.g. Income:Long Term Capital Gain:IBM).

See la sezione chiamata «Example of Changing the Orphaned Gains-CCC to Gain/Loss Account».

Run a Trial Balance

Running a Trial Balance report (Reports → Income & Expense → Trial Balance) after creating capital
gain/loss transactions, is a basic check that capital gains/losses are correctly accounting for the diffe-
rence between the cost paid for securities, and value received from selling them. At the end of the
report, total debits should equal total credits.

Suggerimento

A Trial Balance may not balance due to some other problem. To determine if the cause of an
imbalance is from incorrectly accounting for capital gain/loss:

If necessary, temporarily change the date of the sell transaction and the capital gain/loss
transaction, so they are the only transactions for a particular date, then run the Trial Balance
as at the day before. If the Trial Balance is still out by the same amount, it is not the capital
gain/loss that is causing the problem.

If you find a prior out of balance  Trial Balance, keep running the Trial Balance report with
different dates until you find the date it starts being out of balance. Temporarily change the
transaction dates for each transaction on the problem date to the following day, then change
the dates back to the correct date 1 at a time, running the Trial Balance each time, until you
identify the problem transaction. When you change the date of a security sell transaction, you
also need to change the date of the corresponding capital gain transaction as it is only the
sum of these that will balance in the Trial Balance.
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Considerations

There are some points that should be considered before using the lot management facility.

1. GnuCash implements only the First In/ First Out (FIFO) cost method when automatically linking
buy transactions to sell transactions. I.e. The oldest securities are always sold first. The Last In First
Out (LIFO) cost method may be used by manually linking the most recent buy security splits to
the sell split before scrubbing.

2. The Advanced Portfolio Report does not use lot information when calculating costs, just the security
transaction splits. It calculates the cost basis and gains or losses using the selected Basis calculation
method report option (Average, FIFO or LIFO). If one wishes the Advanced Portfolio Report costs
and gains/losses to be consistent with the capital gain/loss transactions created by scrubbing, the
same cost model must be used in both places.

3. Scrubbing does not work correctly if there has been a previous sale where the capital gain splits
have been manually entered as part of the sale transaction. Therefore ensure previous sales are
recorded as 2 transactions:

Tabella 9.4. Transaction 1 dealing with value received, reduction of the
number of shares and (optionally) commission

Conto Tot Shares (Unit) Price Buy (Debit) Sell (Credit)

Brokerage or
Bank

Debit

Commission (op-
tional)

Debit

Titolo -NumSold SaleUnitPrice SaleValue

Tabella 9.5. Transaction 2 capital gain/loss (loss in this example)

Conto Tot Shares (Unit) Price Buy (Debit) Sell (Credit)

Capital Loss Debit

Titolo 0 0 Credit

4. The automatic capital gains calculations can handle straightforward buy, sell, and return of capital
transactions but any transaction that affect the number of shares, even simple splits, will cause it
to produce wrong answers so those cases must be handled manually.

Example of Manual Lot Creation and Linking

Here is an example of selling part of a security holding using the LIFO method. In this example, the
most recent buy transaction (dated 01/07/2016, a reinvested dividend), is linked to a lot, along with
the sell transaction, and the GnuCash scrub function is used to calculate capital gain or loss and create
the capital gain/loss transaction.

1. Open the security account's register.

Figura 9.2. Selling Shares - Capital Gains - Security register before scrubbing a single lot

An image of the Security Account register in transaction journal view, before lot scrubbing.

2. Ensure all previous capital gain/loss transactions are separate transactions to the sell transactions
which record the reduction in the number of shares and the value received.
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3. Select Actions → View Lots to open the Lots in Account SSSS window where SSSS is the security
account.

Figura 9.3. Selling Shares - Capital Gains - Lots before scrubbing a single lot

An image of the Lots in Account  window before lot scrubbing.

4. Create a new lot using the New Lot button. Initially this lot is not linked to any buy or sell split.

5. Highlight the new lot in the Lots in This Account panel.

6. Highlight the buy split (dated 01/07/2016) of the security to be sold in the Splits free panel.

7. Click the >> button to link the buy split with the highlighted lot. The split moves from the Splits
free panel to the Splits in Lot panel.

8. Repeat the previous 2 steps for any other buy splits that should be included in the lot (in this
example, there is only 1 buy split in the sale).

9. Highlight the sell split in the Splits free panel.

10.Click the >> button to link the sell split with the highlighted lot.

11.Check the lot Balance is as expected. I.e. in this example the lot balance should be zero as the
number of securities sold in the lot, is matched with the same number of security buys.

Figura 9.4. Selling Shares - Capital Gains - Lots before scrubbing a single lot, after manual
linking

An image of the Lots in Account  window before scrubbing a single lot.

12.Click the Scrub button (NOT  the Scrub Account button).

The Lots in Account window has not changed after using the Scrub button so no example screen
image is supplied.

13.Continue to la sezione chiamata «Change Orphaned Gains-CCC to Gain/Loss Account»

Example 1 of Automatic Creation of Capital Gain Or Loss Tran-
sactions

Create the capital gains transaction by following these steps:

1. Open the security account's register.

2. Ensure the sell transaction has been entered with no splits for capital gains or losses.

3. Select Actions → View Lots to open the Lots in Account SSSS window where SSSS is the security
account.

4. If using LIFO, use the above procedure la sezione chiamata «Manual Lot Creation and Linking»
to create a lot for each sell transaction, link the lot with the sell transaction and each of the buy
transactions that make up the sale.

5. Click the Scrub Account button which:
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• Creates lots for any buy transactions that are not already linked to a lot and links them to sell
transactions splits using the FIFO method. As a transaction split can only be linked to 1 lot, if
a sell transaction needs to be linked to multiple lots, the sell transaction split is itself split into
multiple subsplits. In the case of multiple subsplits, it is possible to have different splits from the
same transaction in both the Splits free and Splits in lot panels.

• Creates a separate transaction per lot for capital gain/loss.

Nota

If there are already gain/loss splits as part of a sell transaction, GnuCash scrubbing
does not recognize them. So if manually adding gain/loss, separate gain/loss transaction
splits from the transaction that reduces the No of Shares) by putting them in a separate
transaction if you may use scrubbing in future.

6. Continue with the instructions in the next section.

Example 2 of Automatic Creation of Capital Gain Or Loss Tran-
sactions - 2 Sales at Once

Here is an example of FIFO scrubbing without manual lot creation. In this example, the transactions
for 2 sales are scrubbed at once but usually scrubbing would be performed after each sale. One reason
for scrubbing 2 sales at once, could be because there were multiple sales on the same day.

Figura 9.5. Selling Shares - Capital Gains - Register before Scrub Account

An image of the Security Account register in transaction journal view, before Scrub Account is used.

1. Select Actions → View Lots to open the Lots in Account SSSS window where SSSS is the security
account.

Figura 9.6. Selling Shares - Capital Gains - Lots before Scrub Account

An image of the Lots in Account  window before Scrub Account is used.

2. Click the Scrub Account button.

Figura 9.7. Selling Shares - Capital Gains - Lots after Scrub Account

An image of the Lots in Account  window after using Scrub Account.

Nota

After using the Scrub Account button only the last lot is shown, so the above image is
after the Lots in Account window has been closed and reopened so all the lots show.

3. Close the Lots in Account SSSS window and return to the security account register.

Figura 9.8. Selling Shares - Capital Gains - Register after Scrub Account

An image of the security register  after using Scrub Account.

135



Investimenti

Nota

The security splits in the sell transactions have been split into subsplits, one subsplit per
lot, and a capital gain transaction has been created for each security subsplit of each sell
transaction.

4. Continue to la sezione chiamata «Change Orphaned Gains-CCC to Gain/Loss Account»

Example 3 of Automatic Creation of Capital Gain Or Loss Tran-
sactions - After a Simple Stock Split

Here is an example of FIFO scrubbing without manual lot creation/linking, where the Stock Split
Assistant has been used for a simple stock split. In this example, 100 shares of security XYZ were
bought for $10.00 each, there was a simple 2 for 1 stock split for zero cost (so the holding was then
200 shares @ $5.00 each), then all 200 shares were sold for $6.00 each.

Figura 9.9. Selling Shares - Capital Gains - Register after Scrub Account

An image of the Security Account register in transaction journal view, after Scrub Account is used.

Figura 9.10. Selling Shares - Capital Gains - Lot 0 after Scrub Account

An image of the Security Account register in transaction journal view, after Scrub Account is used.

Figura 9.11. Selling Shares - Capital Gains - Lot 1 after Scrub Account

An image of the Security Account register in transaction journal view, after Scrub Account is used.

The above screen shots show that scrubbing created:

2 lots. A separate lot for each buy (it essentially treats the stock split as a buy of 100 for no cost)

2 capital gain transactions (one for each lot) on the date of the sale:

• Lot 0: 1/7/2009 loss $400 (sale $600 - cost $1000)

• Lot 1: 1/7/2009 gain $600 (sale $600 - cost $0)

Total gain $200 is correct. Whether the gain is a single long-term one or one each of long-term and
short-term or whether there's even a distinction depends on the user's tax jurisdiction and the way the
split is structured. If the user needs help figuring it out they should consult a professional.

Example of Changing the Orphaned Gains-CCC to Gain/Loss Ac-
count

1. Close the Lots in Account SSSS window if open and return to the security account register.

Figura 9.12. Selling Shares - Capital Gains - Register after scrubbing a single lot

An image of the security register  after scrubbing a single lot.
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2. Find each new Realized Gain/Loss transaction in the security account register (they will have the
same date as the sell transactions). Edit the  Orphaned Gains-CCC transaction split to re-assign the
income account to a more meaningful income (or expense) gain or loss account (e.g. Income:Long
Term Capital Gain:IBM).

Suggerimento

You may like to split the capital gain/loss into taxable and non taxable parts if that is in
accord with your tax laws.

Dividendi
Alcune società o fondi comuni rendono periodicamente dei dividendi agli azionisti. I dividendi ven-
gono normalmente forniti in due modalità diverse: o vengono automaticamente reinvestiti nella com-
modity o sono restituiti come liquidi. I fondi comuni sono spesso impostati per reinvestire automati-
camente i dividendi, mentre i dividendi per le azioni comuni vengono generalmente pagati in liquidi.

Dividendi liquidi
If the dividend is presented as cash, you should record the transaction in the asset account that received
the money, as income from Income:Dividends. Additionally if you want to tie the cash dividend to
a particular stock holding then add a dummy transaction split to the stock account with quantity 0
price 1 value 0.

As an example consider the following; the dividends deposited as cash into the Broker Account with
a tie to the stock account.

Un’immagine del registro del conto di mediazione dopo una serie di dividendi liquidi.

Nota

Se si desidera registrare i dividendi per ogni azione, sarà necessario creare un conto Entra-
te:Dividendi:SIMBOLO AZIONE per ogni azione posseduta che genera dividendi.

Dividendi reinvestiti
Se i dividendi sono ricevuti sotto forma di un reinvestimento automatico, la transazione corrispon-
dente dovrebbe avvenire all’interno del conto dell’azione o del fondo comune come entrata dal conto
«Entrate:Dividendi» per il numero di quote effettivamente reinvestite. Generalmente ci si riferisce a
questo tipo di reinvestimento con la sigla DRIP (Dividend Re-Investment Program).

As an example consider the following purchase of NSTAR (NST) stock with the dividends reinvested
into a DRIP Account. Mutual fund re-investments would be the same.

Starting with the purchase of 100 shares on Jan. 3, 2005, all dividends will be reinvested and an
account is created to track the dividend to the specific stock. GnuCash simplifies the entry by allowing
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calculations within the cells of the transaction. If the first dividend is $.29/share, enter $53.28 (purchase
price + dividend) in the share Price cell and 100*.29 in the Buy cell. GnuCash will calculate for you
the corresponding numer of Shares

An image of the NST Stock Account register after a dividend reinvestment.

Return of Capital
This refers to a transaction where an investment returns capital to the investor and doesn't have any
accounting implications other than reducing the cost basis. The number of shares held is not changed.

A Return of Capital transaction can be entered in the stock register by entering the stock split with

Quote 0

Prezzo 0

Vendi Return of Capital value

The other side of the double entry would usually be a debit to the brokerage bank account.

An image of the Stock Account register after a return of capital.

Nota

It is not possible to use the Stock Split Assistant to do this type of transaction.

Suggerimento

If you accidentally entered a non-zero price in the stock split, GnuCash may have created an
unwanted price database entry which could cause reports to be wrong. Check for and remove

such an unwanted entry from the price database using Tools  → Price Editor.

Frazionamenti e fusioni
Le società possono frazionare le loro azioni per diverse ragioni la più comune delle quali è quando
l’amministrazione della società ritiene che il prezzo abbia superato il valore ragionevole per gli in-
vestitori. Alcuni di questi frazionamenti sono semplici scambi (es: 2 per 1 o 3 per 2) mentre altri so-
no meccanismi di scambio più complessi con distribuzione di liquidi. I frazionamenti possono anche
portare a una diminuzione del numero di azioni se lo scambio è un frazionamento inverso (es: 1 per
3 o 0,75 per 1).

Frazionamento azionario semplice
Per fare un esempio, si supponga che la propria società di investimento in azioni NST abbia dichiarato
un frazionamento azionario di 2 per 1 a decorrere dal 6 Giugno 2005. Per inserire la corrispondente
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transazione occorre avviare l’assistente per il frazionamento azionario andando in Operazioni → Fra-
zionamento azionario.

Un’immagine della selezione dell’assistente per il frazionamento azionario.

La prima schermata è solamente di introduzione; premere Avanti per visualizzare la finestra di sele-
zione del conto e dell’azione per il frazionamento. Sarà necessario creare una voce per ogni combina-
zione di Conto:Azioni che si possiede.

Un’immagine dell’assistente per il frazionamento azionario al passo 2 - Selezione del conto/azione.

Selezionare il conto Attività:Investimenti:DRIPs:NST e premere Avanti.

La finestra seguente per i dettagli del frazionamento azionario, contiene 5 campi:

• Data - Inserire la data del frazionamento.

• Quote - Il numero di quote aggiunte (o sottratte) nella transazione.

Nell’esempio si è ipotizzato un frazionamento 2 per 1, quindi il numero di quote addizionali è pari
al numero di quelle presenti attualmente nel registro.

• Descrizione - La descrizione dovrebbe fornire una breve spiegazione della transazione.

• Nuovo prezzo - Se si desidera è possibile inserire qui il nuovo prezzo dell’azione dopo il fraziona-
mento.

• Valuta - è richiesta la valuta della transazione che dovrebbe essere la stessa con cui è avvenuto
l’acquisto delle azioni.

139



Investimenti

Premere il pulsante Avanti.

Un’immagine dell’assistente per il frazionamento azionario al passo 3 - Dettagli del frazionamento.

La schermata successiva verrà saltata per questo esempio poiché non è presente «Cash in Lieu».

Un’immagine dell’assistente per il frazionamento azionario al passo 4 - Cash in Lieu.

Una finestra finale di Termina proporrà diverse opzioni: Annulla, Indietro per annullare o modificare
i dati inseriti, e Applica per completare il frazionamento azionario con i dati inseriti.
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Un’immagine del registro del conto Attività:Investimenti:DRIPs:NST dopo l’inserimento di una tran-
sazione per un semplice frazionamento azionario.

Fusione azionaria moderatamente complessa
Come esempio, si assuma di aver posseduto delle azioni AT&T durante la fusione avvenuta il 18
Novembre 2005 della SBC con AT&T. In questo esempio si ipotizzerà di aver acquistato le azioni
AT&T il 1° Aprile 2005, che i divendi siano stati pagati in liquidi e quindi che non siano stati inseriti
nel registro delle azioni AT&T.

Le condizioni della fusione sancivano che 0,77942 azioni di SBC fossero scambiate per ogni azione
AT&T. La società derivante dalla fusione continuò a utilizzare il simbolo «T» da AT&T.

AT&T fornì dei «dividendi» di €1,20/azione alla data della transazione, comunque questa operazione
non apparirà nel conto delle azioni dato che si trattò di una distribuzione in liquidi.

Il processo di inserimento di questa transazione è identico al frazionamento semplice fino alla scher-
mata dei «Dettagli». Sarà necessario creare una voce di frazionamento in ogni combinazione di Conto
investimenti:Azioni che ha delle azioni frazionate.

Un’immagine dell’assistente per il frazionamento azionario al passo 2 - Selezione del conto/azione
(Conto investimenti:T).

Selezionare il conto Attività:Investimenti:Conto brokeraggio:Azioni:T e premere Avanti.

La finestra seguente per i dettagli del frazionamento azionario, contiene 5 campi:

• Data - Inserire la data del frazionamento. Per questo esempio si inserirà 18 Novembre 2005.
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• Quote - Il numero di quote aggiunte (o sottratte) nella transazione.

Nell’esempio in oggetto si tratta di un frazionamenti di 0,77942 per 1 e quindi il numero di azioni
diminuisce rispetto a quello attualmente presente nel registro. È possibile avvalersi della capacità di
GnuCash di eseguire i calcoli nelle celle inserendo direttamente i dati (Es: «(0,77942*100)-100»)
per calcolare la diminuzione delle azioni derivante dal frazionamento.

• Descrizione - La descrizione dovrebbe fornire una breve spiegazione della transazione.

• Nuovo prezzo - Se si desidera è possibile inserire qui il nuovo prezzo dell’azione dopo il fraziona-
mento.

• Valuta - è richiesta la valuta della transazione che dovrebbe essere la stessa con cui è avvenuto
l’acquisto delle azioni.

Premere il pulsante Avanti.

Un’immagine dell’assistente per il frazionamento azionario al passo 3 - Dettagli del frazionamento.

La schermata successiva verrà saltata per questo esempio poiché non è presente «Cash in Lieu».

Una schermata finale di «Termine» fornirà infine le opzioni per tornare Indietro, allo scopo di modi-
ficare le informazioni inserite in precedenza, e di Applica per completare il frazionamento azionario
con i dati inseriti.

Un’immagine del registro del Conto investimenti:T dopo aver inserito la transazione relativa al fra-
zionamento azionario che comporta la diminuzione delle azioni.
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Capitolo 10. Resoconti
GnuCash is a powerful double entry accounting software package that allows users to enter and track
their money in a reliable manner. However, putting this information into GnuCash is only a part of
the process. To be truly helpful, you need to be able to extract this information in meaningful ways.
GnuCash's reporting features allow you to just that.

GnuCash's reporting features allow you to display nearly any group of transactions in a wide variety of
formats. This makes it easy to answer questions about your finances, such as "How much did I spend
on groceries last month?" or "How much did I earn in the previous six months?"

GnuCash includes a number of common report types, which can be modified to meet your specific
needs. If these common reports are insufficient, it is possible to modify or even write your own custom
reports (although this is not recommended for beginners).

In generale
There are many standard reports pre-built in GnuCash, all available from the Reports pulldown menu
in the main account window.

When you select a report from the list of reports, that report is first run with its default settings. Once
you have opened the report, you can modify its parameters by clicking on the Options button on the
toolbar. Under Options, you will see the different settings that you can change for each report. Note
that for different reports, the options will be different.

Saved Reports Configurations Concepts
Once you have modified a report to meet your needs, you may wish to save that report for reuse at a later
point. GnuCash allows custom reports to be saved, using the Save Report Configuration command.

To save a report configuration:

• Go to the Reports Menu and choose the desired report.

• Change the settings on the report until it includes what is needed.

• Go to the General tab of the report's options and change the Report Name to something meaningful
(Do not confuse this with the Report Title).

• Apply the changes and close the dialog.

• Click the Save Report Configuration or Save Report Configuration As... button

This will store the report options in a file in your home directory.

The first time you save a report with a name that has not already been saved, you can use either the
Save Report Configuration or the Save Report Configuration As... button. You can modify the report
name before saving it.

Once a report has been saved with the current name, the Save Report Configuration button will im-
mediately update the saved report configuration. Use the Save Report Configuration As button to save
the current report configuration with a new name.

Saved report configurations are available for use under the Reports->Saved Report Configurations
entry. They will also be available for use on multicolumn reports.

Saved report configurations can be deleted in the Saved Report Configurations dialog by clicking the
trashcan icon.
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To edit saved report configurations, open the report via Reports->Saved Report Configurations, edit
and apply the new options, and click Save Report Configuration.

Standard Reports Overview
The standard reports that are included in GnuCash are presented here in the order that they appear in
the Reports menu. In each section, a short description for each report is given, which explains what
the report is intended to show, and its primary purpose.

Assets & Liabilities Group
Reports in this group provide general information about assets and liabilities.

Advanced Portfolio

The Advanced Portfolio produces a report on commodity accounts (stock and mutual fund type ac-
counts) using price information stored in the GnuCash price database and within the GnuCash tran-
saction data. If you do not have stock price information in your file, the report will indicate an error.
This report includes extended information about commodity holdings, including information about
the basis, gain, and return of individual commodities.

Advanced Portfolio Capital Gains

The Advanced Portfolio report doesn’t use the capital gain splits to calculate capital gains. It calculates
the gains from the various buy and sell transactions in the account without regard to whether the gains
and losses are recorded or not. Any realized gain splits are ignored. Realized gain splits are recognized
as two splits, one in the stock’s account with a zero number of shares and a non-zero value, the other
in an income or expense account with a value that is the negative of the split in the stock account.
These two splits can be in a separate transaction (as created by scrubbing) or in the same transaction
as the sale (this will cause incorrect future scrubbing). The income or expense split can be split into
multiple splits, say for taxable/non-taxable or short/long term gains, without affecting this report.

Asset Barchart

The Asset Barchart presents the value of assets on a monthly basis in barchart form. By default, the
report displays the eight largest accounts that have specific asset types assigned to them, and it displays
bars for the current financial period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates
account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing in-
formation for more accounts to display. Additionally, the "Show table" option enables the display
of chart information in tabular form below the chart.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Asset Piechart

The Asset Piechart presents the value of assets on a monthly basis in piechart form. By default, the
report shows the seven largest accounts, that have specific asset types assigned to them, arranged in
descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.

144



Resoconti

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates
account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Slices" option will display more slices in the chart, allowing
information for more accounts to display.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Average Balance

The Average Balance report displays monthly averages for the current accounting period.

Balance Sheet

The Balance Sheet lists Asset, Liability, and Equity account balances for all such accounts, and pro-
vides totals as of a given date. Balance sheets are commonly run for the last day of each fiscal year to
give an overall sense of the financial condition of the entity.

General Journal

The General Journal produces a register of all transactions (beginning to end) in order by date, showing
the accounts and the amounts involved, and totals the Net Change by all currencies and assets.

This report is not customizable by date or account, though you can include more or fewer details
about the individual transactions, and whether to include running balances and totals for the credits
and debits. If you need a report restricted to particular accounts, consider the Transaction Report or
open a particular account and choose the Account Transaction Report.

General Ledger

The General Ledger produces information about all transactions for a selected set of accounts. When
first run, this report loads no data, and the report options must be changed to retrieve information
from the file.

Investment Portfolio

The Investment Portfolio produces a report of commodity accounts (that is, accounts with type "Stock"
or "Mutual Fund"), giving holdings, price and value information about commodities in the file.

Liability Barchart

The Liability Barchart presents the value of liabilities on a monthly basis in barchart form. By default,
the report displays the eight largest accounts that have specific asset types assigned to them, and it
displays bars for the current financial period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates
account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing in-
formation for more accounts to display. Additionally, the "Show table" option enables the display
of chart information in tabular form below the chart.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.
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Liability Piechart

The Liability Piechart presents the value of liabilities on a monthly basis in piechart form. By default,
the report shows the seven largest accounts, that have specific asset types assigned to them, arranged
in descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates
account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Slices" option will display more slices in the chart, allowing
information for more accounts to display.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Net Worth Barchart

The Net Worth Barchart summarizes Asset accounts, Liability accounts, and overall Net Worth as
bars on a graph on a monthly basis for the current financial period. This report provides a graphic
overview of the file over time.

Net Worth Linechart

The Net Worth Linechart summarizes Asset accounts, Liability accounts, and overall Net Worth as a
line graph on a monthly basis for the current financial period. This report provides a graphic overview
of the file over time.

Price Scatterplot

The Price Scatterplot displays the value of one commodity relative to another commodity, for example
the value of a stock relative to a currency. When first run, this report loads no data, and the report
options must be changed to retrieve information from the file. Specifically, the "Price of Commodity"
setting on the Price options tab must be changed to a specific commodity.

Budget Group
Budget reports in GnuCash allow you to gather summary information related to budgets you may have
created. In order for these reports to work, you must first create a budget. The reports in this group
are specifically based on budget information. To use these reports, you need to have a budget saved
in your file.

Budget Balance Sheet

Budget Barchart

Budget Flow

Budget Income Statement

Budget Profit & Loss
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Budget Report

Business Group
Reports in this group provide general information about activities related to a business.

Customer Report

Customer Summary

Customer Summary is a customer profit report that can help with job analysis by comparing the income
and expenses for a specific customer.

All invoices have an Owner in GnuCash, so invoices that are made will show a customer and show in
the report. When creating a Bill, the Default Chargeback Customer is blank. To use the profit report,
this field needs an entry, since this is the tag that decides the line to which to attach the expense. Left
blank, the bill will be assigned to "No Customer." Similarly, when income is entered directly in a
register rather than creating an invoice, it will also be assigned to "No Customer."

Thus, if this report includes an entry for "No Customer", this means that the report may be inaccurate,
as the results are not all properly labeled.

Possible use scenarios include:

• Tracking retail sales from different cities

• Tracking rental properties

• Tracking types of business

• Tracking commission sales

Each of these scenarios assumes that the account structure includes breakdowns for individual tracked
categories. Changing settings on the Income and Expense tabs under Options can hone the information
displayed. By default all income and expense accounts are included; however, since GnuCash can't
really predict the names and classification of income and expense accounts, it must group them all
into the "No Customer" entry.

Note that inventory-based businesses won't benefit from this report because of its nature.

Useful options:

• The Expense Accounts tab allows the selection of one or more expense accounts.

• The Income Accounts tab allows the selection of one or more income accounts.

• The Display tab allows sorting by name, profit percentage, or amount of profit.

Easy Invoice

Employee Report

Fancy Invoice

Payable Aging
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Printable Invoice

Receivable Aging

This report provides a listing of all customers, their current balance, and how much they have outstan-
ding from invoices over different time periods&mdash;how much they owe from 0-30 days, from
31-60 days, from 61-90 days, and over 90 days. The report also contains links to each customer and
to their current customer report.

Vendor Report

Income & Expense Group
Reports in this group provide information about Income and Expense

Cash Flow

This report shows the change in value for a set of accounts (the flow of cash) over a given period
of time. By default, this report is based on accounts in Assets and Special Accounts, and covers the
current financial period. The report enumerates all money coming in to and going out of the base
accounts, broken down by the other account.

Equity Statement

This report can be seen as extension of the Balance Sheet report. The Balance Sheet states the balance
of Assets, Liabilities and Equity at a specific point of time. The Equity Statement focuses on the Equity
Accounts by showing the cash flow to and from them for a given period of time.

By balancing this cash flow with income, the report shows the available capital at the beginning and
end of the selected time period.

Expense Barchart

The Expense Barchart presents the value of expenses on a monthly basis in barchart form. By default,
the report displays the eight largest accounts that have specific expense types assigned to them, and
it displays bars for the current financial period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates
account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing in-
formation for more accounts to display. Additionally, the "Show table" option enables the display
of chart information in tabular form below the chart.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Expense Piechart

The Expense Piechart presents the value of expenses on a monthly basis in piechart form. By default,
the report shows the seven largest accounts, that have specific expense types assigned to them, arranged
in descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.
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• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates
account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Slices" option will display more slices in the chart, allowing
information for more accounts to display.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Expenses vs. Day of Week

Expenses vs. Day of Week presents a pie chart showing the totals for selected expense accounts totaled
by the day of the week of the transaction. The report options enable you to make some adjustments
(such as accounts, display options, and the date range) but the account selector only allows expense
accounts to be chosen. The report aggregates expense transactions by day of week, not by any other
period or category. Due to these limitations, the report may be considered a demonstration or an exam-
ple to someone wanting to examine the source code for composing a useful custom report.

Income Barchart

The Income Barchart presents the value of income on a monthly basis in barchart form. By default,
the report displays the eight largest accounts that have specific income types assigned to them, and it
displays bars for the current financial period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates
account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing in-
formation for more accounts to display. Additionally, the "Show table" option enables the display
of chart information in tabular form below the chart.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Income & Expense Chart

Income Piechart

The Income Piechart presents the value of income on a monthly basis in piechart form. By default, the
report shows the seven largest accounts, that have specific income types assigned to them, arranged
in descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates
account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Slices" option will display more slices in the chart, allowing
information for more accounts to display.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Income Statement

This report lists Income and Expense account totals for a set period. By default, it shows all Expense
and Income accounts down to 3 levels of sub-accounts for the current financial period.
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An Income Statement is also called a "Profit and Loss" report or "Revenue Statement."

In earlier versions of GnuCash, this report was called "Profit & Loss," but with version 2, the report
was renamed "Income Statement" to use more common accounting terminology.

The Income Statement helps show where money is coming from and where it is going for a given
time period.

Income vs. Day of Week

Income vs. Day of Week presents a piechart showing the totals for selected income accounts totaled by
the day of the week of the transaction. The report options enable you to make some adjustments (such
as accounts, display options, and the date range) but the account selector only allows income accounts
to be chosen. The report aggregates income transactions by day of week, not by any other period or
category. Due to these limitations, the report may be considered a demonstration or an example to
someone wanting to examine the source code for composing a useful custom report.

Trial Balance

Trial Balance lists the ending balances in all accounts as of a particular date. It is typically run at the
end of an accounting period and is primarily used to ensure that the total of all debits equals the total
of all credits.

Sample & Custom Group
The reports in this group offer examples on how reports can be customized or podified to suit personal
need.

Custom Multicolumn Report

This report provides a base that allows several standard and custom reports to be combined into one
view. Note that this report opens with an empty window; you must open the options and designate
which reports to include for display. Once the reports have been selected, the settings for individual
reports in the multicolumn display can be edited.

Sample Report with Examples

This is a sample report that users can examine to learn how to write their own reports.

Welcome Sample Report

This report demonstrates how the Multicolumn Report can be use to create custom dashboard-type
reports.

Other Reports
Several reports are included on the main Reports menu. These are described below.

Account Summary

This lists the balances of all accounts and subaccounts as of a particular date. By default, this report
shows accounts and totals down to third-level subaccounts.

This report gives effectively the same information as the Chart of Accounts. You can use this report
to export and print the Chart of Accounts.

Note: To generate a report of account totals over a particular time period (especially if you do not close
your books at regular intervals), you might consider using the Income Statement, or Cash Flow reports.
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Future Scheduled Transactions Summary

Tax Report & TXF Export

Generates a report and a downloadable .txf file of taxable income and deductible expenses for a par-
ticular accounting period. To download the report data, choose the Export button on the toolbar and
choose between html and .txf downloadable versions.

To use this report, you must use Edit --> Tax Options to identify which form the taxing authority uses
for each income or expense account. Note that you can see but not modify the "Tax related" checkbox
in Edit --> Edit Account.

Transaction Report

This report lists the transactions in selected accounts during a specified financial period. When first
run, this report loads no data, and the report options must be changed to retrieve information from
the file.

Saved Report Configurations

Selecting this will open a dialog with a list of available Saved Report Configurations. "Saved Report
Configurations" means sets of customized settings for standard reports.

These sets must be saved by the user before they appear here. See Report Concepts above for instruc-
tions on how to save report configurations.

Account Report

The Account Report menu entry only appears when an account register is the active tab. This report
produces a list of all transactions in the open register.

Note that if you conduct a search that retrieves several transactions, the results are displayed in a new
search register, which can then be used to create a report for just those transactions.

Account Transaction Report

This report also only appears when an account register is the active tab. However, this report only lists
transactions that have been selected (e.g. by mouse click) in the current register. If no transactions are
selected, an empty report will be generated.
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Capitolo 11. Guadagni in conto
capitale

Questo capitolo introdurrà alcune delle tecniche utilizzate per tenere traccia dei guadagni e delle per-
dite realizzate e non realizzate, meglio noti come guadagni o perdite in conto capitale.

Concetti base
Questo capitolo introdurrà alcune delle tecniche utilizzate per tenere traccia dei guadagni e delle per-
dite realizzate e non realizzate, meglio noti come guadagni o perdite in conto capitale.

Alcuni capitali re investibili possono variare il loro valore nel tempo come, per esempio, le azioni, le
obbligazioni, gli immobili o le auto. Alcune attività (es: le azioni) possono aumentare in valore mentre
altre (es: un’auto) posso perdere valore. È importante essere in grado di valutare queste variazioni nel
valore del capitale: questo capitolo illustrerà come procedere.

Probabilmente tutto ciò che si possiede aumenterà o diminuirà il proprio valore al trascorrere del
tempo; quindi è importante capire per quali di questi beni sia indicato tracciarne le variazioni del
valore. Si consiglia di tracciare il valore solamente per quei beni che potranno essere venduti in futuro
in cambio di liquidi o che sono relativi alle imposte.

I beni consumabili (es: il cibo, il carburante per l’auto, o la carta per la stampante) ovviamente non
risultano interessati dall’argomento; inoltre, anche se il nuovo abito che si è appena acquistato perderà
valore, non si desidererà tracciare questa diminuzione dato che non si avrà l’intenzione di rivenderlo
e non si dovranno pagare delle imposte per la svalutazione dell’abito. Quindi, per questo esempio,
l’acquisto di un nuovo abito dovrebbe essere registrato come una semplice uscita...i soldi spesi sono
andati (!).

La rivalutazione (aumento del valore) di un bene avviene quando ciò che si possiede aumenta il proprio
valore al trascorrere del tempo. Quando si possiede un bene che ha aumentato il proprio valore, la
differenza tra il suo prezzo di acquisto e il suo nuovo valore prende il nome di guadagno non realizzato.
Quando il bene viene venduto, il profitto che se ne ricava è noto con il nome di guadagno realizzato o
guadagno in conto capitale. Un esempio di bene da cui è possibile avere dei guadagni non realizzati ed
eventualmente dei guadagni in conto capitale, è una azione di una società pubblicamente scambiata.

Stimare il valore
Come ricordato nell’introduzione di questo capitolo, i guadagni in conto capitale sono i profitti ottenuti
dalla vendita di un bene. In questa sezione verrà descritto come tracciare i guadagni in capitale in
GnuCash.

I metodi contabili per trattare le rivalutazioni di un bene, sono in qualche modo diversi da quelli per
le svalutazioni dato che generalmente si è interessati solamente al momento in cui si rivende il bene
e si ottiene un guadagno in capitale; questo è in contrasto con la natura continua del deprezzamento.
I guadagni in conto capitale sono un argomento importante nella sfera di influenza della tassazione,
poiché i governi tendono a essere interessati a far gravare le imposte sui guadagni in conto capitale
in un modo o nell’altro.

Nota

Come sempre, esistono delle eccezioni. Se si possiede un’obbligazione che paga tutti gli in-
teressi a maturazione, le autorità preposte alla tassazione richiedono spesso che venga rico-
nosciuto un interesse ogni anno e si rifiutano di trattarli come un guadagno in conto capitale.
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Si consultino le normative Nazionali a riguardo dei beni che possono essere tassati nell’e-
ventualità che ne derivi un guadagno in conto capitale.

Stimare l’accrescimento del valore di un bene non è generalmente cosa facile dato che spesso è diffi-
coltoso conoscerne il valore prima dell’effettiva vendita.

I titoli scambiati quotidianamente nei mercati aperti come le Borse, rappresentano probabilmente la
tipologia più semplice di bene per cui predire un valore e vendere il bene al prezzo di mercato è
semplice quanto chiamare il proprio Brocker (mediatore). Per contro, la stima del valore di una casa
è ben più complesso. Le case sono vendute meno frequentemente delle azioni, e la compravendita
consiste di grandi sforzi e negoziazioni per cui le stime tendono a essere meno precise. Allo stesso
modo, la vendita di un’auto prevede delle trattative che rendono il prezzo meno prevedibile.

Il valore di oggetti da collezione quali gioielli, opere d’arte, figurine e modellini è di ancora più diffi-
cile stima. I mercati per questi oggetti sono di nicchia e quindi meno aperti rispetto a quelli delle azioni
e delle case. Ancora peggio sono i beni unici nel loro genere; le fabbriche, generalmente, possiedono
dei macchinari che costano centinaia di migliaia di euro, costruiti appositamente per realizzare deter-
minati prodotti. Queste apparecchiature non hanno valore al di fuori di un contesto specifico. In questi
casi, diverse valutazioni in conflitto tra loro possono essere assegnate al bene e nessuna di esse è «in
assoluto» corretta.

Come regola generale della contabilità per quanto riguarda la stima dei guadagni non realizzati (o
perdite), si dovrebbe solamente valutare di nuovo dei beni quali le azioni che possono essere rivendute
immediatamente e per le quali esistono delle stime affidabili del valore. Per tutti gli altri beni, è meglio
attendere semplicemente il momento della vendita, nel quale è possibile determinare esattamente il
guadagno in conto capitale. Naturalmente non esiste una regola scritta per questo e infatti diversi
contabili adottano diversi comportamenti in questi casi.

Impostare i conti
Come nella maggior parte delle applicazioni della contabilità, esistono diverse metodologie per confi-
gurare i guadagni in conto capitale. Nel seguito verrà presentato un metodo generale sufficientemente
versatile per essere applicato nella maggior parte delle situazioni. Il primo conto di cui si ha bisogno
è quello del Costo del bene (conto di GnuCash del tipo Attività), che rappresenta la posizione in cui
verrà registrato l’acquisto originale del bene. Normalmente l’acquisto avviene con una transazione
dal proprio conto bancario.

Per tenere traccia della rivalutazione di un bene, saranno necessari tre conti. Il primo è un conto delle
attività per i Guadagni non realizzati dove verranno inseriti tutti gli importi delle rivalutazioni. Il conto
dei Guadagni non realizzati sarà bilanciato da un conto delle entrate per i Guadagni non realizzati,
in cui saranno registrate tutte le rivalutazioni periodiche. Infine, è necessario un ulteriore conto per le
entrate, denominato Guadagni realizzati in cui verranno registrati i guadagni in conto capitale derivanti
dalla vendita del bene.

Sotto è riportata una generica struttura dei conti adatta a tracciare la rivalutazione di due beni, BE-
NE1 e BENE2. Il conto Attività:Beni immobili:BENE1:Costo è bilanciato dal conto Attività:Attività
correnti:Conto risparmio mentre il conto Attività:Beni immobili:BENE1:Guadagni non realizzati è
bilanciato dal conto Entrate:Guadagni non realizzati (lo stesso discorso vale per il BENE2).

-Assets
    -Current Assets
        -Savings Account
    -Fixed Assets
        -ITEM1
            -Cost
            -Unrealized Gain
        -ITEM2
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            -Cost
            -Unrealized Gain
-Income
    -Realized Gains
    -Unrealized Gains
  

Esempio
Si supponga di acquistare un bene per cui si prevede un aumento del valore, quale un quadro di Degas,
e di volerne tenere traccia (se ne occuperà la compagnia di assicurazione, anche se nessun altro lo farà).

Start with an account hierarchy similar to that shown in la sezione chiamata «Impostare i conti»,
but replace «ITEM1» with «Degas» and you can remove the «ITEM2» accounts. We will assume
that the Degas painting had an initial value of one hundred thousand dollars. Begin by giving your
self $100,000 in the bank and then transferring that from your bank account to your Assets:Fixed
Assets:Degas:Cost account (the asset purchase transaction). You should now have a main account
window which appears like this:

La finestra principale dell’esempio sulla rivalutazione di un bene

Guadagni non realizzati

Un mese dopo, si ha ragione di credere che il valore del quadro sia aumentato di €10.000 (un guada-
gno non realizzato). Per registrare questo aumento, occorre inserire un trasferimento di €10.000 dal
conto dei propri guadagni accumulabili (Entrate:Guadagni non realizzati) al conto dei guadagni non
realizzati (Attività:Beni immobili:Degas:Guadagni non realizzati). La finestra principale assomiglie-
rà a questa:
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La struttura dei conti dopo l’inserimento del guadagno non realizzato

Vendere

Si supponga che un altro mese dopo i prezzi dei quadri di Degas siano saliti ancora un po’, in questo
caso di circa €20.000, come dalle proprie stime. Puntualmente si registreranno i €20.000 come entrate
derivanti da guadagni non realizzati; poi si decide di vendere il quadro.

Si presentano tre possibilità: si potrebbero aver correttamente stimato i guadagni non realizzati, sot-
tostimato i guadagni non realizzati o sovrastimato i guadagni non realizzati.

1. Stima accurata dei guadagni non realizzati.

Le proprie stime ottimistiche del prezzo del quadro erano corrette. Prima di tutto si deve registrare
che i profitti ottenuti sono ora guadagni realizzati, e non guadagni non realizzati. Questo si effet-
tua trasferendo le entrate dal conto Entrate:Guadagni non realizzati al conto Entrate:Guadagni
realizzati.

In secondo luogo, occorre accreditare il conto bancario con il prezzo di vendita del quadro. Que-
sto denaro proviene direttamente dal sottoconto Attività:Beni immobili:Degas. Si trasferisca l’in-
tero valore del conto Attività:Beni immobili:Degas:Costo nel conto Attività:Beni immobili:Conto
risparmio e l’intero valore del conto Attività:Beni immobili:Degas:Guadagni non realizzati nel
conto Attività:Attività correnti:Conto risparmio.

Queste transazioni dovrebbero apparire così:

Tabella 11.1. Convertire un guadagno accumulato in un guadagno realizzato

Conto Trasferimento a Importo della transa-
zione

Totale del conto

Entrate:Guadagni non
realizzati

Entrate:Guadagni rea-
lizzati

€30.000 €0

Attività:Beni immobi-
li:Degas:Costo

Attività:Attività cor-
renti:Conto risparmio

€100.000 €0

155



Guadagni in conto capitale

Attività:Beni immobi-
li:Degas:Guadagni non
realizzati

Attività:Attività cor-
renti:Conto risparmio

€30.000 €0

Questo porta i saldi dei conti Attività:Attività correnti:Conto risparmio e Entrate:Guadagni rea-
lizzati a un totale rispettivamente di €130.000 ed €30.000.

La struttura dei conti dopo l’inserimento dei guadagni realizzati

2. Sottostima dei guadagni non realizzati.

You were over-optimistic about the value of the painting. Instead of the $130000 you thought the
painting was worth you are only offered $120000. But you still decide to sell, because you value
$120000 more than you value the painting. The numbers change a little bit, but not too dramatically.

Le transazioni dovrebbero apparire come nell’immagine seguente (si osservi che l’ultima transa-
zione che bilancia i conti dei Guadagni non realizzati):

Tabella 11.2. Convertire un guadagno accumulato in un guadagno realizzato

Conto Trasferimento a Importo della transa-
zione

Totale del conto

Entrate:Guadagni non
realizzati

Entrate:Guadagni rea-
lizzati

€20.000 €10.000

Attività:Beni immobi-
li:Degas:Costo

Attività:Attività cor-
renti:Conto risparmio

€100.000 €0

Attività:Beni immobi-
li:Degas:Guadagni non
realizzati

Attività:Attività cor-
renti:Conto risparmio

€20.000 €10.000

Attività:Beni immobi-
li:Degas:Guadagni non
realizzati

Entrate:Guadagni non
realizzati

€10.000 €0

Questo porta i saldi dei conti Attività:Attività correnti:Conto risparmio e Entrate:Guadagni rea-
lizzati a un totale rispettivamente di €120.000 ed €20.000.
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3. Sovrastima dei guadagni non realizzati.

Si supponga di riuscire a vendere il quadro a un prezzo superiore alle proprie più rosee previsioni:
€150.000. Il plusvalore è, di nuovo, trattato come un guadagno, cioè un’entrata.

Le transazioni dovrebbero apparire come nell’immagine seguente (si osservi che l’ultima transa-
zione che bilancia i conti dei guadagni non realizzati):

Tabella 11.3. Convertire un guadagno accumulato in un guadagno realizzato

Conto Trasferimento a Importo della transa-
zione

Totale del conto

Entrate:Guadagni non
realizzati

Entrate:Guadagni rea-
lizzati

€50.000 €-20.000

Attività:Beni immobi-
li:Degas:Costo

Attività:Attività cor-
renti:Conto risparmio

€100.000 €0

Attività:Beni immobi-
li:Degas:Guadagni non
realizzati

Attività:Attività cor-
renti:Conto risparmio

€50.000 €-20.000

Entrate:Guadagni non
realizzati

Attività:Beni immobi-
li:Degas:Guadagni non
realizzati

€20.000 €0

Questo porta i saldi dei conti Attività:Attività correnti:Conto risparmio e Entrate:Guadagni rea-
lizzati a un totale rispettivamente di €150.000 ed €50.000.

Tassazione
Le politiche di tassazione variano considerevolmente fra un paese e un altro, quindi è virtualmente
impossibile pronunciarsi in modo valido universalmente. Comunque, è possibile affermare che co-
munemente le entrate generate dai guadagni in conto capitale non sono soggette a tassazione fino al
momento in cui il bene viene venduto e a volte nemmeno in questo momento. I proprietari di case
nel Nord America, normalmente si ritrovano a non dover pagare nessuna tassa per il guadagno in ca-
pitale che ottengono dalla vendita. Altri paesi invece trattano la vendita delle case in modo differente:
le autorità tedesche, per esempio, tassano i guadagni in capitale derivanti dalla vendita di una casa,
solamente se si è stati proprietari per meno di dieci anni.

Chris Browne ha una storia da raccontare relativa a quando era un professionista della preparazione
delle tasse; una famiglia che aveva venduto una fattoria, si aspettava una considerevole somma di tasse
da pagare che però in realtà, furono quasi nulle per il fatto che avevano ottenuto la proprietà prima del
1971 (in cui è stabilita una data critica per le valutazioni in Canada) e dato che la fattoria era anche un
caseificio per cui erano possibili alcune particolari deduzioni. La morale di questa storia è che mentre
qui è stato mostrato in modo semplice, la tassazione può divenire molto complicata...
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Capitolo 12. Valute multiple
This chapter will show how to set up GnuCash accounts to use multiple currencies.

Concetti base
GnuCash supports over a hundred currencies, from the Andorran Franc to the Zimbabwe Dollar. For
example, you can have a bank account set up in Euros, and another using Hong Kong Dollars.

Alcuni dei problemi che sorgono quando si utilizzano più valute, hanno a che fare con il trasferimento
di fondi tra conti con diversa valuta, con il calcolo del valore totale di conti che hanno valute diverse
e con la preparazione dei resoconti con valute miste.

Nota

An alternative way to manage multiple currency accounts from the one presented in the next
sections, is to use the trading accounts capabilities of GnuCash. This feature, which was
introduced with GnuCash version 2.3.14, can be enabled by going to the Accounts tab under

File →  Properties.

For a complete guide on trading accounts, see  this tutorial by Peter Selinger [http://www.ma-
thstat.dal.ca/~selinger/accounting/tutorial.html].

Impostare i conti
Your default account currency is set in the Account tab under Edit → Preferences (GnuCash → Pre-
ferences on Mac OS X).

Similarly, GnuCash offers an option to set your preferred currency for displaying reports (like the
balance sheet and income statement). The option is called Default Report Currency, and is in the
Reports tab of the GnuCash Preferences screen. You’ll want to set both options when you start using
GnuCash because if (for example) your accounts are all in Canadian Dollars but the generated reports
are all in US Dollars, the reports will just say that there are «no data/transactions (or only zeroes) for
the selected time period».

When you create a new account, you have the option to define the commodity in which that account is
denominated. For accounts denominated in a currency, you can specify any of the currencies supported
by GnuCash by simply selecting it from the currency commodity list. You will notice that the default
currency is the currency that is defined for the parent account of the new account.

As an example, let’s set up a bank account scenario where you mostly work in US Dollars, but do also
have a European bank account using the Euro currency, as well as one bank account in Hong Kong
using Hong Kong Dollars. So, set up 3 bank accounts, one denominated in US Dollars, one using
Euros, and the third in Hong Kong Dollars. One possible account structure for this would be:

-Assets (USD)
   -Current Assets (USD)
      -US Bank (USD)
      -European Bank (EUR)
      -HK Bank (HKD)
-Equity (USD)
   -Opening Balances (USD)
      -USD (USD)
      -EUR (EUR)
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      -HKD (HKD)

Note: the currency of each account is shown in parenthesis.
 

Since in this example you mostly work in USD, all of the parent accounts are set to USD. Of course, if
you mostly work in Euros, you could change the currency of these parent accounts to EUR. The totals
shown in the account tree window will always be converted to the currency of each particular account.
Notice, we also set up 3 Starting Balances equity accounts, used to initially populate the 3 banks.

Nota

You could also set up just a single Starting Balance account and use a currency transfer to
populate the «different currency» accounts. However, this is more advanced option, which
is explained in a later section (la sezione chiamata «Purchase of an Asset with Foreign Cur-
rency»).

Below you see the result of this example, in which you start with USD 10,000, EUR 10,000 as well
as HKD 10,000 in the three bank accounts. Notice that the total of the parent accounts only shows the
value of the currency of sub-accounts with matching currencies. In other words, the Total Assets and
Total Equity values only reflect USD amounts, because GnuCash has no way of evaluating the value
of EUR or HKD yet. Once you set up exchange rates between the currencies, the parent accounts will
calculate the converted value of all sub-accounts. See the later section (la sezione chiamata «Recording
and Updating Currency Exchange Rates») on ways to do this.

Impostazione iniziale di 3 conti bancari con valute multiple.

Si noti che la colonna Totale (Resoconto) è visualizzata. Questa opzione è configurabile facendo clic
sulla freccia giù nella riga di intestazione delle colonne e selezionando «Totale(EUR)».

Valute definite dall’utente
Usually when we talk about currencies, we mean government-backed currencies (or more precisely,
currencies defined in ISO 4217 [http://en.wikipedia.org/wiki/ISO_4217]). GnuCash does not allow
you to create your own currencies. If you want to track non-ISO currencies, you can use either of two
workarounds, depending on which fits your needs better.
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The first method is is to treat these as if they were a security—that is, like a stock or mutual fund. The
second method is to use one of the «dummy» currencies for them.

Let’s say for example that you want to track loyalty points you’ve earned by buying from a certain
group of businesses. The account which tracks your loyalty points will be Assets:Other:LoyaltyGrou-
pRewardMiles.

In the first method, you define a new security, of type FUND, called RewardMiles. This is pretty
straightforward—when you create the new LoyaltyGroupRewardMiles account, just set the account
type to Stock or Mutual Fund, click the Select... button next to the Security/currency: box, and click
New to define a new security of type FUND.

This is not really what the stock and mutual fund account types are meant for, but GnuCash will allow
it. The downside is that you’ll have to enter a «price» for every transaction involving this account,
because GnuCash needs the prices to figure out the monetary value of the points and treat them as
one of your assets.

In the second method, you use one of the dummy currencies to track the loyalty points. These curren-
cies are «XTS (Code for testing purposes)» and «XXX (No currency)». If you use one of these for
your LoyaltyGroupRewardMiles account, you can enter transactions into the account without having
to enter share prices for every transaction. And, you can keep using the same two dummy currencies
to track all sorts of amounts—vacation dollars earned and used so far this year, vacation hours earned
and used, health insurance benefits allowance used and remaining, and so on.

The drawback with this second method is that you cannot define exchange rates for the dummy cur-
rencies to convert them to ISO currencies. If you want to do that, you really should use the first method.

Recording and Updating Currency Exchange
Rates

GnuCash allows you to update the Currency Exchange Rates both manually and automatically. This
process is essentially the same as setting share prices for investments (see la sezione chiamata «Im-
postare il prezzo delle quote»). In the following two sections we will work through both methods.

Prima di iniziare, è bene dare uno sguardo alla struttura dei conti
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Initial set up of 3 bank accounts with different currencies.

As you see, the overall balances do not yet reflect any value for EUR or HKD holdings. Adding
currency exchange rates will fix this.

Aggiornare manualmente i tassi di cambio

Aprire l’editor prezzi andando in Strumenti → Editor prezzi.

Finestra dell’editor prezzi.

Click on the Add button to add a new currency exchange rate. A window will appear in which you
can set up a new exchange rate. This window should appear like this:

Finestra dell’editor prezzi

Set the Namespace to Currency and the Security to EUR (Euro). Then set the exchange rate between
the selected security and the selected currency. The price box defines how many units of currency are
required to purchase one unit of the security. In this case, how many dollars it will take to purchase
on Euro. In this example, you will set the exchange rate to 1 EUR for 1 USD.
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La Finestra dell’editor prezzi dopo aver impostato il tasso di cambio tra Euro e dollaro USA

Struttura dei conti dopo aver impostato il tasso di cambio tra Euro e dollaro USA.

Si osservi che poiché non è stato impostato il tasso di cambio per HKD, GnuCash non converte l’HKD
in EUR. Questo verrà aggiunto nella sezione successiva.

Aggiornare automaticamente i tassi di cambio

In the previous section you saw how to manually define a new currency exchange rate, but GnuCash
includes an automatic price update feature, which will now be described.

Aprire l’editor prezzi andando in Strumenti → Editor prezzi.
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Finestra dell’editor prezzi prima di ottenere le quotazioni online.

Premere il pulsante Ricevi quotazioni per caricare automaticamente i vari tassi di cambio di cui si
ha bisogno.

Nota

Se il pulsante Ricevi quotazioni è disabilitato, significa che il modulo di Perl Finance::Quote
non è installato. Per informazioni su come installarlo, consultare la sezione chiamata «Con-
figurazione per la ricezione automatica delle quotazioni»

Finestra dell’editor prezzi dopo aver ottenuto le quotazioni online.

GnuCash downloads exchange rates for all currencies that are in use in your various accounts. This
will happen every time you click on Get Quotes or request GnuCash to download quotes as per la
sezione chiamata «Configurazione per la ricezione automatica delle quotazioni»

Now when you check the main Chart of Accounts you will see that GnuCash has automatically con-
verted the HKD amount to USD amount on the parent accounts that are in USD, as well as on the
Total (USD) column. Also the Euro accounts have been been updated with the latest exchange rate.
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Struttura dei conti dopo aver ottenuto le quotazioni online.

Come disabilitare il recupero della valuta

Ogni volta che si crea un conto che utilizza una valuta diversa da quella predefinita, verrà automatica-
mente abilitata la ricezione delle quotazioni online per quella stessa valuta. Comunque, se in seguito
il conto viene cancellato, GnuCash non disabiliterà automaticamente la ricezione delle quotazioni.

Quando sarà stato cancellato anche l’ultimo conto con una particolare valuta e non si vorrà ricevere
più gli aggiornamenti sulla valuta, procedere nel seguente modo:

• aprire la finestra dei titoli selezionando Strumenti → Editor titoli.

• assicurarsi che sia attivata l’opzione visualizza le valute Nazionali;

• espandere la riga denominata CURRENCY;

• fare doppio clic sulla valuta per cui si desidera disabilitare la ricezione delle quotazioni;

• Deselect the Get Online Quotes box and click OK.

Recording Purchases in a Foreign Currency
Purchases in a foreign currency can be managed in two different ways.

1) Use GnuCash's built-in currency exchange functions when you do your transactions. This is mainly
used for one-time transactions, and nothing which happens regularly.

2) Use separate accounts to track transactions, where all involved accounts use the same currency.
This is the recommended method, since it allows much better tracking and follow up. In this way, you
do one currency exchange transaction, and after that you do normal transactions in the native currency.

The rest of this section will explain more based upon option 2).
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Purchase of an Asset with Foreign Currency
You are using USD as your default currency. But, you decide to purchase a boat in Jamaica. To do
this, you opened a bank account in Jamaica, moved some money from the US, and then purchased
your boat.

To record this in GnuCash we use the following basic account structure:

-Assets (USD)
   -Current Assets (USD)
      -US Bank (USD)
      -Jamaican Bank (JMD)
   -Fixed Assets (USD)
      -Boat (JMD)
-Equity (USD)
   -Opening Balances (USD)
      -USD (USD)

Note: the currency of each account is shown in parenthesis.
 

First you need to transfer some money ($10,000) to Jamaica, and you use your US bank account (with
a balance of $100,000) for that. The bank gives you an exchange rate of USD 1 = JMD 64, but charges
you USD 150 to transfer the money.

Trasferimento di denaro in Jamaica

Selezionare la riga della transazione in Jamaica (€9.850,00), premere il tasto destro del mouse e sele-
zionare Modifica tasso di cambio

La finestra in cui viene specificato il tasso di cambio per una transazione in valuta
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As Exchange Rate, you enter 1 USD = 64 JMD, since this is the rate your bank gave. Press ok in the
Transfer Funds (Edit Exchange Rate) window, and then save this split transaction. Below is how it
now looks in the main Chart of Accounts.

Struttura dei conti prima dell’acquisto della barca

You choose to buy a boat for JMD 509,000. To record this transaction in GnuCash, you will need to
enter a simple transaction in Assets:Current Assets:Jamaican Bank withdrawing JMD 509,000 and
transferring it to Assets:Fixed Assets:Boat

Struttura dei conti dopo l’acquisto della barca

The Chart of Accounts now reflects that your bank account has been reduced by JMD 509,000, and
that your Fixed Assets boat account has been increased by the same amount. If you also have turned
on the CoA (Column Choice) "Total (USD)" you will see the corresponding value in USD. The USD
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value will always reflect the latest currency exchange rate you have either automatically or manually
retrieved.

Purchasing Foreign Stocks

This example will show how to purchase stocks that are priced in a currency other than your primary
currency.

Assume that you live in New York and therefore you have set the default currency to USD. You decide
to purchase a stock traded in Hong Kong that is priced in HKD. You would also like to be able to track
the various income and expense amounts per stock and broker.

You decide to purchase stock in the Beijing Airport (Hong Kong). The ticker for this stock is 0694.HK
on Yahoo! Since you wanted to track all various income and expense amounts, here is the necessary
account structure:

Assets:Investments:Brokerage Accounts:Boom:0694.HK (0694.HK)
Assets:Investments:Brokerage Accounts:Boom:Bank (HKD)
Equity:Opening Balances:HKD (HKD)
Expenses:Commissions:Boom.0694.HK (HKD)
Income:Investments:Dividend:Boom:0694.HK (HKD)
      

La struttura dei conti assomiglia a questa dopo la creazione di tutti i conti necessari:

Struttura dei conti per azioni internazionali

Le informazioni sull’azione sono visualizzabili nell’editor titoli (Strumenti+Editor titoli):
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Titoli Internazionali

If you have not moved money (HKD 50,000) into the brokerage cash account (Assets:Investmen-
ts:Brokerage Account:Boom:Bank), do so now, either using the Equity (HKD) account, or an existing
bank account (Currency Transfer).

There are two ways to enter the actual purchase transaction: you can enter it from the cash account
(shown below), or you can enter it from the stock account. If entered from the stock account, the stock
is assumed to be priced in the currency of the parent account.

Let’s assume that the stock price is HKD 3 per share. To record the purchase, open the brokerage’s
HKD cash account (Assets:Investments:Brokerage Account:Boom:Bank), and enter the following:

Buy Stocks

Assets:Investments:Brokerage Account:Boom:Bank Prelievo 50,000

Expenses:Investments:Commission:Boom_HKD Deposito 500

Assets:Investments:Brokerage Account:Boom:0694 Deposito 49,500 (16,500
shares)

Se non viene visualizzata automaticamente la finestra del Tasso di cambio, fare clic con il tasto destro
del mouse nella riga dell’azione e selezionare Modifica tasso di cambio. Nella finestra che verrà aperta,
inserire il numero di azioni (16.500) nel campo Trasferisci a:

Impostazione del numero di quote nella finestra del trasferimento fondi
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When you return to the Chart of Accounts, you will see the purchased shares reflected in the stock
account’s total.

Struttura dei conti con alcune azioni Internazionali

Come si può vedere, il totale in Euro potrebbe essere zero se non è stato impostato alcun tasso di

cambio tra EUR e HKD. Per porvi rimedio, andare in Strumenti → Editor prezzi e premere il pulsante
Ricevi quotazioni per far sì che GnuCash recuperi automaticamente i vari tassi di cambio di cui si
ha bisogno.

Nota

To reiterate, this example shows how stock can be purchased in any currency by entering the
transaction in the register of the cash account used to make payment. It is also possible to
enter the purchase in the stock account’s register, but be aware that the stock is assumed to
be priced in the currency of the stock account’s parent.

In questo esempio, il conto padre (Attività:Investimenti:Conto brockeraggio:Boom) è impo-
stato in HKD. Dato che si tratta della stessa valuta con cui viene espresso il prezzo dell’azio-
ne, l’acquisto può essere inserito tranquillamente nel registro del conto dell’azione.

Tracking Currency Investments
Currency investment is when you decide to invest in a different country's currency, and hope that it
will rise in value relative your own currency.

When you enter these transactions into GnuCash, you will have to decide on how much detail you
would like to have.

If you are not interested in detail at all, a very simple account structure would suffice:

    Assets:Investments:Currency:Bank (USD)
    Assets:Investments:Currency:XXX (XXX)
    

You would simply enter transfers between the two accounts, noting exchange rates as you went.

But, if you do want to be able to track capital gains or losses, as well as any fees, you do need a more
complex account structure, such as:
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    Assets:Investments:Currency:Bank (USD)
    Assets:Investments:Currency:Currency Bank:XXX (XXX)
    Expenses:Investments:Currency:Currency Bank:XXX (XXX)
    Income:Investments:Currency Bank:Capital Gains:XXX (XXX)
    

Purchasing Currency

When purchasing another currency, you will buy a certain number of units of foreign currency with
your own currency, at a particular rate. For example, you might buy USD 10,000 worth of Andorran
Francs, at 5 Francs to the dollar, with a transaction fee of $150.

Buy Currency

Attività:Investimenti:Valuta:Banca Prelievo 10,000

Expenses:Investments:Currency:Currency Bank:ADF Deposito 150

Assets:Investments:Currency:ADF Deposito 49,250

The Exchange Rate window should pop up when you leave the last row in the split above (Currency
Transaction). If this window does not pop up, right click on the row or select Actions, and select Edit
Exchange Rate. In the Exchange Rate window you specify the exchange rate you got from the bank.

Vendere un investimento in valuta

Entering a currency sale is done in the same way as a currency buy except that you are now transfer-
ring money from the Currency account to your Savings account (very similar to la sezione chiamata
«Vendere le azioni»).

The proper recording of the currency sale *must* account for realized gains or losses. This can be done
using a split transaction. In the split transaction, you must account for the profit (or loss) as coming
from an Income:Capital Gains account (or Expenses:Capital Loss). To balance this income, you will
need to enter the Currency asset twice in the split—once to record the actual sale (using the correct
amount and correct exchange rate), and once to balance the income profit (setting the amount to 0).

In breve, una transazione di vendita per la valuta, dovrebbe assomigliare a quella riportata più sotto,
vista di nuovo dal conto Attività:Investimenti:Valuta:Banca.

Tabella 12.1. Schema per la vendita di valuta con una transazione suddivisa

Conto Deposito Prelievo

Attività:Investimenti:Valuta:Banca Importo venduto -
Imposta di cambio

 

Uscite:Investimenti:Valuta:Valuta Banca:XXX Imposta di cambio  

Attività:Investimenti:Valuta:XXX  Importo venduto

Entrate:Investimenti:Valuta Banca:Guadagni in capitale:X-
XX

[PERDITA] UTILE

Attività:Investimenti:Valuta:XXX PROFITTO (con
trasferisci a = 0)

[PERDITA (con
trasferisci a = 0) ]
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Reconciling Statements in a Foreign Curren-
cy

Reconciling foreign statement are done in the same manner as when you reconcile your local bank sta-
tement. If you have created a Chart of Accounts structure which allows you to have the same currency
per account as your statement, it is actually exactly the same as reconciling your local bank statement.

Se si hanno diverse valute, si dovranno convertire manualmente gli importi tra una valuta e l’altra,
mentre si riconciliano i conti.
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Capitolo 13. Business Features
Introduction to Business Features

Le necessità contabili di un’impresa sono evidentemente differenti da quelle di un singolo individuo.
Le imprese devono gestire i clienti (che sono debitori di denaro), i fornitori o venditori (che sono
creditori), i libri paga dei dipendenti, una legislazione delle imposte più complessa, ecc... GnuCash
offre delle funzioni dedicate all’impresa per venire incontro a queste necessità.

Accounts Receivable (A/R) are used by businesses to record sales for which they are not immediately
paid. This is represented on the balance sheet as an asset, because the expectation is that you will
receive payment soon.

Accounts Payable (A/P) record bills that businesses have received, but may not pay until later. This
is represented on the balance sheet as a liability because you will have to pay for them.

A/R and A/P accounts are used primarily when you have a lot of bills and receipts flowing in and out,
and do not want to lose track of them just because you do not pay or get paid right away. For most
home users, A/R and A/P are too complicated to be worthwhile.

Business Setup
To set up GnuCash to handle accounts receivable or accounts payable for a company, these preliminary
steps must be done.

• Build an appropriate Account Hierarchy.

• Set up Tax Tables.

• Enter the company information in GnuCash.

• Set Business Preferences.

• Set up Billing Terms.

Impostare i conti
Esistono diversi modi per configurare una struttura dei conti per un’impresa; si può iniziare con quella
fornita dall’assistente per l’impostazione di una nuova struttura dei conti oppure crearne manualmente
una nuova. Per accedere alle strutture già pronte fornite con il programma, avviare GnuCash e sele-

zionare File → Nuovo file dal menu e procedere fino a quando viene visualizzata la lista delle strutture
disponibili, da cui si potrà selezionare quella relativa all’impresa.

The prebuilt Business Account hierarchy will not meet your needs exactly. You will need make ad-
justments to the hierarchy so that it will meet your particular needs. It should be close enough, howe-
ver, that it is recommended you begin with it.

To use GnuCash’s integrated accounts receivable system, you must first set up a special account (usual-
ly a sub-account under Assets) to hold transactions for receivables. This account must be defined with
account type A/Receivable. GnuCash will use this account to place transactions related to the integra-
ted accounts receivable system.

To use GnuCash’s integrated accounts payable system, you must first set up an account (usually a
sub-account under Liabilities) to hold transactions for payables. This account must be defined with
account type A/Payable. GnuCash will use this account to place transactions related to the integrated
accounts payable system.
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Basic A/R and A/P Account Hierarchy:

-Assets
   -Accounts Receivable
   -Checking
-Expenses
  ...(as required)
-Income
   -Sales
-Liabilities
  -Accounts Payable
  -Tax
      -Tax on Purchases
      -Tax on Sales
  

You need to add additional accounts to this hierarchy for it to be useful.

Nota

You do not need to create an individual A/R account for each customer. GnuCash keeps track
of customers internally and provides per-customer reports based on the internal tracking. The
same applies to A/P and vendors.

Nota

If you deal with customers in more than one currency you will need a separate Accounts
Receivable account for each currency.

If you deal with vendors in more than one currency you will need a separate Accounts Payable
account for each currency.

Nota

Transactions involving an Accounts Receivable or Accounts Payable account should not be
added, changed or deleted in any way other than by using Post/Unpost Bill/Invoice/Voucher
or Process Payment!

Setting up Tax Tables
Tax Tables can used to determine the tax for customer invoices (or vendor bills).

A tax table can be assigned to an invoice line or bill line.

Set up distinct tax tables for customers and vendors.

The default invoice line tax table can be assigned to each customer and the default bill line tax table
can be assigned to each vendor.

The default tax table for new customers or new vendors can be specified in the Book Options  window

which can be accessed by File → Properties → Business tab.

Tax Tables are maintained using the Sales Tax Table editor which is accessed via menu Business →
Sales Tax Table.

Figura 13.1. Tax Tables
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Figura 13.2. New Sales Tax Table

• Name This is the tax table name.

• Type Either Percent % or Value $.

• Value This is the percentage or value depending on Type.

• Account This is the account to which tax will be posted. For tax collected from customers, this
should probably be a Liability account as it must be payed to the government. For tax paid to
vendors, if tax laws allow tax paid to vendors to offset tax collected from customers, this should
probably also be a Liability account (even though it will usually have a debit balance) so that the
net tax owed to the government can be easily observed.

If you set up Tax on Purchases and Tax on Sales as subaccounts of Liabilities:Tax then the net tax
will be rolled up and can be seen in the GnuCash Accounts tab.

If unsure about tax law requirements, get professional advise.

Enter Company Information
After you have built the account structure and defined your tax tables, designate your company in the
GnuCash file. To do this, select the Business tab in the Book Options window, which can be accessed

from File → Properties.

Figura 13.3. Entering Company Information

Here you can:

• Inserire il nome della società e le informazioni di contatto quali il numero di telefono, di fax, l’in-
dirizzo e-mail e l’indirizzo internet.

• Inserire l’identificativo della propria impresa per il pagamento delle tasse nel campo ID impresa.

• Selezionare la tabella imposte predefinita applicabile ai clienti e ai venditori più comuni.

Setting Business Preferences

Set options on the Business tab of the GnuCash preferences, which is accessed via Edit → Preferences

(GnuCash → Preferences on Mac OS X). See Help manual chapter 10.3.3 Business Book Options Tab.

Setting Billing Terms
Billing Terms can be used to determine the payment due date and be a guide for determining discount
for early payment of invoices (or vendor bills).

Nota

As of GnuCash 2.6.7, Billing Terms are only partially supported. Date due is calculated using
the Billing Terms but discount amount is not.

Discount for early invoice payment is not implemented. There are 2 ways this may be done,
although neither is recommended, and professional advice should be used to confirm that
regulations are being complied with:
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• After creating and posting a payment which pays the invoice in full, manually edit the
payment transaction (usually strongly discouraged) and split the payment to reduce it by the
amount of the discount and a create a compensating split in an income (discount) account.

• Alternatively, after creating and posting a payment for the discounted amount, create a
credit note for the discount using a specific negative sales income (discount) account for
the transfer account.

You can specify the billing terms on each invoice/bill. Invoice billing terms will default from the
customer billing terms. Bill billing terms will default from the vendor billing terms.

Billing Terms are maintained using the Billing Terms Editor which is accessed via menu Business

→ Billing Terms Editor.

Figura 13.4. Billing Terms Editor

Figura 13.5. New Billing Term

• Name The internal name of the billing term. For some examples of billing term names and descrip-
tions see http://wiki.gnucash.org/wiki/Terms.

• Description The description of the billing term, printed on invoices

• There are 2 types of billing terms, with different information to be entered

• Type Days

• Due Days The invoice or bill is due to be paid within this number of days after the post date

• Discount Days The number of days after the post date during which a discount will be applied
for early payment

• Discount % The percentage discount applied for early payment

• Type Proximo

• Due Day The day of the month bills are due

• Discount Day The last day of the month for the early payment discount

• Discount % The discount percentage applied if paid early

• Cutoff Day The cutoff day for applying bills to the next month. After the cutoff, bills are
applied to the following month. Negative values count backwards from the end of the month.

Crediti correnti
Per crediti correnti si intendono quei prodotti o servizi forniti dalla propria società e per i quali non
è ancora stato ricevuto il pagamento.

Componenti del sistema
Transactions generated by the A/R system are recorded within the Accounts Receivable account. You
should not work directly with this account. Instead, you will work with the four integrated GnuCash
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A/R application components available through the Business → Customer sub-menu. These four com-
ponents are:

• Cliente è un singolo o una società a cui sono stati venduti prodotti o servizi in credito.

• Fattura rappresenta il documento cartaceo inviato al cliente per richiedere il pagamento. Essa con-
tiene una lista dettagliata degli oggetti venduti.

In addition, GnuCash also has support for Credit Notes which represent the inverse of Invoices.
A credit note is usually handed to a customer to correct items that were incorrectly invoiced or
returned.

Both document types will be set up using the same menu items. Credit notes were introduced starting
with GnuCash stable release 2.6.0.

• Lavoro (opzionale) qui vengono registrati i lavori relativi al cliente. Un lavoro in GnuCash è un mec-
canismo attraverso il quale è possibile raggruppare diverse fatture relative a un particolare cliente.

• Procedura di pagamento permette di registrare i pagamenti ricevuti da un cliente.

Cliente

Per cliente si intende un singolo o una società alla quale vengono venduti beni o servizi. Il cliente deve
essere registrato nel sistema dei crediti correnti.

Registrare un nuovo cliente

To register a new customer, enter the menu Business → Customer → New Customer. Fill in customer
information, such as Company Name, Address, Phone, Fax, etc.
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Finestra di registrazione di un nuovo cliente

Trovare e modificare un cliente

Per trovare un cliente, utilizzare la funzione Impresa → Cliente → Trova cliente. È poi possibile sele-
zionare, dalla finestra dei risultati, un cliente da Visualizzare o modificare. Questa finestra è anche uti-
lizzata per selezionare un cliente quando si crea una nuova fattura e quando si procede a un pagamento.
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Finestra di ricerca del cliente

Se dalla ricerca vengono restituiti molti elementi corrispondenti, è possibile filtrare i risultati eseguen-
do una ulteriore ricerca tra questi ultimi. Il gruppo dei risultati attuali viene analizzato quando è sele-
zionata l’opzione Perfeziona la ricerca attiva. GnuCash rende disponibile questa opzione solamente
dopo che è stata eseguita con successo la ricerca iniziale.

Se il cliente che si sta cercando non è stato trovato con il criterio di ricerca inserito, è possibile cambiare
il criterio di ricerca e selezionando l’opzione Nuova ricerca seguita dal pulsante Trova. Il passo più
importante è la selezione dell’opzione Nuova ricerca. Se il venditore non è tra i risultati della ricerca
originale e si effettua una ricerca tra i risultati ottenuti, il venditore non verrà trovato anche se il criterio
di ricerca è stato cambiato.

Nota

Per visualizzare una lista dei clienti attivi, si imposti il criterio di ricerca a corrisponde all’e-
spressione regolare e inserire un singolo punto . nel campo del testo da ricercare. Assicurarsi
che non sia selezionata l’opzione Cerca solo tra i dati selezionati, poi premere Trova. L’e-
spressione regolare . significa trova tutto.

Fattura

Una fattura è il documento cartaceo che si invia a un cliente per richiedere il pagamento di prodotti o
servizi prestati. GnuCash è in grado di creare e di registrare le fatture.

A credit note is the paperwork you send to a customer to correct products or services rendered that
were incorrectly invoiced. GnuCash can generate and track credit notes via the same menu entries
as invoices.

Nota

This section applies to both invoices and credit notes. In order to avoid repeating everything
twice and to keep the text easier to read it will refer only to invoices. You can apply it equally
to credit notes. Only where the behavior of credit notes differs from invoices this will be
explicitly mentioned.

Registrare un nuovo cliente

To send an invoice to a customer you must first create the new document. To create an invoice use

Business → Customer → New Invoice. The New Invoice window must be filled in appropriately.
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Creazione di una nuova fattura

Quando si preme il pulsante OK, verrà aperta la finestra di Modifica fattura.

Modificare una fattura

From the Edit Invoice window you can enter an itemized list of goods and services you sold on this
invoice in a manner similar to how the account register works. For credit notes you enter an itemized
list of goods and services you refunded instead.

182



Business Features

Finestra di modifica della fattura

Quando sono state inserite tutte le voci, si può Emettere e stampare la fattura.

Emettere una fattura

Quando è terminata la fase di modifica di una fattura e si è pronti a stamparla, è necessario Emettere
la fattura. Non è necessario emettere la fattura immediatamente; in fatti, la fattura deve essere emessa
solamente quando si è pronti a stamparla. L’emissione di una fattura prevede l’inserimento automatico
delle transazioni necessarie nel conto dei crediti correnti.

Finestra di emissione della fattura

Trovare una fattura

To find an existing invoice, use the Business → Customer → Find Invoice menu item. From the results
of the search, you can select an invoice to edit or view.
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Nota

Prima di poter modificare una fattura emessa, sarà necessario Annullarla.

Uno degli obiettivi di progetto del sistema di gestione dei crediti correnti presente in GnuCash, era
quello di fornire diverse strade per raggiungere una stessa posizione a seconda del metodo con cui si
idealizza il problema:

• si può cercare prima il cliente, e poi visualizzare le fatture a esso associate;

• si può cercare una fattura per numero o per nome della società;

• si possono visualizzare le fatture associate a un lavoro cliente.

Stampare una fattura
Dopo aver emesso una fattura, può essere utile stamparla e inviarla al cliente. Per stampare una fattura,

utilizzare la voce del menu principale File → Stampa fattura.

Risultato di stampa della fattura

Nota

È possibile modificare l’aspetto della fattura inserendo, per esempio, il logo della società
ecc... Per le istruzioni su come farlo, vedere la la sezione chiamata «Cambiare l’aspetto della
fattura».

Le fatture possono essere anche stampate dalla finestra principale selezionando la voce del menu

Resoconti → Resoconto impresa → Fattura stampabile. La finestra del resoconto avviserà che non è
stata selezionata una fattura valida per la stampa. Per selezionarla procedere come segue:

1. Utilizzare il pulsante Opzioni della barra degli strumenti o selezionare Modifica → Opzioni reso-
conto dal menu principale.

2. Selezionare la scheda Generale della finestra delle opzioni del resoconto.

3. Premere il pulsante Seleziona a fianco del campo del Numero fattura.

4. Cercare la fattura come al solito.

È inoltre possibile stampare le fatture direttamente dalla finestra della procedura di pagamento. Con-
sultare la la sezione chiamata «Procedere al pagamento» per le istruzioni su come procedere.
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Assegnare un numero iniziale alla fattura

GnuCash parte automaticamente con il numero 1 e ne incrementa poi il valore. È possibile inserire
manualmente un numero di fattura nella casella di testo ogni volta che viene creata un nuova fattura,
ma questa operazione può essere ripetitiva e prima o poi si arriverà a inserire dei numeri duplicati.

You can change the starting invoice number if it is important you. Use File → Properties, access the
Counters tab, change the Invoice number value to be one less than your desired starting invoice number
and click the OK button or the Apply button.

Lavori per un cliente
Customer Jobs are used to group multiple invoices and credit notes to the same customer. Use of the
Customer Jobs feature is optional. The feature is useful when you have multiple jobs for the same
customer, and would like to view all the invoices and credit notes related to a single job.

Nuovo lavoro per un cliente

To use customer jobs, you must create them using the Business → Customer → New Job menu item.
You will see the New Job window.

To edit an existing customer job, use the Business → Customer → Find Job menu item. Select the
desired job in the search results, and click the View/Edit Job button.

To select from the invoices and credit notes associated with a given job, use Business → Customer →
Find Job menu item. Select the desired job in the search results and click the View Invoices button. A
window listing invoices and credit notes associated with this job appears. Select an invoice or credit
note and click the View Invoice button to open an invoice editor in the main application window.

Procedere al pagamento
Verosimilmente, si riceverà il pagamento dai clienti per i quali è stata emessa una fattura. Per regi-

strarlo, si utilizza la procedura di pagamento raggiungibile dal menu Impresa → Cliente → Procedura
di Pagamento.
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Finestra della procedura di pagamento

Cambiare l’aspetto della fattura

Lo stile predefinito per le fatture, come mostrato nella la sezione chiamata «Stampare una fattura», à
piuttosto spoglio. Esso prevede che la parte superiore del documento sia vuota, in modo che la fattura
possa essere stampata su carta intestata. È però possibile modificare l’aspetto delle fatture.

Utilizzare la voce File → Proprietà per inserire le informazioni relative alla propria società nella scheda
Impresa della finestra Opzioni libro. Alcune delle informazioni inserite verranno stampate sul lato
destro delle fatture.

Per aggiungere uno sfondo, uno striscione di intestazione e un logo personalizzati alle fatture, occorre

modificare il foglio di stile. Per farlo, andare in Modifica → Fogli di stile e selezionare il pulsante
Nuovo nella finestra di Selezione del foglio di stile HTML che si aprirà. Verrà poi presentata una
finestra come questa:
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La finestra del nuovo foglio di stile.

Dare un Nome al nuovo foglio di stile (ad esempio Fattura personalizzata) e selezionare il Modello
denominato Elaborato. Alla pressione del pulsante OK verrà aperta la finestra delle Proprietà dei fogli
stile HTML. Questa contiene cinque schede: Colori, Stili, Generali, Immagini e Tabelle. La prima
scheda relativa ai colori permette di variare la colorazione delle varie sezioni che compongono la
fattura. La sezione deegli stili permette di impostare gli stili e le dimensioni dei caratteri. La scheda
delle impostazioni generali è dedicata alle informazioni del redattore e del destinatario e permette di
abilitare i collegamenti. La scheda delle immagini permette di importare delle immagini nel foglio di
stile. Infine, la schede delle tabelle, permette di configurare la spaziatura tra le tabelle che formano
la fattura.

Per inserire un logo della società, uno striscione di intestazione e una immagine di sfondo, è possibile
utilizzare un’applicazione di grafica come GIMP o OpenOffice Draw per creare l’immagine e salvarla
in formato GIF o PNG. A questo punto è possibile importarle nel foglio di stile utilizzando la sezione
Immagini descritta in precedenza.

Qui sotto è visualizzato un esempio in cui sono state importate tutte e tre le immagini.

La finestra del foglio di stile HTML con un esempio di immagine di sfondo, striscione di intestazione
e logo.

Nota

Le immagini sono inserite nella fattura con i criteri seguenti: l’Immagine di sfondo è adattata
per essere inserita come sfondo, lo Striscione di intestazione viene inserito al di sopra del testo
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della fattura e il Logo è posizionato nell’angolo in alto a sinistra della fattura a fianco dello
striscione di intestazione. Sarà probabilmente necessario provare immagini di dimensioni
diverse prima di ottenere una bella fattura. Vengono forniti alcuni suggerimenti su questo
argomento: il logo dovrebbe essere di circa 1 cm quadrato mentre lo striscione di intestazione
dovrebbe essere largo 15 cm e alto 1cm.

Avendo configurato il foglio di stile, al momento della stampa della fattura sarà possibile selezionarlo
dal menu Opzioni. Più sotto è riportata la fattura ottenuta dopo aver utilizzato il foglio di stile descritto
precedentemente.

La fattura che si ottiene con le immagini selezionate nel foglio di stile.

Debiti correnti
Accounts Payable (or A/P) refers to the accounting of products or services which a company has
bought and needs to pay for.

Componenti del sistema
GnuCash ha un sistema integrato di gestione dei debiti correnti. Le transazioni generate da esso ven-
gono inserite nel conto dei debiti correnti, come registrazione di ciò che avviene. Generalmente non si
lavora con questo conto ma si utilizzano i quattro componenti dell’applicazione integrata in GnuCash

per i debiti correnti. Questi componenti sono disponibili nel menu secondario Impresa → Venditore.
Essi sono:

• Venditore è un singolo o società dal quale si acquistano prodotti o servizi in credito.

• Ricevuta è il documento che il venditore invia per richiedere il pagamento. La ricevuta contiene un
elenco di ciò che è stato acquistato.

In addition, GnuCash also has support for Credit Notes which represent the inverse of Bills. A credit
note is usually received from a vendor to correct items that were erroneously billed or returned.

Both document types will be set up using the same menu items.

• Lavoro (opzionale) è dove vengono registrati i lavori venditore. I lavori sono degli strumenti con i
quali è possibile raggruppare le ricevute di un singolo venditore.
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• Procedura di pagamento permette di registrare i pagamenti in favore di un venditore verso cui si
è debitori.

La sezione seguente tratta individualmente i componenti dell’applicazione per i debiti correnti.

Venditore
Un venditore è un singolo o una società dalla quale si acquista uno o più beni o servizi. I venditori
devono essere inseriti nel sistema dei debiti correnti.

Registrare un nuovo cliente

To register a new vendor, select the Business → Vendor →  New Vendor menu item. Fill in general
information about the vendor, such as Company Name, Address, Phone, Fax, etc. Below is a list of
the other options:

La finestra di registrazione di un nuovo venditore assomiglia a questa:

Finestra di registrazione di un nuovo venditore
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Trovare e modificare un cliente

To search for an existing vendor, use the Business → Vendor →  Find Vendor window. You select
a vendor to View/Edit from the results of the search. This window is also used to look up a vendor
when entering bills and processing payments.

Finestra di ricerca del venditore

Se dalla ricerca vengono restituiti molti elementi corrispondenti, è possibile filtrare i risultati eseguen-
do una ulteriore ricerca tra questi ultimi. Il gruppo dei risultati attuali viene analizzato quando è sele-
zionata l’opzione Perfeziona la ricerca attiva. GnuCash rende disponibile questa opzione solamente
dopo che è stata eseguita con successo la ricerca iniziale.

Se il venditore che si sta cercando non è stato trovato con il criterio di ricerca inserito, è possibile
cambiare il criterio di ricerca e selezionando l’opzione Nuova ricerca seguita dal pulsante Trova. Il
passo più importante è la selezione dell’opzione Nuova ricerca. Se il venditore non è tra i risultati della
ricerca originale e si effettua una ricerca tra i risultati ottenuti, il venditore non verrà trovato anche se
il criterio di ricerca è stato cambiato.

Nota

Per visualizzare un elenco dei venditori attivi, impostare il criterio di ricerca a corrisponde
all’espressione regolare e inserire un singolo punto «.» nel campo del testo da ricercare. As-
sicurarsi che non sia selezionata l’opzione Cerca solo tra i dati selezionati, poi premere Tro-
va. L’espressione regolare «.» significa «fai corrispondere a qualsiasi cosa».

Ricevuta
Una ricevuta è la richiesta di pagamento che si riceve da un venditore. GnuCash è in gradi di gestire
le ricevute.

A credit note is the document you receive from a vendor to correct products or services rendered that
you were incorrectly charged for on a bill. GnuCash can generate and track credit notes via the same
menu entries as bills.

Nota

This section applies to both bills and credit notes. In order to avoid repeating everything
twice and to keep the text easier to read it will refer only to bills. You can apply it equally to
credit notes. Only where the behaviour of credit notes differs from bills this will be explicitly
mentioned.
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Registrare un nuovo cliente

Quando si riceve una ricevuta da un venditore e la si vuole immettere in GnuCash, è necessario creare

una nuova ricevuta. Per farlo è disponibile la voce Impresa → Venditore → Nuova ricevuta. Apparirà
una finestra in cui sono presenti diversi campi da completare.

Finestra per la creazione di una nuova ricevuta

Alla pressione del pulsante OK verrà aperta la finestra di Modifica ricevuta.

Modificare una fattura

From the Edit Bill window you can enter an itemized list of goods and services you purchased, in a
manner similar to how the account register works. For credit notes you enter an itemized list of goods
and services the vendor refunded instead.
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Finestra di modifica della ricevuta

Quando si è terminata l’immissione di tutte le voci, si può Emettere la ricevuta.

Emettere una fattura

Quando si è terminata la fase di modifica di una ricevuta, la si deve Emettere. Non è necessario emet-
terla subito, è possibile infatti chiudere la finestra di modifica e ritornarvi in seguito. Prima o poi però
la ricevuta dovrà essere emessa. L’emissione di una ricevuta comporta l’inserimento delle necessarie
transazioni nel conto per i debiti correnti. La finestra di emissione della ricevuta richiede l’inserimento
di alcune informazioni:

Finestra di emissione della ricevuta
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Trovare una fattura

To find an existing bill, use the Business → Vendor → Find Bill menu item. From the results of the
search, you can select a bill to edit, or view.

Nota

Prima di poter modificare una ricevuta emessa, è necessario Ritirarla.

Nota

Esistono altri modi per accedere a una ricevuta esistente simili a quelli utili per accedere alle
fatture per i clienti. Consultare la sezione chiamata «Trovare una fattura» per avere maggiori
informazioni.

Lavori per un venditore
Vendor Jobs are used to group multiple bills and credit notes from a single vendor. Use of the vendor
jobs feature is optional. The feature is useful when you have multiple jobs for the same vendor, and
would like to view all the bills and credit notes for a single job.

To use vendor jobs, you must create them using the Business → Vendor → New Job menu item. You
will see the New Job window.

Nuovo lavoro venditore

To edit an existing vendor job, use the Business → Vendor → Find Job menu item. Select the desired
job in the search results, and click the View/Edit Job button.

To select from the bills associated with a given job, use Business → Vendor → Find Job menu item.
Select the desired job in the search results and click the View Invoices button. A window listing bills
and credit notes associated with this job appears. Select a bill or credit note and click the View Invoice
button to open a bill editor in the main application window.

193



Business Features

Procedere al pagamento
Prima o poi sarà necessario pagare le ricevute. Per farlo, si utilizza l’applicazione per il pagamento

raggiungibile nel menu Impresa → Venditore → Procedura di pagamento.

Più sotto è riportata la finestra di pagamento dei crediti correnti in GnuCash.

Finestra della procedura di pagamento

Libro paga
Payroll is a financial record of wages, net pay, paid vacations, and deductions for an employee. This
section demonstrates how to track payroll using GnuCash.

Concetti base
Il libro paga consiste nella registrazione finanziaria di salario, retribuzione netta, ferie e trattenute per
un dipendente: fondamentalmente tutto ciò che è relativo al conferimento di denaro e benefici a un
dipendente. La tenuta del libro paga è una delle pratiche più complesse della contabilità poiché nel
pagamento degli stipendi sono coinvolti molti conti, persone e agenzie.

Il libro paga è generalmente contabilizzato come un’uscita. A volte i contabili «accumulano» le uscite
del libro paga in un conto delle passività a breve termine. Questo accorgimento risulta utile per il libro
paga delle imposte che potrebbero dover essere pagate in un momento diverso rispetto ai dipendenti. Il
dipendente potrebbe essere pagato ogni due settimane mentre le tasse ogni trimestre. Questo capitolo
illustra il caso in cui i salari vengono pagati immediatamente mentre le tasse vengono accumulate in
un conto delle passività.
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Nota

GnuCash non fornisce un sistema integrato di gestione del libro paga. Anche se è possibile
registrare le uscite del libro paga in GnuCash, i calcoli delle imposte e delle deduzioni devono
essere realizzati al di fuori del programma.

Impostare i conti
Le legislazioni locali in materia di imposte devono essere considerate al momento della creazione dei
conti. Dato che esistono diversi modi con cui vengono calcolate le imposte sul libro paga a seconda
del paese in cui ci si trova, in questa sezione verrà presentato solamente un semplice schema. Partendo
da questo, sarà necessario sviluppare una struttura più complessa che si adatti alle proprie necessità
particolari.

Assume that you must pay 2 taxes, Tax1 and Tax2, and that each has an employee contribution and
an employer contribution.

Gli stipendi dei dipendenti e queste due tasse sono conti per le uscite. Le imposte della società sono
passività. I conti delle passività per le imposte servono per accumulare le imposte trattenute a tutti i
dipendenti. Le imposte saranno poi pagate alla relativa agenzia governativa.

              Simple Payroll Account Layout:
              
              -Assets
              --Checking
              -Liabilities
              --Tax1  (short term «Immagazzinamento» account)
              --Tax2  (short term «Immagazzinamento» account)
              -Expenses
              --Salaries
              --Tax1
              --Tax2
           

Nota

Si resista alla tentazione di creare dei sottoconti per registrare i salari per ogni dipendente: si
verrebbe a creare una lista ingestibile di conti. Si pensi, per esempio, alla lista che si avrebbe
dopo diversi anni di attività e vari dipendenti licenziati e assunti. È molto più semplice regi-
strare tutti gli stipendi in un unico conto (per esempio Uscite:Stipendi) e utilizzare i resoconti
per visualizzare le informazioni suddivise per dipendente.

The Transaction report can be used to sort and total by description or memo (but not by part
of them).

To report salary transactions for a specific employee where the employee name or code is en-

tered in the transaction description or memo, use the Find Transaction assistant (Edit → Find)

to select the transactions, and then report on them using Reports → Account Report . Further
formatting or analysis may be done by copying and pasting the report into a spreadsheet. See
Find Transaction [ghelp:gnucash-help?tool-find-txn] in the GnuCash Help Manual.

Payroll Protocol Sample
GnuCash non possiede un sistema integrato per la gestione del libro paga. GnuCash permette di regi-
strare le uscite del libro paga, ma è necessario implementare un codice di calcolo per il libro paga ed
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eseguire i relativi calcoli con un programma diverso da GnuCash, per esempio in un foglio di calcolo.
In questa sezione viene illustrato un codice di calcolo di questo tipo che è possibile utilizzare come
modello.

Passo 1: Elenco delle deduzioni

Il primo passo per la realizzazione del codice di calcolo consiste nella creazione di una lista di tutte le
possibili tasse e deduzioni per ogni dipendente. Ogni voce deve contenere le definizioni e le formule
necessarie a calcolarne il valore. Una volta stabilito il codice, questo deve essere cambiato solamente
quando il libro paga o la legislazione sulle imposte cambiano.

Nello scenario proposto, l’elenco sarà come questo:

• D_STIPENDIO_LORDO - Stipendio lordo del dipendente
• D_IMPOSTA1 - Contributo del dipendente all’imposta1 (X% di D_STIPENDIO_LORDO)
• D_IMPOSTA2 - Contributo del dipendente all’imposta2 (X% di D_STIPENDIO_LORDO)
• S_IMPOSTA1 - Contributo della società all’imposta1 (X% di D_STIPENDIO_LORDO)
• S_IMPOSTA2 - Contributo della società all’imposta2 (X% di D_STIPENDIO_LORDO)

Nota

Lo stipendio netto del dipendente (D_STIPENDIO-NETTO) è definito come D_STIPEN-
DIO_LORDO - D_IMPOSTA1 - D_IMPOSTA2 e non è necessario inserirlo in questa lista
dato che può essere calcolato dagli elementi già noti.

Inserire le formule corrette per calcolare le deduzioni corrispondenti alle voci della lista. A volte le
formule possono essere complesse mentre altre volte si tratta solamente di guardare la tabella XYZ
delle leggi in materia.

Si noti che con le definizioni più sopra è possibile calcolare dei valori di un certo interesse. Per esem-
pio è possibile conoscere il costo totale per la società: D_STIPENDIO_LORDO + S_IMPOSTA1 +
S_IMPOSTA2.

Passo 2: Creare lo schema della transazione

Quando si inserisce un libro paga in GnuCash, conviene farlo con una singola transazione suddivisa
che coinvolge i conti appropriati di uscite e passività. Per poter controllare i dettagli del libro paga in
un secondo momento, aprire la transazione suddivisa.

Con l’elenco delle deduzioni descritto precedentemente, è possibile creare uno schema per la transa-
zione suddivisa di un impiegato. Ogni elemento della lista è collegato a un conto di GnuCash.

Tabella 13.1. Schema della transazione

Conto Aumento Diminuzione

Attività:Conto corrente D_STIPENDIO-NETTO

Uscite:Stipendi D_STIPENDIO_LORDO

Passività:Imposta1 D_IMPOSTA1

Passività:Imposta2 D_IMPOSTA2

Uscite:Imposta1 S_IMPOSTA1

Passività:Imposta1 S_IMPOSTA1

Uscite:Imposta2 S_IMPOSTA2

Passività:Imposta2 S_IMPOSTA2
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Si noti come i componenti di S_IMPOSTA1 e S_IMPOSTA2 abbiano delle ricadute sia sul conto
delle passività che su quello delle uscite. La parte di competenza della società per ogni imposta è
contabilizzata alla data del libro paga, ma rimane una passività fino al momento del versamento.

Passo 3: Pagare il dipendente

Andare nel conto da cui verrà pagato il dipendente, per esempio il proprio conto Attività:Conto cor-
rente. Aprire una transazione suddivisa e inserire il valore reale utilizzando come guida lo schema
della transazione descritta più sopra. Ripetere il procedimento per tutti i dipendenti.

Suggerimento

Questo processo manuale è tedioso, specialmente se si ha a che fare con un elevato numero
di dipendenti.

Uno strumento fornito da GnuCash che può essere di aiuto in questa transazione è quello
che permette di duplicare una transazione (utilizzare il pulsante Duplica sulla barra degli
strumenti). Questo permette di evitare l’inserimento di tutte le suddivisioni nella transazione
per ogni dipendente. Sarà comunque necessario variare secondo necessità gli importi della
busta paga del dipendente, ma non occorrerà più creare da zero le suddivisioni necessarie.

Se le transazioni del libro paga non cambiano significativamente tra una scadenza e l’altra,
è possibile utilizzare la funzione di duplicazione della transazione per creare una copia del-
la busta paga più recente di un dipendente ed utilizzarla per l’attuale stipendio. Se questo
processo viene eseguito con una certa cadenza costante, leggere il capitolo sulle transazioni
pianificate per risparmiare ancora più tempo!

Passo 4: Pagare il governo

L’ultima operazione da compiere è relativa alle tasse governative. Il conto delle passività ha raccolta
le tasse spettanti alle varie agenzie governative; queste devono essere pagate periodicamente inviando,
per esempio, un assegno agli uffici competenti. Per registrare il pagamento in GnuCash è sufficiente
inserire una transazione a due conti dal (per esempio) il conto corrente per pagare la passività derivante
dalle imposte. La transazione avviene esclusivamente tra il conto corrente e il conto delle passività;
nell’operazione non viene coinvolto alcun conto delle uscite. Il conto delle uscite è addebitato nel
momento in cui viene registrata la passività relativa alle imposte.

Business Payroll Example

Using the account setup seen previously, let’s go through an example. Assume that there are 2 em-
ployees (E1 and E2) who each earn $1000 per month gross salary. The employee contribution to Tax1
and Tax2 are 10% and 5% respectively. The company contribution to Tax1 and Tax2 are 15% and
10% each on top of the employee’s gross salary.

Starting with $50k in the bank, and before doing any payroll, the account hierarchy looks like this:
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Impostazione iniziale del libro paga

The deductions list for employee 1 are:

• D_STIPENDIO_LORDO - stipendio lordo del dipendente - €1.000

• D_IMPOSTA1 - Contributo del dipendente all’imposta1 - €100 (10% si D_STIPENDIO_LORDO)

• D_IMPOSTA2 - Contributo del dipendente all’imposta2 - €50 (5% di D_STIPENDIO_LORDO)

• S_IMPOSTA1 - Contributo della società all’imposta1 - €150 (15% di D_STIPENDIO_LORDO)

• S_IMPOSTA2 - Contributo della società all’imposta2 - €100 (10% di D_STIPENDIO_LORDO)

Tabella 13.2. Schema della transazione per il Dipendente 1

Conto Aumento Diminuzione

Attività:Conto corrente €850 (D_STIPENDIO-NETTO)

Uscite:Stipendi €1000 (D_STIPENDIO_LOR-
DO)

Passività:Imposta1 €100 (D_IMPOSTA1)

Passività:Imposta2 €50 (D_IMPOSTA2)

Uscite:Imposta1 €150 (S_IMPOSTA1)

Passività:Imposta1 €150 (S_IMPOSTA1)

Uscite:Imposta2 €100 (S_IMPOSTA2)

Passività:Imposta2 €100 (S_IMPOSTA2)

From the checking account, enter the split transaction for employee 1. It should look like this:
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Transazione suddivisa per il Dipendente1

Suggerimento

Quando si pagano i dipendenti, inserire solamente il nome del dipendente nel campo della
descrizione. Se si decide di utilizzare GnuCash anche per la stampa degli assegni, l’assegno
verrà creato con il nome corretto del dipendente a cui si riferisce. Per registrare altre infor-
mazioni nella transazione oltre al nome del dipendente, utilizzare il campo delle note, dispo-
nibile quando si visualizza il registro nella modalità a doppia linea.

Si ripeta la procedura descritta anche per il secondo dipendente; al termine la struttura dei conti asso-
miglierà a questa:

La struttura dei conti dopo aver pagato gli stipendi

Now, you will enter the company contributions. The Liabilities:Tax1 and Liabilities:Tax2 accounts
track how much you must pay to the government for each tax type. When it is time to pay these
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agencies, you will make a transaction from the checking account to these liability accounts. No expense
accounts are involved. The main account will then appear like this:

I conti dopo aver pagato le imposte governative
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Capitolo 14. Bilanci
Questo capitolo spiega come creare e gestire i bilanci con GnuCash.

Concetti base
Il bilancio è uno strumento che permette di stimare e prevedere le entrate e le uscite. Si può utilizzare
per aiutarsi nella pianificazione delle proprie finanze in un certo periodo di tempo e per esaminare
come sono le proprie transazioni finanziarie attuali in confronto a quelle attese.

Il concetto di bilancio è generale e quindi GnuCash offre uno strumento di calcolo del bilancio che
è semplice e flessibile. L’utente ha la libertà di decidere la complessità o la semplicità del proprio
bilancio. Questa guida aiuterà nella scelta di queste decisioni.

Terminologia
Esistono dei termini utili che verranno utilizzati per trattare l’argomento del bilancio:

• Bilancio - un piano finanziario che descrive i redditi attesi e/o le spese relative ad un particolare
periodo di tempo period

• Bilancio dei liquidi - un bilancio preventivo per gli introiti e gli esborsi di liquidi. Questio tipo di
bilanciosi occupa dei flussi di liquidi: da dove proviene il proprio denaro, qual’è la sua destinazione
e, naturalmente, a quanto ammonta.

• Bilancio delle uscite - un bilancio destinato principalmente alla pianificazione delle destinazioni del
proprio denaro. Questo tipo di bilancio registra le proprie uscite. Generalmente non ha niente a che
vedere con le rivalutazioni o con i rimborsi delle passività. Comunque, tiene conto degli interessi.
Per esempio, se si acquistano €100 di alimentari con la carta di credito, si incorre in una spesa
di €100 per alimentari e una passività di 100€ verso la compagnia della carta di credito. Quando
si pagherà la ricevuta della carta di credito, verrà applicato un tasso di interesse che si suppone
dia origine ad una spesa addizionale di €10. Un bilancio delle uscite è in grado di pianificare la
transazione per l’acquisto degli alimentari e per il pagamento degli interessi, ma non la transazione
per ripagare la compagnia della carta di credito.

• Bilancio di capitale - un bilancio che descrive un piano per pagare una ingente spesa futura, spesso
attraverso una combinazione di risparmi e prestiti in denaro. Nota: i bilanci di capitale possono
a volte divenire piuttosto complessi perché hanno anche lo scopo di rispondere alla domanda «è
possibile permettersi di fare questo e quello?» esplorando diversi scenari che coinvolgono conti
ipotetici.

• Periodo di bilancio - il periodo di tempo durante il quale il piano si sviluppa. I periodi di bilancio più
comunemente utilizzati sono l’anno e il mese. Alle volte, potrebbe essere utile fare il bilancio per
diversi periodi consecutivi in una volta, per convenienza o per una pianificazione più dettagliata.
Ad esempio, un bilancio annuale può includere un periodo di bilancio di 12 mensilità.

Creare un bilancio
Ancora prima di iniziare la creazione di un bilancio, è importante spendere un po’ di tempo pensando
alla struttura dei conti. Per esempio, se si desidera ottenere un bilancio per le proprie spese di elettricità
e acqua, non è possibile avere solamente un conto Uscite:Servizi. I conti devono essere dettagliati
almeno quanto il bilancio che si vuole ottenere.

Scegliere i conti per i quali creare il bilancio
Il primo passo da compiere nella creazione di un bilancio, consiste nello scegliere che cosa di desidera
pianificare. Questa decisione influisce sulla scelta dei conti da includere nel bilancio. Ad esempio, se
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si è interessati solamente al tracciamento delle proprie spese, si può creare un bilancio delle uscite
inserendo solamente gli importi dei conti delle uscite. D’altra parte, se si desidera tracciare tutti i propri
movimenti di liquidi, si può creare un bilancio dei flussi di liquidi immettendo gli importi dei conti
di attività, passività, entrate e uscite.

Prima di procedere alla creazione del bilancio occorre prendere due decisioni: per quali conti si desi-
dera ottenere un bilancio? e, per quando si desidera che venga calcolato il bilancio? È sempre possibile
cambiare idea in seguito dopo la creazione del bilancio, ma è necessario iniziare con qualcosa.

Suggerimento

Come regola generale, spesso interessa conoscere in cosa si spende il proprio denaro e quindi
si potrebbe voler realizzare un resoconto delle uscite. Se si è anche preoccupati di non avere
abbastanza denaro al posto giusto nel momento giusto, si potrebbe voler realizzare un bilancio
dei flussi di liquidi.

Scegliere il periodo di bilancio
Prima di creare un bilancio occorre anche decidere per quale periodo di tempo si desidera pianificare. I
periodi di bilancio più comuni sono mensilmente e annualmente. Se si desidera realizzare un bilancio il
cui percorso finanziario nel tempo sia variabile, allora sarebbe necessario includere diversi periodi nel
bilancio. Ad esempio, se si desidera pianificare delle spese maggiori per i servizi nel periodo invernale
piuttosto che in quello estivo, allora si potrebbe voler suddividere il bilancio annuale in 4 trimestri o
anche in 12 mesi, e mettere nel bilancio un valore superiore per il periodo invernale e uno inferiore
per quello estivo.

Come Iniziare

Per creare il primo bilancio selezionare Operazioni → Nuovo → Nuovo bilancio preventivo. Verrà
immediatamente visualizzato un nuovo bilancio con le impostazioni predefinite e nessun elemento.
Selezionare poi il pulsante Opzioni. Le opzioni più importantii sono quelle relative al periodo e al
numero di occorrenze. Per il periodo del bilancio, selezionare la data d’inizio e il periodo di tempo
più corto per il quale si vuole effettuare il conteggio. Poi selezionare il numero di occorrenze.

La pagina del bilancio mostra ora una lista di conti con una colonna per ogni periodo di bilancio. La
data visualizzata nel titolo di ogni colonna rappresenta l’inizio di quel periodo di bilancio.

Inserire i valori di bilancio
Ora si devono inserire i valori di bilancio cioè gli importi che ci si aspetta che i saldi dei conti assumano
durante il periodo di bilancio. I valori di bilancio possono essere inseriti in due modi: il primo consiste
nel fare clic direttamente nella cella di interesse e inserire un importo.

Se si hanno a disposizione delle transazioni inserite in GnuCash, il secondo metodo consiste nel far
stimare a GnuCash i valori di bilancio sulla base di queste transazioni. Prima, selezionare il conto che
si desidera far stimare a GnuCash; poi, premere il pulsante Stima sulla barra degli strumenti. Nella
finestra di Stima dei valori del bilancio, selezionare la data dopo la quale GnuCash dovrà controllare
le transazioni. GnuCash inizierà da questa data e controllerà nel seguito per il periodo di durata del
bilancio. Ad esempio, se si sta facendo un bilancio annuale e si sceglie come data il 1° Gennaio 2005,
GnuCash controllerà tutte le transazioni in quel conto dal 1° Gennaio 2005 al 31 Dicembre 2005.

Resoconti del bilancio
la parte più complessa è terminata: la creazione del bilancio. Per sapere come appaiono le transazioni
attuali nei confronti del proprio piano è necessario creare un resoconto di bilancio.
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Andare in Resoconti → Impresa → Resoconto di bilancio. Per ogni conto, il resoconto di bilancio
mostrerà l’importo previsto dal bilancio e quello attuale in due colonne adiacenti per ogni periodo
di bilancio. Se sono stati creati due o più bilanci, è possibile utilizzare le opzioni per il resoconto di
bilancio per selezionare il bilancio da visualizzare nel resoconto.

Two other types of budget reports are commonly used in the small business setting. They are the
Budgeted Income Statement and the Budgeted Balance Sheet.

Budgeted Income Statement
The budgeted income statement is similar to the income statement. Both show the revenues and ex-
penses for a given period as well as the profit, which is the difference revenue - expenses. The income
statement is based on historical data, but the budgeted income statement is based on the predictions
made in the budget.

Budgeted Balance Sheet
The budgeted balance sheet is similar to the balance sheet. Both show the assets, liabilities, and equity.
The difference is that the balance sheet is based on historical data, and the budgeted balance sheet is
based on the predictions made in the budget.
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Capitolo 15. Altre attività
Concetti generali

Questo capitolo illustra altre pratiche contabili per quelle attività, frequenti per le imprese, che neces-
sitano di essere registrate sui libri contabili. Le spiegazioni seguenti riguardano sia la descrizione sia lo
scopo dell’attività edincludono anche le comuni pratiche contabili (scrittura sui libri o registrazione)
per le relative transazioni.

Questi concetti si sono evoluti sulla base di centinaia di anni di esperienza e aiuteranno a massimizzare
l’utilità e la significatività della propria attività di registrazione.

This section introduces categorization of assets in the balance sheet based on time or the asset’s useful
life (current and long-term). Sometimes assets are also considered from the standpoint of their liquidity
, which is regarded as how close or distant the asset is from being turned into cash. Near-cash assets
are relatively quickly converted to cash (e.g., accounts receivable), while assets requiring rather a
long time to convert to cash are considered to be relatively fixed  in their non-cash state (e.g., heavy
equipment, buildings, land). (Fixed does not mean they were repaired!)

You should find that current assets parallel those with more liquidity, while long-term and fixed assets
are those with much less liquidity. Finally, below you will find a few assets that could be either current
or long-term based on the nature of the facts constituting them.

Other Assets Described
Attività correnti

Current Assets are those activities whose normal expected life would be one year or less. Such activi-
ties could be tracking reimbursable expenses, travel advances, short-term loans to a friend or family
member, prepaid expenses, annual insurance premium amortization, and so on. The individual entity
could have many other kinds of short term activities that reflect what it is doing. (These asset types
are explained individually below.)

Long-term (Fixed) Assets
Long-term (Fixed) Assets are those activities whose normal expected life exceeds one or more years.
This grouping covers both tangible and intangible assets. Examples of tangible assets are land, buil-
dings, and vehicles (cars, trucks, construction equipment, factory presses, etc.) Intangible assets in-
clude such things as patents, copy rights, goodwill, etc. Because the lives of some of these assets
show wear and tear and deterioration in value over time, businesses and individuals can allow for that
diminution in value by calculating depreciation on such assets. For example, land normally does not
depreciate, but buildings do, as do equipment and vehicles. (These asset types are explained indivi-
dually below.)

Attività correnti
This section explains short-term receivables, reimbursable expenses, travel advances, prepaid pre-
miums, prepaid rent, suspense or wash accounts.

Short-term Receivables
This kind of account is useful to reflect an agreement made with someone you trust. Suppose you lent
someone $500 and he agreed to repay you $50 a month. If he paid on time, the loan you made would be
paid off within a year, which is why it is classified as a short-term receivable. So you could record that
loan initially in this account tree: OtherAssets:Current Assets:LoanToJoe. At the time you give him
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the money: your entry is debit (increase) LoanToJoe $500 and credit (decrease) Bank $500. Each time
you receive Joe’s payment you record $50 debit (increase) to Bank and credit (decrease) LoanToJoe.

Suggerimento

Don’t become confused by the use of the word «Loan». «Loan-To» is the tipoff that you
really have a receivable, that is, you will receive from Joe, the money you previously loa-
ned. Until he actually pays the money owed you, you reflect his debt in your books by an
account describing your expectation–you will receive the money owed you, hence the word
«receivable».

Spese rimborsabili
This kind of activity is one in which you spend your own money on behalf of someone else (your
employer, perhaps) and later you receive repayment of what you spent. The case might be a business
trip. The employer has a policy of covering (paying for) all authorized expenses. After the trip is over,
the employee submits a report listing dates and amounts spent with receipts for all the expenditures.
The employer reviews the report and pays for all items that it considers as having a valid business
reason. (Normally, employees know in advance what the employer will reimburse, so only those items
are recorded as a reimbursable expense on the employee’s books.)

Because a business trip can involve different kinds of expenditures (air travel, lodging, transportation
at the destination, etc.), different kinds of expenditures would be recorded in the one account as long
as the expenditures all related to the same trip. In other words, if a second trip is made before the first
is fully settled, a second account for a different event could be set up. It would make sense to do this,
if it would help to keep separate all the details of one trip from those of another. It is up to the person
making the trip to decide how much trouble it would be to put separate trips in separate accounts or to
put them all in the same account. The trip taker should remember that the account must be reconciled
in order to know with certainty that all expenses have been reimbursed.

Recording the expenditures on the trip would be much the same. That is, if you paid trip expenses by
cash you would debit (increase) the reimburseable expense account for the money paid in cash, because
it is a receivable to you until it has been reimbursed to you. The credit offsetting your expenditure
would decrease the account that shows the cash in your pocket or the account from which you drew
the cash for the payment made. If you paid by credit card, the debit side would be the same as just
described, but the credit would be an increase to the credit card company account on your books.

When you received your reimbursement, then the journal entry (or transaction) to record receipt of the
funds from the employer would be: debit (increase) Bank for the check amount and credit (decrease)
the reimbursable expense account for the check amount.

If it turns out that the reimbursable expense account is not zero balance after processing the employer’s
payment, then it means that there is a difference between you and the employer in handling the expense,
which needs to be investigated. If the balance is a debit (a positive balance), your account has some
money that was not reimbursed. If the balance is a credit (a negative balance), you were paid for more
than what you recorded as due you. In both of those situations you should reconcile the difference
between what you recorded and what was paid. That effort should disclose exactly what is causing
the discrepancy. You will need to contact the employer’s bookkeeper to know what was paid, if the
reimbursement check was not accompanied by a detailed list of the items being paid you.

In the event the employer refused to reimburse you for an expenditure, that effectively makes it your
expense. In that case, you would make this entry: debit (increase) your own Expense (appropriately
named) and credit (decrease) the Reimbursable Expense account. That entry should result in a zero
balance in the Reimbursable Expense account. If not, reconcile until you identify the difference.

Suggerimento

Sometimes there are small differences that don’t match an individual entry. In those cases
divide the amount by 2 or by 9. If the unresolved amount is divisible by two, it suggests that
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both you and the employer entered the item in the same manner: both as debits or both as
credits. If it is divisible by 9, then likely one of you transposed adjoining numbers; e.g., one
entered 69 and the other entered 96. If the difference is divisible neither by 2 or by 9, then
it could be that more than one error is present.

Travel Advances
These are very similar to Reimbursable Expenses. The difference is that someone gives you money
first; you spend it, and then you give a report accounting for what you spent it on. The report is
supported by invoices establishing who, what, where, when, and how much for each expenditure. In
the Reimbursable Expense case, you spent your money first and later recovered it.

In the Travel Advance case when you receive the advance, you record on your books this entry: debit
(increase) Bank for the travel advance amount received (say, $500); credit (increase) the short-term
liability Travel Advance ($500). This is a liability, because you are not gifted with the money, but
only loaned it for the purpose of having funds to spend when doing the employer’s business.

Frequently, the way these monetary arrangements work is that at the beginning of for example a sa-
lesperson’s employment, he or she receives the advance and monthly (or more frequently) turns in a
report about who, what, where, when, and how much he spent. The money in the report is reimbursed
if approved.

During the period after receiving the advance and before filing a request for reimbursement report,
the salesperson can record his or her expenditures into the advance liability account. In that case, the
balance in the account will show how much of the advance has not yet been spent (assuming the Travel
Advance balance is a credit). If no mistakes have been made and all expenses are approved, then the
sum of the unspent account balance and the reimbursing check amount will equal the original travel
advance amount.

It makes sense for the salesperson to record the travel expenses to this advance account (and not to
his or her own expense accounts), because the money is being spent on behalf of the employer, for
the employer’s authorized expenses. It is not the employee’s own money, and therefore not his or her
own expense.

When the salesperson receives the report reimbursement (say, $350), he or she debits (increases) Bank,
and credits (increases) again the Travel Advance liability account, assuming that previously he or she
had been recording expenditures to the travel advance account. Tracking activity in this manner causes
the account to always show the amount that is owed the employer.

See la sezione chiamata «Spese rimborsabili» above for what to do if the employer does not accept an
item the employee put on the travel advance reimbursement request report. The difference resolution
effort is essentially the same for both types of accounts.

Prepaid Premiums or Prepaid Rent
Some types of expenses are usually billed as semi-annual or annual amounts. For example, the insu-
rance industry will bill home insurance annually, while car insurance premiums can be annual or se-
mi-annual. For those that pay an amount that covers several months or a full year, the proper accoun-
ting treatment is to reflect in each accounting period the amount that expresses the benefit applying
to that period.

In the case of someone who pays a full-year’s insurance premium at the beginning of the insurance
period, the entry to record this is debit (increase) Prepaid Insurance Premium for say, $1,200, and
credit (decrease) Bank for $1,200.

Then a monthly recurring journal entry (scheduled transaction) is created that debits (increases) Insu-
rance Expense $100 and credits (decreases) Prepaid Insurance Premium $100. This technique spreads
the cost over the periods that receive the insurance coverage benefit. Businesses following generally
accepted accounting practices would normally use this technique, especially if they had to present
financial statements to banks or other lenders. Whether individuals do depends on the person and how
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concerned they are to match cost with benefit across time periods. Another factor influencing use of
this technique would be the number of such situations the person encounters. It is relatively easy to
remember one or two, but more difficult if having to manage 10 to 20. You would set up as many or
as few as proved useful and important to you.

Suspense or Wash Accounts
The purpose of these accounts is to provide a device to track «change of mind» situations. The objective
of these accounts is to provide a temporary location to record charges and credits that are not to be
included permanently in your books of record. When the transactions reflected in these accounts have
been fully completed, Wash/Suspense accounts will normally carry a zero balance.

For example, say in the grocery store you see canned vegetables on sale, so you buy 6 cans at $1 per
can. Say that the total purchases were $50. When you come home and are putting things in the cupboard
you discover you already had 12 cans. You decide to return the 6 you just bought. Some persons in
this situation would charge (increase) the whole bill to Grocery Expense; and when they returned the
cans, they would credit (decrease) Grocery Expense. That is one way of handling that. The effect of
this method is to leave recorded on your books the cost of items that you really did not purchase from
a permanent standpoint. It is only when the items have actually been returned and the vendor’s return
receipt has also been recorded that the distortion this method generates will then be removed.

Actually, there are several treatments, depending on when and how the original transaction was boo-
ked/recorded and when you decided to return the items purchased. Basically, did you change your
mind before you recorded the transaction or after doing so?

If you decided to return the items after recording the purchase transaction, you may originally have
charged Grocery Expense for the full amount ($50) of all items. In that scenario, what you kept and
the amount of the items to be returned were grouped into one account. You could edit the original
transaction and restate the amount charged to the Grocery Expense account to be the difference ($44)
between the total paid ($50) for groceries and the value of the items to be returned. That leaves the
returned-item value as the amount ($6) you should record to the Suspense account.

Obviously, if you decided to return items before you recorded your purchase, then you would book the
original entry as a charge to Grocery Expense for the amount kept ($44) and as a charge to Suspense
for the amount returned ($6). The off-setting credit ($50) to cash or credit card is not affected by these
treatments.

When there are several persons shopping and at different vendors, there can be a case where there are
several returns happening at once and in overlapping time frames. In that case the Wash Account is
charged (increased) at time of changing the mind, and either Bank or Credit Card is credited. When the
return occurs, the reverse happens: Bank or Credit Card is debited for the cash value of the returned
items and the Wash/Suspense Account is credited in the same amount.

If the wash account has a non-zero balance, scanning the debit and credit entries in the account will
show the non-matched items. That is, debits not matched by offsetting credits indicate items intended
to be returned but not actually returned yet. The reverse (credits not matched by offsetting debits)
indicates that returns were made but the original charge was not recorded in the Wash Account.

These differences can be cleared up by returning unreturned items or recording charges (debits) for
items already returned. The mechanics of doing that likely will be finding the original expense account
the item was charged to and making an entry like: debit Wash Account, credit original expense. It
also could be as described above where the original recording is adjusted by adding a charge to Wash/
Suspense account and decreasing the amount charged to the original account.

Short or Long-term Assets
This section explains why some types of assets may be short or long-term and presents an example.

An example is deposits (e.g., utility, rental, security). If the deposit agreement contains a provision to
recover the deposit at the end of a year, the treatment could be that of a short-term asset. However,
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when the agreement is that the deposit holder returns the funds only upon successful inspection at the
end of the relationship, then at the start of the relationship or agreement, the person paying the deposit
has to decide whether to write it off as a current expense or to track it for eventual recovery at the end
of the agreement (not infrequently, moving to a new location).

Whichever decision is made, the accounting treatment is to debit (increase) expense (assuming the
write-off decision) or debit (increase) Deposits Receivable (assuming the intent is to recover the de-
posit in the future) and credit (decrease) Bank for the amount of the deposit (if paid by cash) or credit
(increase) credit card if paid using that payment method.

Long-term (Fixed) Assets
This section illustrates long-term assets (those whose useful lives exceed a year) and discusses these
types: land, buildings, leasehold improvements, intangibles, vehicles and other equipment.

Terreni
Land is not a wasting asset. That is, it does not get used up over time and rarely suffers damage such
that it loses value. For that reason, it usually is recorded at cost at the time of purchase. Appreciation
in its value over decades is not recorded and is not recognized in any way on the books of the owner.
It is only after land has been sold that sale price and purchase cost are compared to calculate gain
or loss on sale.

Land is frequently sold/purchased in combination with structures upon it. That means that the cost has
to become separated from the cost of structures on it. Land valuation is usually part of the transfer
of ownership process and its value is shown on the purchase documents separately from that of any
structures it supports.

Land values shown on purchase documents frequently arise from the process of value determination
managed by assessors whose job it is to assign values to land for tax purposes. Local and regional
areas of a state or province use the values determined by assessors in their tax formulas, which provide
revenues for local and regional governing authorities to finance their required community services.

Should land be acquired in a situation not subject to a history of land valuation by a formal valuation
system, then the purchaser can appeal to real estate agents and an examination of recent sale transac-
tions for information that would allow calculating a reasonable amount to express the value of the land.

Edifici
Buildings are the man-made «caves» in which much of life’s human interaction occurs. These struc-
tures are wasting assets, because in their use they or their components gradually wear. Over time they
begin to lose some of their function and they can suffer damage due to planetary elements or human
action.

Accepted accounting practice is to record the cost of the building determined at time of ownership
transfer (purchase) or at conclusion of all costs of construction. Because buildings are frequently used
for decades, and due to the need to be able to calculate gain or loss on sale, accounting practice preser-
ves the original cost by not recording declines in value in the account containing the original purchase
or construction cost.

Instead, the depreciation technique is used to show (in the balance sheet) the structure’s net book value
(original cost reduced by accumulated depreciation). Depreciation is a separate topic treated elsewhere
in this Guide.

Leasehold Improvements
When a business does not own the building where it operates, and instead has a long-term lease, it
is not uncommon for the business tenant to make improvements to the premises so that the structure
obtains both function and appearance that enhances conducting its business activities.
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In these cases, the expenditures that the business incurs are recorded in a Leasehold Improvements
account: increase (debit) Leasehold Improvements, decrease (credit) Bank or increase (credit) a sui-
table liability account (which could be a liability to a contractor or a bank or a credit card, etc.).

Veicoli o attrezzature
Vehicles or Equipment of all kinds usually last for several years, but their useful lives are much shorter
than that of assets that have little movement in their functioning. Because they do wear out over time,
common accounting practice in business is to record depreciation using life spans and depreciation
methods appropriate to the nature and use of the asset. Frequently, the life and depreciation methods
chosen are influenced by what is permitted per national tax regulations for the kind of asset being
depreciated.

Usually, businesses depreciate their assets. Individuals can do so as well to the degree that taxing
authorities permit. Very wealthy persons employ accountants and attorneys to track and manage their
investments and assets holdings to take advantage of all tax benefits permitted by law.

Intangibles
The mechanics of accounting (debiting and crediting appropriate accounts) for these assets are relati-
vely simple, much the same as for any of the above assets. Where the difficulty lies is in their valuation,
which is an advanced topic and not something that individual persons and small businesses would
likely encounter. For that reason further discussion of items such as patents, copyrights, goodwill, etc.
are left out of this Guide.
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Capitolo 16. Deprezzamento
Questo capitolo introdurrà i concetti di deprezzamento (o svalutazione) in contabilità e fornirà alcuni
esempi reali di utilizzo.

Concetti base
La svalutazione è il metodo contabile per spendere gli acquisti di capitale nel tempo. Esistono due
motivi per cui si potrebbe voler registrare il deprezzamento: si sta tenendo la contabilità delle proprie
finanze personali e si desidera tenere traccia del valore netto oppure si sta tenendo la contabilità di
una piccola impresa e si ha la necessità di produrre un documento finanziario dal quale si dedurranno
le detrazioni fiscali.

Il metodo di registrazione della svalutazione è lo stesso in entrambi i casi ma lo scopo finale è diverso;
in questa sezione verranno discusse le differenze fra i due Prima di tutto si riportano dei termini di
utilizzo comune trattando di deprezzamento.

• Deprezzamento accumulato - il totale cumulato del deprezzamento avvenuto nella vita di un bene.
Esso viene accumulato nel conto di deprezzamento nella sezione del bene.

• Deprezzamento contabile - è l’importo del deprezzamento che viene registrato sui documenti finan-
ziari per un periodo contabile.

• Giusto valore di mercato - l’importo per il quale un bene può essere venduto a una data precisa.

• Valore netto registrato - è la differenza fra il costo originale di acquisto del bene e il deprezzamento
a una certa data.

• Costo originale - è l’importo di denaro con cui è stato acquistato il bene. Sono inclusi in esso tutti
i costi necessari a rendere utilizzabile per i propri scopi il bene. Per esempio: spedizione, costi di
installazione, addestramenti speciali ecc...

• Valore di recupero - è il valore al quale si stima che il bene possa essere venduto al termine della
sua vita utile (per il proprio utilizzo).

• Ammortamento fiscale - è l’importo del deprezzamento utile per individuare il valore del reddito
imponibile per l’applicazione delle imposte.

Finanze personali
Il deprezzamento è utilizzato nelle finanze personali per far diminuire periodicamente il valore di un
bene al fine di avere a disposizione una stima accurata del valore netto corrente. Per esempio, se si
possiede un’auto, è possibile tener traccia del suo valore attuale registrando il deprezzamento ogni
anno. Per farlo, è necessario registrare il prezzo di acquisto originale come un’attività e poi registrare
un’uscita relativa alla svalutazione (consultare la sezione chiamata «Esempio» per vedere un esempio).
Così facendo il valore netto contabile sarà approssimativamente uguale al giusto valore di mercato
del bene alla fine dell’anno.

Depreciation for personal finance has no tax implications, it is simply used to help you estimate your
net worth. Because of this, there are no rules for how you estimate depreciation, use your best jud-
gement.

Per quali beni si dovrebbe stimare la svalutazione? Dato che lo scopo del deprezzamento per le finanze
personali è quello di fornire una stima del valore netto dei propri beni, si consiglia di registrare la sva-
lutazione solamente per quei beni che hanno un valore rilevante e che un giorno si potrebbe desiderare
rivendere come, per esempio, un’auto o una barca.
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Impresa
Al contrario delle finanze personali dove lo scopo è quello di tracciare il valore dei beni personali, le
imprese devono far corrispondere le spese di acquisto di un bene capitale con la rendita che questo può
fornire; questo è possibile solo con la registrazione della svalutazione. Le imprese hanno anche a che
fare con le leggi sulle imposte che trattano il deprezzamento; questo prende il nome di ammortamento
fiscale. L’impresa è libera di scegliere qualsiasi schema desideri per registrare il deprezzamento, ma
lo schema utilizzato per l’ammortamento fiscale è fisso. Spesso questo comporta delle differenze tra
svalutazione contabile e ammortamento fiscale, ma è possibile prendere dei provvedimenti per ridurre
questo effetto.

Quali acquisti dovrebbero essere capitalizzati? se si prevede che un bene acquistato possa fornire
delle entrate per un tempo superiore all’anno corrente, allora dovrebbe essere capitalizzato. In questa
definizione ricadono quindi i beni quali i terreni, gli edifici, le attrezzature, le auto e i computer (se
vengono tutti utilizzati per lavoro). Non sono compresi i beni che possono considerarsi come scorte.
Così, se si acquista un bene con l’intento di rivenderlo, non dovrebbe essere capitalizzato.

Oltre al prezzo di acquisto del bene in sé stesso, qualsiasi costo sostenuto per rendere utilizzabile il
bene, dovrebbe essere capitalizzato. Per esempio, se si acquista un’attrezzatura che deve essere spedita
fuori città, che necessita di lavori elettrici per l’installazione e di corsi specifici sul suo utilizzo, tutti
questi costi potranno essere inclusi nel costo dell’attrezzatura.

È anche necessario conoscere il valore di recupero del bene che, solitamente, viene assunto pari a zero.
Il bisogno di conoscere il valore di recupero deriva dal fatto che il bene sarà deprezzato fino a quando
il valore netto contabile (costo meno deprezzamento) sarà pari al valore di recupero. Così, quando il
bene sarà tolto dal registro, non si avranno perdite o guadagni derivanti dalla cessione del bene.

L’ultimo passo consiste nell’individuare il metodo di svalutazione da utilizzare. Questo argomento
verrà discusso nelle pagine seguenti.

Nota

ATTENZIONE: si presti attenzione al fatto che diversi Paesi possono avere politiche sulle
imposte sostanzialmente diverse per quanto riguarda il deprezzamento; questo documento
fornisce solamente delle nozioni di base in modo che poi ognuno possa applicare la politica
sulle imposte e sul deprezzamento che interessa nel caso specifico.

Stimare il valore
Un nodo centrale del problema del deprezzamento è la determinazione di come deve essere stimato il
valore futuro del bene. A differenza delle spesso incerte stime che si devono effettuare quando si ha
a che fare con le rivalutazioni di un bene, il campo delle svalutazioni è più concreto. Utilizzando le
fonti elencate di seguito, dovrebbe risultare immediata la stima del valore futuro di un bene oggetto
di svalutazione.

• Leggi sulle imposte: per le imprese che vogliono utilizzare il deprezzamento ai fini del calcolo delle
imposte, il governo tende a fornire delle precise regole su come si deve calcolare la svalutazione.
Consultare le norme vigenti nel proprio paese in quanto dovrebbero esplicitamente indicare come
calcolare il deprezzamento.

• Giornali dell’usato:, per le auto e per le moto, è facile trovare dei valori di riferimento su riviste e
giornali specifici che permettono di conoscere il valore di un’auto dopo un certo periodo di tempo
dall’acquisto. Da questi valori sarà possibile estrapolare un modello di svalutazione.

Schemi di svalutazione
Uno schema di svalutazione è un modello matematico che descrive come un capitale verrà speso nel
tempo. Per ogni bene soggetto a deprezzamento, sarà necessario scegliere uno schema di svalutazione.
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È importante ricordare che, relativamente alle imposte, si dovrà svalutare il bene seguendo determi-
nate regole; questo processo prende il nome di ammortamento fiscale. Per scopi relativi all’analisi
delle proprie finanze, si è liberi di utilizzare il metodo che si preferisce: si parla, in questo caso, di
deprezzamento contabile. In questo modo c’è meno differenza tra le entrate nette sull’estratto e le
entrate tassabili..

Questa sezione illustrerà 3 fra i più diffusi schemi di svalutazione: lineare, geometrico e somma delle
cifre. Per semplificare gli esempi, si assumerà che il valore di recupero del bene che viene deprezzato,
sia zero. Se si desidera utilizzare un valore di recupero, si dovrà interrompere la svalutazione nel
momento in cui il valore netto contabilizzato eguaglia il valore di recupero.

1. La svalutazione lineare diminuisce il valore di un bene di un quantitativo prefissato ogni periodo
fino a quando il valore è nullo. Il calcolo relativo è molto semplice: basta stimare la vita utile del
bene e dividere in parti uguali il costo per la vita utile.

Esempio: si è acquistato un computer per €1.500 e si desidera svalutarlo in un periodo di 5 anni.
Ogni anno il valore del deprezzamento ammonta a €300, il che comporta i seguenti risultati:

Tabella 16.1. Esempio di schema a svalutazione lineare

Anno Deprezzamento Valore residuo

0 - 1500

1 300 1200

2 300 900

3 300 600

4 300 300

5 300 0

2. Nella svalutazione geometrica il deprezzamento è calcolato come percentuale del valore del bene
nel periodo precedente. Si tratta quindi di uno schema di svalutazione pesato in avanti dato che il
deprezzamento maggiore si ha all’inizio. In questo schema il valore di un bene decresce esponen-
zialmente lasciando un valore residuo finale maggiore di zero (es: il valore di rivendita).

Esempio: si considera l’esempio precedente con un deprezzamento annuale del 30%.

Tabella 16.2. Esempio di schema a svalutazione geometrica

Anno Deprezzamento Valore residuo

0 - 1500

1 450 1050

2 315 735

3 220,50 514,50

4 154,35 360,15

5 108,05 252,10

Nota

Attenzione: le autorità per le imposte potrebbero richiedere (o permettere) l’utilizzo di
una percentuale maggiore nel primo periodo. D’altra parte però in Canada, questa regola
è invertita dato che è permessa solo mezza quota del «Capital Cost Allowance» nel primo
anno. Il risultato di questo approccio è che il valore del bene decresce più rapidamente
all’inizio che alla fine del periodo; questo comportamento è probabilmente più realistico
rispetto a quello lineare per la maggior parte dei beni. Questo è certamente vero per le
automobili.
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3. Somma delle cifre è uno schema di svalutazione pesato in avanti simile a quello geometrico a
eccezione del fatto che il bene raggiunge un valore nullo al termine del periodo. Questo metodo è
applicato prevalentemente nei paesi Anglosassoni; eccone un esempio:

Esempio: si divida d subito il valore del bene per il numero di anni di utilizzo; per l’esempio con-
siderato sopra con un valore del bene pari a €1.500 utilizzato per un periodo di anni pari a 5, si
ottiene 1.500/(1+2+3+4+5)=100. Il deprezzamento e il valore del bene sono così calcolati:

Tabella 16.3. Esempio di schema di svalutazione con somma delle cifre

Anno Deprezzamento Valore residuo

0 - 1500

1 100*5=500 1.000

2 100*4=400 600

3 100*3=300 300

4 100*2=200 100

5 100*1=100 0

Impostare i conti
Come nella maggior parte della pratica contabile, esistono diversi modi per impostare i conti per il
deprezzamento. Nel seguito verrà illustrato un metodo generale che dovrebbe essere sufficientemente
flessibile per essere utilizzato nella maggior parte delle situazioni. Il primo conto di cui si avrà bisogno
sarà un conto relativo al Costo del bene (tipo di conto di GnuCash: attività), nel quale verrà semplice-
mente registrato l’acquisto del bene. Normalmente questo acquisto avviene con una transazione dal
proprio conto bancario.

Allo scopo di tenere traccia del deprezzamento del bene, saranno necessari due conti di svalutazione.
Il primo è il conto per il Deprezzamento accumulato nel quale verranno registrate le somme di tutti
gli importi di svalutazione e conterrà dei valori negativi; in GnuCash, questo conto appartiene alla
famiglia delle attività. Il conto del deprezzamento accumulato è bilanciato da un conto Uscite:De-
prezzamento, nel quale vengono registrate tutte le uscite periodiche; in GnuCash, questo conto è del
tipo Uscite.

Più sotto è riportata una generica struttura dei conti per il tracciamento della svalutazione di due beni:
BENE1 e BENE2. I conti del Costo del bene sono bilanciati dal Conto Bancario, il conto del Deprez-
zamento accumulato è bilanciato dal conto delle Uscite del deprezzamento.

-Attività
   -Beni immobili
      -BENE1 
         -Costo                (Conto del costo delle attività)
         -Deprezzamento     (Conto del deprezzamento accumulato)
      -BENE2
         -Costo                (Conto del costo delle attività)
         -Deprezzamento     (Conto del deprezzamento accumulato)
   -Attività correnti
      -Banca
-Uscite
   -Deprezzamento        (Conto delle uscite del deprezzamento)
  

Uno dei vantaggi della struttura dei conti presentata, è che fornisce immediatamente alcuni valori
riassuntivi riguardanti il bene che si sta deprezzando. Il totale del conto Attività:Beni immobili:BE-
NE1 mostra il valore attualmente stimato per il BENE1, il conto Attività:Beni immobili:BENE1:Costo
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visualizza quanto è stato pagato originariamente il BENE1, Attività:Beni immobili:BENE1:Deprez-
zamento riporta il deprezzamento accumulato relativo al BENE1 e, infine, il conto Uscite:Deprezza-
mento visualizza il deprezzamento totale cumulato di tutti i beni.

È sicuramente possibile utilizzare altre strutture dei conti. Una configurazione diffusa prevede di com-
binare i conti delle attività Costo del bene e Deprezzamento accumulato. In questo modo si ha il van-
taggio di avere meno conti che popolano la propria struttura, ma, di contro, per determinare alcune
delle grandezze principali descritte nel paragrafo precedente, è necessario aprire la finestra del registro
del conto. Come nella maggior parte delle cose, esistono diversi metodi per compiere la stessa azione:
l’importante è utilizzare quella che risulta più comoda per le proprie necessità o capacità.

L’inserimento degli importi relativi al deprezzamento, deve essere effettuato in modo manuale per
ogni periodo contabile. Non c’è, attualmente, modo in GnuCash di eseguire automaticamente i calcoli
relativi allo schema di svalutazione o di inserire automaticamente i valori nel conto corretto. Comun-
que, essendo il periodo contabile generalmente pari a 1 anno, non si tratta di un lavoro molto impe-
gnativo eseguendolo manualmente.

Esempio
Si immagini di essere un fotografo e che quindi si debba utilizzare un’auto e una costosa macchina
fotografica per il proprio lavori. Sarà utile tenere traccia della svalutazione di questi beni dato che sarà
probabilmente possibile dedurre la svalutazione dalle imposte sulla propria attività.

Il primo passo consiste nella costruzione della struttura dei conti (come mostrata nella sezione prece-
dente, sostituendo a BENE1 e a BENE2 «auto» e «macchina fotografica»). Ora, è possibile registrare
l’acquisto dei beni trasferendo il denaro dal proprio conto bancario al relativo conto del costo del be-
ne per ogni oggetto (es: il conto Attività:Beni immobili:Auto:Costo per l’auto). In questo esempio si
parte con €30.000 in banca, l’auto costa €20.000 e la macchina fotografica costa €10.000 entrambe
acquistate il 1° Gennaio 2000.

La finestra principale dell’esempio di svalutazione del bene, prima del deprezzamento

Controllando i codici sulle tasse, si apprende che il deprezzamento deve essere calcolato utilizzando
lo schema «somma delle cifre», su un periodo di 5 anni. Quindi, i deprezzamenti annuali per l’auto
ammontano a €6.667, €5.333, €4.000, €2.667, €1.333 per gli anni da 1 a 5 rispettivamente, arrotondati
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all’euro. Gli importi della svalutazione annua per la macchina fotografica sono €3.333, €2.667, €2.000,
€1.333, €667. Si consulti la sezione precedente sugli schemi di svalutazione per ritrovare la formula
con cui questi valori sono stati calcolati.

Per ogni periodo contabile (anno fiscale) si deve registrare il deprezzamento come un’uscita nel cor-
rispondente conto del deprezzamento accumulato (es: il conto Attività:Beni immobili:Auto:Deprezza-
mento per l’auto). Le due finestre più sotto mostrano il conto del deprezzamento accumulato relativo
alla propria auto e la finestra principale dopo il terzo anno (es: il terzo periodo) di svalutazione utiliz-
zando lo schema somma delle cifre.

La finestra del registro di deprezzamento di un bene

La finestra principale di deprezzamento di un bene

Nota

ATTENZIONE: dato che il deprezzamento e il calcolo delle imposte sono fortemente legati,
non si sarà sempre liberi di scegliere il metodo che si preferisce. La correzione di calcoli
errati richiede sempre molto tempo e sforzo, più di quanto sia richiesto calcolando da subito i
valori esatti; quindi, se si ha intenzione di svalutare dei beni, è bene informarsi prima di tutto
su quale schema è permesso o necessario utilizzare.
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Capitolo 17. Python Bindings
GnuCash è sempre stato un’applicazione tradizionale nel senso che è sempre stato utilizzato attraverso
un’interfaccia grafica che permette di aprire, modificare e salvare i propri dati. Questo fatto può essere
considerato come una limitazione dato che è possibile fare solamente quello che i menu, le finestre e
la barra degli strumenti permettono di fare.

A volte però si avverte il bisogno di una maggiore flessibilità. Per esempio si potrebbe aver bisogno
di un resoconto con alcune informazioni diverse da quelle fornite dai resoconti inclusi in GnuCash,
oppure si vuole automatizzare un’operazione frequente. Queste manipolazioni personalizzate sono le
candidate ideali per essere scritte in un linguaggio di programmazione piuttosto che in un altro.

A partire dalla versione 2.4 di GnuCash è possibile utilizzare degli script di Python per manipolare
i propri dati finanziari.

Nota

Le estensioni di Python sono una caratteristica opzionale del codice sorgente. Per poter uti-
lizzare gli script di Python, GnuCash deve essere stato compilato con questa opzione abilita-
ta. Al momento questa opzione non è abilitata di default, quindi per poter utilizzare questa
funzionalità, è necessario compilare GnuCash da sorgente.

Le estensioni Python sono fornite con un paio di script già pronti per l’utilizzo. Questo capitolo illustra
come utilizzarli.

Nota

Questo capitolo non spiega come scrivere il proprio script di Python. Per questo fare riferi-
mento alla documentazione per gli sviluppatori.
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Capitolo 18. Importare i dati
dell’impresa
Importare fatture e ricevute

This functionality is only available by default for versions greater than 2.6

For 2.4.13 the Customers and Vendors importer is an optional module and needs to enabled by editing
the file $HOME/.gnucash/config.user, adding the line:

(gnc:module-load "gnucash/plugins/bi_import" 0)

Su sistemi Linux questo file è $HOME/.gnucash/config.user e su MacOSX ~/Libra-
ry/Application Support/GnuCash/config.user. Se il file non esiste già, lo si dovrà
creare. Dopo aver riavviato GnuCash l’elemento comparirà alla fine del menu Impresa.

Perchè l’importatore funzioni correttamente, i dati devono essere in formato a lunghezza fissa di cam-
po, o separati da virgole. Uno script di Python è fornito di seguito come esempio.

import sys
import csv

VENDOR_ID="000013"
INFILE=sys.argv[1]
INV_ID=sys.argv[2]
try:
  ACCOUNT=sys.argv[3]
except:
  ACCOUNT="Expenses:Materials General"

Reader = csv.reader(open(INFILE), delimiter=',')

# Need to ignore 1st and last rows

for row in Reader:
  if row[0].isdigit(): # We only use numbered lines
    outline=(INV_ID + ",," + VENDOR_ID + ",,,," + row[1] + " > " + row[4] + ",ea," +
      ACCOUNT + "," + row[2] + "," + row[5].replace("GBP", "") + ",,,,no,,,,,,,")
  print outline
      

Esempio di un file d’ordine del fornitore scaricato da Rapid Electronics (UK).

line number,product code,quantity,availability,product description,unit price,discounts,line total,delivery,sub total,vat,grand total
1,47-3524,100,100 Available,BC848C SOT-23 NPN TRANSISTOR (INF) (RC),GBP0.03,GBP0.00,GBP0.03
2,47-3278,30,30 Available,L78L05ACZ 0.1A +5V VOLTAGE REG (ST) (RC),GBP0.18,GBP0.00,GBP0.18
3,22-0120,1,1 Available,Tube 34 14pin DIL socket, narrow7.62mm, without central support,GBP1.05,GBP0.00,GBP1.05
4,22-0127,1,0 Available<br />1 on Back Order,Tube 17 28pin DIL socket, wide15.24mm, without central support,GBP1.22,GBP0.00,GBP1.22
5,62-0368,1,1 Available,820R CR25 0.25W CF Resistor Pk 100,GBP0.50,GBP0.00,GBP0.50
6,47-3130,100,100 Available,1N4001 1A 50V SILICON RECTIFIER DIODE RC,GBP0.01,GBP0.00,GBP0.01
7,17-0310,1,1 Available,PROFESSIONAL MINATURE PROBE HOOK RED RC,GBP0.90,GBP0.00,GBP0.90
8,17-0312,1,1 Available,PROFESSIONAL MINATURE PROBE HOOK BLACKRC,GBP0.90,GBP0.00,GBP0.90
9,34-0655,1,1 Available,PROTOBLOC 2 BREADBOARD,GBP4.39,GBP0.00,GBP4.39
10,18-0200,1,1 Available,PP3 9V ALKALINE BATTERY "Not For Retail Sale",GBP1.37,GBP0.00,GBP1.37
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,,,,,,,,GBP4.95,GBP24.93,GBP4.35,GBP29.28
      

Un file simile dopo essere stato processato con lo script di Python.

MEC-0071,,000013,,,,34-0655 > PROTOBLOC 2 BREADBOARD,ea,Expenses:Materials General,1,4.39,,,,no,,,,,,,
MEC-0071,,000013,,,,18-0105 > PP3 / PP6 BATTERY CLIP 150MM (RC),ea,Expenses:Materials General,10,0.06,,,,no,,,,,,,
MEC-0071,,000013,,,,62-0370 > 1k CR25 0.25W CF Resistor Pk 100,ea,Expenses:Materials General,1,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,62-0354 > 220R CR25 0.25W CF Resistor Pk 100,ea,Expenses:Materials General,1,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,34-5548 > PLAIN DOCUMENT WALLET ASSORTED PK 50 RE,ea,Expenses:Materials General,1,6.95,,,,no,,,,,,,
MEC-0071,,000013,,,,62-0386 > 4k7 CR25 0.25W CF Resistor Pk 100,ea,Expenses:Materials General,1,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,34-0860 > COPPER CLAD SRBP SS 100 X 160 (RC),ea,Expenses:Materials General,5,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,18-0163 > PP3 BATTERY HOLDER WITH FLYING LEADS RC,ea,Expenses:Materials General,5,0.23,,,,no,,,,,,,
MEC-0071,,000013,,,,73-4290 > ATMEGA8-16PU 8-BIT MICRO 8K DIL-28 (RC),ea,Expenses:Materials General,3,1.99,,,,no,,,,,,,
MEC-0071,,000013,,,,81-0014 > BC108 NPN GP TRANSISTOR RC,ea,Expenses:Materials General,20,0.16,,,,no,,,,,,,
MEC-0071,,000013,,,,DELIVERY,ea,Expenses:Postage,1,4.95,,,,no,,,,,,,
MEC-0071,,000013,,,,VAT,tax,Expenses:VAT,1,4.35,,,,no,,,,,,,
        

Come si può vedere mancano alcuni campi mentre altri non sono necessari per l’importazione. La
prima riga e l’ultima sono superflue dato che GnuCash si prenderà cura di calcolare il totale. Tutto
ciò che serve è di prelevare ciò che è necessario e produrre un file di output con il formato corretto
per essere importato in GnuCash. In questo caso i campi del numero dell’elemento (part number) e
della descrizione (description) verranno uniti per comporre la descrizione della fattura (o ricevuta) in
GnuCash. Sono necessari il campo della quantità (quantity) e del prezzo (price). Contrariamente alla
dicitura dell’intestazione, la VAT non è riportata per ogni riga dato che è sempre 0, ma è calcolata
nell’ultima riga sul totale dell’ordine.

Nota

Questo causerà problemi in seguito.
In questo esempio il conto Uscite:Materiali generici è stato impostato come conto di destinazione.
Questo può essere cambiato dopo l’importazione nel modo usuale, così come qualsiasi altro dato. Se
questo conto non esiste, verrà lasciato vuoto durante l’importazione e dovrà essere impostato manual-
mente. Le righe che iniziano con il simbolo «#» sono considerate come commenti e quindi tralasciate.

Lo script è invocato con il seguente comando:

python importer.py file_da_importare, invoice_id > file_in_cui_salvare.csv

Questo breve script può facilmente essere modificato per adattarlo a qualsiasi formato scaricato. L’u-
nica restrizione riguarda il numero di campi che deve essere fisso, almeno al momento. L’importatore
ignorerà le righe con un numero errato di campi (questo potrebbe essere corretto nelle versioni future).
L’ID venditore è semplicemente il numero identificativo assegnato a quello specifico venditore. Gli
elementi row[N] si riferiscono alla posizione dove sono presenti i dati. È importante notare come il
primo campo sia row[0] e non row[1].

Una volta che il file è stato convertito, selezionare Impresa → Importa fatture e ricevute per aprire
una nuova finestra di importazione. Selezionare il file appena creato, selezionare poi fattura o ricevuta
e il formato separato da virgole. Controllare che i dati dei campi siano nelle colonne corrette prima
di selezionare OK. Una volta importata la fattura può essere aperta per modificarla o per emetterla
nel modo usuale.

Una nota sulla VAT o qualsiasi altra imposta sugli acquisti. Come già detto, Rapid Electronics calcola
la VAT sul totale della ricevuta e non per ogni riga. GnuCash calcola la VAT per ogni riga e ne fai poi
il totale. Questa differenza può comportare delle inaccuratezze nell’importo della VAT di alcuni cen-
tesimi che sono sufficienti a causare problemi in fase di riconciliazione del conto usato per l’acquisto.
Al momento il superamento del problema dipende solamente dal proprio modo preferito; ad esempio
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la VAT può essere aggiunta manualmente in una riga separata come i costi di spedizione. QUindi parte
del lavoro è lasciata all’utente ma la parte più noiosa di inserimento di ogni elemento è eliminata.

Per il fututro: attualmente il formato di importazione è ristertto e diversi utenti potrebbero andare in-
contro a dei problemi durante il processo di conversione. Aggiungere un modello per ogni possibile
formato CSV dei fornitori sarebbe un lavoro enorme e probabilmente infruttuoso dato che molti for-
nitori spesso cambiano formato senza avvertire gli sviluppatori di GnuCash. I miglioramenti futuri
del processo di importazione saranno basati sui consigli degli utenti e probabilemente verrà reso più
semplice o flessibile (spesso «semplice» non è compatibile con «flessibile»).

Nota

Se non si ha dimestichezza con Python (esistono altri linguaggi), è possibile inviare una
richiesta alla lista dell’utente di GnuCash, con un esempio del proprio file CSV scaricato, e
probabilmente qualcuno si preoccuperà di scrivere uno script di Python per la sua traduzione.
[https://lists.gnucash.org/mailman/listinfo/gnucash-user]

Note per gli autori Python
Per poter completare con successo il processo di importazione, il numero di campi deve essere rispet-
tato, quindi le virgole sono importanti.

Di seguito è riportato un elenco completo dei campi necessari:

id, date_opened, owner_id, billingid, notes, date, desc, action, account, quantity, price, disc_type, di-
sc_how, discount, taxable, taxincluded, tax_table, date_posted, due_date, account_posted, memo_po-
sted, accu_splits,

Nota

Si noti la virgola finale

Una breve descrizione di ogni campo
• id - il numero della fattura. Tutte le righe devono contenerlo o la riga verrà rifiutata.

• date_opened - Use the same date format as setup in Preferences. Today's date is inserted if this is
blank.

• owner_id - numero ID del venditore o del cliente. Tutte le righe devono contenere questo valore
altrimenti verranno rifiutate.

• billingid — ID ricevuta.

• notes — note della fattura.

• date - la dta dell’elemento sulla riga. Può essere lasciata vuota per considerarla in data odierna.

• desc - descrizione della fattura o della ricevuta

• action - per le ricevute normalmente è «ea».

• account - il conto a cui è attribuito l’elemento.

• quantity - quantità di ogni elemento. Deve contenere un valore o la riga verrà rifiutata.

• price - prezzo di ogni elemento. Deve contenere un valore o la riga verrà rifiutata.

• disc_type - tipo di sconto; può essere «%» o «TODO». Si applica solo alle fatture. È necessario fare
qualche prova in questo caso dato che può essere funzione della valuta.
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• disc_how - si applica solamente alle fatture.

• discount - importo dello sconto applicato. Si applica solamente alle fatture.

• taxable - Will tax be applied to the item? «yes» or blank.

• taxincluded - Is tax included in the item price? «yes» or blank.

• tax_table — tabella delle imposte da applicare all’elemento.

• date_posted - If posted, what date. Normally left blank for manual posting after editing the invoice.
Use the same date format as setup in Preferences.

• due_date - Date payment is due. Use the same date format as setup in Preferences.

• account_posted — conto di emissione.

• memo_posted  - If posted insert memo here.

• accu_splits - Accumulate splits? «yes» or blank.

Importare clienti e venditori
This functionality is only available in the 2.6 versions of GnuCash and is only loaded by default for
versions greater than 2.6.

For versions lower than 2.6 the Customers and Vendors importer is an optional module and needs to
enabled by editing the file $HOME/.gnucash/config.user, adding the line:

(gnc:module-load "gnucash/plugins/customer_import" 0)

Su sistemi Linux questo file è $HOME/.gnucash/config.user e su MacOSX ~/Libra-
ry/Application Support/GnuCash/config.user. Se il file non esiste
già, lo si dovrà creare. Dopo aver riavviato GnuCash l’elemento com-
parirà alla fine del menu Impresa.

In order for the importer to work each line in the input file must have the following structure.

id, company, name, addr1, addr2, addr3, addr4, phone, fax, email,
notes, shipname, shipaddr1, shipaddr2, shipaddr3, shipaddr4, shipho-
ne, shipfax, shipmail

Fields can be separated with commas or semicolons and each field can be in quotes. These options
are selectable in the import dialog. Vendors don’t have shipping information so even though the fields
have to exist, leave them empty. The id field is optional and if it is empty a new id will be chosen.
If the id field has a value this will UPDATE any vendor/customer with the same id. This may not be
what you want. Note that in your input file the data must be a single line for each customer/vendor.

The importer does not currently import billing information for customers or vendors, these will have
to be edited individually after importing.

220



Parte IV. Appendices



Indice
GnuCash Glossary ......................................................................................................  223
A. Guida alla migrazione .............................................................................................  227

Usare i conti in luogo delle categorie .....................................................................  227
Organizazzione dei file QIF (Discussione) ..............................................................  227
Problemi comuni di duplicazione (Discussione) .......................................................  227
Controllo dei dati QIF (Discussione) .....................................................................  227
Convertire i file XML di GnuCash ........................................................................  227

B. Domande poste frequentemente (FAQ) ......................................................................  229
Fonti di Informazione .........................................................................................  229

D: Dov’è la FAQ? ...................................................................................... 229
D: Ci sono delle liste di discussione dedicate a GnuCash? .................................  229
D: esiste la possibilità di cercare un argomento nell’archivio delle liste di discus-
sione? .......................................................................................................  229
D: Esistono altri mezzi per ottenere aiuto riguardo GnuCash? .............................  229

Informazioni generali ..........................................................................................  229
D: Posso usare GnuCash in ambiente Windows? ..............................................  229
D: Ho sentito dire che è troppo difficile compilare GnuCash! .............................  229
D: C’è un metodo automatico (non-interattivo) in GnuCash, per realizzare conti-
nuamente rapporti, grafici ecc..? ...................................................................  230
D: È possibile che più persone abbiano accesso allo stesso progetto in GnuCash? ...  230
D: Perché GnuCash è scritto in C? ................................................................  230
D: Perché non riscrivete GnuCash nel linguaggio pinco-pallino così che io possa
contribuire più facilmente? ...........................................................................  230
D: Vorrei usare la funzione XYZ ma GnuCash non ce l’ha. Come posso fare? ........ 231
D: È disponibile un’interfaccia web in GnuCash? ............................................. 231
D: Come posso proteggere i miei dati di GnuCash utilizzando CFS, e simili? .........  231
D: Come posso contribuire al progetto GnuCash? ............................................  231
D: Credo di aver trovato un bug. Come posso comunicarlo? ...............................  231

Utilizzare GnuCash ............................................................................................. 231
D: Come posso spostare le transazioni da un conto «A» a un conto «B», in modo
da unirli? ..................................................................................................  231
D: È possibile unire due progetti di GnuCash? ................................................  232
D: Come posso salvare un modello predefinito della struttura del mio conto? .........  232
D: Quando cerco un cliente (o qualsiasi altra cosa), come posso ottenere una lista
di tutto? ....................................................................................................  232
D: Come posso registrare una transazione in date diverse (la data reale e quella
della banca)? .............................................................................................  232

Contabilità ........................................................................................................  232
D: Come devo trattare le tasse? Come un conto debiti correnti o come una usci-
ta? ...........................................................................................................  232

C. Contributed Account Trees ......................................................................................  233
UK Vat ............................................................................................................  233

D. Formati di file ausiliari ...........................................................................................  235
File di formato per gli assegni (Check Format File *.chk) .......................................  235

In generale ................................................................................................  235
Esempio di contenuto del file .......................................................................  235
Descrizione dei campi .................................................................................  236
Creare dei file di formato per gli assegni ........................................................  245

222



GnuCash Glossary
This is a glossary of common terms used in GnuCash. Some entries here are taken from Wikipedia (http://en.wi-
kipedia.org).

Conto An account keeps track of what you own, owe, spend or receive.

Accounting Period An accounting period is the period with reference to which accounting books
of an entity are prepared. Common accounting periods include month, quarter,
and year.

AqBanking A library which implements the German Home Banking Computer Interface
(HBCI) and Electronic Banking Internet Communication Standard (EBICS),
OFX Direct Connect and Paypal. It is the successor of openHBCI.

Asset An asset is something you own. Anything tangible or intangible that can be
owned or controlled to produce value and that is held to have positive econo-
mic value is considered an asset.

Balance Sheet A Balance Sheet is a summary of the financial balances of an individual or or-
ganization. It summarizes a company's assets, liabilities and ownership equity
at a specific point in time.

Book A book is a record of all transactions for an individual or organization. In
GnuCash, each file contains a book.

Capital Gain/Loss The difference between the purchase and selling prices of an investment at
the time the investment is sold. Also known as Realized Gain/Loss. Before an
investment is sold, the difference in value is referred to as Unrealized Gain/
Loss.
Vedi anche Realized Gain/Loss, Unrealized Gain/Loss.

Capital stock Vedi Stock.

Struttura dei conti A listing of all the accounts available in the data file. The chart of accounts
consists of balance sheet accounts (assets, liabilities, stockholders' equity) and
income statement accounts (revenues, expenses, gains, losses).

Commissionie The fee paid to a broker to buy or sell securities.

Commodity A commodity is something of value that is easily tradeable or sellable; for
example, currencies, stocks, bonds, grain, copper, and oil are all commodities.

Azione ordinaria Vedi Stock.

Interesse composto The concept that the reinvested interest can later earn interest of its own (in-
terest on interest). This is often referred to as compound interest.

Cost Basis Cost basis is the original cost of property, adjusted for various factors. Its
primary use is for tax purposes. Factors that affect the cost basis include: stock
splits, dividends, depreciation and return of capital distributions. Cost basis is
used to determine the capital gain.

CSV Stands for Comma Separated Values. CSV files are used to store data in plain
text. Each line of the file is a record and each record can be comprised of
multiple fields separated by commas. CSV is one import format that GnuCash
supports.

Dividendi Dividends are cash payments a company makes to shareholders. The amount
of this payment is usually determined as some amount of the profits of the
company. Not all common stocks give dividends.
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Capitali Equities are investments in which the investor becomes part (or whole) owner
in something.

Financial Transaction Services
(FinTS)

A banking protocol used by German banks. Developed by the German Central
Banking Committee ZKA (Zentraler Kredit-Ausschuss). The standard is used
only by German banks. Prior 2002, it was called Home Banking Computer
Interface (HBCI). FinTS is one import format that GnuCash supports.
Vedi anche Home Computer Banking Interface (HBCI).

GSettings Since version 2.5 the tool that stores user configuration data. It uses the native
data store of the operating system:

Linux DConf since Gnome 3.0 dropped GConf

Mac OS X Defaults. Use the command-line defaults(1) to modify
prefs when GnuCash isn't running.

Finestre Registry.

Home Computer Banking Inter-
face (HBCI)

A bank-independent online banking protocol used by German banks. Home
Banking Computer Interface (HBCI) was developed by the German Central
Banking Committee ZKA (Zentraler Kredit-Ausschuss). Since 2002, it has
been called Financial Transaction Services (FinTS). HBCI is one import for-
mat that GnuCash supports.
Vedi anche Financial Transaction Services (FinTS).

Interesse What a borrower pays a lender for the use of their money. Normally, this is
expressed in terms of a percentage of the principal per year. For example, a
savings account with 1% interest will pay you $1 for every $100 you keep
deposited per year.

Liability A liability is a debt or obligation that an individual or organization owes.

LibOFX An open source library for OFX. It was created by one of the GnuCash deve-
lopers, originally to be the OFX interface for GnuCash.
Vedi anche OFX.

Liquidità A measure of how easily convertible an investment is to cash. Money in a
savings account is very liquid, while money invested in a house has low liqui-
dity because it takes time to sell a house.

Lot A lot is a means of grouping a commodity so that you later identify that the
item bought in one transaction is the same as one sold in a different transaction.
Lots are often implemented with stocks, where capital gain can depend on
which item is being sold at a given time.

MT940 A financial information standard defined by SWIFT and used by several Eu-
ropean banks. It is also used internally in HBCI. Unfortunately, you can't do-
wnload the MT940 standard, but some banks publish it on their web sites.
MT940 is one import format that GnuCash supports.

OFX The Open Financial eXchange format. This is a financial information exchan-
ge standard used by many institutions. OFX is one import format that Gnu-
Cash supports.

Price Database The price database contains a store of price quotes for stocks, mutual funds,
and currencies.

Somma capitale The original amount of money invested or borrowed.
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QFX The Quicken Financial eXchange format is a proprietary financial information
exchange standard promoted by Quicken and used by many institutions. QFX
is one import format that GnuCash supports.

QIF The Quicken Interchange Format (QIF) is an open specification for reading
and writing financial data to files. This is an older format that is still used by
many institutions. QIF is one import format that GnuCash supports.

Realized Gain/Loss The difference between the purchase and selling prices of an investment at
the time the investment is sold. Also known as Capital Gain/Loss. Before an
investment is sold, the difference in value is referred to as Unrealized Gain/
Loss.
Vedi anche Capital Gain/Loss, Unrealized Gain/Loss.

Profitto The total income plus capital gains or losses of an investment.
Vedi anche Rendimento.

Rischio The probability that the return on investment is different from what was expec-
ted. Investments are often grouped on a scale from low risk (e.g., savings ac-
counts or government bonds) to high risk (e.g., common stocks or junk bonds).
As a general rule of thumb, the higher the risk, the higher the possible return.

Scheduled Transaction Scheduled transactions provide a framework for remembering information
about transactions that are set to occur in the future, either once or periodically.
Vedi anche Rendimento.

Scheme Scheme is a functional programming language based on a dialect of LISP.
Reports in GnuCash use the Scheme programming language; thus, users wi-
shing to customize reports must write Scheme.

Azionista A shareholder is a person who holds common stock in a company.

Split A split, or Ledger Entry, is the fundamental accounting unit. Each split con-
sists of an amount, the value of that amount expressed in a (possibly) different
currency, a Memo, a pointer to the parent Transaction, a pointer to the debited
Account, a reconciled flag and timestamp, an action field, and a key-value
frame which can store arbitrary data.

Stock A security that represents a certain fractional ownership of a company. This is
what you buy when you «buy stock» in a company on the open market. This
is also sometimes known as capital stock, or common stock.

Frazionamento azionario Occurs when a company offers to issue some additional multiple of shares for
each existing stock. For example, a «2 for 1» stock split means that if you own
100 shares of a stock, you will receive an additional 100 shares at no cost to
you. The unit price of the shares will usually be adjusted so there is no net
change in the value, so in this example the price per share will be halved. Note
that such transactions affect the cost basis per share owned.

Transaction A transaction consists of a date, a description, an ID number, a list of two
or more splits, and a key-value frame. Transactions embody the notion of
"double entry" accounting.

Unrealized Gain/Loss Unrealized gain or loss is the difference in value between a purchase price
and the current value of a given asset. These gains remain unrealized until the
asset is sold, at which point they become Realized gains or losses.
Vedi anche Capital Gain/Loss, Realized Gain/Loss.

Valuation The process of determining the market value or the price the investment would
sell at in a «reasonable time frame».
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XML The eXtensible Markup Language is an international markup standard. Gnu-
Cash stores its data by default in an XML data structure.

Rendimento A measure of the amount of money you earn from an investment (i.e., how
much income you receive from the investment). Typically, this is reported as
a percentage of the principal amount. Yield does not include capital gains or
losses (see Return). For example, a stock that sells for $100 and gives $2 in
dividends per year has a yield of 2%.
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Appendice A. Guida alla migrazione
Questa appendice è di supporto agli utenti di altri software finanziari nella migrazione a GnuCash. Sa-
ranno descritte le differenze di impostazioni di GnuCash confrontandole con quelle di altri programmi.

Usare i conti in luogo delle categorie
Se si ha familiarità con altri programmi per la gestione delle finanze personali, si sarà già abituati a
tenere traccia delle proprie entrate e uscite come categorie. Dato che GnuCash utilizza un sistema a
partita doppia (consultare la sezione 2.1), entrate e uscite sono trattate come conti. Il concetto di base è
lo stesso, ma la struttura a conti presenta una maggiore coerenza con l’uso commerciale comune. Così,
sia che si utilizzi per gestire la propria attività o per le proprie finanze personali, GnuCash permette
di tenere facilmente traccia di ogni operazione.

I conti per le entrate e per le uscite forniscono le stesse informazioni contenute nelle categorie ma
in più forniscono maggiore flessibilità nell’immissione delle transazioni. In GnuCash si ha infatti la
possibilità di inserire direttamente le transazioni attraverso il relativo registro contabile; i programmi
che utilizzano le categorie non offrono questa possibilità perché, per le categorie, non esiste un «re-
gistro contabile».

In GnuCash si ha anche la possibilità di trattare i conti di entrate e uscite esattamente come si tratte-
rebbero le categorie, se ci si sente più a proprio agio con quest’ultimo metodo. In Quicken® e altri
programmi simili, le transazioni hanno bisogno di un conto e di una categoria. Sostituendo un nome
di conto entrate o uscite in GnuCash con il nome della categoria uitlizzata nell’altro programma, il
risultato dovrebbe essere identico. L’immissione delle transazioni è discusso in dettaglio al capitolo 4.

Organizazzione dei file QIF (Discussione)

Problemi comuni di duplicazione (Discussio-
ne)

Controllo dei dati QIF (Discussione)

Convertire i file XML di GnuCash
I file dei dati XML creati da GnuCash possono essere trasformati facilmente in quasi tutti gli altri
formati di file di dati (es. QIF, CSV...), se si ha familiarità con XSLT. I file dei dati creati da GnuCash
sono XML «well-formed» e possono essere quindi «dati in pasto» a un parser XSLT con un foglio di
stile associato. Questo permette di trasformare il file in qualsiasi formato che può essere progettato,
dato un adeguato foglio di stile.

Per portare a termine la procedura con successo, è necessario seguire alcuni passi; la scrittura di un
foglio di stile non è argomento da affrontare in questa sede ma, se si dispone di uno di questi, ecco
come procedere:

1. Copiare il file dei dati XML di GnuCash in un file che funziona.

Nota

Se il file è stato modificato l’ultima volta con una versione di GnuCash precedente alla
2.0, allora prima di continuare al passo successivo, è necessario modificare il tag <gnc-
v2> come di seguito indicato:
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<gnc-v2 xmlns:cd="http://www.gnucash.org/XML/cd"
        xmlns:book="http://www.gnucash.org/XML/book"
        xmlns:gnc="http://www.gnucash.org/XML/gnc"
        xmlns:cmdty="http://www.gnucash.org/XML/cmdty"
        xmlns:trn="http://www.gnucash.org/XML/trn"
        xmlns:split="http://www.gnucash.org/XML/split"
        xmlns:act="http://www.gnucash.org/XML/act"
        xmlns:price="http://www.gnucash.org/XML/price"
        xmlns:ts="http://www.gnucash.org/XML/ts"
        xmlns:slot="http://www.gnucash.org/XML/kvpslot"
        xmlns:cust="http://www.gnucash.org/XML/cust"
        xmlns:entry="http://www.gnucash.org/XML/entry"
        xmlns:lot="http://www.gnucash.org/XML/lot"
        xmlns:invoice="http://www.gnucash.org/XML/invoice"
        xmlns:owner="http://www.gnucash.org/XML/owner"
        xmlns:job="http://www.gnucash.org/XML/job"
        xmlns:billterm="http://www.gnucash.org/XML/billterm"
        xmlns:bt-days="http://www.gnucash.org/XML/bt-days"
        xmlns:sx="http://www.gnucash.org/XML/sx"
        xmlns:fs="http://www.gnucash.org/XML/fs"
        xmlns:addr="http://www.gnucash.org/XML/custaddr">
    

Si può inserire più o meno qualsiasi cosa prima del segno di uguale, ma generalmente si
utilizza un URL.

2. creare un foglio di stile XSLT contenente la trasformazione che si desidera effettuare oppure recu-
perarne uno già preparato (non ce ne sono molti, ma ce n’è uno per il formato CSV in lavorazione);

3. installare un processore XSLT come Saxon (http://saxon.sourceforge.net/) o Xalan-J (http://xml.a-
pache.org/). Comunque qualsiasi processore simile funzionerà...;

4. elaborare il file di lavoro e il foglio di stile attraverso il processore seguendo le istruzioni fornite;

5. si disporrà infine di un file nel formato desiderato. Un utente intraprendente può addirittura arrivare
a scrivere un foglio di stile per trasformare un file dei dati di GnuCash in un foglio di Calc per
OpenOffice (o vice-versa). Alcuni formati, come il QIF, richiedono un po’ meno lavoro.

Il beneficio risiede nel fatto che non è necessario scrivere un modulo in Scheme o una nuova routine in
C per eseguire la trasformazione. Chiunque conosca o abbia voglia di imparare il linguaggio XML può
cimentarsi in questa operazione: sinceramente, niente di più difficile che scrivere una pagina web....

Anyhow, I just wanted this tidbit to be captured somewhere permanently. The process works on 2.6.14
datafiles, and ought to work on earlier versions, too.
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Appendice B. Domande poste
frequentemente (FAQ)

Questo è un elenco delle domande poste nelle liste di discussione e per le quali non esiste una sezione
apposita nella documentazione.

Fonti di Informazione

D: Dov’è la FAQ?
R: La stai leggendo! La versione più aggiornata è all’interno della Wiki di GnuCash [http://wiki.gnu-
cash.org/wiki/FAQ].

D: Ci sono delle liste di discussione dedicate a Gnu-
Cash?

R: Sì! qui: http://lists.gnucash.org/mailman/listinfo/gnucash-user e http://lists.gnucash.org/mail-
man/listinfo/gnucash-devel per iscriverti.

D: esiste la possibilità di cercare un argomento nell’ar-
chivio delle liste di discussione?

R: Sì, recati qui http://news.gmane.org/gmane.comp.gnome.apps.gnucash.devel e qui http://
news.gmane.org/gmane.comp.gnome.apps.gnucash.user (anche qui http://news.gmane.org/gma-
ne.comp.gnome.apps.gnucash.german se conosci il Tedesco).

D: Esistono altri mezzi per ottenere aiuto riguardo
GnuCash?

R: Sì. La maggior parte dei programmatori si ritrovano su ICQ nella discussione #gnucash su irc.gno-
me.org. È anche disponibile un wiki qui: http://wiki.gnucash.org/wiki/GnuCash.

Informazioni generali

D: Posso usare GnuCash in ambiente Windows?
R: Sì. A partire dalla versione 2.2.0, GnuCash è disponibile anche per Windows.

Altre opzioni correlate potrebbero essere colinux, VMWare e un server-X basato su windows che fa
da host per una sessione remota di GnuCash.

D: Ho sentito dire che è troppo difficile compilare Gnu-
Cash!

R:Questo era probabilmente vero quando la versione 1.6.0 è stata rilasciata. Oggi non è più vero, da-
to che quasi ogni distribuzione comprende già tutte le librerie necessarie (ad eccezione di g-wrap, il
che significa che di fatto manca «una sola» libreria extra che deve essere installata prima di compi-
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Domande poste fre-
quentemente (FAQ)

lare GnuCash). Comunque, normalmente le distribuzioni non installano i pacchetti di sviluppo delle
librerie necessarie, così potrebbe essere necessario avviare il programma di installazione della distri-
buzione per impostarlo in modo da installare non solo i pacchetti delle librerie ma anche i pacchetti di
sviluppo (con suffisso «-devel»). In genere, è stato puntualizzato che questo problema affligge diver-
se applicazioni dell’ambiente Gnome e dipende dal fatto che non esiste niente di simile a un «unico
enorme pacchetto di Gnome».

D: C’è un metodo automatico (non-interattivo) in Gnu-
Cash, per realizzare continuamente rapporti, grafici
ecc..?

R: No, per ora GnuCash funziona solo interattivamente.

D: È possibile che più persone abbiano accesso allo
stesso progetto in GnuCash?

R: È possibile che più persone possano accedere a un stesso progetto ma non contemporaneamente.

Per creare un progetto multi-utente, tutte le persone devono avere accesso in lettura e scrittura alla
cartella contenente i dati (per leggere i file creati dagli altri e crearne di nuovi). Un modo per farlo
consiste nel creare un gruppo e assegnare la cartella al gruppo creato con il codice 2775. Il «2» rap-
presenta l’attributo setgid che copia i permessi a tutti i file.

D: Perché GnuCash è scritto in C?

R: Le funzionalità principali di GnuCash sono scritte in C, ma non dimentichiamo che la maggior parte
di queste sono accessibili tramite Guile (Scheme). Ci sono un sacco di ragioni per cui GnuCash è stato
scritto in C. La prima è storica, infatti GnuCash è nato nel 1996 (o forse prima!) e la maggior parte
dei compilatori OOP (C++, Java, Python) non erano ancora maturi e sufficientemente standardizzati
per la varietà di piattaforme presenti a quel tempo, di conseguenza il C era l’unica scelta. Una seconda
ragione è rappresentata dal fatto che l’interfaccia grafica standard su cui si basa GnuCash è GTK, che
è scritta in C.

D: Perché non riscrivete GnuCash nel linguaggio pin-
co-pallino così che io possa contribuire più facilmen-
te?

R: La risposta più immediata è «non lo faremo». Quella più lunga è anche più complessa ma si con-
clude comunque con «non lo faremo». GnuCash è un grosso insieme di codice mantenuto da un pic-
colo gruppo di programmatori che conoscono bene i linguaggi C e Scheme (Guile). Ad oggi, l’80%
del codice è in C e circa il 13% in Scheme/Lisp. Non c’è nessuna buona ragione che giustificherebbe
la riscrittura di una così grande quantità di codice in un nuovo linguaggio. Inoltre, creare dei collega-
menti a linguaggi più recenti quali Python e Ruby o (inserisci qui il nome del tuo linguaggio preferi-
to!) sarebbe un lavoro impegnativo, considerando che siamo già piuttosto impegnati a mantenere ed
evolvere il codice già esistente.

Detto questo, GnuCash è un progetto open source e ognuno è libero di fare o contribuire come vuole.
Non aspettarti però un grande aiuto se la ragione del tuo cambio è dovuta solo alla mancanza di voglia
di imparare il C o Scheme. Inoltre, GnuCash aveva dei collegamenti a SWIG (http://www.swig.org)
che sono state usate per alcune parti programmate in perl. Stando ad una discussione, questi collega-
menti a SWIG potrebbero essere una strada per includere altri linguaggi in GnuCash, ma attualmente
sono inutilizzati e non supportati.
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D: Vorrei usare la funzione XYZ ma GnuCash non ce
l’ha. Come posso fare?

R: Chiedi gentilmente. :-) Puoi presentare una richiesta qui http://bugzilla.gnome.org/en-
ter_bug.cgi?product=gnucash. Ricorda di descrivere il più dettagliatamente possibile la caratteristica
che vorresti vedere implementata. Il trucco sta tutto nel riuscire a fornire più informazioni possibili ai
programmatori sulle caratteristiche della funzionalità da implementare. Se vuoi accelerare lo sviluppo,
considera la possibilità di effettuare una donazione come descritto nella GnuCashDevelopment.

D: È disponibile un’interfaccia web in GnuCash?
R: No

D: Come posso proteggere i miei dati di GnuCash uti-
lizzando CFS, e simili?

R: Senza risposta

D: Come posso contribuire al progetto GnuCash?
R: Stiamo organizzando un processo più formale ma per ora puoi iscriverti alla lista di discussio-
ne raggiungibile all’indirizzo http://lists.gnucash.org/mailman/listinfo/gnucash-user e http://lists.gnu-
cash.org/mailman/listinfo/gnucash-devel e discutere con gli iscritti il modo in cui puoi contribuire.
Tieni però presente che GnuCash è costituito da una bella percentuale di codice scritto in C e Scheme
(vedi la domanda più sopra, «Perché GnuCash è scritto in C?» se vuoi conoscerne i motivi). Se non ti
senti di programmare con questo linguaggio, puoi comunque contribuire in altro modo.

D: Credo di aver trovato un bug. Come posso comuni-
carlo?

R: Prima di tutto, cerca di verificare che si tratti realmente di un bug e che non sia già stato messo in
evidenza in passato. Cerca nell’archivio delle liste di discussione (vedi domanda più sopra). Poi passa
a cercare in Gnome Bugzilla [http://bugzilla.gnome.org] database.

Se sei convinto di aver trovato realmente un nuovo bug, puoi comunicarlo all’indirizzo http://bugzil-
la.gnome.org/enter_bug.cgi?product=gnucash. Per favore ricorda di descrivere il bug con il massimo
dettaglio possibile. Il trucco sta nel riuscire a fornire più informazioni possibili ai programmatori per
riuscire a riprodurre il bug. Un programmatore è in genere in grado di risolvere un bug solo quando
lo vede, se non riesci a mostrarlo al programmatore, non verrà tolto!

Utilizzare GnuCash

D: Come posso spostare le transazioni da un conto
«A» a un conto «B», in modo da unirli?

R: Al momento, GnuCash non offre un modo di spostare un gruppo di suddivisioni da un conto a
un altro; devono essere spostate una alla volta. Apri il registro per il conto «A» e seleziona la voce

del menu Visualizza → Giornale della transazione per rendere visibili tutte le suddivisioni. Per ogni
suddivisione in cui il campo «conto» mostra il conto «A», reimpostalo come conto «B». Per fare questo
velocemente e in sicurezza, utilizza prima la combinazione di tasti Ctrl+C per copiare il nome del
conto di destinazione (conto «B») nella memoria. Seleziona poi ogni riferimento al conto «A» con un
doppio clic su di questo e premi Ctrl+V per incollare il nome del conto di destinazione. Premendo
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Invio dopo ogni operazione di incollaggio, automaticamente verrà spostata la transazione fuori dal
registro.

FAI ATTENZIONE! se inavvertitamente imposti il campo «Conto» a una destinazione non voluta,
dovrai cercare tra tutti i tuoi conti per ritrovare la transazione persa e correggere l’errore.

D: È possibile unire due progetti di GnuCash?
R: Al momento non è possibile.

D: Come posso salvare un modello predefinito della
struttura del mio conto?

R: È disponibile un comando dal menu: File → Esporta → Esporta conti

D: Quando cerco un cliente (o qualsiasi altra cosa),
come posso ottenere una lista di tutto?

R: Seleziona l’opzione corrisponde all’espressione regolare e inserisci un semplice punto «.» nel cam-
po del testo da ricercare. Premi poi Trova. L’espressione regolare «.» significa di cercare tutto.

D: Come posso registrare una transazione in date di-
verse (la data reale e quella della banca)?

R: Conviene registrare la transazione con la data in cui hai firmato l’assegno o iniziato l’operazione.
Quando viene «liquidata» dalla banca, puoi fare clic nel campo Riconciliata per «liquidare» la tran-
sazione (cambierà la «n» in «l»).

Contabilità

D: Come devo trattare le tasse? Come un conto debiti
correnti o come una uscita?

R: Questa è una bella domanda; dovresti consultare il tuo commercialista. Il modo in cui trattare le
tasse dipende fortemente dalla loro tipologia e da come tu vuoi trattarle... In alcuni casi sono spese,
in altri sono debiti.
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Appendice C. Contributed Account
Trees

UK Vat
Tipo di conto (visualizzato solamente se diverso da quello genitore)

• [u] Uscita

• [E] Entrata

• [A] Attività

• [p] Passività

• [C] CapitalE

• [B] Conti bancari

• [T] Carta di credito:

• [R] Crediti correnti

• [P] Conti debitori

(Box n) refers to VAT form box number (I actually have these as descriptions to the account to remind
me)

Add all the (Box n -part) together to get the whole (Box n) The VAT shows you liability - if its negative
they owe you.

Capital Equipment (Box 7 - part) and (Box 6 - part) is the value of all *additions* (purchases) made
over the VAT return period - not the absolute value, nor the difference in value unless that difference is
wholly due to new purchases. Depreciation, losses (e.g a write off of faulty item) and other reductions
in capital value are not included. If you sell a capital item then that sale and its VAT is recorded under
Income. The asset is «converted to cash», so the «net of VAT» increase in your bank account, when
the invoice is payed, is matched by a decrease in capital.

Bank Accounts [B]
  |___ Main Account
  |___  Reserve Account

Cash [A]

Assets [A]
  |___ Capital Equipment    (Box 7 - Part) - additions only, not absolute value
  |           |___ Computers      Can be depreciated to zero this year
  |           |___ EEC reverse VAT purchase  (Box 6 - Part) create sub-accounts if needed
  |___  Other

Receivable [R] Customers to whom you give credit - (business section)

Cards [C]
  |___  Card 1

Liabilities [L]
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  |___  Owed Corp Tax
  |___  Owed Fees
  |___  Owed Tax / NI
  |___  Other

VAT [L]   Net (Box 5)
  |___ i/p [A]   purchases (Box4)
  |___  o/p [L]     (Box3)
             |___EEC   on reverse VAT purchases (Box 2)
             |___Sales   all including zero rate UK/ EEC  and World (Box1)

Payable [P]   Suppliers who give you credit (business section)

Equity [Q]
  |___  Corp Tax
  |___  Director’s Loan
  |___  Dividends
  |             |___  Director1
  |             |___  Director2
  |             |___  Shareholder 1
  |___ Grants (and stuff that does not count as income)
  |___Opening Balances

Income [I]   (Box 6 - part)
   |___ Interest
   |___ Misc
   | ___ Sales
                |___ EEC
                |     |____ goods  (Box 8) (sub accounts as needed)
                |     |____ services includes software (sub accounts as needed)
                | ___ UK
                |____ World

Expenses [E]
        |__Depreciation
        |__ Emoluments
        |            |___ Directors Fees
        |            |___ NI Employer
        |            |___ Employee 1
        |                     |___NI
        |                     |___Net Salary
        |                     |___Stakeholder
        |                     |___Tax
        |___ Other Non VAT Expenses
        |___ VAT Purchases    (Box 7 - part)
                    |___  Accountancy
                    |___  Bank Charges
                    |___  Consumables
                    |___  EEC  reverse VAT purchases  (Box 6 - Part)
                    |         |___ goods (Box 9) (sub accounts as needed)
                    |         |___ services   includes software (sub accounts as needed)
                    |___  Office
                    |___  Phone and Internet
                    |___  Software
                    |___  Subscriptions
                    |___  Sundry
                    |___  Travel / Accom
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Appendice D. Formati di file ausiliari
Questi sono i formati di alcuni file ausiliari utilizzati da GnuCash.

File di formato per gli assegni (Check Format
File *.chk)

In generale
Il file di formato per gli assegni è utilizzato per indicare a GnuCash come stampare uno o più assegni
in un foglio di carta. Questo file descrive dapprima la disposizione generale della pagina (numero di
assegni, orientazione, ecc...) e poi descrive l’impaginazione delle singole voci per ogni assegno. Il
file è organizzato nel tipico formato a chiave e valore utilizzato dalla maggior parte delle applicazioni
Linux. Le coppie di chiave e valore sono raggruppate in sezioni che iniziano con il nome del gruppo
racchiuso tra parentesi quadre.

GnuCash cerca i file di formato per gli assegni in due differenti posizioni nel momento in cui viene
aperta la finestra di stampa degli assegni: la prima posizione è generalmente /usr/share/gnu-
cash/checks, dove risiedono i file di formato distribuiti con il programma; la seconda posizione è
la cartella personale ~/.gnucash/checks. L’utente può aggiungere dei file di formato in qualsiasi
momento (anche mentre GnuCash è in esecuzione) copiando semplicemente un nuovo file *.chk in
questa cartella. Aprendo nuovamente la finestra di stampa degli assegni, il nuovo formato apparirà
nella lista di quelli disponibili.

Nota

La stampa funziona in modo differente in funzione della versione di GTK installata nel siste-
ma. Quando GnuCash utilizza una versione precedente alla 2.10, tutti gli spostamenti sono
misurati a partire dall’angolo in basso a sinistra del foglio o dell’assegno singolo; quando
invece si utilizza la versione 2.10 o successive, tutti gli spostamenti sono relativi all’angolo
in alto a sinistra del foglio o del singolo assegno.

Esempio di contenuto del file
Un tipico file per gli assegni di GnuCash è mostrato di seguito. Il contenuto di questo file verrà descritto
nelle sezioni successive.

[Top]
Guid = 67b144d1-96a5-48d5-9337-0e1083bbf229
Title = Quicken/QuickBooks (tm) US-Letter
Rotation = 0.0
Translation = 0.0;4.0
Show_Grid = false
Show_Boxes = false

[Check Positions]
Height = 252.0
Names = Top;Middle;Bottom

[Check Items]
Type_1 = PAYEE
Coords_1 = 90.0;102.0;400.0;20.0
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Type_2 = AMOUNT_WORDS
Coords_2 = 90.0;132.0

Type_3 = AMOUNT_NUMBER
Blocking_Chars_3 = true
Coords_3 = 500.0;102.0

Type_4 = DATE
Coords_4 = 500.0;67.0

Type_5 = NOTES
Coords_5 = 50.0;212.0
        

Descrizione dei campi

Gruppo Top

Questa sezione del file degli assegni descrive la disposizione generale nella pagina degli assegni (o
dell’assegno) che vengono immessi nella stampante.

Tabella D.1. Campo per la descrizione della disposizione generale

Nome Tipo Necessario Descrizione

Guid stringa obbligatorio Il codice guid permette
di identificare univoca-
mente un formato di as-
segni utilizzato da Gnu-
Cash. Deve essere unico
tra tutti quelli delle ap-
plicazioni fornite e quel-
li forniti dall’utente. Se
si copia un file di forma-
to esistente da utilizzare
come base per le proprie
modifiche, questo valo-
re deve essere cambia-
to. Il programma uuid-
gen può essere usato per
generare questo identifi-
cativo.

Titolo stringa obbligatorio Il campo title permette
di identificare univoca-
mente il formato di as-
segni da parte dell’uten-
te. Questo valore è pre-
sentato tale e quale nella
lista dei formati presen-
te nella finestra di stam-
pa degli assegni. Se si
copia un file di forma-
to esistente da utilizzare
come base per le proprie
modifiche, questo valo-
re deve essere cambiato
adottando una qualsiasi
stringa in formato utf-8.
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Nome Tipo Necessario Descrizione

Carattere stringa opzionale Se fornita, rappresenta il
carattere predefinito uti-
lizzato per stampare tut-
ti campi di testo nell’as-
segno. Questo campo
può contenere qualsia-
si stringa accettata da
GTK come carattere. Se
questo campo è lascia-
to vuoto, verrà utilizza-
to il carattere predefini-
to indicato nelle prefe-
renze di GnuCash. Un
valore tipico può essere
«sans 12».

Blocking_Chars Booleano opzionale Se fornito, rappresen-
ta il valore di default
quando si stampano tut-
ti gli elementi TEXT su
questo assegno. Quan-
do impostato a «true»,
stampa i caratteri ***
prima e dopo ogni cam-
po di testo nell’assegno.
I caratteri di blocco sono
stampati per proteggere
i campi di testo da mo-
difiche. Per esempio, il
campo dell’importo po-
trebbe essere stampato
come ***100,00***

DateFormat Booleano opzionale Se fornito, rappresen-
ta il valore predifinto
quando si stampano tut-
ti gli elementi DATE su
questo assegno. Se im-
postato a «true», il for-
mato di data verrà stam-
pato in 8 punti, centra-
to e sopra la data corren-
te. Per esempio DDM-
MYYYY.

Rotation virgola mobile opzionale Questo valore indica la
rotazione di tutta la pa-
gina (in gradi) rispet-
to al punto di origine.
Per le versioni di GTK
precedenti alla 2.10, il
punto di origine è si-
tuato nell’angolo in bas-
so a sinistra della pagi-
na e la rotazione è posi-
tiva in senso antiorario.
Per le versioni di GTK
superiori o uguali alla
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Nome Tipo Necessario Descrizione

2.10, il punto di origi-
ne è nell’angolo in alto
a sinistra della pagina e
la rotazione è positiva in
senso orario. La rotazio-
ne della pagina è appli-
cata prima della trasla-
zione.

Translation elenco di 2 numeri a vir-
gola mobile

opzionale Questi valori specifica-
no la rotazione lungo
x e lungo y dell’inte-
ra pagina (in punti) re-
lativamente al punto di
origine. Per le versioni
di GTK precedenti alla
2.10, il punto di origi-
ne è situato nell’angolo
in basso a sinistra del-
la pagina e la traslazione
è positiva verso l’alto e
verso destra. Per le ver-
sioni di GTK superiori o
uguali alla 2.10, il pun-
to di origine è nell’ango-
lo in alto a sinistra del-
la pagina e la traslazione
è positiva verso destra e
verso il basso. La rota-
zione alla pagina è ap-
plicata prima della tra-
slazione.

Show_Grid Booleano opzionale Se questo valore è impo-
stato a true allora Gnu-
Cash disegnerà una gri-
glia nella pagina, par-
tendo dal punto di ori-
gine con delle linee in-
tervallate di 50 punti.
Questa opzione è utile
quando si desidera crea-
re un nuovo file di for-
mato per la stampa degli
assegni.

Show_Boxes Booleano opzionale Se questo valore è im-
postato a true allora per
ogni elemento di cui so-
no state specificate lar-
ghezza e altezza, Gnu-
Cash disegnerà un ri-
quadro che mostra la
posizione e l’ingombro
massimo dell’elemento
stesso. Questa opzione è
utile quando si deside-
ra creare un nuovo file
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Nome Tipo Necessario Descrizione

di formato per la stampa
degli assegni.

Nota

Le opzioni Blocking_Chars e DateFormat sono definite per tutti i formati di assegno nella

scheda Stampa in Modifica → Preferenze. Si raccomanda che queste opzioni globali riman-
gano impostate a falso (valore predefinito) e che vengano invece impostate per ogni assegno
nel gruppo Check Items come descritto nel seguito.

Gruppo Check Positions

Questo gruppo di elementi specifica come sono distribuiti gli assegni nel foglio di carta e fornisce dei
nomi a ogni posizione di un assegno in modo che l’utente possa indicare a GnuCash quale di queste
posizioni debba essere stampata. Questo gruppo di valori e chiavi è opzionale e deve essere tralasciato
se si desidera che venga stampato un solo assegno per foglio.

Tabella D.2. Campi per la stampa di più assegni per foglio

Nome Tipo Necessario Descrizione

Altezza virgola mobile obbligatorio Questo campo specifica
l’altezza del singolo as-
segno nella pagina. Se
si desidera stampare più
di un assegno per pagi-
na, allora questo campo
è obbligatorio. Se si de-
sidera invece stampare
un solo assegno per fo-
glio, tutta la sezione do-
vrebbe essere tralascia-
ta.

Names elenco di stringhe obbligatorio Questo campo specifi-
ca i nomi delle posi-
zioni degli assegni che
possono essere stampa-
ti per ogni pagina. Que-
sti nomi rappresentano
le posizioni dell’asse-
gno partendo dall’alto
della pagina e spostan-
dosi verso il basso. I
nomi vengono indicati
in modo identico nel-
la lista delle posizioni
presente nella finestra
di stampa degli asse-
gni. Un valore tipico per
questo campo può esse-
re Top;Middle;Bottom,
ma potrebbe anche es-
sere First;Second;Third
o qualsiasi altro insieme
di stringhe che identifi-
ca chiaramente la posi-
zione dell’assegno. Se si
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Nome Tipo Necessario Descrizione

desidera stampare più di
un assegno per pagina,
allora questo campo è
obbligatorio. Se si desi-
dera invece stampare un
solo assegno per foglio,
tutta la sezione dovreb-
be essere tralasciata..

Gruppo Check Items

Questa sezione indica le singole voci da stampare sull’assegno. Non c’è limite al numero di voci che
è possibile inserire e la stessa tipologia può essere ripetuta più volte; questo permette la stampa di
assegni che hanno una matrice laterale, o degli assegni per le imprese che sono uno per pagina e che
hanno sia l’assegno e le matrici multiple nella stessa pagina. per esempio, per stampare il nome del
beneficiario in un assegno per imprese e in entrambe le matrici, basta specificare tre diverse voci del
tipo Payee con differenti coordinate per la stampa.

Ogni nome di chiave contenuta in questa sezione include esplicitamente il numero dell’elemento a cui
viene applicata: es. la chiave denominata Type_1 si applica al primo elemento stampato e la chiave
Coords_3 viene applicata al terzo elemento che deve essere stampato. I numeri delle voci cominciano
da uno e crescono in modo sequenziale. Ogni salto nella numerazione viene interpretato da GnuCash
come la fine della lista della voce. Gli elementi sono stampati secondo l’ordine numerico, non nell’or-
dine con cui appaiono nel file.

Ogni elemento specificato deve includere un tipo di dichiarazione. I restanti parametri per l’elemento
dipendo dal suo particolare tipo. Consultare la Tabella D.4, «Tipi di voci per un singolo assegno» per
recuperare una lista di tipi di elementi validi e i rispettivi parametri richiesti.

Tabella D.3. Campi degli elementi per un unico assegno

Nome Tipo Necessario Descrizione

Type_n stringa obbligatorio Questo campo specifi-
ca il tipo di elemen-
to da stampare sull’as-
segno. Consultare la Ta-
bella D.4, «Tipi di voci
per un singolo assegno»
per una lista di voci va-
lide.

Coords_n elenco di 2 o 4 numeri a
virgola mobile

obbligatorio Questo campo specifi-
ca le coordinate in cui
la voce verrà inserita
nell’assegno e, opzio-
nalmente, ne specifica
anche l’altezza e la lar-
ghezza. I valori rappre-
sentano rispettivamente
gli spostamenti lungo
agli assi X e Y rispet-
to all’angolo in basso
a sinistra dell’elemento
e opzionalmente la sua
larghezza e altezza. Se
viene fornito un valore
per l’altezza, allora deve
essere inserita anche la
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Nome Tipo Necessario Descrizione

larghezza e quindi que-
sto campo deve conte-
nere 2 o 4 valori. Per le
versioni GTK preceden-
ti alla 2.10, il punto di
origine è nell’angolo in
bsso a sinistra della pa-
gina e le traslazioni so-
no positive verso l’alto e
verso destra. Per le ver-
sioni GTK 2.10 e supe-
riori, il punto di origine
è situato in alto a sini-
stra e le traslazioni sono
positive verso il basso e
verso destra.

Nota

Indipendente-
mente dalla
posizione del
punto di origi-
ne (in alto o in
basso), le coor-
dinate specifi-
cano sempre il
punto in bas-
so a sinistra
dell’elemento.

Font_n stringa opzionale Se fornita, rappresen-
ta il carattere utilizzato
per stampare la specifi-
ca voce di testo. Que-
sto campo può contene-
re una stringa qualsia-
si purché sia accettata
da GTK. Se questo cam-
po è lasciato vuoto, ver-
rà utilizzato il caratte-
re predefinito specifica-
to nella sezione Inizia-
le del file di descrizio-
ne degli assegni o, se an-
che questo è stato trala-
sciato, il carattere spe-
cificato nelle preferen-
ze di GnuCash. Que-
sto campo viene ricono-
sciuto solamente se si
utilizza GTK 2.10 o suc-
cessivo.

Align_n stringa opzionale Se fornita, rappresenta
l’allineamento utilizza-
to per stampare la speci-
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Nome Tipo Necessario Descrizione

fica voce di testo. Que-
sto campo deve conte-
nere una delle seguen-
ti stringhe «sinistra»,
«centro» o «destra». Se
questo campo è lasciato
vuoto, il testo verrà al-
lineato a sinistra. Que-
sto campo viene ricono-
sciuto solamente se si
utilizzano le GTK 2.10
o successive.

Text_n stringa opzionale Questo campo è utiliz-
zato solamente quando
il tipo di voce è impo-
stato a TEXT. Specifica
il testo, in formato utf-8,
da stampare sull’asse-
gno.

Filename_n stringa opzionale Questo campo è uti-
lizzato solamente quan-
do il tipo di elemen-
to è impostato a PIC-
TURE. Specifica il no-
me del file dell’immagi-
ne da stampare sull’as-
segno. La stringa può
specificare un percorso
assoluto o relativo. In
quest’ultimo caso, Gnu-
Cash controlla prima
nella cartella dei forma-
ti di assegno forniti dal
programma (general-
mente /usr/share/
gnucash/checks) e,
se non lo dovesse trova-
re, cercherà nella cartel-
la personale ~/.gnu-
cash/checks. Que-
sto campo viene ricono-
sciuto solamente se si
utilizza GTK 2.10 o suc-
cessivo.

Blocking_Chars_n Booleano opzionale Se fornito, imposta l’op-
zione di stampa Bloc-
king_Chars per questo
elemento.

DateFormat_n Booleano opzionale Se fornito, imposta l’op-
zione di stampa Date-
Format per questo ele-
mento.

Queste sono le voci che possono essere stampate individualmente su un assegno; necessitano tutte
delle coordinate rispetto alla pagina dove devono essere stampate. La maggioranza di queste voci pro-
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ducono la stampa di un testo sul foglio ed è possibile, per ognuna di esse, specificare un carattere e un
allineamento. Per esempio, l’importo in cifre di un assegno può essere stampato con la giustificazione
a destra mentre, tutto il resto, giustificato a sinistra. Gli altri tipi devono avere dei parametri unici.

Tabella D.4. Tipi di voci per un singolo assegno

Nome Valori obbligatorio Valori facoltativi Descrizione

PAYEE Coordinate Font
Align
Blocking_Chars
                    

Questo valore del ti-
po indica a GnuCash di
stampare il nome del be-
neficiario partendo dalle
coordinate specificate.

DATE Coordinate Font
Align
Blocking_Chars
DateFormat
                    

Questo valore del ti-
po indica a GnuCash di
stampare la data parten-
do dalle coordinate spe-
cificate.

NOTES Coordinate Font
Align
Blocking_Chars
                    

Questo valore del ti-
po indica a GnuCash di
stampare il campo del-
le note della transazione
partendo dalle coordina-
te specificate.

CHECK_NUMBER Coordinate Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the
check number at the
specified coordinates.
The check number re-
flects the book op-
tion selection under Fi-

le → Proprietà for
number source (tran-
saction number or an-
chor-split action - see
Use Split Action Field
for Number [ghelp:gnu-
cash-help?num-
action-book-option] in
the Book Options sec-
tion of the GnuCash
Help Manual).

MEMO Coordinate Font
Align
Blocking_Chars
                    

Questo valore del ti-
po indica a GnuCash
di stampare il il campo
promemoria della sud-
divisione partendo dalle
coordinate specificate.

ACTION Coordinate Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the
split action field at
the specified coordina-
tes. However, the prin-
ted field reflects the
book option selection

under File → Proprietà
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Nome Valori obbligatorio Valori facoltativi Descrizione

for number source (tran-
saction number or an-
chor-split action - see
Use Split Action Field
for Number [ghelp:gnu-
cash-help?num-
action-book-option] in
the Book Options sec-
tion of the GnuCash
Help Manual). If num-
ber source for the book
is specified as an-
chor-split action, this
field will instead print
the transaction number
field.

AMOUNT_WORDS Coordinate Font
Align
Blocking_Chars
                    

Questo valore del ti-
po indica a GnuCash
di stampare l’importo
in lettere dell’assegno
partendo dalle coordina-
te specificate. L’impor-
to apparirà nella forma
Un milione, due cento
trenta quattro e 56/100.

AMOUNT_NUMBER Coordinate Font
Align
Blocking_Chars
                    

Questo valore del ti-
po indica a GnuCash
di stampare l’importo in
cifre dell’assegno par-
tendo dalle coordina-
te specificate. L’impor-
to apparirà nella forma
€1.234,56.

ADDRESS Coordinate Font
Align
Blocking_Chars
                    

Questo valore del ti-
po indica a GnuCash di
stampare l’indirizzo alle
coordinate specificate.

SPLITS_ACCOUNT Coordinate Font
Align
Blocking_Chars
                    

Questo valore del ti-
po indica a GnuCash di
stampare i nomi dei con-
ti per ogni suddivisione
partendo dalle coordina-
te specificate. Vedere la
nota sulla stampa delle
suddivisioni.

SPLITS_AMOUNT Coordinate Font
Align
Blocking_Chars
                    

Questo valore del ti-
po indica a GnuCash di
stampare l’importo per
ogni suddivisione par-
tendo dalle coordinate
specificate. Gli impor-
ti sono stampati con
il simbolo della valu-
ta. Vedere la nota sulla
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Nome Valori obbligatorio Valori facoltativi Descrizione

stampa delle suddivisio-
ni.

SPLITS_MEMO Coordinate Font
Align
Blocking_Chars
                    

Questo valore del ti-
po indica a GnuCash
di stampare il campo
del promemoria parten-
do dalle coordinate spe-
cificate. Vedere la nota
sulla stampa delle sud-
divisioni.

TEXT Coordinate, testo Font
Align
Blocking_Chars
                    

Questo valore del ti-
po indica a GnuCash
di stampare una stringa
arbitraria partendo dal-
le coordinate specifica-
te. La stringa da stam-
pare è specificata dalla
chiave Text_n.

PICTURE Coordinate, nome del fi-
le

(nessuno) Questo valore del ti-
po indica a GnuCash di
stampare un’immagine
partendo dalle coordi-
nate specificate. L’im-
magine da stampare
è specificata attraverso
la chiave Filename_n.
Questo tipo è ricono-
sciuto solamente quan-
do si utilizza GTK 2.10
o successiva.

Nota

SPLIT items include all split entries for the transaction except for the split that applies to
the current account register (referred to as the anchor-split). This is usually the last split
listed when splits are displayed in the register. The coordinate location defines the lower left
location for the split information.

Creare dei file di formato per gli assegni
Creare un proprio file di formato per gli assegni è un’operazione piuttosto semplice. Il metodo più
semplice consiste nel copiare un file di formato esistente dalla cartella del programma (generalmente
/usr/share/gnucash/checks) alla cartella ~/.gnucash/checks. È importante ricordarsi
di cambiare il valore guid per fare in modo che il nuovo file venga accettato da GnuCash e di cambiare
il titolo in modo che sia di descrittivo. A questo punto è possibile cambiare e aggiungere i campi come
si desidera. È possibile anche creare un nuovo file di formato premendo il pulsante Salva formato nella
pagina del Formato personalizzato della finestra di stampa degli assegni.

Nota

I nomi delle chiavi sono sensibili alle lettere maiuscole o minuscole. Se si avessero dei pro-
blemi con un file di formato per gli assegni, assicurarsi che tutti i nomi delle chiavi inizino
con la lettera maiuscola.
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Appendice E. Documentazione sulla
licenza libera GNU (in inglese)

Versione 1.1, Marzo 2000
Diritto d'autore © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA02111-1307USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing
it is not allowed.

0. PREAMBLE
The purpose of this License is to make a manual, textbook, or other written document «free» in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without
modifying it, either commercially or noncommercially. Secondarily, this License preserves for the
author and publisher a way to get credit for their work, while not being considered responsible for
modifications made by others.

This License is a kind of «copyleft», which means that derivative works of the document must them-
selves be free in the same sense. It complements the GNU General Public License, which is a copyleft
license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms
that the software does. But this License is not limited to software manuals; it can be used for any
textual work, regardless of subject matter or whether it is published as a printed book. We recommend
this License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work that contains a notice placed by the copyright holder
saying it can be distributed under the terms of this License. The «Document», below, refers to any
such manual or work. Any member of the public is a licensee, and is addressed as «you».

A «Modified Version» of the Document means any work containing the Document or a portion of it,
either copied verbatim, or with modifications and/or translated into another language.

A «Secondary Section» is a named appendix or a front-matter section of the Document [246] that
deals exclusively with the relationship of the publishers or authors of the Document to the Document’s
overall subject (or to related matters) and contains nothing that could fall directly within that overall
subject. (For example, if the Document is in part a textbook of mathematics, a Secondary Section
may not explain any mathematics.) The relationship could be a matter of historical connection with
the subject or with related matters, or of legal, commercial, philosophical, ethical or political position
regarding them.

The «Invariant Sections» are certain  Secondary Sections [246] whose titles are designated, as being
those of Invariant Sections, in the notice that says that the Document [246] is released under this
License.

The «Cover Texts» are certain short passages of text that are listed, as Front-Cover Texts or Back-
Cover Texts, in the notice that says that the Document [246] is released under this License.

A «Transparent» copy of the  Document [246] means a machine-readable copy, represented in a
format whose specification is available to the general public, whose contents can be viewed and edited
directly and straightforwardly with generic text editors or (for images composed of pixels) generic
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paint programs or (for drawings) some widely available drawing editor, and that is suitable for input to
text formatters or for automatic translation to a variety of formats suitable for input to text formatters.
A copy made in an otherwise Transparent file format whose markup has been designed to thwart or
discourage subsequent modification by readers is not Transparent. A copy that is not «Transparent»
is called «Opaque».

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo
input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-con-
forming simple HTML designed for human modification. Opaque formats include PostScript, PDF,
proprietary formats that can be read and edited only by proprietary word processors, SGML or XML
for which the DTD and/or processing tools are not generally available, and the machine-generated
HTML produced by some word processors for output purposes only.

The «Title Page» means, for a printed book, the title page itself, plus such following pages as are
needed to hold, legibly, the material this License requires to appear in the title page. For works in
formats which do not have any title page as such, «Title Page» means the text near the most prominent
appearance of the work’s title, preceding the beginning of the body of the text.

2. VERBATIM COPYING
You may copy and distribute the Document [246] in any medium, either commercially or noncom-
mercially, provided that this License, the copyright notices, and the license notice saying this License
applies to the Document are reproduced in all copies, and that you add no other conditions whatsoe-
ver to those of this License. You may not use technical measures to obstruct or control the reading
or further copying of the copies you make or distribute. However, you may accept compensation in
exchange for copies. If you distribute a large enough number of copies you must also follow the con-
ditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display
copies.

3. COPYING IN QUANTITY
If you publish printed copies of the Document [246] numbering more than 100, and the Document’s
license notice requires Cover Texts [246], you must enclose the copies in covers that carry, clearly
and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on
the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies.
The front cover must present the full title with all words of the title equally prominent and visible.
You may add other material on the covers in addition. Copying with changes limited to the covers, as
long as they preserve the title of the Document [246] and satisfy these conditions, can be treated
as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones
listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque [246] copies of the Document [246] numbering more than
100, you must either include a machine-readable Transparent [246] copy along with each Opaque
copy, or state in or with each Opaque copy a publicly-accessible computer-network location containing
a complete Transparent copy of the Document, free of added material, which the general network-using
public has access to download anonymously at no charge using public-standard network protocols.
If you use the latter option, you must take reasonably prudent steps, when you begin distribution of
Opaque copies in quantity, to ensure that this Transparent copy will remain thus accessible at the stated
location until at least one year after the last time you distribute an Opaque copy (directly or through
your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document [246] well before
redistributing any large number of copies, to give them a chance to provide you with an updated
version of the Document.
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4. MODIFICATIONS
You may copy and distribute a Modified Version [246] of the Document [246] under the condi-
tions of sections 2 and 3 above, provided that you release the Modified Version under precisely this
License, with the Modified Version filling the role of the Document, thus licensing distribution and
modification of the Modified Version to whoever possesses a copy of it. In addition, you must do
these things in the Modified Version:

• A. Use in the Title Page [247] (and on the covers, if any) a title distinct from that of the
Document [246], and from those of previous versions (which should, if there were any, be listed
in the History section of the Document). You may use the same title as a previous version if the
original publisher of that version gives permission.

• B. List on the Title Page [247], as authors, one or more persons or entities responsible for
authorship of the modifications in the Modified Version [246], together with at least five of the
principal authors of the Document [246] (all of its principal authors, if it has less than five).

• C. State on the Title Page [247] the name of the publisher of the Modified Version [246],
as the publisher.

• D. Preserve all the copyright notices of the Document [246].

• E. Add an appropriate copyright notice for your modifications adjacent to the other copyright
notices.

• F. Include, immediately after the copyright notices, a license notice giving the public permission
to use the Modified Version [246] under the terms of this License, in the form shown in the
Addendum below.

• G. Preserve in that license notice the full lists of  Invariant Sections [246] and required Cover
Texts [246] given in the Document’s [246] license notice.

• H. Include an unaltered copy of this License.

• I. Preserve the section entitled «History», and its title, and add to it an item stating at least the
title, year, new authors, and publisher of the Modified Version  [246]as given on the Title Pa-
ge [247]. If there is no section entitled «History» in the Document [246], create one stating
the title, year, authors, and publisher of the Document as given on its Title Page, then add an item
describing the Modified Version as stated in the previous sentence.

• J. Preserve the network location, if any, given in the Document [246] for public access to a
Transparent [246] copy of the Document, and likewise the network locations given in the Do-
cument for previous versions it was based on. These may be placed in the «History» section. You
may omit a network location for a work that was published at least four years before the Document
itself, or if the original publisher of the version it refers to gives permission.

• K. In any section entitled «Acknowledgements» or «Dedications», preserve the section’s title,
and preserve in the section all the substance and tone of each of the contributor acknowledgements
and/or dedications given therein.

• L. Preserve all the Invariant Sections [246] of the Document [246], unaltered in their text
and in their titles. Section numbers or the equivalent are not considered part of the section titles.

• M. Delete any section entitled «Endorsements». Such a section may not be included in the Mo-
dified Version [246].

• N. Do not retitle any existing section as «Endorsements» or to conflict in title with any Invariant
Section [246].

If the Modified Version [246] includes new front-matter sections or appendices that qualify as
Secondary Sections [246] and contain no material copied from the Document, you may at your
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option designate some or all of these sections as invariant. To do this, add their titles to the list of
Invariant Sections [246] in the Modified Version’s license notice. These titles must be distinct from
any other section titles.

You may add a section entitled «Endorsements», provided it contains nothing but endorsements of
your Modified Version [246] by various parties--for example, statements of peer review or that the
text has been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text [246], and a passage of up to 25
words as a Back-Cover Text [246], to the end of the list of Cover Texts [246] in the Modified
Version [246]. Only one passage of Front-Cover Text and one of Back-Cover Text may be added
by (or through arrangements made by) any one entity. If the Document [246] already includes a
cover text for the same cover, previously added by you or by arrangement made by the same entity
you are acting on behalf of, you may not add another; but you may replace the old one, on explicit
permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document [246] do not by this License give permission to
use their names for publicity for or to assert or imply endorsement of any Modified Version  [246].

5. COMBINING DOCUMENTS
You may combine the Document [246] with other documents released under this License, under the
terms defined in section 4 above for modified versions, provided that you include in the combination
all of the Invariant Sections [246] of all of the original documents, unmodified, and list them all as
Invariant Sections of your combined work in its license notice.

The combined work need only contain one copy of this License, and multiple identical Invariant Sec-
tions [246] may be replaced with a single copy. If there are multiple Invariant Sections with the
same name but different contents, make the title of each such section unique by adding at the end of it,
in parentheses, the name of the original author or publisher of that section if known, or else a unique
number. Make the same adjustment to the section titles in the list of Invariant Sections in the license
notice of the combined work.

In the combination, you must combine any sections entitled «History» in the various original docu-
ments, forming one section entitled «History»; likewise combine any sections entitled «Acknowled-
gements», and any sections entitled «Dedications». You must delete all sections entitled «Endorse-
ments.»

6. COLLECTIONS OF DOCUMENTS
You may make a collection consisting of the Document [246] and other documents released under
this License, and replace the individual copies of this License in the various documents with a single
copy that is included in the collection, provided that you follow the rules of this License for verbatim
copying of each of the documents in all other respects.

You may extract a single document from such a collection, and dispbibute it individually under this
License, provided you insert a copy of this License into the extracted document, and follow this License
in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT
WORKS

A compilation of the Document [246] or its derivatives with other separate and independent docu-
ments or works, in or on a volume of a storage or distribution medium, does not as a whole count as
a Modified Version [246] of the Document, provided no compilation copyright is claimed for the
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compilation. Such a compilation is called an «aggregate», and this License does not apply to the other
self-contained works thus compiled with the Document, on account of their being thus compiled, if
they are not themselves derivative works of the Document. If the Cover Text [246] requirement of
section 3 is applicable to these copies of the Document, then if the Document is less than one quarter
of the entire aggregate, the Document’s Cover Texts may be placed on covers that surround only the
Document within the aggregate. Otherwise they must appear on covers around the whole aggregate.

8. TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Docu-
ment [246] under the terms of section 4. Replacing  Invariant Sections [246] with translations
requires special permission from their copyright holders, but you may include translations of some or
all Invariant Sections in addition to the original versions of these Invariant Sections. You may include
a translation of this License provided that you also include the original English version of this License.
In case of a disagreement between the translation and the original English version of this License, the
original English version will prevail.

9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document [246] except as expressly provi-
ded for under this License. Any other attempt to copy, modify, sublicense or distribute the Document
is void, and will automatically terminate your rights under this License. However, parties who have
received copies, or rights, from you under this License will not have their licenses terminated so long
as such parties remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation [http://www.gnu.org/fsf/fsf.html] may publish new, revised versions
of the GNU Free Documentation License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems or concerns. See http://
www.gnu.org/copyleft/ [http://www.gnu.org/copyleft].

Each version of the License is given a distinguishing version number. If the Document [246] spe-
cifies that a particular numbered version of this License «or any later version» applies to it, you have
the option of following the terms and conditions either of that specified version or of any later version
that has been published (not as a draft) by the Free Software Foundation. If the Document does not
specify a version number of this License, you may choose any version ever published (not as a draft)
by the Free Software Foundation.

Addendum
To use this License in a document you have written, include a copy of the License in the document
and put the following copyright and license notices just after the title page:

Copyright Cristian Marchi.

Permission is granted to copy, distribute and/or modify this document under the
terms of the GNU Free Documentation License, Version 1.1 or any later version
published by the Free Software Foundation; with the Invariant Sections [246]
being LIST THEIR TITLES, with the Front-Cover Texts [246] being LIST, and
with the Back-Cover Texts [246] being LIST. A copy of the license is included
in the section entitled «GNU Free Documentation License».

If you have no Invariant Sections [246], write «with no Invariant Sections» instead of saying which
ones are invariant. If you have no Front-Cover Texts [246], write «no Front-Cover Texts» instead
of «Front-Cover Texts being LIST»; likewise for Back-Cover Texts [246].

250

http://www.gnu.org/fsf/fsf.html
http://www.gnu.org/fsf/fsf.html
http://www.gnu.org/copyleft
http://www.gnu.org/copyleft
http://www.gnu.org/copyleft


Documentazione sulla licen-
za libera GNU (in inglese)

Se il proprio documento contiene esempi di programmazione non immediati, se ne raccomanda il
rilascio con una licenza di software libero a propria scelta, quale la  GNU General Public License
[http://www.gnu.org/copyleft/gpl.html], per permetterne l’utilizzo nel software libero.
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